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1: Welcome to PAC Control

Introduction

Welcome to PAC Control ", Opto 22's visual control language for Opto 22 SNAP PAC control systems
and the input/output (I/0) units that work with them.

PAC Control makes it easy to write control applications with little or no programming experience. If
you know how to design a control application and can draw some flowcharts to describe it, you
already know the basics of PAC Control. At the same time, PAC Control provides a complete and
powerful set of commands, as well as the OptoScriptm programming language, to meet your most
demanding industrial control needs.

PAC Control comes in two forms: PAC Control Basic and PAC Control Professional .

«  PAC Control Basic is included in the purchase of an Opto 22 SNAP PAC controller and is also
available as a free download from our website, www.opto22.com. PAC Control Basic includes
both flowchart and OptoScript programming, subroutines, a graphical debugger, and about
400 commands.

«  PAC Control Professional is available for purchase either separately or as part of the
complete PAC Project  Professional software suite. The Professional version of PAC Control
adds:

- Support for controller redundancy and Ethernet link redundancy to controllers and /0 units

- Support for Legacy hardware, including serial mistic 1/0 units with a SNAP PAC S-series
controller

— A conversion utility to help you move older OptoControl” strategies to PAC Control
— Additional "Pro version only” PAC Control commands

For information on features supported by a specific controller, see the controller documentation.

For Developers: SNAP PAC REST API

If you're a developer who'd like to use PAC Control strategy tags in communications with other
devices, the Opto 22 SNAP PAC REST APl is a secure and powerful way to do just that. The APl is
available in SNAP PAC R-series and S-series controllers with PAC firmware R9.5a and higher. To
configure https access to your PAC's RESTful server and learn how to call the API, visit
developer.opto22.com.
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ABOUT THIS GUIDE

About this Guide

This user's guide not only teaches you how to use PAC Control, but also provides programming
instruction and tips. The separate PAC Control Command Reference describes in detail all PAC Control
programming commands and instructions.

This quide assumes that you are already familiar with Microsoft” Windows on your personal
computer, including how to use a mouse, standard commands, and menu items to open, save, and
close files. If you are not familiar with Windows or your PC, refer to the documentation from
Microsoft and your computer manufacturer.
This guide covers both PAC Control Basic and PAC Control Professional.

@ The Basic icon indicates features or functions that apply only to PAC Control Basic.

Bro The Pro icon indicates features or functions that apply only to PAC Control Professional.
Here's what is in this user’s guide:

1: Welcome to PAC Control—Information about the guide and how to reach Opto 22 Product
Support.

2: PAC Control Tutorial—A tutorial designed to help you use PAC Control as quickly as possible.
The chapter leads you through a sample strategy that you can manipulate, download, and run in
Debug mode.

3:What Is PAC Control?—An introduction to PAC Control, key terminology, and the main windows
and toolbars.

4: Designing Your Strategy—Programming in PAC Control: how to get from your real-world
control problem to a working strategy.

5: Working with Control Engines—How to configure and communicate with control engines.

6: Working with 1/0—How to configure and communicate with input/output (I/0) units, 1/0
points, and PID loops.

7: Working with Strategies—Detailed steps for creating, compiling, and running strategies.

8: Working with Flowcharts—Detailed steps for creating and working with the flowcharts that
make up your strategy.

9: Using Variables and Commands—Steps for configuring the seven types of variables you can
use in programming: communication handle, numeric, string, pointer, numeric table, string table,
and pointer table variables. Also shows how to use the commands that control the I/O and variables
you've configured.

10: Programming with Commands—Important tips on using PAC Control commands to
accomplish what you want in your strategy.

11: Using OptoScript—Details on the optional scripting language available in PAC Control for
complex loops, string handling, and mathematical expressions.

12: Using Subroutines—How to use subroutines to streamline your strategy development.

A: Troubleshooting—Tips for resolving communication problems and other difficulties you may
encounter.

B: Errors and Messages—Types of errors, where you'll see them, and the causes of common errors.

C: PAC Control Files—A list of all PAC Control files located in the PAC Control directory and in any
strategy directory.
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D: Sample Strategy—An illustration and description of the sample “Cookies” strategy used in
Chapter 1.

E: OptoScript Language Reference—Details about OptoScript code, including comparisons to
other languages, lexical reference, and notes to experienced programmers.

Index—Alphabetical list of key words and the pages where they are located.

Choosing Documentation

This user’s guide contains the latest information you need to use PAC Control with your SNAP PAC
system. However, if you are using Opto 22 “legacy” products designed to work with pre-SNAP PAC
systems, see Opto 22 form 1710, PAC Control User’s Guide, Legacy Edition. The legacy version includes
references to pre-SNAP PAC devices and commands, which are not included in this guide.

For information on what we mean by “legacy”and how to migrate from an older system to a SNAP
PAC system, see form 1688, the SNAP PAC System Migration Technical Note.

To enable legacy 1/0 units and commands in PAC Control, see “Legacy Options”on page 211.

Document Conventions

The following conventions are used in this document:

« ltalic typeface indicates emphasis and is used for book titles. (Example: “See the PAC Display
User’s Guide for details.”)

«  Names of menus, commands, dialog boxes, fields, and buttons are capitalized as they appear in
the product. (Example: “From the File menu, select Print.”)

«  File names appear either in all capital letters or in mixed case, depending on the file name itself.
(Example: “Open the file TEST1 txt.")

«  Key press combinations are indicated by plus signs between two or more key names. For
example, Shift+F1 is the result of holding down the Shift key, then pressing and releasing the
F1 key. Similarly, Ctrl+-Alt+Delete is the result of pressing and holding the Ctrl and Alt keys, then
pressing and releasing the Delete key.

«  “Click"means press and release the left mouse button on the referenced item. “Right-click”
means press and release the right mouse button on the item.

«  Menu commands are referred to with the Menu > Command convention. For example,
“File > Open Project”means to select the Open Project command from the File menu.

«  Numbered lists indicate procedures to be followed sequentially. Bulleted lists (such as this one)
provide general information.

Help, Documents, and Opto22.com Resources

To help you learn, understand, and use PAC Control systems, we offer a wide variety of options:

«  Helpis available in PAC Control and in all of the applications in the PAC Project™ Software Suite
from Opto 22.
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- To see screen and field-level help, click the Help button on any PAC Control screen. While

entering commands (instructions), click the Command Help button to see details about
the command.

- Inthe PAC Control menu bar, click Help to view the list of help topics.

- (lick Help > Manuals to open the PDF versions of the documents that are installed when

you install PAC Control, including:

- Opto 22 form 1700, the PAC Control User’s Guide—Shows how to install and use PAC
Control.

- Opto 22 form 1701, the PAC Control Command Reference—Contains detailed
information about each command available in PAC Control.

—  Opto 22 form 1703, the PAC Control Commands Quick Reference—Lists all PAC Control
commands plus their OptoScript code equivalents and arguments.

- Opto 22 form 1704, the PAC Manager User’s Guide, and other guides provided for
specific hardware—Help you install, configure, and use controllers and 1/0 units.

Our website at www.opto22.com offers has a broad range of resources—from helpful videos to
online blogs, forums, and news to free online self-training. We even offer free hands-on training
at our headquarters in Temecula, California.

Product Support

If you have any questions about PAC Control, you can call, fax, or email Opto 22 Product Support.

Phone: 800-TEK-OPTO (800-835-6786 NOTE: Email messages and phone
toll-free in the U.S. and Canada) calls to Opto 22 Product Support
951-695-3080 are grouped together and
Monday through Friday, answered in the order received.

7 a.m.to 5 p.m. Pacific Time

Fax: 951-695-3017
Email: support@opto22.com
Opto 22 website: WWw.0pto22.com

When calling for technical support, you can help us help you faster if you can provide the following
information to the Product Support engineer:

Opto 22 hardware part numbers or models that you're working with

Software version (available by clicking Help > About in the application’s menu bar)
Firmware version

Specific error messages you saw

Version of your computer's operating system

Installing PAC Control

PAC Control is a component of the PAC Project Software Suite, a comprehensive set of software tools
for industrial automation, remote monitoring, and data acquisition projects in any line of business.

PAC Control User's Guide


http://www.opto22.com/site/documents/drilldown.aspx?aid=3165
http://www.opto22.com/site/documents/drilldown.aspx?aid=3164
http://www.opto22.com/site/documents/drilldown.aspx?aid=3162
http://www.opto22.com/site/documents/drilldown.aspx?aid=3161
http://www.opto22.com
message URL http://www.opto22.com/site/watch.aspx
http://www.opto22.com/site/community.aspx
http://www.opto22.com/site/training.aspx
http://www.opto22.com/site/training.aspx
mailto:support@opto22.com
http://www.opto22.com

CHAPTER 1: WELCOME TO PAC CONTROL

Installation is easy and quick, and you can download PAC Project directly from the Opto 22 Support
> Downloads webpage.

The PAC Project installer includes both the Basic (free) version of the software suite, and the software
for PAC Project Professional. Click here for a comparison of PAC Project Basic and PAC Project
Professional features.

To install PAC Control:
1. Download PAC Project from the Opto 22 Support > Downloads webpage.

2. Navigate to the folder where you downloaded PAC Project, and then double-click the
installation file (PAC_Project_<release number>.exe) to begin installation.

NOTE: You must have an OptoPassword to install the Professional version of PAC Control. For details, see
the Opto 22 website, www.opto22.com, Support > Downloads tab, and click the link for OptoPassword
(located in the text above the Search field).

If you have trouble installing PAC Control, contact Opto 22 Product Support at 800-835-6786
(toll-free in the U.S. and Canada) or 951-695-3080.

System Requirements

Installation Requirements

Here’s what you need to install and run PAC Control. If you are using PAC Display, please note its
requirements in form 1702, the PAC Display User’s Guide.

«  Acomputer with a standard or mainstream core processor and (at least) the minimum memory
required for your version of Microsoft Windows. (Low-end CPUs are not recommended.)
Additional memory may be required for some configurations.

+  One of the following operating systems:
- Microsoft Windows 10 Professional (32-bit or 64-bit)
- Windows 8.1 Professional (32-bit or 64-bit)
- Windows 7 Professional (32-bit or 64-bit)
- Windows Vista® Business (32-bit only)

NOTE: PAC Project will not install on Windows XP or older Windows operating systems. Embedded
operating systems are not tested or supported.
«  Ethernet capability.

«  VGA or higher resolution monitor (Super VGA recommended). Minimum size: 800x600 with
small fonts.

«  Mouse or other pointing device.
+  (Optional) Installed Windows printer.
«  Foravailable hard disk requirements, please see the PAC Project Release Notes.

«  Compatible control engine and I/0 unit(s), as shown on page 6.
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INSTALLING PAC CONTROL

Important Note on Disk Drives

Opto 22 applications, including PAC Control, perform best when using files from a local hard disk.
Network drives may be used, but performance may suffer and depends upon the speed and

reliability of the network. While it may be possible to use other drive types, such as key chain USB
drives and memory cards, their use is not recommended. They are better suited for transferring files

rather than directly accessing them.

Compatible Controllers and I/0O Units

The following controller and I/0 unit combinations are compatible with PAC Control Basic and PAC

Control Professional as shown:

Using this controller

PAC Control Basic supports these I/O units

PAC Control Professional supports these I/O units

SNAP PAC S-series

SNAP-PAC-R1 SNAP-PAC-SB1
SNAP-PAC-R1-B SNAP-PAC-SB2
SNAP-PAC-R1-W*

SNAP-PAC-R2

SNAP-PAC-R2-W*
SNAP-PAC-EB1
SNAP-PAC-EB1-W*
SNAP-PAC-EB2
SNAP-PAC-EB2-W*

SNAP-PAC-R1
SNAP-PAC-R1-B
SNAP-PAC-R1-W*
SNAP-PAC-R2
SNAP-PAC-R2-W*
SNAP-PAC-EB1
SNAP-PAC-EB1-W
SNAP-PAC-EB2
SNAP-PAC-EB2-W*
SNAP-PAC-SB1
SNAP-PAC-SB2

SNAP PAC R-series

SNAP-PAC-R1
SNAP-PAC-R1-B
SNAP-PAC-R2
SNAP-PAC-EB1
SNAP-PAC-EB2

SNAP-PAC-R1
SNAP-PAC-R1-B
SNAP-PAC-R2
SNAP-PAC-EB1
SNAP-PAC-EB2

SoftPAC

SNAP-PAC-R1
SNAP-PAC-R1-B
SNAP-PAC-R1-W*
SNAP-PAC-R2
SNAP-PAC-R2-W*
SNAP-PAC-EB1
SNAP-PAC-EB1-W*
SNAP-PAC-EB2
SNAP-PAC-EB2-W*

SNAP-PAC-R1
SNAP-PAC-R1-B
SNAP-PAC-R1-W*
SNAP-PAC-R2
SNAP-PAC-R2-W*
SNAP-PAC-EB1
SNAP-PAC-EB1-W*
SNAP-PAC-EB2
SNAP-PAC-EB2-W*

* Wired+Wireless PACs and I/O can be used on a wired Ethernet network or on a wireless LAN.
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Introduction

In this chapter, we'll start with a sample strategy: a control application for a simple cookie factory.
You'll learn how to work with strategies, open and manipulate flowcharts, work with variables and
/0 points, configure a control engine, compile and download a strategy, run it in Debug mode,
make an online change, and more. The tutorial can be used with either PAC Control Basic or PAC
Control Professional. (The images in the tutorial show PAC Control Basic.)

The best way to use the tutorial is to sit down at your computer and follow it through. To start, all
you need is PAC Control, which allows you to do everything up to the point of downloading your
strategy. To do the complete tutorial you will need the controller and I/0 included in a SNAP PAC
Learning Center. For more information, go to the Opto 22 website, www.opto22.com, and search on
the part number SNAP-PACLC.

In this Chapter

OPENING thE SITATEGY w.vvovreverreeeseeresseensesessssssssssss s s sssss s
Saving the Strategy....
Examining the Strategy
Opening a Chart..
Opening a Block
FaYo Lo [Tat k= I @oTaaTa 2T g o FN OO
Configuring @ CONLrOl ENGING w.....ocooooeceeeeeceeeeeessseees e ssssseesssssseesssnssses oo
Compiling the Strategy
Running the Strategy.... . .
Compiling and Downloading the Change . . .
USING @ WAtCh WINAOW ...ocoveeosceeeeceseseecesssseeessssssesssssssesssssssesssssssseesssssseessssnsssessns
Closing the Strategy and EXItING .ooo.cvveoeceeecescceseeessssees e ssssseesssssseessssnsssessns
WNEE'S INEXE? .o s 44
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OPENING THE STRATEGY

Opening the Strategy

A strategy is a complete control program developed in PAC Control. Our sample strategy controls a
cookie factory. The sample strategy is described in detail on page 409, but for now, let's just open
and explore it.

1. Open PAC Control:

- InWindows 7 and Windows Vista, press the Windows Start key E and then click
Programs > Opto 22 > PAC Project 9.6 > PAC Control.

- InWindows 10 and Windows 8.1, press the Windows Start key E type PAC Control
9.6 and then press the Enter key.

The PAC Control main window opens.

1PAC Control Basic

File Edit Configure Chart Subroutine Tools  Wiew  Help Vlenu bar

EETE © 5 @ am X Ak Y mee el P

WF&C Contral: Ready | MU

2. On the PAC Control toolbar, click the Open Strategy button .

3. Inthe Open Strategy dialog box, browse to
CA\Users\Public\Documents\Opto 22\PAC Project 9.6\Control Basic Examples\ioCookies.

(If you're using PAC Control Pro, substitute “Control Pro Examples”for “Control Basic Examples”
in the folder location.)

4. C(lick Cookies.idb to select it, and then click Open to open the strategy in PAC Control.
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The Cookies strategy opens and the PAC Control window now shows the Cookies strategy in
the Strategy tree window. (Yours may look somewhat different.)

1 PAC Control Basic
File Edit Configure Chart Subroutine Compile Mode Tools View Window Help

EEETEEE @ © J C en X #AY kL ime e e E P

I Control Engines
1) Subroutines Included
I=5) Charts
= 1) Wariables
# IC5) Mumeric Yariables Strategy
I String Wariables
I5) Pointer Yariables
I5) Communication Handles
IE5) Mumeric Tables
IC5) Stiing Tables
I5) Pointer Tables
& I 140 Units

Strategy name

v| @ Mext ﬁ} Prey

—|1 Cookies

PAC Control; Ready Configure UM

Saving the Strategy

Now let’s save the strategy to a new name, so we can change it while leaving the original intact.
1. Inthe PAC Control menu bar, click File > Save Strategy As.

Save Strategy As

Save in: | |23 ioCookies |ﬂ| Q-
‘Cookies.idb

File: name: | | L Save J
Save as type: |F'AEI Contral Strategy Files [*.idb) v| [ Cancel ]

2. Since each PAC Control strategy must be located in its own directory, you cannot save the
strategy to a new name in its current location.
a. Inthe Save Stategy As dialog box, click the Up One Level button # to move up to the
Examples directory.
b. Click the Create New Folder button ©*
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The new folder appears in the list.

Save Strategy As

Save in: | |25 Contral Pro Examples Iv| ] ?‘ g .

[C)Error Handler Complesc

[CS)Error Handler Simple

[C5) InitYariables

(C)ioConkies

5 OptasScript Examples
NEL, Jder|

File name: | | [ Save ]

Save as type: |F'AEI Contral Strategy Files [*.idb) v| [ Cancel ]

c. Type My Cookies toreplace New Folder.
d. Double-click the folder to open it.
e. Inthe File name field, type Cookies.

The dialog box now looks like this:

Save Strategy As

Save in: | I My Cookies IV| €] ?‘ ® -

File name: | Cookies | [ Save ]

Save as type: | PAL Control Strategy Files [*.idb) w | [ Cancel ]
f. Click Save.

Your new Cookies strategy is saved in the My Cookies directory.

Examining the Strategy

Briefly, our cookie factory consists of:

«  Atank of pre-mixed cookie dough

«  Atankof chocolate chips

+ Anoven

«  Avisual inspection station

«  Aconveyor belt

«  Compressed air to blow rejected cookies off the belt
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Conveyor EIORCOROD T H
belt ——~Push To Srar:}
FTic

Oven Inspection station

The process starts when a ball of dough drops on the belt. It moves along under the chip tank to
receive some chips, and then it moves into the oven to be baked. The next stop is an inspection,
where rejected cookies are blown off the belt and good cookies move along to shipping. Should
anything go wrong, we also have some built-in alarms to stop the process.

The best way to see all the components of the strategy is to look at the Strategy Tree.

The Strategy Tree Window

To configure and run a strategy, you must leave the strategy tree window open—if you close the
strategy tree window, the strategy closes, too.

To expand a folder in the strategy tree, click the plus sign; click the minus sign to collapse the folder.

To move the strategy tree window, click and drag title bar. To minimize, maximize, or dock it, click
the buttons in title bar. To resize the window, drag any edge.

Tl bar —

The strategy tree

. I5) Control Engines window
Click the 15 Subroutines Included

minus sign %El %ar:l —
armz X .
to collapse &, Dough. Chip_Contl |~ This strategy has
a folder l?o Dough_Vessel_Pressure_( five charts
l?o Oven_|nzpection_Control
l?o Powerup
= I£5) Wariables
I3 Mumeric Yariables
IC5) String Wariables
IC5) Pointer Yariables
I5) Communication Handles
I3 Mumeric Tables
. IC5) Stiing Tables
Click the IC5) Pointer Tables
plus sign ® ) 140 Urits

to expand
a folder

>

<
-
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Expanding the folders in the strategy tree reveals that the strategy includes five flowcharts (in the
Charts folder), eight Numeric Variables, and one Mixed I/0 Unit (with both analog and digital
points). The Strategy Tree not only shows you all components of the strategy but it also provides
shortcuts to many common PAC Control activities, such as opening flowcharts.

Docking the Strategy Tree

Since the strategy tree is so useful, you'll probably want to keep it visible while you create and debug
your strategy. To keep the strategy tree window visible, you can dock it in a separate frame.

1. Click the docking button [ in the upper-right corner of the strategy tree window.

The strategy tree moves into its own frame at the left side of the main window.

1PAC Control Basic
File Edit Configure Chart Subroutine Compile Mode Tools  Wiew window Help

DEH ¥ af|a X | A '-B_‘,’B R 'g‘ S $ ® 5 & | ok vien 5 compikal

Docked
strategy tree

=) Cocke:
® =y Contral Engines
I Subroutines Included
= 5y Charts
= % Alarms
=] TQ Dough_Chip_Control
= T@ Dough_Yessel Pressure_Cor
] *@ Owen_Inspection_Contral
E % Powenp
= |5 Variables
2 I Mumeric Yarables
E bStartFlag
g&% diCookietotionT imer
D oughPressursS etpaint
R ampt/ alue
[SetpointtinusD eadbanc

FLT

[Tl nChartStatus

1=z

2l nConkiehatinnPreset

=z
@ nLoopCounter

1= String Yariables

I Pointer Variables

I3 Communication Handles

I Mumeric Tables

I Shing Tables

I Pointer Tables

& =y 140 Units

& [IE | 3

B o

PAC Control: Ready Configure MM

2. Tochange the width of the strategy tree’s frame, move your mouse over the right side of the

frame. When the pointer changes to the Windows Splitter icon « , click and then drag the
side to make the frame wider or narrower.
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Using Quick Find

The quick find tool at the bottom of the strategy tree helps you to find items quickly in the tree.
Use the Next and Prev buttons (or F3 and Shift+F3) to find multiple matches. Any partial match will
work.

i Cookies (¢ |Z| |E| [gl

= £ Cookies
|53 Control Engines
(£ Subroutines Ineluded
(=) Charts
[ Wariables
() 140 Units

Quick find tool Use the Next and Previous buttons
tofind the next or previous instance
of your Quick Find search

Sner o

For example, if you enter the word, “setpoint,” when you click Next, the first match is found.

i Cookies o =1
(£ Wariables ~
= () Mumeric Yariables
g bStartFlag
':]‘;21% dtCookiebationTimer
Match @ fD oughPres:s tpoint R

|L—'ﬂ R ampvalue

FL

2l {5 etpointtinusD eadband

FLT

&l nChartStatus

Izz

2] nCookieMationPreset

Iz2
==

[

| *

< >
-

When you click Next again, the next match is found.

Opening a Chart

Every control process can be planned and mapped out using one or several PAC Control flowcharts,

or charts. Because flowcharts are easy to follow, PAC Control strategies are easy to understand.

For an example, let’s take a look at the Dough_Chip_Control chart.

1. With the Charts folder expanded, double-click the Dough_Chip_Control chart name on the
Strategy Tree. (You can also open a chart by clicking Chart > Open in the PAC Control menu
bar, and then double-clicking the chart name.)
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The chart appears somewhere in the large frame of the main window.

"1 PAC Control Basic

& ' -
v| @ Mext ﬁ} Presy

File Edit Configure Chart Subroutine Compile Mode Tools View Window Help

[ config ~1 ebuo oo IR

= 15 Cookies -
=) Control Engines
I Subroutines Included
= I5) Charts
H % Alarmz
EEO Dough_Chip_Contral
=] EEO Dough Vessel Pressure_
] % Oven_|nzpection_Control
H % Powerup
= ) Wariables
= 1) Numeric Yariables
[z] bStartFlag

Izz

a4 dCookieMotionTimer —

THE:

B o oughPressureSetpe

FL

R amptfalue

B 5 etpointtinuzDeadb

FLT

T2l nChantStatus

HEFS

121 nCookieMationPresst

IZZ
12 nLoooCaunter b

=

=

B R X

H | &

The Powerup chart starts
this chart.

This chart runs
continuously once the
program has been started.

#ay LM Eocoens dH @&

This chart drops the dough and chips on the conveyor belt.
The belt must be running between 50% and 65% of max rpm.

-
Start

z

Speed OK?
N

>

(1) Shortcuts EX v

4] A2 T Ghart /

2

Dough_Chip_Contral |

PAC Control: Ready

Configure UM

White tab shows
this is a chart.

Gray tab shows

Maximize
button

2. (lick and drag the title bar of the chart window if necessary to see the Maximize button at the
upper right. Click the Maximize button to make the chart fully fit the frame.

Note the tabs at the bottom of the main window; the white tab tells you you're viewing a chart,
and the gray tab shows the chart’s name.

A PAC Control Basic - [Dough_Chip_Control]
ﬁFile Edit Configure Chart Subroutine Compile Mode Tools  Wiew Window Help

TS o~ J

2l Emo o e s d &

= I5) Cookies

I5) Control Engines
15 Subroutines Included

= I3 Charts
EL'O Alarmz
EL'O [ough_Chip_Contral
EL'O Dough_esszel_Pressure_
EL'O Oven_|nzpection_Control
EL'O Powerup

= IC5) Wariables
= I£5) Mumeric Yariables

=] bStartFlag

Izz

a4 diCookietotionTimer

THR

B o oughPressureSetpc—

FLT

] R amptalue

FLT

B 5 etpointtinuzDeadb

FLT

T2l nChantStatus

HEFS

12l nCookieMationPresst
@ nLoopCodm

< | B

5] /]|

chart name.

tf

arl TL pewt Py
| |

-
This chart drops the dough and chips on the conveyor belt. B
The belt must be running between 50% and 65% of max rpm.
The Powerup chart starts d Start
this chart.
1w
Start
Conweyar
7
This chart runs
continuously once the Speed OK?
program has been started.
T
e Drop the dough.
Drop Dough
L 7
< ¥
il (i)Shortcuts | 85% v
[T T hart/
—If:l [ough_Chip_Contral

IPAC Control: Ready

Configure MM
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PAC Control Blocks and Connections

Let's take a closer look at what this chart does. Even without its descriptive comments, it's easy to
see that this program segment begins by starting a conveyor belt. If the belt isn't running at the
correct speed, the process goes into a loop until the speed is correct. When it is correct, dough is
dropped on the belt, and then chips are dropped on the dough. The process then loops back to
re-evaluate the conveyor speed, waiting if it's incorrect, and dropping more dough and chips if it's
correct.

The rectangular-shaped blocks are called action blocks. They do things.
The diamond-shaped blocks are condition blocks. They decide things.

Charts may also contain other blocks, including oval-shaped continue blocks, which route the
program logic back to another block in the same chart, and hexagon-shaped script blocks, which
contain instructions and logic written in PAC Control’s built-in OptoScript programming language.

Connections link the blocks together and show how the program logic flows. Action blocks exit
through just one connection, since they always go in one direction. Condition blocks exit through
two connections, one for a true evaluation and the other for a false evaluation.

Action Block tool

OptoScript Block tool
Tind tool Condition Block tool
| # 2% ||L | <£ ® 4] | £ Compile View £ Compile All
|
£ Pan tool | Texttool
elect tool Connect tool
ind and replace tool Continue Block tool

This chart drops the dough and chips on the conveyor belt.
The belt must be running between 50% and 65% of max rpm.

The Powerup chart starts start ——Action Block

this chart.
7
Start
This chart runs

continuously once the
program has been started.

Text Drop the dough.
op Dough

§ Drop the chips.

Connections OptoScript Block

Condition Block
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Opening a Block

Let's see what's in a block.
1. Double-click the Drop Dough block.

The Instructions dialog box appears.

A Instructio Dough_Chip_Control - Drop Dough

nCookieMotionPreset
dtCookieMotionTimer

Open the dough valve,

ghDisp Val
Previous Block.
Keep the dough valve open for 2 seconds.
Delay (Sec)

2.0 _—

Cloze the dough valve,
Turn Off

£

[ Cloze ] [ Help ] [ Command Help ]

This block contains four instructions: Move, Turn On, Delay (Sec), and Turn Off. Each one has a
description above it.

2. Double-click the Turn On instruction to see more about it. (You could also click it once and click
Modify).

The Edit Instruction dialog box for the Turn On command appears.

# Edit Instruction

X

Instruction:
v|[ Select... ]

Comment:

|Dpen the dough valve. |

Type Mame

Drigital Dutput v | | doDoughDispensel alve v |

[ QK. ] [ Cancel ] [ Help ] [ Command Help ]

Here we see the details of the command: It turns on doDoughDispenseValve (the digital output
point for the dough dispensing valve). In other words, it opens the valve.

3. Close the Edit Instruction dialog box by clicking OK or Cancel.
4. C(lose the Instructions dialog box by clicking Close or by pressing Esc (the Escape key).
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Add a New Block and a New Connection

Before we leave the Dough_Chip_Control chart, let's make a cosmetic change. We noted earlier that
we didn't have any continue blocks in this chart. Let's add one to replace the long connection that
loops from the Drop Chips block up to the Speed OK? block.

1.

Delete the existing long connection line by clicking it to select it, and then pressing the Delete
key.
Now click the Continue Block tool @ ' in the toolbar.

When you bring the mouse back into the chart area, an oval outline appears, representing the
new continue block.

Position the oval below the Drop Chips block, and then click the mouse.
A continue block appears with the default name Block (and the block number).

If you move the mouse pointer again, a new oval outline follows. Deactivate the Continue Block
tool by right-clicking the mouse, or by pressing Esc.

Your screen should now look something like this:

{J
The Powerup chart starts Start A
this chart.
1w
Start
Conveyar
g
This chart runs
continuously once the Speed OK?
program has been started.
T
d Drop the dough.
Drop Dough
i Drop the chips.
Drop Chips
18
v
< ¥
(i)Shortcuts | B4% w
[AT- TR chart £

5. Connect the Drop Chips block to the continue block:

a. Clickthe Connecttool t .
b. Click once in the Drop Chips block.

NOTE: When using connections, always click first in the block that the connection is coming from.

If you move your pointer around the screen, you see a connection following the pointer. Click
the top of the continue block to complete the connection. Deactivate the Connect tool by
right-clicking the mouse button or by pressing Esc.
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Rename a Block

Let's rename the continue block.
1. Click the continue block to select it.
2. Right-click the continue block and select Name from its pop-up menu.

The Name Block dialog box appears.

#1 Name Block

Ok

Cancel

Help

L ox ]
[ Concel |
[tee ]

3. Type Back to “Speed OK?~ over the selected text, and then click OK.

The chart now looks something like this:

The Powerup chart starts
this chart.

This chart runs
continuously once the

program has been started.

Start
Conveyar

i

Speed OK?
T -
d Drop the dough.
Drop Dough
i Drop the chips.
Drop Chips
T
I Back to o
'Speed OK?
[ v

(i)Shortcuts | B4% w

[AT T2 Chart /
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Select a Continue Block’s Destination

Now let’s give the continue block its instructions.
1. Double-click the continue block to see a list of all the blocks in the chart.

1 Select Continue Block Destination E]
Block Id: Mame Type
; Drop Chips
5 Drop Dough Action
2 Speed QK7 Condition
1] Start Action
17 Start Conveyor OptoScript
[ QK. ] [ Cancel ] [ Help ]

2. (lickthe Speed OK? block to select it, and then click OK.

When the program reaches the continue block, it returns to the Speed OK? block. We haven't
changed the way the program works; we've just done the same thing in a different way.

Continue blocks are useful in a complex chart to avoid crossing connection lines.

Adding a Command

Now we're going to add a command (also called an “instruction”) to a block in the
Dough_Chip_Control chart. This command will keep track of the number of cookies we produce.

NOTE: To enable legacy commands in PAC Control for a specific strategy, see “Legacy Options”on
page 211.

1. Double-click the Drop Dough block.

A Instruction Dough_Chip_Control - Drop Dough

Far animation in ~ m

Move

From nCookieMotionPreset Modify.

To dtCookieMotionTimer

Open the dough valve,

Turn On Mext Block
doDoughDispenseValve
Previous Block.

Keep the dough valve open for 2 seconds.
Delay (Sec)
2.0 =

Cloze the dough valve,
Turn Off

£

[ Cloze ] [ Help ] [ Command Help ]

2. We'lladd the new instruction (command) between the Turn On and Delay (Sec) commands.
a. Click anywhere on Delay (Sec) to highlight this command.
This highlight indicates the position where the next command is added.
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b. Click Add to open the Add Instruction dialog box.

#1 Add Instruction

Instruction:

v| [ Select... ]

LComment:

X

Type Mame

ar |AII Walid Types v | |aiD0ughVesseIF'ressure v |
Fut Result in |AII Walid Types w | |aoE0nveyorSpeedEontrol w |
[ QK. ] [ Cancel ] [ Help ] [ Command Help ]

Finding Commands in the Instructions Dialog Box. There are several ways to find
commands.

If you know the exact name of the command you want, you can start typing it as soon as you
open the Instructions dialog box. (Don't worry about typing over the Absolute Value
command—It appears in the Instruction field only because it's the first command in the

alphabetical list of commands).

As you type, the first command matching the letters you have typed is filled in automatically.
As you continue typing, PAC Control displays the next matching command. When you see the
command you want, press Enter or click the Add button to add it to the block.

For example, if you want to create a Move command:

As you type: This command appears:
m Make Integer 64
mo Modulo

mov Move

One way to add a command is to click the Instruction drop-down list, and then scroll through

the list of commands to find the one you want.
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A third way to add a command is the one we'll use now.

3.

In the Add Instruction dialog box, click Select.

4 Select Instruction *
Groups: Instructions:

Anialog Point ~ "
Chart Add

Communication Arccosine

Control Engine Arcsine

Deprecated Arctangent

Digital Point Clamp Float Table Element

Error Handling Clamp Float Variable

IO Unit Clamp Integer 32 Table Element

IO Unit - Event Message Clamp Integer 32 Variable

IO Unit - Memory Map Complement

IO Unit - Scratch Pad Cosine

Logical Decrement Variable

Divide

Miscellaneous Generate Random Mumber

PID - Ethernet Hyperbolic Cosine

Pointers - Hyperbolic Sine v
Sirnu datinn Hunarhnlic Tannent

Cancel Help Command Help

Command groups are listed on the left, and commands in the highlighted group are listed on
the right.

The command we want will increase a counter. Counting sounds like math, so let’s try the
Mathematical group.

Click Mathematical on the left to highlight it, then scroll through the list on the right until you
findthe Increment Variable command. Click it once.

# Select Instruction [‘5_<|
Groups: Instructions:

Diigital Point # || | Clamp Integer 32 T able Element A
Error Handling ~ | | Clamp Integer 32 Y ariable b
Event/Reaction Complement

High Denzity Digital Module Cosine

1/0 Unit Decrement W ariable

140 Unit - Event Message Divide

140 Uit - Memary Map Generate Random Mumber

1/0 Unit - Seratch Pad

Loiical

Miscellaneous

FID - Ethernet

PID - Mistic Minirnum

Puairters Modulo

Simulation | | Multiply

Shing Matural Log

Time/D ate ¥ ||| Raize e to Power b
[ QK ] [ Cancel ] [ Help ] [ Command Help ]

NOTE: If you need information about a command, click the Command Help button.

Click OK, and this command is displayed in Instruction filed of the Add Instruction dialog box.

The cursor is automatically moved to the next field, which is Comment. Comments are optional
but very useful; they can help someone else understand the purpose of the instruction.

In the Comment field, type Increment a counter of cookies produced.
Next, click the Type down-down list (the field that currently reads “All Valid Types”).

This list shows what those valid types are: a float variable, an integer 32 variable, and an integer
64 variable.
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Counters are integers, so select Integer 32 Variable.

8. Now we're going to create the integer 32 variable to increment, which will be called
nCookie_Counter.
a. C(lick the Name down-down list (the field that currently reads “bStartFlag”).
The drop-down list shows all variables currently configured as integer 32 variables:

1 Add Instruction g|

Instruction:

|IncrementVariabIe v| [ Select... ]

LComment:

|Increment a counter of cookies produced |

Type
Integer 32 Variable v
hChartStatus
nCookiet otionPreset
nLoopCounter
[ QK ] [ Cancel ] [ Help ] [ Command Help ]

nCookie_Counter is not in the list, because we haven't created it. We'll create it now using
what we call “on-the-fly configuration.”

b. Click bstartFlag to selectit, and then type the new variable name right over it:
nCookie_Counter

¢. Click OKto close the dialog box, and the following message appears.

PAC Control Professional

The object you have specified does not exist,
. Do you wish to add it now?

[ Yes H Mo ][ Cancel ]

d. Click Yes to create the new nCookie_Counter variable.
Notice that the name and type have already been filled in.

Add Variable 53

Mame: | nCookie_Counter |

Description: | |
Initialization

O Initialize on strategy download
(%) Iritialize on strategy run
() Persistent/Redundant

Initial Value: |0

[ QK. H Cancel H Help ]

e. Add adescription, if you wish. Leave the initial value at zero, which is the default. Then click
OK to save your changes and close the dialog box.

PAC Control User's Guide



o.

CHAPTER 2: PAC CONTROL TUTORIAL

In the Add Instruction dialog box, click OK to close it.

The new instruction appears in the Drop Dough Instructions dialog box.

A Instructions - Dough_Chip_Control - Drop Dough

For animation in ioDisplay -
Move T
From nCookieMotionPreset
To dtCookieMotionTimer

Open the dough valve,
Turn On
doDoughDispenseValve

ol

nCookie_Counter

Keep the dough valve open for 2 seconds.
Delay (Sec)

£

an

[ Cloze ] [ Help ] [ Command Help ]

Add...

Mext Block
Previous Block.

X

But maybe it makes more sense to start the counter at the beginning of the process, rather than in
the middle, after some dough has already been dropped.

1.

With the Increment Variable command highlighted, right-click to display the pop-up menu,

and then click Cut.

You can also use Ctrl+X to cut. Cutting puts the instruction in the Windows Clipboard.

Now click Turn On to highlight it. Right-click to display the pop-up menu, and then click Paste.

You can also use Ctrl+V to paste. The Increment Variable command is pasted above the
highlighted instruction, like this:

ntrol - Drop Dough

nCookie_Counter

Open the dough valve,
Turn On

doDoughDispenseValve

Keep the dough valve open for 2 seconds.
Delay (Sec)
2.0

€

[ Cloze ] [ Help ] [ Command Help ]

Mext Block
Previous Block.

Click Close to return to the chart.

To save the changes you've made, click the Save Strategy button [ on the toolbar, and then

click OK.

To see your new variable in the strategy tree:

a. Ifthe Variables folder is collapsed, click the plus sign to expand it.
b. If the Numeric Variables subfolder is collapsed, click the plus sign to expand it.
Your new nCookie_Counter variable should be in the list in alphabetical order.
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Congratulations! You've just added a cookie counter variable. Now we're ready to download the
strategy to a control engine. But first we have to tell PAC Control that we have a control engine.

Configuring a Control Engine

Up to this point, we've been able to play around in PAC Control without hardware. Now it's time to
configure a control engine (a controller).

1. If you have a PAC Control-compatible controller and 1/0 unit you can use, make sure they are
on the same network as your PC, and make sure you have loaded the most recent firmware.

For a list of compatible controllers and /0 units, see page 6. For instructions to load firmware,
see form 1704, the PAC Manager User’s Guide.

2. Turnthe I/O unit off and then back on again.

3. Double-click the Control Engines folder on the Strategy Tree, or select Configure > Control
Engines.

The Configure Control Engines dialog box appears.

Active Engine:
Engines Associated with Strategy:
Set Active
Modify...
Delete
Download Options. ..
oK Cancel | Help

Since we haven't configured a control engine yet, there are no control engines in the list.
4. C(lick Add.

Configured Control Engines:

Modify.

Delete

5. (lick Add again to add a control engine.
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The Control Engine Configuration dialog box appears.

Configure Ethemet Connection

Configure control engine name and parameters:
Control Engine Name:

System Type
(®) Standard
() Redundart Networks (PRO only)
(©) Redundant Corttrollers (PRO only)

Settings
IP Address/Hostname: |0.0.0.0

Controller Port: | 22001
Software Retries 0]
Software Timeout: 5000 ] msec

Enter Cookie Controller as the control engine name.

The name can contain letters, numbers, spaces, and most other characters except colons and
square brackets. Spaces cannot be used as first or last characters.

Under System Type, make sure Standard is selected.
Enter the control engine’s IP address.

On hardware such as a SNAP PAC R-series controller, he IP address is usually written on a sticker
on the side of the unit. If an IP address has not been assigned to the control engine, see form
1704, the PAC Manager User’s Guide, for configuration instructions.

On a SoftPAC controller, if PAC Control and SoftPAC are on the same PC, use the loopback IP
address, 127.0.0.1. However, if SoftPAC is on a different PC, use the address for that PC's network
interface card (NIC). In this case, the SoftPAC PC's NIC must be configured with a static IP
address.

NOTE: In PAC Control Professional, a second IP address field is available, so you can designate a
secondary communication path to the control engine should the primary one fail. For more
information, see “Using Ethernet Link Redundancy in PAC Control” on page 104.

Make sure that you have not changed the values in the Port, Retries, and Timeout fields, and
then click OK.
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COMPILING THE STRATEGY

The newly configured control engine appears in the Select Control Engine dialog box.

Configured Control Engines:
Delete
[ ok || canca |

10. Click the new Cookie Controller control engine to select it, and then click OK.

The new control engine appears in the Configure Control Engines dialog box.

Active Engine:
| Cookie Controller

Engines Assodated with Strategy:
[

| Download Qptions...

Since you have only one configured control engine at this point, it is automatically set as the
active control engine. If there were more than one control engine, you would have to select it
and click Set Active to load it into the Active Engine field.

11. Click OKto close the Configure Control Engines dialog box.

On the Strategy Tree, the new control engine appears as the first entry in the Control Engines
folder.

Compiling the Strategy

The simplest way to compile a strategy is to enter Debug mode. The strategy is saved and compiled
before changing modes.

NOTE: The remainder of the tutorial is designed to work with the controller and /0 on a SNAP PAC Learning
Center. For more information, go to the Opto 22 website, www.Opto22.com and search on the part
number, SNAP-PACLC.

1. Click the Debug mode button [EXZH on the toolbar (or select Debug from the Mode menu).
2. Inthe Save Strategy dialog box, click Yes to save the strategy.
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If you see a Powerup Clear Expected message, click OK.

You may see a Download Warning message like this one:

X

Download Warning

'\ Strategy Mismatch
- —

The strategy to be downloaded does not match the strategy already in the control engine.
Strategy To Download

o Mame: Cookies
2 Checksum: 8ADI073CCSC4F42C0F 7B 7O0AFCF2FCED
Timestamp: 06/04/09 12:29.33

Strategy in the Controller
M ame: Cookies
Checksum: 577EF49E0D 78930 A3EFEEASIE3CF3031
Timestamp: 06/03/09 17.07.54
If you choose to continue, the strategy that is in the control engine will be replaced by this strategy.

Do you want ta continue the download?

[ Yes ] [ Mo ] [ Help ]

Or you may see a message that the control engine’s memory has been cleared.
Click Yes to proceed.

Two additional dialog boxes appear. The first dialog displays the progress as the strategy is
compiled. The second dialog shows progress as the strategy is downloaded to the control
engine.

st rategy Download

E Downloading your strategy
=
v

Download strategy: [ |

Cancel

Assuming the strategy was compiled and downloaded successfully, you are now in Debug
mode.
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In the PAC Control window, you'll notice that the Debug toolbar is now available. The mode is
shown at the bottom of the main window. The open chart window shows that the strategy is
stopped, as shown in the following figure:

Debug toolbar #1PAC Control Professional - [Dough_Chip_Control] [Z”E”‘S__q
bUttOﬂS = it__Control Engine  Debug  Chart  Subroutine Mode  Tools  View Watch  Window  Help - | @ X
s> m o D)
© x| ) 3
2 This chart drops the dough and chlps on the conveyor belt.
Bl ([ Cookies A The belt must be running between 50% and 65% of max rpm.
= I£5) Control Engines
# Cociie Conuter The Powerup chart starts g
125 Subroutines Included this chart Start
= 15 Charts
l?o Alarms
l?o [ough_Chip_Contral
l?o Dough_esszel_Pressure_
l?o Intermupt
l?o Owen_lnzpection_Contral
l?o Powerup 3 s
= I£5) Wariables This chart runs '
= [ Numeric Variables continuously once the Speed OK?
[E] bChipDispenselialve program has been started.
2] bChipLevelSwitch
@ bDoughDizpenszetaly 5
2] bDoughLevelSwitch Drop Dough Drop the dough.
@ bD oughPressureCornt
2] hest T ¥,
Strategy statu Hal bEStop 3 5
= innPassF ails = =
3 . [, Chart
b Next 1 Prev —|f:", Dough_Chip_Contral f:ﬁ Dough_Yesszel Pressure_Contral | " Mode

IC:'l,Program Files\OptoZ2\PAC Project 8, 1\Display Pro ExamplesiioCookies\Control\Cookies

Debug

MM

Running the

Strategy

In Debug mode, we're going to run our strategy and examine it. We'll see how the strategy run
affects variables, how the command blocks are executed, and so on. The first chart to run in any

strategy is the Powerup chart, so we'll look at it first.

1.

2.

Double-click the Powerup chart on the Strategy Tree. When it opens, notice that it says
Stopped at the bottom left.

Click the Run Strategy button p- .

A dialog box asks if you are sure you want to run the strategy.

Click Start Strategy.

A progress window appears, perhaps only briefly. And at the bottom of the chart window, the
word Stopped changes to Running. Let’s try pausing the program to see where we are.

Click the Pause Chart button ' .
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X

#1 PAC Control Professional - [Powerup]

ﬂ’l File Edit Control Engine Debug Chart  Subroutine Mode Tools  Wiew Watch  Window Help - | &8 x
LR B %0
ookie 1 v
Cooki ~ .
& © Cookies : = This chart starts the program and all other charts.
= I£5) Control Engines
% Cookie Controller ]
125 Subroutines Included Start Program
= 15 Charts
L_E.]Q Alarmz
T Dough_Chip_Control Wait until start flag is set
L_r.’o Dough Yessel Pressure true (non-zero). =
l?o Intermipt
L_E.]Q Owen_lnzpection_Control
l?o Powerup
B [ Variables ] Start the alarm monitoring,
= I£5) Mumeric Yariables Start Charts dough/chip control, pressure
2] bChipDispenseValve control, and oven/inspection
2] bChipLevelSwitch charts.
@ bDoughDizpenszetaly v
) ¢ | »
@ bDoughLevelSwitch
(2] bDoughPressweCont v | | | IEEEEEEN R XN T () shoteuts
£ I > [ Chart /
Ib Mext  qp Prev ﬂ’l Dough_Chip_Contral ﬁlDough_VesseI_F'ressure_E... ﬂ’l Pawerup
IPAC Control: Ready Debug MM

The hatch marks on the Start? block indicate that this command block was about to be
executed when we clicked Pause. Apparently the program isn’t getting past this block. Notice
that the False exit routes right back to the top of the Start? block, while the True exit moves on
to Start Charts. We can see that if the start flag had been true (non-zero), the program would
have gone right into the Start Charts block. Since we didn't get that far, the start flag must be
zero.

And in fact it is. We planned it that way because we wanted someone (for example, a factory
operator) to start the process intentionally. We can simulate this ourselves in PAC Control by
manually setting the flag to a non-zero value.

Double-click the bStartFlag variable on the Strategy Tree.
Alittle box appears.

3 "bStartFlag" (scanning)

Walue: |D | & Maximize button

In this dialog box you can view the variable value, but you cannot change it unless you
maximize the dialog box.

Click the Maximize button.

3 "bStartFlag" (scanning)

Mame: bStartFlag

Walue: | u} |

OMoeio 7

This dialog box displays current information on the variable bStartFlag. You can see that the
variable is initialized to zero on strategy download.
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7. Highlight the value zero in the dialog box and type 1 to replace it.
The field turns purple, indicating a change has been made but not implemented.

8. (lick Apply toimplement the change. Click the Minimize button in the bStartFlag View Variable
dialog box and move it out of the way. Click the Powerup tab to make the Powerup chart the
active window.

Inspecting Messages

1. Look for a light-blue [TMFS" box in the status bar at the bottom of the window.

The status bar in the main PAC Control window tells you when an information, warning, or error
message has been placed in the message queue. Messages can help in troubleshooting your
strategy. In this example an Information message is in the message queue.

2. (lickthe [IMFG  box or select Control Engine > Messages to view the View Message Queue

dialog box.
+ View Message Queue for “Cookie Controller™ [’._|[’E|r‘5__<|
75 Refresh _é Copy Al ETPUD Top Message X Clear All Messages
#  Code Severty Description Chart Block. Line | Object Time Drate
o -4 Info Device has powered up. [Powerup clea..  <system: _|.. M4 Mia Miked.. 1313, 09/25

This message tells you that the I/O unit has powered up.

3. Close the dialog box to return to the Powerup chart.

Stepping Through the Chart

Now let's step through the chart to see what's happening.
1. Clickinside the Powerup chart, and then click the Step Over button T

The hatch marks move from Start? to Start Charts. We've just moved (stepped) to the next
block.

2. (lick the button again.

PAC Control executes the Start Charts block and steps to the next command block. Since there
are no more blocks in this chart, we are actually exiting this chart and moving on to new
instructions in another chart. The Powerup chart has stopped, and you can see the word
Stopped at the bottom left of the chart.

In the View Variable dialog box, the bStartFlag value reverts to zero, because the Start Charts
block set the flag back to zero.

3. Close the bStartFlag View Variable dialog box. In the Powerup chart window, click the Pause
Chart button to turn stepping off.
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Then close the Powerup chart.
4. Double-click the Charts folder on the Strategy Tree.
The View Chart Status dialog box appears.

5, View Chart Status

Mame Statuz Mode Breakpoint Status FPaused At
Alarmz Fiunning Step Off Break Off
Dough_Chip_Control - Running Step Off Break Off
Dough_Yeszel_Pre... Running Step Off Break Off
Oven_|nzpection_...  Running Step Off Break Off
Powerup Stopped Step Off Break Off
< ¥

This dialog box shows us all the charts in our strategy. As you can see, four of the charts are
running, and one (Powerup) is stopped.

Powerup is stopped because it has already done its job. Let’s check the running charts.
5. Close the View Chart Status dialog box and click inside the Dough_Chip_Control chart again.
6. If your mouse has a wheel, hold down the Ctrl key and move the mouse wheel up or down to
change the zoom.

If your mouse doesn't have a wheel, there are several other ways to zoom out, too. You can
right-click on the chart and select Zoom from the pop-up menu. You can select Zoom Out
from the View menu. You can press the + or - keys on the keyboard. After zooming out, the
chart looks something like this:

Tl ohartdrop & 18 dough and ahilp & on s conveyor belt
The beltmu ctbe running betwesn 50% and 85% ofmax rpm.

The Fowerup ohart shrts
#ilcohart

Tisohartruns
oninuou dy onos his
program hac been shried.

b
>

<
% Chart /

—|ﬁ| Dough_Chip_Contral |

You can zoom back in if you wish by holding down the Ctrl key and moving the mouse wheel
down or one of the other methods.

The chart's status bar indicates that it is running, but we can’t see much happening.
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7. Click the Pause Chart button ' .

One of the command blocks appears with hatch marks.

8. Now click the Step Over button ¥ .
The next command block is hatched.

9. Continue clicking and watch how the program proceeds from Speed OK? to Drop Dough to
Drop Chips to Back to 'Speed OK?"and back up to Speed OK?

A pulsating green border appears around a block when the commands inside the block are
being executed. While you are stepping through, and anytime the Pause Chart button is
clicked, the chart status indicates Step On.

10. Click the Pause Chart button again to run the strategy at full speed.
Step Off now appears in the chart status bar.

Auto Stepping

The final stepping option is auto stepping. You can select this option whether or not the chart is
currently paused.

1. Clickthe Auto Step Chart button ¥ and watch the program move from block to block.
At one time or another, your chart looks like this:

this chart. STrt »

7
Start

Conveyor

This chart runs
continuously once the
program has been started.

Drop the dough.

TessRsssisss)  Drop the chips.

13
Back to
"Speed OK?"
v

< ¥
[Furning 5tc0 Ao | Break 0 |_2.005 5ec._] Shoreus 100~
[ TR TR chart £

—|ﬁ’l Dough_Chip_Contral |

Notice that in the PAC Control toolbar, the Run and Auto Step Chart buttons are depressed. The
chart status bar shows us the chart is running and in Step Auto mode. The time indicator to the
right of Break Off shows the time it took for the most recent block to execute.

2, (lickthe Auto Step Chart button again to end auto stepping.

Step Off appears, indicating the program is again running without interruption.
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Now let’s see how many cookies we've produced to this point.

On the Strategy Tree, double-click the numeric variable nCookie_Counter.

%< "nCookieCounter™ (scanning)

WValue: |42 =

The Value field should increase every time a cookie is produced, adding to the total number of
cookies produced since the strategy run began. The nCookie_Counter above shows this figure
as 42. (Yours may be different.)

But nCookie_Counter tells us the total number of cookies put on the conveyor belt, without
considering that some of them may be rejected by the inspection station. We need to subtract
the number of bad cookies so that nCookie_Counter keeps track of the number of cookies sent
out the door, not just sent to the oven.

Close the nCookie_Counter View Variable window and click the Configure mode button on the
toolbar.

Double-click the Oven_Inspection_Control chart on the Strategy Tree to open it.

The chart window looks something like this:

~
The Powerup chart starts
this chart. Start
v
2 . While conveyor speed
Speed F is out of spec, set oven
0K? OvenStandby | . 1 perature to 200
degrees.
>
7 Set oven temperature to
Oven On 450 degrees.
If inspection station sees
a bad cookie, open reject
valve for 0.5 second.
w
< >
(i) Shortcuts | 100% v
[T chart /

Near the bottom of the chart, the Reject Cookie? block determines whether a bad cookie has
been found. If one has, the strategy moves to the next block, Blow Off, which is where the bad
cookie gets blown off the conveyor. When that happens, we want to decrement the
nCookie_Counter variable.

Double-click the Blow Off block to open its instructions window:
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10.
11.

12.

13.

A Instructio ontrol - Blow Off

e Mewt Block
Previous Block

dilnspectionPassFailSwitch

Turn on reject valve to blow away bad cookie.
Turn On
doRejectValve

Leave reject valve on for 2 seconds.
Delay (Sec)
2.0

<

[ Cloze ] [ Help ] [ Command Help ]

This command block is executed only when a bad cookie has been found. This block first resets
the on-latch triggered by the bad cookie, so that the next cookie won't be marked bad, too. The
block then turns on the reject valve. The valve stays on for two seconds before being shut off.
Let's decrement the counter after the cookie is gone and the valve is shut.

Scroll down and click on the open spot, below the other instructions.
The highlighted line marks the position of the next command to be added.
Click Add.

A Add Instruction E]

v| [ Select... ]

LComment:

Type Mame

ar |AII Walid Types v | |aiD0ughVesseIF'ressure v |
Fut Result in |AII Walid Types w | |aoE0nveyorSpeedEontrol w |
[ QK. ] [ Cancel ] [ Help ] [ Command Help ]

You can use PAC Control without a mouse, and to demonstrate how, we'll use only the
keyboard to enter data in this dialog box.

Type dec in the Instruction field.

The Decrement Variable command appears, since it's the first command that starts with that
text pattern. This is the command we want to use.
Press Tab twice to move to the Comment field. Type in a comment.

Press Tab again to move to the Type field. Press the down arrow on your keyboard twice to
select Integer 32 Variable.

Press Tab again to advance to the Name field, and then press the down arrow until you see
nCookie_Counter.

Press Tab again and notice that an outline appears on the OK button.
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New
command

15.
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An outlined button means that pressing the space bar or Enter is equivalent to clicking the
button.

Now the dialog box looks like this:

X

A Add Instruction

Instruction:

|DecrementVariabIe v| [ Select... ]

LComment:

|Decreases cookie count by one to account for a rejected cookie |

Type Mame

Integer 32 Variable v | | nCookie_Counter v |

[ QK. ] [ Cancel ] [ Help ] [ Command Help

Press Enter.

The dialog box closes and the new command appears in the Instructions window.

A Instructions - Oven_Inspection_Control - Blow Off r>_<|

Add...
Turn off reject valve.

Turn Off
doRejectValve Mext Black
Previous Block

Leave reject valve on for 2 seconds.
Delay (Sec)

>

nCookie_Counter

[ Cloze ] [ Help ] [ Command Help ]

Click Close to return to the Oven_Inspection_Control chart.

Compiling and Downloading the Change

Now we'll compile and download the modified strategy.

1.

Click the Debug mode button on the toolbar.

A message box appears, warning you that changes have been detected and asking if you want
to save them before downloading.

Click Yes to continue.

Another warning notes that the strategy name, check sum, or timestamp differs from that in
the control engine and asks if you want to continue.
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3. Click Yes.

4. On the toolbar, click the Run Strategy button ' . In the Strategy Tree, double-click the
bStartFlag variable. Maximize the dialog box, change the value to 1, and click Apply. Close the
dialog box.

Click inside the Oven_Inspection_Control chart to make it the active chart, and then click the
Auto Step Chart button.

You see three blocks being processed: Speed OK?, Oven On, and Reject Cookie? The strategy
doesn’t move into the Blow Off block. That's because an inspector has to flag bad cookies, but
we don't have an inspector right now. So we'll simulate what would happen by tripping the
digital input that flags a bad cookie.

bl

6. Inthe Oven_Inspection_Control chart, click the Auto Step Chart button again to stop auto
stepping.
Step Auto changes to Step Off in the status bar.

7. (lick the Pause Chart button.
Step Off changes to Step On.
8. (lick the Breakpoint tool €% and click once on the Blow Off block.

A breakpoint hand appears on the block.

9. (lick the right mouse button or press ESC to release the tool. Notice that Break On now appears
in the chart status bar.
10. Click the Breakpoint tool and click once on the Blow Off block.

Ared box appears around the Blow Off block, and Break On now appears in the chart status
bar.

The Powerup chart starts

this chart. S
v
2 : While conveyor speed
Speed F is out of spec, set oven
0K? OvenStandby | . 1 perature to 200
degrees.
e
7 Set oven temperature to
Oven On 450 degrees.

If inspection station sees
a bad cookie, open reject
valve for 0.5 second.

Break On <

\‘ — Blow Off

v
>

£
[ funning T Step Off JBreak On] ] DShoteuts [100% v

Oven_lnspection_Control\-~LLJ\M
|ﬁ’l Dough_Ehip_EoW Oven_|nzpection_Control |

11. Click the Dough_Chip_Control tab at the bottom of the PAC Control main window.
The chart appears.
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12. Click the Pause Chart button to pause the chart.

|>

This chart runs
continuously once the
program has been started.

Drop the dough.

Drop Dough

v

7 Drop the chips.
Drop Chips

h

3
ack to
"Speed OK?"

v
£ | 2
[ unning J Step On JBreak 0t | 2003 Sec ] (@) shoteuts

\ et S

—|ﬁ| Dough_Chip_Contral |ﬁ| Oven_|nzpection_Control |

Using a Watch Window

To see clearly what we're doing, we'll create a watch window to monitor cookie production.
1. Inthe Strategy Tree, double-click nCookie_Counter.

%+ " nCookieCounter” (scanning)

Yalue: | 74 | &=

The value is frozen at some number, such as the 74 shown above. Since the counter is no
longer increasing, we can see that cookie production has temporarily stopped.

2. Maximize the dialog box.

3w« “nCookie_Counter* (scanning)

Mame: nCookie_Counter

Walue: | 7q |

(i1 More Irfo 7

3. Click Add Watch.
4. C(Click Watch.
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1 Add Watch Entry

Mame: | nCookie_Counter

Select Portions To ‘watch:

Walue Select Al

LClear

Select W atch Window

[ QK. H Cancel ][ Help ]

Since there is no watch window available to select, we'll create one.
5. C(lick New.

Create New Watch Window:

Lok in: | 125 My Cookies v| @ ? # ,
File name: | | [ Open ]
Files of bype: | PALC Contral ' atch Window Files [*.wth] w | [ Cancel ]

6. Make sure the My Cookies directory appears in the Look in field. Type a name for the watch
window in the File name field. Then click Open.

The watch window name appears in the Add Watch dialog box, and the new watch window
appears behind it.

7. Inthe Add Watch Entry dialog box, click OK. Close the nCookie_Counter view variable dialog
box.
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The new watch window looks something like this:

Watch window

Cookies

= I5) Cookies
I5) Control Engines
15 Subroutines Included
= I3 Charts
L_r.lo Alarmns
L_[.'O [ough_Chip_Contral
L_[.'O Dough_Yeszel_Pressu
L_[.'O Intermupt
L_r.lo Oven_|nzpection_Conl
L_[.'O Powerup
= £ Wariables
= I£5) Mumeric Yariables
2] bStartFlag

IZZ

2 diCookieM ationTir—
] [DoughPressureSe
] R ampyalue

B [SetpointtinusDe:

12l nChartStatus

nC aunter
121 nCockieCounter 4
| >

< >
-

#1 PAC Control Professional - [nCookie_Counter]
¢ File Edit ControlEngine Debug Chart Subroutine Mode Tools Wiew ‘Wabtch Window Help

Docking

(B |

-8 x

F

nCookie_ Counter

Type IVAL
Integer 32 Warisbhle 74

ﬂ’l Oven_lnspection_Control | &®

nCookie_Counter

IPAC Control: Ready

Debug

MM

Since we want to be able to see chart windows as well as the watch window, let's dock the

watch window at the bottom.

In the watch window, click the docking button [ in the upper-right corner.
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Docked watch
window

The watch window moves to the bottom of the main window.

i conig = oebug 03 or-Lo- [

= I5) Cookies ~
I5) Control Engines
15 Subroutines Included
= I3 Charts
EL'O Alarmns
EL'O [ough_Chip_Contral
EL'O Dough_Yesszel_Pressu
EL'O Intermupt
EL'O Oven_|nzpection_Conl
EL'O Powerup
= £ Wariables
= I£5) Mumeric Yariables
@ bStartFlag
T diCookieMationTir ¥

£ | =
e

A PAC Control Professional - [Dough_Chip_Control]
ﬁFile Edit Control Engine Debug Chart  Subroutine Mode Tools Wiew ‘Watch  Window Help - 8 x

% (e

H Speed OK?

CBX

This chart runs
continuously once the
program has been started.

&

% Chart

>

T
8 Drop the dough.
Drop Dough =
7 Drop the chips.
Drop Chips

£ | >
[ oo T o Joreakon] G
%

i v

Dough_Chip_Contral

i

Oven_|nzpection_Control |

ﬁ} Prev
nCookie_Counter
Name

nCookie_ Counter

Type
Integer 32 Warishle 74

IVAL

XVAL

PAC Control: Ready

UM

Debug

Now we'll trip the latch that signals a bad cookie.

On the Strategy Tree, under the I/0 Units folder at the bottom of the window, expand
Mixed_IO_Unit by clicking the plus sign at the left of the name.

You see a folder named Points.

10. Expand the Points folder to display the digital I/O points configured for this I/0 unit.

:« Cookies

IC5) Wariables
= £ 140 Units

= 28 Mived_I0_Unit

= 15 Paint
LU 4D oughLevelSwich
L diChipLevelSwitch
I“'%“_' dilrspectionPassFail3wi
L diEStop
B"’—_“,' doD oughPressureContro
B"’—_“,' doD oughDispensel alve
B"’—_“,' doChipDispenzetalve
B"’—_“,' doRejectyalve
OM_, aolvenT emperatureCol
OM_, aolonveyorSpeedContr
IM,_ aillvenT emperature
IM,_ aiDoughvesselPressure

= PiDs

v

Points folder

< |
-
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11. Double-click dilnspectionPassFailSwitch.

%.& "dilnspectionPassFailSwit. .. rz|
[

oL SAL:

Maximize button

12. In the minimized dialog box, click the Maximize button.

3% "dilns pectionPassFailSwitch® |... rz|

Mame:  dilnzpectionPassF ailSwitch

Tupe:  Digital Input (i1 More Irfo

IWAL: HAL:

Communication
Pairit:

140 Unit; _ =1 Open Parent
5

NOTE: Don't worry if the red error message “I/O unit not configured” or XVAL values appear in this
dialog box. This occurs because the strateqgy is configured for sample hardware that probably doesn’t
correspond to your actual I/O units and modules. PAC Control can't locate this hardware. That's okay
for this example.

When an inspection finds a bad cookie, the on-latch attached to the I/O point
dilnspectionPasskailSwitch is supposed to go on. We're going to trip it manually.

13. Click one of the arrows in the On-Latch IVAL field to change it to On. Also make sure that the
Enable comm field says No.

The dialog box should look like this:

%.& "dilnspectionPassFailSwitch™ (... rz|

Mame:  dilnzpectionPassF ailSwitch
Tupe:  Digital Input (i1 More Irfo
IWaL: HbL
On-fatch On——{rtacr_ B
Communication
140 Unit; _ =1 Open Parent
[ Apply ] [ Wwatch ] [ Flat > ] =

14. Click Apply.
The On-Latch IVAL field turns green after a second or two, indicating the latch is on.
15. Click Add Watch.

We'll add the variable to our watch window, so we can see what happens.
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16.

17.

18.

19.

20.

In the Add Watch dialog box, leave all portions checked. Click OK to add the variable to the
Cookie Watch window. Close the view point dialog box.

In the Cookie Watch window, click the plus sign next to (02) dilnspectionPassFailSwitch.
Your screen may show only part of the words.

Move your cursor over the right side of the Name column until the cursor changes shape. Then
click and drag the column to make it wider, until you can see all the words.

== Watch Window

Type
Integer 32 Warisbhle

|
| {02} ail... |Digital Input

State OFF OFF
Cn-Latch 1):] OFF
COff-Latch OFF OFF

4

Clickin the Oven_Inspection_Control chart to make it active, and move the scroll bars until you
can see the Blow Off block at the bottom.

Your window now looks something like this:

A PAC Control Professional - [Oven_Inspection_Control] |._||E|r>__<|
ﬁFile Edit Control Engine Debug Chart  Subroutine Mode Tools Wiew ‘Watch  Window Help - | &8 x

#horm
Cookies | | degrees. ~
15 Paints \\I//
=l EJHs Set oven temperature to
El Event_01 450 degrees.
%‘S‘ Mixed 0_Unit
= I Points
L1 4D oughLevelSwitch =
L diChipLevelSwitch If inspection station sees
a bad cookie, open reject
ILu] dlEStDp valve for 0.5 second.
OL‘" doD oughPressureContraly's
B"’—_“,' doD oughDispensel alve
B"’—_“,' doChipDispenzetalve 2
B"’—_“,' doRejecty alve — ¢ | > —
=4
R (I ] > 0 [ o oo 1> IO
< | T I
Ab Mext  qp Prev ﬂ’l Dough_Chip_Contral ﬂ’l Oven_lnspection_Control |
B 0 e ———. [X]
Tarme Type IVAL EWVAL L
nCoockie Counter Integer 32 Warisbhle 472

2} diInspectionPassFail... [Digital Input

Jtate
On-Latch
COff-Latch

C:\Program Files\Opko22\PAC Project 8, 1%Control Pro ExamplesiioCookies\Cookies.idb Debug (]

Click the Step Over button as many times as it takes to get the hatch marks to the Blow Off
block. Now watch the nCookie_Counter IVAL value in the watch window as you click the
button again.
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A bad cookie was found, so the counter was decreased by one. At the same time, the on-latch
was reset to Off, as you can also see in the watch window.

A PAC Control Professional - [Oven_Inspection_Control] |._||E|r>__<|
ﬁFile Edit Control Engine Debug Chart  Subroutine Mode Tools Wiew ‘Watch  Window Help - 8 x

CRMERCRGER

Oven Standby| 15 @UtoT SPEt. SeT
- temperature to 20'
S Points e degrees
= [ E/Rs il
1
o fig Event 01 7 Set oven temperature to
- Muxed_!D_Umt Oven On 450 degrees.
= 5 Paints

L1 4D oughLevelSwitch

L diChipLevelSwitch

I“'%“_' dilnzpectionP azsF ailSwitch
L diEStop

B"’—_“,' doD oughPressureContraly's
B"’—_“,' doD oughDispensel alve

B"’—_“,' doChipDispenzetalve

B"’—_“,' doRejectyalve =

< - | 3
= aolvenTemperatureContre
= e =
2 anlnrweunisneedCantnl Y l:l Break D [#39719 813 Sec RIS
| !

< Ed % Chart
dL Mext  {f Prev ﬁ: Oven_lnspection_Contral

If inspection station sees
a bad cookie, open reject
valve for 0.5 second.

<

ﬂ’l Dough_Chip_Contral

Type
Integer 32 Warisbhle

. [Pigital Input

------- on-Latch OFF ) OFF
------- Off-Latch OFF OFF 7
PAC Control: Ready Debug MM
On-latch reset to Off Counter decreased by one

21. (lick the Auto Step Chart button to go back to auto stepping.

The counter does not decrease again, because the on-latch is no longer set. But the counter
won't increase until we start the Dough_Chip_Control chart again.

22. (lick the Dough_Chip_Control chart tab. Click the Pause Chart button to unpause the chart.
Verify that Step On changes to Step Off in the chart status bar.

The watch window shows the nCookie_Counter value going up again.
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Closing the Strategy and Exiting

Before we finish this tutorial, you may want to explore the sample strategy on your own. You can
double-click items in the Strategy Tree or open up other charts to see what they do. You can also
double-click command blocks to see what they contain.

1.

What's Next?

When you're ready to stop, click the Stop Strategy button in the toolbar.

This action prevents the strategy from running continuously unattended on the control engine.
A dialog box asks if you are sure you want to stop the strategy.

Click Stop Strategy.

To close the strateqy, select File > Close Strategy; or select File > Exit to quit PAC Control. If
dialog boxes ask whether you want to remove breakpoints and take charts out of stepping
mode, click Yes.

Your introduction to PAC Control is now complete. Using the sample Cookies strategy, you have
learned how to:

Open, save, and close a strategy

Work with the Strategy Tree

Work with charts and add commands in blocks

Configure a control engine

Compile, run, step through, and add breakpoints to a strategy
Make an online change

Use a watch window to monitor variables and 1/0 points.

The rest of this book expands on the knowledge you've just acquired. Now may be a good time to
look at the table of contents or thumb through the book and familiarize yourself with its contents.
Some sections you may want to read; others you'll probably just refer to as needed.
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Introduction

The tutorial in Chapter 2 introduced you to PAC Control without explaining much about it. In this
chapter we'll learn more about PAC Control and see its main windows and toolbars.

In this Chapter

ADOUL PAC CONEION oot ssssss s s
General Control Concepts...... . .
PAC CoNtrol TEMMINOIOGY ....ovooeeeeeresceerssicesssssecsssssssessssssssssssssssssssssssssssssss s
PAC Control Main WINAOW ..........oovvveeeeeeesssssssessssssenssssssenss

Windows and Dialog Boxes in PAC Control
CUSTOMIZATION FEATUIES .oveevrreeeversnneessssnesnesssses s

ONINE HEID oot es s sessssees s sssssssesessosssesses

About PAC Control

PAC Control is a programming language based on flowcharts. Whether you have PAC Control Basic
or PAC Control Professional, you use PAC Control to develop software that monitors and controls all
kinds of equipment and sensors, from a simple heating system to a complex factory. The software
you develop controls the Opto 22 hardware that runs your heating system or factory.

The diagram below shows how PAC Control on your PC can work with the hardware in your control
system. This example shows a small system; yours may be even smaller or considerably larger and
more complex. The diagram uses a SNAP-PAC-51 as the control engine. Input/output (I/O) points on
the subordinate SNAP PAC1/0O units monitor and control the analog, digital, and serial devices
connected to them. All these terms are defined in the following pages.
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Control System Example

PAC Display

Viewing, Trending, PAC Control
Alarming Programming,
Debugging

1 SNAP PAC S-series
g controller
;I | Runs strategy,
i controls all 1/0

Fuel Pump
(Analog output)

SNAP PAC
1/0 unit

rature :
ocouple) |
g input)

(Digital ot

Tank Level
SNAP PAC (Analog input)

1/0 unit

Photo Sensor
=+ (Digital input)

Barcode Reader

- AV

N

(Serial device)
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General Control Concepts

Automation

Automation is a way of adding intelligence to an industrial process. When you automate a process,
you are less dependent on human action to carry out the process. The process generally becomes
faster, more accurate, and more reliable. For example, take a look at the tank level and pump
combination in the diagram on the previous page. Instead of having a person watch the level in the
tank and turn the pump on or off when the level gets too low or too high, you can automate the
process by installing a processor and 1/0. The processor and /0 respond in milliseconds and are on
the job 24 hours a day.

Control Engines

In an Opto 22 PAC Control system, the control engine is the programmable component in Opto 22
controllers that provides the intelligence required for automation.

Using PAC Control, you create a software program (a strategy) that tells the control engine how
every aspect of a process should work. You download the strategy to an Opto 22 control engine
which runs it as a stand-alone application. On a SNAP PAC controller, the strategy is stored in the
controller's electronic memory; the development PC can be turned off or used for other operations
while the control engine runs the program. Whenever necessary you can modify the strategy and
download it again to the control engine.

In the diagram on the previous page, one SNAP PAC S-series controller runs the program that
controls the three areas of automation.

Digital and Analog Inputs and Outputs

An industrial process can include many different hardware components: switches, pumps, tanks,
valves, furnaces, conveyors, photo sensors, thermocouples, and so on. All the components
communicate with the control engine in the controller by way of input/output (1/0) points.

Input points are wired to hardware that brings information into the control engine from the
process. Examples of devices that can be wired to input points are thermocouples, switches, and
sensors. The control engine takes the information from the input points—such as whether a switch
is on or what temperature is registered on a sensor—processes it using the software instruction set,
and returns information to the process through output points.

Output points are wired to hardware that receives information from the control engine and uses
this information to control components of the process. For example, lights, motors, and valves are all
devices that can be wired to output points. Using an output point, the control engine might turn on
a light or open a valve.

There are two types of /0 points, digital and analog:

«  Digital points can be either on or off (True or False). Push buttons and LEDs are examples of
digital devices. An LED is either on or off; it has no other possible state.

In the Control System Example on page 46, the photo sensor is an example of a digital input
device. The photo sensor is either on or off. When it turns off as the sheet passes through its
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beam, the digital I/O module tells the control engine it is off, and the control engine responds
as programmed to stamp the sheet.

The pump is an example of a digital output device. Based on information from the tank level
input, the control engine turns the pump on or off as programmed.

Analog points have a range of possible values. Temperature and pressure are examples of
analog information. Temperature might be any number in a range, -2 or 31.65 or 70.1 or many
other possible numbers.

In the Control System Example on page 46, the tank level sensor is an analog input device. It
registers the changing level of water in the tank and reports the level to the control engine,
which responds by turning the pump on or off.

The fuel pump is an example of an analog output device. Based on information about the
temperature in the furnace, the control engine adjusts the pressure of fuel through the pump
as programmed.

SNAP Serial Communication Modules

In the PAC Control system, some I/O modules do not contain standard analog or digital
input/output points, but are used for communication over a serial network.

SNAP serial communication modules provide one or two channels for sending data to or receiving
data from a serial device (RS-232 or RS-485/422) or a protocol like PROFIBUS or Controller Area
Network (CAN) that can communicate over a serial network. In the Control System Example on
page 46, the barcode reader is an example of a serial device.

Key Features

See the following topics for some of PAC Control's key features:

“Copying /0 Configurations”on page 125

Using a configuration file, you can copy an /O configuration from one strategy to another. Or,
using PAC Manager, you can send the configuration to multiple I/O units at the same time.

"Using Network Segmenting in PAC Control”on page 104

You can leverage the two independent Ethernet network interfaces on a SNAP PAC controller
to segment the control network from the company network.

“Using Ethernet Link Redundancy in PAC Control”on page 104

(Pro only) If you are using SNAP PAC controllers and PAC Control Professional, you can use
Ethernet link redundancy to set up alternate network links.

“Persistent Data” on page 238

You can configure the data in most variables to be persistent. The variable’s value is saved in the
controller's memory; it does not change when the strategy is run, stopped, or started, and it
does not change if the strategy is changed and downloaded again.

“Pointer Commands”on page 330

For advanced programming, you can create pointers that store the memory address of a
variable or some other PAC Control item, such as a chart, an I/0 point, or a PID loop. You can
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perform any operation on the pointer that you could perform on the object the pointer points
to.

«  "Setting Initial Values in Variables and Tables During Strategy Download”on page 244

When you are adding table variables in PAC Control, you can set all table elements to one initial
value. Or you can set each individual table element to its own value by creating an initialization
file to download with your PAC Control strategy.

«  "Using Subroutines”on page 381"12: Using Subroutines”on page 373

You can use subroutines that are independent from strategies, but that can be called from any
chart or other subroutine in your strategy. Subroutines offer two ways to work with variables
and other logical elements: they can be passed in or they can be local to the subroutine.

«  "Configuring PID Loops”on page 146

A proportional integral derivative (PID) control loop (often referred to as a PID loop) monitors a
process variable, compares the variable’s current value to a desired value (a setpoint), and
calculates an output to correct error between the setpoint and the variable. Because the
calculation is complex, it is done by a mathematical formula, or algorithm, that you can then
adjust (tune) for each PID loop.

PAC Control Terminology

action block

Action blocks are rectangular blocks in a flowchart that contain one or more instructions (actions)
that do the work of the strategy, such as turning things on or off, setting variables, and so on. Several
instructions can be placed in one action block. Action blocks can have many entrances, but only one
exit.

analog point

Analog points have a range of possible values. Temperature and pressure are examples of analog
information. Temperature might be any number in a range, -2 or 31.65 or 70.1 or many other
possible numbers. Analog points can be either inputs (such as a tank level sensor) or outputs (such
as a fuel pump).
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blocks

A chartis made up of action blocks,
condition blocks, continue blocks, and
OptoScript blocks connected by arrows,
which show how the process flows. A
chart used with redundant controllers
also has sync blocks.

sync block

The sync block tool is visible only when
controller redundancy support is
enabled. A sync block is used to
synchronize redundant controllers at
strategic locations in a transactional

chart (a chart that contains sync blocks).

For more information, see form 1831,
the SNAP PAC Redundancy Option User’s
Guide.

condition block

Action block

Condition block

Process A

OptoScript block

4
Checkpoint

Sync block

Continue blocl

L . o
N v
< >

(iiShortcuts | 100% v
[ A1 TPI Chart /

Condition blocks are diamond-shaped blocks in a flowchart that contain questions (conditions) that
control the logical flow of a strategy. Condition blocks can have many entrances, but only two exits:
True and False. The block can contain more than one condition, and you can use AND or OR to

indicate whether all conditions must be true to exit True, or whether any one condition must be true

to exit True.

continue block

Continue blocks are oval-shaped blocks in a flowchart that route the flow of execution to an action,
condition, or OptoScript block. They do not contain any instructions, but store only the name of the
next block to execute. Continue blocks can have many entrances, but no exits, since the exit is

defined within the block. Continue blocks avoid awkward connections between two blocks that are

far apart.

digital point

Digital points can be either on or off (true or false). Push buttons and LEDs are examples of digital
devices: an LED is either on or off; it has no other possible state. Digital points can be either inputs
(such as a photo sensor) or outputs (such as a pump).

external value

The external value (XVAL) is the real-world value measured or set by an I/0 point. The PAC Control
strategy reads and writes only to internal values, and transfers internal values to external values if
communication to the associated I/0 unit is enabled.

flowcharts

Since most control applications are complex, the strategy typically consists of a series of process
flowcharts, or charts, that all work together. Each chart controls one aspect of the strategy—one
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piece of the automated process. Together, all the charts constitute the strategy. The total number of
charts in a strategy is limited only by the amount of memory available in the control engine.

A chart can be running, suspended, or stopped. A running chart is actively performing its assigned
task. A suspended chart is temporarily paused. A stopped chart is inactive. Every chart in a PAC
Control strategy can change the status of any other chart in the strategy, yet every chart is
independent of every other chart. Any combination of charts can be running simultaneously, up to
the maximum limit allowed on the control engine. (See also, multitasking.)

Every strategy automatically contains a Powerup chart. The Powerup chart is automatically started
when the strategy begins running, so it starts other charts. All other charts you create, based on the
needs of your process.

input point

Input points are wired to hardware that brings information into the brain from the process.
Examples of devices that can be wired to input points are thermocouples, switches, and sensors. The
control engine in the brain takes the information from the input points—such as whether a switch
is on or what temperature is registered—processes it using commands in the strategy, and returns
information to the process through output points.

instructions (commands)

PAC Control commands, or instructions, tell the control engine what to do at each step in the
flowchart to control the process. Each block in a chart contains one or more instructions, such as
Convert Number to String or Start Counter or Chart Running?

Commands are in two forms: Actions and Conditions.

«  Action commands do something in the process; for example, Convert Number to String and
Start Counterare both action commands. On the flowchart they appear as instructions in action
blocks, which are rectangular in shape. They may also appear in hexagonal OptoScript blocks.

«  Condition commands check a condition and are in the form of a question. Chart Running?
and Variable False? are examples of condition commands. They appear as instructions in
condition blocks, which are diamond-shaped, or in hexagonal OptoScript blocks. Condition
commands are questions that always have two possible answers, either yes or no (true or false).
The answer determines the flow of logic and what happens next in the chart.
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The instruction shown below is for the condition block, Button D3 On? This block contains only one
instruction. As you look at the chart, you can see that the answer to the question in the instruction
determines whether the process flows to Turn LED D7 On or to Turn LED D7 Off

“Button ™._]
D3 0n? o~ =

Instruction for the block
named Button D3 On?

Mext Block b
4y 0
Previous Block.

Operator
(&) AND
CI0R

Cloze ] [ Help ] [ Command Help

internal value

The internal value (IVAL) is the value read or written by the PAC Control strategy. Internal values are
transferred to external values only when communication to the I/0 unit is enabled.

multitasking

The control engine can run several charts seemingly at once, each performing a different task
through a time-slicing technique called multitasking (also called multicharting). Opto 22 SNAP PAC
R-series controllers can run up to 16 charts plus one host task simultaneously; SNAP-PAC S-series
controllers can run up to 32 charts plus one host task simultaneously; a SoftPAC controller can run up
to 64 charts plus one host task simultaneously. The host task is an invisible chart used to
communicate to a PC, which may be running PAC Control in Debug mode or PAC Display.

Each chartin a running or suspended state counts toward the total that can run simultaneously.
Charts that are stopped do not. When the Powerup chart is running, it also counts.

The actual order and timing for running tasks is not deterministic—that is, it is not always the same,
but depends on priorities at any given time. For example, communication may sometimes take a
higher priority than a running chart.

OptoScript block

OptoScript blocks are hexagonal blocks in a flowchart that contain OptoScript code. OptoScript is a
procedural language that can simplify tasks such as math computations, string handling, and
complex loops and conditions. OptoScript blocks can have more than one entrance but only one exit.
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output point

Output points are wired to hardware that receives information from the brain and uses this
information to control components of the process. For example, lights, motors, and valves are all
devices that can be wired to output points. Using an output point, the control engine in the brain
might turn on a light or open a valve.

pointer

A pointer does not store the value of a variable; instead, it stores the memory address of a variable or
some other PAC Control item, such as a chart, an I/0 point, or a PID loop. You can perform any
operation on the pointer that you could perform on the object the pointer points to. Pointers are an
advanced programming feature and are very powerful, but they also complicate programming and
debugging.

Because pointers can point to any data type, pointer tables can store an assortment of data types in
a single table.

Pointers allow one level of indirection within PAC Control; a pointer cannot point to another pointer.
After you add a pointer through the “Add Variable Dialog Box”on page 240, you can use it wherever
the object itself would be used.

strategy

The software program you create using PAC Control Basic or PAC Control Professional. The strategy
includes all the definitions and instructions (commands) necessary to control the process that one
Opto 22 controller handles. Since most control processes are complex, the strategy typically consists
of a series of process flowcharts that all work together, with each chart controlling one piece of the
automated process. You may have several PAC Control systems, each controlling a different process
and therefore running different strategies. Or you may have two or more PAC Control systems
controlling identical processes in different areas and running the same strategy.

variables

A variable is a holding place that represents a piece of information in a strategy, such as the
parameters for communication, temperature reported by a thermocouple, the name of a chart, or a
group of words and numbers to be sent to a display. The information a variable represents is called
the value of the variable. As a strategy runs, the variable’s name remains the same, but its value may
change. For example, the value of a variable named Oven_Temperature may change several times
while its strategy is running, but its name remains Oven_Temperature.

A variable stores one of six types of data: floating point, integer, timer, string, point, or
communication handle. When you create the variable, you designate the type of data it contains.

«  Afloating point (or float) is a numeric value that contains a decimal point, such as 3.14159,
1.0, 0r 1234.2. A good example of a float variable is one that stores readings from an analog
input, such as a thermocouple.

« Aninteger is a whole number with no fractional part. Examples of integer values are -1, 0, 1,
999, or -456. The state of a switch, for example, could be stored in an integer variable as 1 (on)
or 0 (off).

«  Atimer stores elapsed time in units of seconds with resolution in milliseconds. Up timers
count up from zero, and down timers start from a value you set and count down to zero. For
example, you could set a down timer to make sure a value is updated at precise intervals.
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»  Astring stores text and any combination of ASCII characters, including control codes and
extended characters. For instance, a string variable might be used to send information to a
display for an operator to see.

A string variable can contain numeric characters, but they no longer act as numbers. To use
them in calculations, you must convert them into floating point or integer numbers. And a
numeric value to be displayed on a screen must be converted into a string first.

«  Apointer does not store the value of a variable; instead, it stores the memory address of a
variable or some other PAC Control item, such as a chart or an 1/0 point.

«  Communication handles store parameters needed for communication with other devices.

You can use variables that are individual pieces of information, and you can also use table variables,
which are groups of related information in the form of a table.

PAC Control Main Window

With a strategy open, the main window in PAC Control Basic and PAC Control Pro look similar to this:

PAC Control title bar 441 PAC Control Basic - Cookies = 5 %
Menu bal’—-Flle Edit Configure Chart Subroutine Compile Mode Tools Wiew Window Help
Toolbar —— KL [N S H|% /@ X | #4% khGmeee @

Strategy Tree —— H ol i
() Subroutines Included
() Charts
= [ Variables
(Z5) Mumeric Variables
() String Variables
() Pointer Variables
(C3) Communication Handles
[C5) Numeric Tables
() String Tables
[L5) Pointer Tables
(=) 1/O units

] v Gom

|54 Cookies | | Mode

Status bar——eac controk Ready Configure NUM

Since PAC Control uses standard Microsoft Windows conventions, you'll recognize the title bar and
menu bar and already be familiar with some of the menus, such as File, Edit, View, Window, and
Help. This section discusses some things that may not be familiar.

Status Bar

The status bar at the bottom of the window shows you information about PAC Control. When you
move your mouse over the toolbar, a description of the button you're pointing to appears in the
status bar. The status bar indicates the mode PAC Control is in and indicates messages or errors
helpful in debugging.

To hide or show the status bar, choose View > Status Bar. A check mark next to the menu item
means the status bar will show; no check mark means it is hidden.
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Mode

You can run PAC Control in three modes: Configure, Debug, or Online. The current mode is shown in
the status bar, on the right. Toolbars and menus change depending on the mode.

Configure mode is used to create, modify, save, and compile strategies, flowcharts, and
subroutines; and to configure control engines, 1/0, and variables.

Debug mode is used to download, run, and debug strategies and to view control engine and
communication status and errors while the strategy is running.

Online mode is a scaled-down version of Configure mode, used to change a strategy while it
is running. You cannot add variables and I/0 in Online mode, but you can change ones that
already exist.

NOTE: When you change a chart in Online mode, a new copy of that chart is downloaded to the
control engine, but the old one is not deleted. After you have made a few online changes, the
additional chart copies begin to take up memory. To avoid memory problems, be sure you stop the
strategy after making several online changes and completely compile and download it to clear out
old chart copies.

To change modes, choose the mode you want from the Mode menu, or click its button in the
toolbar.

Toolbars

Toolbars give you shortcuts for doing many things that also appear on menus. Toolbars in PAC
Control include standard Windows buttons like New and Save as well as special buttons for PAC
Control functions. The tools that you can use depend on which mode you're in. Tools not currently
available are grayed out.

The following toolbars are standard in PAC Control.

“Mode Selection Toolbar”

“Configure Mode and Online Mode Toolbar”
“Debug Mode Toolbar”

Mode Selection Toolbar

The mode selection tools are always available.

£} pebug [1§ Online

Tool Description

Configuration Mode

Debug Mode

Online Mode
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Configure Mode and Online Mode Toolbar

The following toolbar appears in configure mode and online mode.
O EH # B X &« oo o @O Y A & compleview E5 Comple al

In a smaller window, the toolbar looks like this.

NEH ¥R X A% Do der s E| &8

Tool Name Tool Name
] New Strategy 4m Pan Tool
= Open Strategy = Action Block Tool
[ Save Strategy [ OptoScript Block Tool
& Cut < Condition Block Tool
By Copy ] Continue Block Tool
Fe Paste ) Checkpoint Block Tool
x Delete ty Connect Tool
83 Find A Text Tool
B Find and Replace 2 Compile Active View
L Select Tool Compile All

Debug Mode Toolbar

The following toolbar appears in debug mode.
P Run Strategy [l Stop Strategy ] Pause Chart  Pl1Inke [ ower [T out ':of fwutostep <l Breakpoint

In a smaller window, the debug toolbar looks like this.

R Il BIFIT & O
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B Run Strategy i Over

| Stop Strategy * Out

11 Pause Chart % Auto Step

™M |Into ) Breakpoint
Strategy Tree

The Strategy Tree opens when you open a strategy, and closing it is equivalent to closing the
strategy. The Strategy Tree shows you all the elements of your strategy: control engines, flowcharts,
subroutines, variables, 1/0 units and points, and PIDs.

2 [Ch Cookies
=6
& Ri
|3 Subroutines Incuded
Strategy tree ~ © Charts
1 = I3 Variables
\ [C5) Numeric Variables
|5 String Variables
[C3) Pointer Variables
[ Communication Handles
[C3) Numeric Tables
[C3) String Tables
|5 Pointer Tables
= 3 1o Units
= 28 Mixed_10_Unit
[C3) Paints
[ PDs

] onet o

The Strategy Tree works just like Windows Explorer: you can expand or collapse folders to view or
hide what is in them. You can easily see what is in your strategy, open elements to change them by
double-clicking them, or open a pop-up menu by right-clicking on an element.

Each element in the strategy is represented by a button, shown just to the left of its name. The table
below shows the buttons and what they represent.

#‘-‘ Control Engine I Integer 32 Table

=
E::\’ Chart

-
h

i

Integer 64 Table

._.
L]
x
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Button Description Button Description
- Subroutine ===z String Table
=TF
|E| Integer 32 Variable EEH Pointer Table
I=Z PTF.
[T5]  Integer 64 Variable Ll pigital 110 Unit
Ie4 ul
24 Float Variable Ll Mixed 1/O Unit
FLT R/
@)d  Down Timer Variable A Analog Input Point
THR I+
ot Up Timer Variable o Digital Input Point
THE I+
[RE] String Variable = Analog Output Point
ZTR 9 o+ 9 =up
E=T Communication Handle 1¥al) Digital Output Point
cH o—k
Float Table E4 PID Loop
FLT FIL
|E| Pointer Variable
FTF.

Windows and Dialog Boxes in PAC Control

Windows and dialog boxes in PAC Control follow Microsoft Windows standards. You can minimize,
maximize, move, resize, and tile them as needed. See your Microsoft Windows documentation for
information on how to perform these functions.

The following topics describe other useful features in PAC Control:
“Using Tabs to View Open Windows"on page 59

“Docking Windows" on page 61

“Zooming in a Chart or Subroutine Window" on page 61
“Redrawing a Chart or Subroutine Window” on page 63
"Changing Column Width in a Dialog Box"on page 64

“Sorting Data in a Dialog Box"on page 65
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Using Tabs to View Open Windows

When multiple windows are open—especially if they are maximized—it can be difficult to know
where you are, and windows can become lost behind each other. However, you can click the tabs at
the bottom of the main PAC Control window to move among chart windows, subroutine windows,
watch windows, and blocks you may be stepping through for debugging.

- O X

- & *®

ﬁ PAC Control Basic - Cockies * - [Dough_Chip_Control]
%File Edit Configure Chart Subroutine Compile Mode Tools View Window Help

Iuﬁﬂl | aglilnmo o e E|

C < M belt must be running between 50% and 65% of max pm. ~
N L]

= [ Cookies Powerup chart starts S
[E5) Control Engines chart.
IC5) Subroutines Induded
£ charts =
= I£5) Variables Start

Conveyor

[C5) Mumeric Variables
|5 String Variables

[C5) Painter Variables w
[C5) Communication Handles chart runs
[E5) Mumeric Tables |inuously once the Speed OK?
[ String Tables ram has been started.
[C5) Pointer Tables T
© 1/0 Unis £ Drop the dough.
Drop Dough
& Drop the chips.
Drop Chips &
< >
(i)shortouts | 91% -
< 5

MNUM

] &nee o

Ch\Users\Public\Documents\Opto ZZ\PAC. I;r.oj,eé.ft\l.’_ontrol Basic Examples\}C "okies\C tkies.idb  Configure
White tabs show where you a( Gray tabs show open windows. Click a
when stepping through a chart tab to bring its window into view.

or subroutine.
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The upper layer of tabs appears when you are stepping through your strategy in Debug mode. It
acts as a kind of call stack to let you see how you got to the current block or command.

#1 PAC Control Professional - [Counter]

ﬂ’l File Edit ControlEngine Debug Chart Subroutine Mode Tools  Wiew ‘Wabch  Window  Help -8 x
£} pebug 88 H I ir % |i|
OEin er Con 0 & A
=1 |5 Sprinkler_Contral
=1 [C3 Contral Engines
& Sprinkler Controller
1= Subroutines Included
+ ) Charts
= | variables N
+ T3 Mumeric Yariables Variahle F
[ String Yariables Increased?
IC5) Painter Yariables : —
I3 Communication Handles T
i -2 -
IC5) Mumeric Tables Confirmation
[C5) String Tables ) Beep
IC5) Painter Tables .
T Y ST * y
S Mixed_10_Liit - Fupdate Holding
# (D Paints Variahle
=) PIDs
< | >
E Break Off || 20.086 Sec. (1) Shortcuts
[T AW} Chart } Action Block - Teremert Courter” - I #7 Subroutine "Yariable_Increase_Motification”
dbmext 47 Py —|ﬁ| Counter ﬂ’l Messages ﬂ’l Mp |-=£ Yariable_|ncrea... |6"\:r‘ Count Wwatch
PAC Control: Ready Debug MM

Click the arrow @tons to
see tabs thatare notvisible
or are only partly visible.

This white tab shows you are stepping inside the
Variable_Increase_ Notification subroutine, which was called by
the Increment Counter action block on the gray tab at left. The
gray Chart tab farther left shows the chart this action block is in.
Click any tab to see how you got to where you are.
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Docking Windows

You can place the strategy Tree and watch windows where you want them (dock them) in the PAC
Control main window. Docked windows do not have tabs but are contained in their own frames.
PAC Control remembers their position the next time you open that strategy.

«  Todocka window, click the docking button [ in the window's title bar.

The window moves to its own frame. (Compare the following figure with the one on page 54
to see the difference in the Strategy Tree window.)

1PAC Control Professional
File Edit Configure Chart Subroutine Compile Mode Tools View Window Help

Dicoi e R

Sprinkler_Control < [x|

Docked strategy Tree

= | Sprinkler_Control
# ) Control Engines
|5 Subroutines Included
| I5) Charts
| |5 variables
# I Mumeric Yariable
|5 String Yariables
IC5) Painter Yariables
15 Communication F
I Mumeric Tables
|5 String Tables
|5 Painter Tables
# I IO Units

[+

|

@ Mext ﬁ} Prev

PAC Control: Ready Configure | MM

«  Tochange the docked position, click and drag the window's title bar to any edge of the main
window.

»  Tochange the docked window's width or height, click and drag the edge of its frame in the
direction you want.

«  Tofree the window from its docked position, click the docking button [ in its title bar.

Zooming in a Chart or Subroutine Window

You can change the scale of any chart or subroutine window by using the zoom feature. There are
several ways to zoom:

«  Hold down the Ctrl key and move the mouse wheel up and down.

+  Press the + or - keys on the keyboard.

»  Right-click anywhere on a chart or subroutine window to display a pop-up menu. Select Zoom
and choose In, Out, or Reset (to return the zoom to 100 percent).

«  From the View menu, choose Zoom In, Zoom Out, or Zoom Reset.
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«  To pick the zoom percentage you want, click the zoom field at the bottom right of the window
and choose one of the preset zoom levels. The “Zoom to fit" option resizes the chart to fit in the
window.

NOTE: Zooming always takes place with reference to the center point of the window.

Here is a window at 50 percent zoom:

= Oven_Inspection_Control |Z| |E| rz|
-

Thic ohartmaintain g his oven #mperaiirs and rejeots
wookle & hatdo notpaces vimal Ingeodon.

The Fowerup ohart shrts
#ilcohart

v

< 4

(i) Shortcuts | B0 w

[T T2 Chart /

The same window at 200 percent zoom looks like this:

= Oven_Inspection_Control |Z| |E|P5__<

]
[ -

s ; ¢ - F P
pee
OK? Oven Standby
T .
7 Set oven temf.
Oven On 350 degrees.
< l 3 5
(1) Shortcuts ’m
[T [T chart /

PAC Control User's Guide



CHAPTER 3: WHAT IS PAC CONTROL?

Panning a Chart

The pan tool allows you to easily pan around a flowchart.
1. Using the pan tool % , click and hold to grab a portion of a chart.

You can access the pan tool either from the toolbar or by holding down the space bar and
clicking the left mouse button.

T EF WHITE CONVEyor speed v
Speed is out of spec, set oven
Oven Stan| !
OK? SR temperature to 200
Pan tool — TI degrees.

7 Set oven temperature to
Oven On 450 degrees.

If inspection station sees
a bad cookie, open reject
valve for 0.5 second.

2. Move the pan tool to a new position and release.
The chart moves to a new position.

This chart maintains the oven temperature and re
cookies that do not pass visual inspection.

The Powerup chart starts

this chart. Start

Redrawing a Chart or Subroutine Window
If you want to move quickly to a particular block, you can redraw a chart or subroutine window with
any block at its center.

1. With a chart or subroutine open in the active window, select View > Center On Block, or
right-click in the chart or subroutine window and choose Center On Block from the pop-up
menu.
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The Center On Block dialog box appears, listing all blocks in the chart.

M Center On Block

Block 1d: Mame Type
Back o ".. Continue
7 Dirop Chips Action
5 Drop Dough Action
2 Speed DK7Y Condition
i} Skhart Action
17 Start Canv...  OptaScript
[ u] 4 l [ Cahcel ] ’ Help ]

2. Double-click the block you want, or click it once and click OK.

The chart or subroutine is redrawn with the selected block in the center of the window.

Changing Column Width in a Dialog Box

Many dialog boxes include several columns of information. To see all the data in some columns, you
may need to make columns wider.

«  Towiden or narrow a column, click the right edge of the column label and drag it horizontally.

A Configure 170 Units X

Enabled

plati, RefC.. | Descii..
Disabled  Enabled

Mame Type Port Address
| |... SMAP-.. Ethemn.. 127.0..

|~ Click and drag

1/0 Paints...
FID Loops...

Event/Reactions...

[ Cloze ] [ Help ]

«  Toresize a column to the exact width of its longest entry, double-click the line that separates
the column from the one on its right.
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Sorting Data in a Dialog Box

In some dialog boxes with columns of data, you can sort the information in the way you want to see

it. The Center On Block dialog box provides an example. The blocks in this dialog box normally
appear in alphabetical order by the block name.

# Center On Block rg|
Block 1d: Mame Type
Back to ... Caontinue
7 Drop Chips Action
5 Drop Dough  Action
2 Speed OK?  Condition
1] Start Action
17 Start Conv...  OptoScript
[ QK ] [ Cancel ] [ Help ]

«  Tosort by block number instead, click the Block Id column label.

# Center On Block rg|
Blo... M ame Type
2 Speed OK?  Condition
5 Drop Dough  Action
7 Drop Chips Action
17 Start Conv...  OptoScript
13 Backto ... Continue
[ QK ] [ Cancel ] [ Help ]

To sort in the opposite order (descending numbers instead of ascending numbers), click the
Block Id column label again.

Some dialog boxes don't allow custom sorting. If you click a column label in these dialog boxes,
nothing happens.

Customization Features

This section describes PAC Control special features for displaying numeric data, launching other

applications from PAC Control, and modifying strategies using PAC Control's Command-Line
Interface tool.

See also “Legacy Options”on page 211 and “Advanced Options”on page 214.
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Setting Decimal, Binary, or Hex Display Mode

You can set up PAC Control to show the values of all integers and integer tables in decimal (the
default), binary, or hexadecimal (hex) format. Binary and hex formats help you use masks. Hex view
is available in all modes: Configure, Debug, and Online.

The default view is in decimal notation, as shown in the following figure.

%+ " nCookie_Counter” (scanning)

Mame: hCookie_Counter
Value: [314 H Decimal view

Apply (i1 More Irfo =

To view integers and integer tables in binary view, choose View > Binary Integer Display, or click the
DEC button and choose Binary. The integers appear as shown below.

2'£ "nCookie_Counter” (scanning)

Mame: nCookie_Counter

Binary view. All the bits

Walue: |DDDDDDDD 00000000 00001110 00001000
cannot be shown at once.

Apply (i1 More Irfo =

To view integers and integer tables in hex view, click BIN in the dialog box, and then select
Hexadecimal. Here's how the integers appear in hex:

2.* "nCookie_Counter” (scanning)

Mame: nCookie_Counter

Hex view. The 0x before the number
indicates that the number is in hex.

Yalue [0x00000EZ0

Apply (i1 More Irfo =

To return to decimal view, click HEX and then select Decimal.

Setting Hex String View

You can also set strings to appear in hex notation. Here is the View Variable window showing a
string in regular notation:

Zeusi ring_Variable™ (scanning)

Mame: Sting_ariable
wfidth: 10 max width 0 current width

Walue: |ITtem price =

Bytes: 0o: 73 116 101 109 Item
4: 32 112 114 105 price =
: 99 101 32 61
1z: 3z
Apply (i1 More Irfo =l

To change to hex notation, click the ASCII button on the dialog box.
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Here's how the string appears in hex:

%% String_Variable™ (scanning)

Mame: Sting_ariable
wfidth: 10 max width 0 current width

Walue: |49 74 65 6D 20 70 72 69 63 65 20 3D

Bytes: 0: 73 11s 101 109 Item
4: 32 112 114 105 price =
§: 599 101 3z 61
iz: 32

OMoeio 7

Setting Up Applications to Launch from PAC Control

You may find it useful to launch other software applications directly from PAC Control. For example,
you may want to launch PAC Display, Notepad, or the Calculator from PAC Control. You can set up
PAC Control so that these applications appear in the Tools menu.

NOTE: If you launch an application from within PAC Control when that application is already running, a
second instance of the application may open. It depends on the application, some check to see whether
the application is already running, and some do not.

1. With PAC Control open, choose Tools > Customize.

The Customize dialog box appears.

Menu Cantents o ]

Add

2. (lick Add. In the Menu Text field, type the name of the application as you want it to appear in
the Tools menu.

3. Inthe Command field, type the path for the application’s executable file, or click the Browse
button [...) and navigate to the file.

4. (Optional) In the Arguments field, type any necessary command line parameters.

5. (Optional) In the Initial Directory field, type the directory the application should default to when
it runs. For example, this is the directory the application would show when you open or save files.

6. Repeat the steps to add other applications. To change an application’s position in the menu list,
highlight it and click the Move Up or Move Down keys.

7. When you have finished adding applications, click OK.The PAC Control main window is
displayed, and the applications you've added now appear in the Tools menu.
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Using PAC Control’s Command-Line Interface Tool

PAC Control's Command-Line Interface (CLI) tool was built for customers who want a fast and easy
way to modify existing strategies without using the PAC Control graphical user interface.

CLIis a command-line program that runs in Microsoft's Command Prompt window. It can:

+  Move a configured I/O module or I/O point to an empty position on the same or different I/0 unit
+ Add new variables

«  Create a control engine download (.cdf) file

You can perform operations one at a time, or you can run multiple commands in a batch.

Responses to commands (and error codes) are logged to a file. For details, see “Checking CLI
Command Qutput.”

CLI Commands and Syntax

CLI commands are not case-sensitive. You can run them from either a normal or an Admin
(“elevated privilege”) Command Prompt window.

The syntax for a CLI command is:
<CL1 executable program> <strategy filename> /<operation> <arguments>

where:

+  <CLI executable program> isyour PAC Control filename and extension:
- For PAC Control Basic, the programis ~ control .basic.exe
—  For PAC Control Professional, it is control .pro.exe

+ <strategy filename> isthe strategy to modify; for example: cookies.idb
Note that you can perform operations on only one strategy at a time.

/<operation> <arguments> isthe operation to perform and its required arguments (described
on page 69). Multiple arguments are separated by semicolons.

IMPORTANT: Paths, filenames, and arguments that contain a space must be enclosed in straight quotes (" ").

Depending on the folder you run CLI from, you may need to enter the path and filename for the CLI
executable program, the strategy, or both.

For example, if PAC Control Basic is installed on your C:\ drive, the path and filename for the CLI
executable program is:

"C:\Program Files (x86)\0pto22\PAC Project 9.6\control _basic.exe"
Because the path contains spaces, the path and filename have been enclosed in straight quotes.

B Command Prompt — [m] =

\Public\Documents

Example of a CLI command and response.
Paths, filenames, and arguments that include spaces must be enclosed in straight quotes.
Note that the response is a new prompt.
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When typing CLI commands:
«  Type aspace after:
— The ClLl executable program name.
- The strategy filename.
- The operator.
«  Type asemicolon (;) between arguments. Don't put spaces before or after the semicolons.

+  Ifyour path, filename, or arguments include spaces, you must enclose them with straight
quotes (" ).

The following table describes the CLI operations and arguments. Required characters are shown in
bold, red color to make them easier to see.

...use this

To do this: . ...with these arguments:
operation:
Move a configured 1/O /mm <source /O unit>;<source module position>;<target I/0 unit>;
module to an empty position <target module position>
where:

¢ <source I/O unit> is the name of the I/O unit that contains the
module? you want to move.

»  <source module position> is the current position number? of
the module to move.

e <target I/O unit> is the name of the I/O unit you want to move
the module to.

»  <target module position> is the position number® where you
want to move the module. Note that the position must be
empty (that is, not configured with another module).

Example: C:\>control .pro.exe cookies.idb /mm Mixed_10_Unit;8;Sprinkler_Control;4

Move a configured 1/O point /mp <source I/0 unit>;<source point name>;<target I/O unit>;
to an empty position <target module position>;<target point position>
where:

e <source I/O unit> is the name of the I/O unit that contains the
point you want to move.

e <source point name> is the name of the point to move.

e <target I/O unit> is the name of the I/O unit you want to move
the point to.

e <target module position> is the position number? of the
module where you want to move the point.

»  <target point position> is the point number on the module®
where you want to move the point. Note that the position
must be empty (that is, not configured with another point).

Example: C:\>control .pro.exe cookies.idb /mp Mixed_l10_Unit;doRejectValve;Valve_Unit;2;0
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NOTE: This operation does
not support pointer variables
or pointer table variables.

PAC Control User's Guide

To do this: use t.h's ...with these arguments: (Continued)
operation:
Add a variable /av <variable type>;<variable name>;<description>;<initialization

type>;<initial value>[;<string width>][;<table length>]

where:

<variable type> indicates the type of variable.
Enter one of the following values.

Type this: ...if the variable is a:
INT32_VAR 32-bit integer variable
INT64_VAR 64-bit integer variable
FLOAT_VAR Float variable
STR_VAR String variable

DNTMR_VAR Downtimer variable

UPTMR_VAR Uptimer variable

CMHDL_VAR Communication handle variable

INT32_TBL 32-bit table variable
INT64_TBL 64-bit table variable
FLOAT_TBL Float table variable

STR_TBL String table variable

<variable name> is the name of the variable. The name must
follow PAC Control conventions (for example, it cannot start with
or contain spaces, it cannot start with a number, and so forth).
Maximum length is 50 characters.

<description> is a brief description of the variable (in straight
quotes, if it contains spaces). To leave the description field
blank, enter a space in straight quotes (like this: " ).
Maximum length for the description is 127 characters.

<initialization type> indicates how to initialize the variable.
Enter one of the following values.

Type this: ..to:

ON_DOWNLOAD | Initialize the variable on strategy download.

ON_RUN Initialize the variable when the strategy runs.

PERSISTENT (Not applicable to timer variables.) This
argument makes the variable persistent.
For more information about

persistent variables, see “Persistent Data”
on page 238.

<initial value> is the variable’s initial value.

NOTE: Not applicable to timer variables. For timers, enter a
space for this argument.
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To do this: use t.h's ...with these arguments: (Continued)
operation:

e [;<string width>][;<table length>] Applicable only to strings
and table variables.

— Strings: The string width. Example: 15
The maximum width you can give a string is 1024
characters.

— String tables: The string width and table length.
Example: 15;99 Note the semicolon between the
numbers.

The maximum width you can give a string is 1024
characters. The maximum table length is 1,000,000
elements.

— Integer and float tables: The table length. Example: 99

Example: C:\>control .pro.exe cookies.idb /av INT32_VAR;nFlavor;"Cookie Flavor';ON_RUN;O

Perform a series of /f * <filename of a text file that contains CLI commands>
commands This feature lets you issue one command to perform all the
commands in a text file.

Each command must follow CLI command syntax:

<CLI executable program> <strategy filename> /<operation> <arguments>
Each command must be on a separate line. (Don’t use word
wrapping in the file.)

Each command is processed in order.

Responses (and, if applicable, errors) are logged to a file. For
details, see “Checking CLI Command Output.”

Example: C:\>control .pro.exe cookies.idb /f "C:\Documents\my batch commands.txt"

Compile a strategy into a /cdf This operation has no arguments.
.cdf file The output is saved in the folder where PAC Control is installed.

Example: C:\>control .pro.exe cookies.idb /cdf

@Remember that module numbers and point numbers are zero-based; the first position is number 0 (not 1).
The syntax to load a strategy in PAC Control's graphical user interface is:
<CLI executable program> <strategy filename>
Example: C:\>control.pro.exe cookies.idb

Checking CLI Command Output

For each CLI command you enter, the system logs a record in a Control.Output.csv file. (If the file
already exists, new messages are appended to the file.) You can view the Control.Output.csv file to
see whether or not a CLI command was successful. The file's .csv format lets you open the file in text
editors (like Notepad), as well as in spreadsheet programs (like Excel).

«  When a command is successful, CLI logs “Succeeded,” and the name of the operation you
performed.

+  When a command fails, the message shows “Failed,” followed by an error code (described on
page 72), the name of the operation, and the arguments entered with the operation.

Control.Output.csv files are located in the same folder as the strategy used in the CLI command.
For example, if the strategy in your command is located in the C:\MyStrategies folder, the
Control.Output.csv is saved in C:\MyStrategies.
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Example of a Control.Output.csv file opened in Microsoft Excel®.
In this example, Excel has parsed the data into columns.

[&] Control.Output.csv - Microsoft Excel - [m} X

Home Insert Page Layout Formulas Data Review  View Developer  Acrobat  Team @9 @ = e

A-d QL EOBEEY -
A5 - Jx | Succeeded
[ A B c

1 |Failed (Error4) Create Controller Download File No controller in strategy

2

3 |Failed (Error4) Create Controller Download File No controller in strategy
____§__1Succeeded _I Create Controller Download File

6

7 |Failed (Error 11) Add Variable INT32_VAR

8

9 |Failed (Error 12) Add Variable INT32_VAR;

10

11 |Succeeded Add Variable INT32_VAR;nRogersint32;"Test Variable";ON_RUN;0

Error Codes

This table explains the error codes you might see in the Control.Ouput.csv log file.

Operation Error code Meaning
all 1 No operation was entered. Please enter an operation.
/f (Command file) 2 The text file containing CLI commands could not be opened.
all 3 CLI could not open the strategy.
all 4 The strategy does not have a configured controller
5 CLI could not create the .cdf file.
6 CLI could not re-open the .cdf file.
{gcgéciitl)gpile to 7 CLI could not create the .crn file.
8 CLI could not open the intermediate file.
9 CLI could not append to the .crn file.

PAC Control User's Guide



CHAPTER 3: WHAT IS PAC CONTROL?

Operation Error code Meaning (Continued)
10 The variable type argument is missing.
The variable name argument is missing, or too long (maximum length is 50
characters), or is formatted incorrectly, or already in use, or is a program-
1 C ” :
ming “reserved word.” (Reserved words cannot be used as variable
names.)
12 The description argument is missing or too long. The maximum size for a
description is 127 characters.
13 The initialization kind argument is missing.
/av (Add Variable) 14 The initial value argument is missing.
(Applicable only to string and string table variables.) The string width argu-
15 ment is missing or too long.The maximum size you can give a string is
1024 characters.
16 (Applicable only to table variables.) The table length argument is missing
or too long. (Maximum table length is 1,000,000 elements.)
17 Cannot create the variable.
18 Cannot get an ID for the new variable.
19 Cannot add the variable to the strategy.
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Operation Error code Meaning (Continued)

20 The source I/O unit is missing. Please enter the name of the source 1/0
unit.
The source module position is missing. Please enter a source module

21 position number. Remember that module positions are zero-based (count
up from 0 instead of from 1).

22 The target I/O unit is missing. Please enter the name of the target 1/O unit.
The target module position is missing. Please enter a target module

23 position number. Remember that module positions are zero-based (count
up from 0 instead of from 1).

24 The source /O unit is not in the strategy. Check the name and re-enter.
The source module position is out-of-range. Check the number and

25 re-enter. Remember that module positions are zero-based (count up from
0 instead of from 1).

26 The target I/0 unit is not in the strategy. Check the name and re-enter.
The target module position is out-of-range. Check the number and

27 re-enter. Remember that module positions are zero-based (count up from
0 instead of from 1).

/mm (Move Module) 28 A module alrgady exists at the target module position. Enter an empty

module position.

29 No module is defined at the source module position. Check the number
and re-enter.
One or more points on the source module are referenced by a PID loop,

30 and the target I/O unit is not the source 1/O unit. To move the module,
remove the PID loops, or make sure the source module and the target
module are the same.

31 The target module cannot be used because it's not compatible with the
source module.

32 The source I/O unit cannot be verified.

33 The target 1/O unit cannot be verified.
The source module position is out-of-range. Check the number and

34 re-enter. Remember that module positions are zero-based (count up from
0 instead of from 1)
The target module position is out-of-range. Check the number and

35 re-enter. Remember that module positions are zero-based (count up from
0 instead of from 1)

36 The points on the source module are not allowed on the target I/0 unit.

PAC Control User's Guide




CHAPTER 3: WHAT IS PAC CONTROL?

Operation Error code Meaning (Continued)

40 The source I/O unit is missing. Please enter the name of the source 1/0
unit.

41 The source point name is missing. Please enter the name of the source
point.

42 The target I/0 unit is missing. Please enter the name of the target I/O unit.
The target module position is missing. Please enter a target module

43 position number. Remember that module positions are zero-based (count
up from 0 instead of from 1).
The target point position is missing. Please enter a target position number.

44 Remember that point positions are zero-based (count up from 0 instead of
from 1) and are the position on the module (not the absolute point
position).

45 The source /O unit is not in the strategy. Check the name and re-enter.

46 The source point name is not in the strategy. Check the name and re-enter.

47 The target I/0 unit is not in the strategy. Check the name and re-enter.
The target module position is out-of-range. Check the number and

48 re-enter. Remember that module positions are zero-based (count up from
0 instead of from 1).
The target point position is out-of-range. Check the number and re-enter.

49 Remember that point positions are zero-based (count up from 0 instead of
from 1) and are the position on the module (not the absolute point posi-
tion).

/mp (Move Point)

50 A point already exists at the target point position. Enter an empty point
position.
The point on the source module is referenced by a PID loop, and the target

51 I/O unit is not the source 1/0O unit. To move the point, remove the PID loop,
or make sure the source module and the target module are the same.

52 The target point cannot be used because it's not compatible with the
source point.

53 The source I/O unit cannot be verified.

54 The target 1/O unit cannot be verified.

55 The source point name cannot be verified.
The target module position is out-of-range. Check the number and

56 re-enter. Remember that module positions are zero-based (count up from
0 instead of from 1).
The target point position is out-of-range. Check the number and re-enter.

57 Remember that point positions are zero-based (count up from 0 instead of
from 1) and are the position on the module (not the absolute point
position).

58 The point on the source module is not allowed on the target 1/O unit.

59 Quadrature modules must be moved to an even numbered channel.

60 Quadrature modules require two adjacent channels. The second channel

is occupied by another point.
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Keyboard and Mouse Shortcuts

Use the following keyboard and mouse shortcuts to view and navigate a chart.

Action

Shortcut

Action

Shortcut

Center on Block 0

0 or Numeric Keypad 0

Move to Bottom Left

Numeric Keypad 1

Center on Block...

J

Move to Bottom

Numeric Keypad 2

Block Preview

Middle-click on a block

Move to Bottom Right

Numeric Keypad 3

Move to Top Left Numeric Keypad 7 Zoom In +
Move to Top Numeric Keypad 8 Zoom Out -
Move to Top Right | Numeric Keypad 9 Zoom to Fit and Center | F
Move to Left Numeric Keypad 4 Zoom to 100% 4

Move to Center

Numeric Keypad 5

Pan

Space + Left Mouse Button

Move to Right

Numeric Keypad 6

Online Help

To open Help within PAC Control, click Help > Help Topics in the PAC Control menu bar, or click the
Help button in any dialog box. Help buttons in dialog boxes are context-sensitive and provide help
specifically on that dialog box. Buttons labeled “Command Help” give specific information on the
command (instruction) you are currently using. (The command must be highlighted to open
Command Help.)

For brief explanations of buttons, move your mouse over the button and look in the status bar.

In Action and Condition Instructions dialog boxes, let your mouse rest for a second on a command,
and you'll see a list of the variable types used in that command. (To show or hide the variable types
list, in Configure mode, click PAC Control Options > Show/Hide Instruction Type Information.)

To open copies of PAC Control manuals and quick reference cards, click Help > Manuals. You will
need Adobe Acrobat Reader to open these files. You can also find information, documents, and
support on the Opto 22 website.
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4: Designing Your Strategy

Introduction

This chapter introduces you to PAC Control programming—how to design a PAC Control strategy to
control your automated process. For additional important information on using PAC Control
commands (instructions) to program your strategy effectively, see page 261 and the individual
command information in the PAC Control Command Reference.

NOTE: Because our focus in PAC Project is on the SNAP PAC System, PAC Control initially shows only SNAP
PAC /O units and the commands used with them. When you're using the SNAP PAC system only, hiding
legacy 1/0 units and commands makes it simpler and less confusing to build your strategy. However, the
legacy capabilities are still there and can be made visible in a specific strategy as needed. For information,
see “Legacy Options”on page 211.

In this Chapter

Steps to Design.... . . . . . . v 77
BASIC RUIES oo 84
INSTIUCTION EXAMIPDIES .oossosseeesecesssseee s ssssses s ssssssseessssnsssessss 87
(] oyalaa1v4Tale I 1 aTCo Ve aT LU SO0 97

Steps to Design

How do you get from your real-world control problem to a working PAC Control strategy that solves
it? Here’s an outline of the basic approach; we'll fill in the details on the following pages.

First, solve the problem.
+  Define the problem.
—  Whatam | trying to do?
- What inputs and data do | have to work with?
- What do the outputs have to be?
- How many times does the process have to be repeated?
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«  Design a logical sequence of steps to solve the problem.
— Break down the larger process task into sub-process tasks.
—  Break down the sub-process tasks into detailed steps.
+  Testthe steps.
Next, build the strategy.
«  Configure hardware.
- Control Engines
— 1/O units
- 1/0 points
«  Determine necessary variables and configure them.
«  Create charts, one for each sub-process, and add instructions.
«  Compile and debug each chart.
«  Compile and debug the whole strategy.
Finally, use and improve the strategy.
Now let’s take a look at each of these steps in order.

Solving the Problem

You can avoid a lot of extra time and rework if you define and solve your problem before you ever
start building a flowchart in PAC Control.

Defining the Problem

Suppose, for example, you want to automate a simple lawn sprinkler system. Start by asking yourself
(or others) questions about the control process you're trying to do.

What are you trying to do? Start with the big picture and work down to the smaller details.
«  Big picture: I'm trying to control this sprinkler system.
«  Smaller details:

— The sprinklers should turn on every Sunday and every Wednesday.

- They should not turn on if it’s raining.

— They should start at six o'clock in the morning.

— They need to run for 15 minutes.

What inputs and data do you have to work with? List all the inputs. Describe the data they
provide. Check for any inputs or data you need but don't have.

Input Data the input provides

Hygrometer Humidity (percentage from 0-100%)

Day Day of the week (Sunday through Saturday)
Time Hour of the day (24-hour clock)
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Input Data the input provides

Sprinkler status Whether sprinklers are currently running (on or off)

Input from timer Length of time sprinklers have been on (in minutes)

What do the outputs need to be? List all the outputs. Describe the results that are needed. Check
for any outputs you need but don't have.

Output What it does

Sprinkler switch Turns sprinklers on or off

Timer control Sets timer

How many times does the process have to be repeated? Our example is a simple sprinkler
system in which the process happens twice a week on certain days. In a more complex system,
however, you might have one section of the sprinklers turn on, followed by other sections, repeating
the process several times in different areas and then repeating the whole pattern on certain days.

Designing a Logical Sequence of Steps to Solve the Problem

Now that you've determined what you're trying to do and what your inputs, data, and outputs look
like, you're ready to outline the steps needed to solve the control problem. Think about how you
would do the job if you were doing it by hand. Again, work from the top down, starting with big
steps and then breaking those big steps into smaller steps.

Sprinkler Control System

Every day at 6:00 a.m.:
1. Check the day and the weather. 2. If it's raining, leave the 3.Ifit'stherightdayandit'sdry,

sprinklers off. turn them on.

1. Check the day and the
weather.

Read the day of the week.

If it's Sunday or Wednesday, read
the hygrometer.

2. If it's raining, leave them
off.

If the hygrometer says 100%,

check to make sure sprinklers
are off.

If they're on, turn them off.

3. If it's the right day and
it's dry, turn them on.

Ifit's Sunday or Wednesday and
if the hygrometer says 99% or
below, turn sprinklers on.

Start the timer.

When they've been on for 15
minutes, turn them off.

If a human being were doing this job, this level of instruction would probably be just fine. With a
computer, however, the instructions need more detail. For example, the first instruction, “Every day
at 6:00 a.m.,"would have to be expanded more like this:

a. Read the hour.
b. If the hour equals six, go on to the next step.
c. If the hour does not equal six, go back to step a.
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Testing the Steps

Now that you have your steps in place, run through each sub-process in your mind to see if anything
is missing. Is there an answer for every “if"? Are all the possibilities taken into account?

It may help you to draw out your control process as a flowchart. Often it is easier to see decision
points and responses to decisions in a flowchart. You're still working at the human level at this point;

just be aware that the computer may require more details.

Here is a possible flowchart for the simple sprinkler control problem.

Simple Sprinkler System Process Flowchart

At 6:00 a.m., read
the day of the week

<

Is it Sunday or
Wednesday?

Wait 24 hours |«

| Read the hygrometer |

Yes

Ishumidity less
than 100%?

Sprinklers off?

Turn sprinklers [Turn sprinklers off f——t
onand settimer

for 15 minutes

Yes

|Turn sprinklers off :

Building the Strategy

Once you have the control problem solved in detail, you can begin building the strategy in PAC

Control. Now you'll add all the logical details the computer needs.

Configuring Hardware

The first step in building your strategy is to configure your control engine, I/0 units, and I/0O points.
(For more information and step-by-step procedures, see Chapter 5: Working with Control Engines
and Chapter 6: Working with 1/0) You can add more I/0 units and points later if needed, but it saves

time to configure them now.
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When you solved this control problem, some of the inputs and outputs you defined were physical
/0, such as the hygrometer and the switch to turn on the sprinklers. You configure these physical
inputs and outputs as the I/0 points.

Here are the I/0 points you might configure for the simple sprinkler system:

Physical I/0 Type 1/0 Point Name
Hygrometer Analog Input Hygrometer

Sprinkler status Digital Input Sprinkler_Status
Sprinkler switch Digital Output Sprinkler_Switch

Determining and Configuring Variables

Some of the inputs and outputs you defined when you solved the problem were not physical I/0,
but information. For example, the day of the week is not a physical input; it's a piece of information
you can get using a command in PAC Control. These inputs and outputs become variables.

You also need variables to store the information that input points give you. And you may need
variables for manipulating information.

To determine the variables you need, think about the pieces of information your process requires.
Then look at the PAC Control commands in the PAC Control Command Reference. Find the commands
you need and check them to see what types of variables each command requires.

For example, you need to know what day of the week it is. Will the control engine give you this
information as a string (for example, “Wednesday”) or in some other format? When you check the
command Get Day of Week, you discover that the day is returned as a number

(Wednesday = 3), so you set up this variable as a numeric integer.

Here are some variables you may need. (See Chapter 9: Using Variables and Commands for more
information and step-by-step procedures to add variables.) You can change them or add other
variables later if necessary.

Variable Needed Type Name in PAC Control
Hour of the day Numeric (32-bit integer) Time_of_Day

Day of the week Numeric (32-bit integer) Day_of_the Week
Humidity Numeric (float) Humidity

Down timer Timer Timer

Creating PAC Control Charts and Adding Instructions

If you have already drawn the process in a flowchart, this step will go faster. PAC Control is based on
flowcharts because they are a natural way to show a control process. And the block names and
instructions you add to charts—just like the names of variables—are in normal, everyday language.
(For more information and step-by-step procedures, see Chapter 8: Working with Flowcharts and
Chapter 9: Using Variables and Commands).

The difference between the flowchart you drew before and the chart you create in PAC Control is
that the flowchart was designed for human beings, but the PAC Control chart must be more
detailed so the computer can follow it.
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Because the chart is more detailed—and because most control processes are far more complex
than our sprinkler system—you will usually create multiple charts for a PAC Control strategy. Break
the process down into logical chunks, or modules, and then create a chart for each module. A
modular design makes it easier to test and to update your strategy.

Even for a simple process like our sprinkler control, there is no single “correct” way to solve the

control problem and build the strategy. Instead, there are many possible ways. The following chart
shows one example:

This strategy turns on the ]

sprinklers at 6:00 a.m. Block 0

g
Wait 60 sec

Between
............. 687 am?

g

Wait 24 hrs

............. v Read
............. Hygrometer

. F¥- : :
1Jl'urn off sprinklers

Turn

v
S >

(i15horteuts | 100% v

[0 T chart /

One difference between this chart and the human-level chart on page 80 is that several delays have
been added to the chart. There is one before rechecking the hour of the day, one before rechecking
the day of the week, one before rechecking whether the timer has expired, and finally one before
starting the flowchart over again.

This sprinkler system is not time-critical. If the sprinklers turn on at a little past 6:00 a.m. or the grass
is watered an extra few seconds, it doesn't matter. Delays give the control engine time to do other
things. (For more information on delays and using control engine time effectively, see page 97.)
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Each block in the chart contains the PAC Control commands (instructions) that do the work in the
system. For example, here are the instructions for the block “Turn on sprinklers, set timer”:

# Instructions - Dough_Chip_Control - Start

Turn On Add...
Sprinkler_Switch

Set Down Timer Preset Value

Target Value 900.0

Down Timer Timer

Mewt Block

Start Timer

Timer Timer Previous Block

[ Cloze ] [ Help ]

As you create charts and enter instructions, keep referring to the PAC Control Command Reference.
The Command Reference describes the “arguments”for each command, which are pieces of
information you must enter in the instruction. You can also press F1 to open online help for
commands, which gives you the same information as in the printed Command Reference.

For example, one of the commands shown above, Set Down Timer Preset Value, has two arguments.
The Command Reference and online help tell you that the first argument—the target value, or the
value from which the timer counts down—can be a float variable or a float literal (entered in either
decimal or hexadecimal form), and that the second argument is the name of the down timer variable.
You need this information when you enter the instruction in the Add Instruction dialog box.

#1 Add Instruction rz|

Instruction:

|SetD0wn Timer Preset Yalue v| [ Select... ]
LComment:

| |

Tupe Marme
Targst Value Float Literal v| [a000 v|
Arguments <<_| _
Down Timer D owvar Tirmer W ariables v| |Timer v|
[ QK. ] [ Cancel ] [ Help ] [ Command Help ]

The sample flowchart we've shown uses standard PAC Control commands only. If you have a
programming background, you may wish to incorporate OptoScript blocks in your flowchart.
OptoScript is a procedural language that can simplify some programming tasks, including string
handling, math calculations, and complex loops and conditions. See Chapter 11: Using OptoScript
for more information.

Compiling and Debugging the Strategy

When all charts are completed and their instructions added, the next step is to compile and debug
the strategy. But first, check your hardware. Check cabling and connections, and make sure the
actual I/0 matches the configured I/O in the strategy.
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Now compile and debug the strategy. (See Chapter 7: Working with Strategies for more information
and step-by-step procedures. If you have problems, see Appendix A: Troubleshooting.Opto 22
form 1700, the PAC Control User's Guide.) If you have multiple charts, debug each one separately and
then debug the strategy as a whole. It is easier to find errors in one flowchart than in a group of
interrelated ones.

Make sure the connections between charts are accurate. For example, is a chart started at the
correct block in another chart?

Use the debugging tools discussed in Chapter 6 to find errors by stepping through a chart and
setting breakpoints to discover which block or line contains the problem. And if you've tried
everything and it still doesn't work, contact Opto 22 Product Support. (See page 4.)

Using and Improving the Strategy

Any strategy is one of several possible ways to solve a control problem. One way may be more
efficient under some circumstances; another way may be better for others. As you use the strategy
over time, as control needs change, and as you become more knowledgeable about PAC Control,
you'll find ways to make the strategy better.

Basic Rules
The sprinkler strategy we just created is a simple example. This section gives basic rules to keep in
mind when you're solving more complex control problems.

When you create a new PAC Control strategy, a Powerup chart is automatically included. You add all
the other charts you need, and the total number of charts in the strategy is limited only by the
control engine’s memory. Be aware, however, that the maximum number of charts that can be
running at any one time is based on the control engine you are using:

« 16 charts on a SNAP PAC R-series controller

«  32chartson a SNAP PAC S-series controller

« 64 charts on a SoftPAC controller

Program logic moves through a flowchart in one of two ways: flow-through or loop.

«  Achart with flow-through logic performs a set of specific commands and then stops. It has a
beginning and an end, and at the end is a condition or action block that has no exit.

Subroutines, the Powerup chart, and any other chart that does not need to run continuously
should always have flow-through logic. In complex strategies, be careful when using delays
and condition looping (waiting for something to occur) in charts with flow-through logic.

«  Achart with loop logic has no end. It loops through a set of actions and conditions
continuously. A loop-logic chart can have several paths through which the direction of the
logic may flow, depending on certain criteria. Use loop logic for a chart that needs to run
continuously. (The simple sprinkler chart has loop logic; it runs continuously.)

PAC Control User's Guide


http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=3165

CHAPTER 4: DESIGNING YOUR STRATEGY

Chart Guidelines

As you design your strategy, put each sub-process of your overall control problem into a separate
chart within the strategy. On a SNAP PAC R-series controller, a maximum of 16 charts (plus one host
task) can run at once. On a SNAP PAC S-series controller, 32 charts (plus one host task) can run at
once. On a SoftPAC controller, 64 charts (plus one host task) can run at once. (For more information,
see "Optimizing Throughput”on page 97.)

In general, follow these chart guidelines:

«  Use the Powerup chart just to set initial values for variables, perform setup commands, and
start the main charts. Use flow-through logic so the Powerup chart will stop as soon as the
other charts begin.

«  C(reate a few charts to monitor essential or time-critical pieces of your process, such as
emergency stops on dangerous equipment or I/O that must be monitored continuously. These
charts should use loop logic so they are constantly running.

« Ifasetof operationsis used multiple times in your strategy or is used in more than one
strategy, you can put that logic in a subroutine and call the subroutine when needed. Calling a
subroutine doesn't require as much time as calling a chart or starting a new chart. In addition, a
subroutine starts as soon as it is called in the context of the chart that is calling the subroutine.
A Start Chart command is simply placed in the task queue and started in turn. See Chapter 12:
Using Subroutines for more information.

«  Use the text tool to type a descriptive title in each chart and add any necessary explanations.
Keep blocks far enough apart to easily see the flow, and if possible, design the chart so its entire
flow can be seen within one window. If a chart becomes too complex, split it into smaller
charts.

«  When you use OptoScript code, remember that it is not self-documenting. Be sure to add
comments so that you or others can easily see what the code is doing. (Similar comments are
also useful in other PAC Control flowchart blocks.) Use OptoScript blocks within a flowchart for
operations they make easier, such as string handling and math calculations, but keep the logic
and purpose of the strategy clear in the flowchart.

«  Within a chart, leave Block 0 empty. This makes it easy to insert logic at the beginning of the
chart by adding a block between Block 0 and the next block. If a block contains more
instructions than can be easily traced and debugged, break it down into two or more
sequential blocks. Never place another block in the flowchart before Block 0. Charts always
start with Block 0, which cannot be deleted.

Naming Conventions

To save trouble in the long run, it's wise to establish naming conventions for charts, blocks, variables,
/0 units and points, control engines, subroutines, and so on. If you name these elements in a
consistent way from the beginning, it is easier to find them in lists, to see related elements, and to
know their functions without opening them.

Since PAC Control automatically alphabetizes these names, you can plan naming schemes to place
similar items together in the way you expect to use them.

Names have a maximum length of 50 characters. They can be all upper-case characters, or they can
be mixed case.
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In chart names, for example, you might include a few letters indicating whether the chart monitors
critical tasks, is a master chart calling others, or is periodically called:

«  Mntr_Tank_Leak (constantly running chart that monitors a critical situation)
+  Mstr_Conveyor_Process (master chart that calls others for a sub-process)
+  (Call_Message_Display (chart called by a master chart for a specific purpose)

Block names should tell what the block does, so you can understand a chart without needing
additional explanations. Block names should describe the purpose of the instructions within them.
Use a question for the name of a condition block, with a true exit reflecting the answer yes.

«  ReadThermometer (action block)

«  Temperature Too High? (condition block)

«  Turn OnPump 1 orPump 1 On (action block)
«  Pump On? (condition block)

Variable names can include Hungarian notation to indicate the type of variable, since the variable
type is not always apparent in its name. For example a variable named Month might be either a
string or an integer. However, using Hungarian notation, sMonth indicates a string, and nMonth
indicates an integer.

Another good practice is to identify variables used in a single chart differently than variables used by
more than one chart or process, especially if you have a large chart and want to separate these types
of variables. For variables used only in a table, you can include the table name in the variable name.
For example, you might use the name Fail_Count_in_Config_Values for a variable to be used in a
table named Config_Values.

The following table shows suggested notation for use in PAC Control:

Variable type Letter Variable type Letter
integer 32 variable n pointer variable p
integer 32 variable used as Boolean b pointer table pt
integer 32 table nt digital 1/0O unit dio
integer 64 variable nn mixed 1/O unit mio
integer 64 table nnt analog input point ai
float variable f analog output point ao
float table ft digital input point di
down timer dt digital output point do
up timer ut chart cht
string variable s communication handle cmh
string table st

In 1/0 point names, you may want to indicate the point’s function, the state of the device when the
point is active, its location, or a schematic reference. You can abbreviate names of familiar devices
and write out less familiar names. Include the information you need in the order in which it will be
most useful to you:

«  Heater_Switch (You have only one heater.)
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«  Htr6_Switch_SW23B (You have many heaters, and the schematic reference is needed.)
»  Cnvyr_Speed_Encoder_BIdgA (You want all conveyors to appear together.)
+  BldgA_Cnvyr_Speed_Encoder (You want all points in Building A to appear together.)

Instruction Examples

This section includes examples of common instructions you may want to use. See Chapter 10:
Programming with Commands. For additional information on programming with PAC Control. If you
need to use math calculations, strings, or complex loops and conditions in your strategy, also see
Chapter 11: Using OptoScript for examples of OptoScript. OptoScript is a procedural language
within PAC Control that can make programming easier, especially if you are an experienced
programmer.

Creating Messages to Display On Screen

You may need to create messages to display on screen, for example to give data to operators.
Typically these messages consist of some specific, literal words and symbols followed by a variable
value and maybe some additional literal words or symbols.

Current temperature=|86.3|F.

Literal words Variable Literal words
& symbols value & symbols

Average price=5/4.86
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You can create the message in a single block in your PAC Control chart, like this:

1. To enter the literal text, use the
command Move String.

* Instructions - Message Display - Create Message

Remember to include spaces Move String
where you want them to appear, | T Ffrom ‘Current temperature =
i To Current_Temp_Message
such as after the equal sign.
Convert Float to String
. Convert Current_Temp
2. Add the.var.|ab|e valge by Length : T
converting it to a string and Decimals 1
appendmg itto the string you Put Result in Current_Temp_String Previous Block.
JUSt created. ppend String to String
Append Current_Temp_5String
To Current_Temp_Message
Append String to String
. If needed, append another Append e
literal string To Current_Temp_Message
[ Cloze ] [ Help ]

Alternatively, you can create the message by placing the following OptoScript code within a single

OptoScript block:

FloatToString(Current_Temp, 5, 1, Current_Temp_String);
Current_Temp_Message = "Current temperature = " + Current_Temp_String +
nELn-

OptoScript can be more efficient for string handling than standard PAC Control commands. See
Chapter 11: Using OptoScript for more information.
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Error Handling

Every strategy should have a way to handle errors. It's important to check values and errors that are
returned from the commands in your strategy. Communication to an I/0 unit, for example, will be
automatically disabled if a command sends it variable values that are clearly wrong, such as a
memory map address in an incorrect format.

Counting

Most standard digital inputs can be used as counters to count the number of times the input
changes from off to on. The availability of counters depends on the brain’s capabilities, and the
speed of counters depends on the module.

For information on brain capabilities, see Opto 22 form 1689, the SNAP PAC Brains Data Sheet.

For more information on module counting speed, see the module’s specifications on the Opto 22
website, www.opto22.com. On the website, select Products > SNAP PAC System > Brains and I/0 >
Digital I/0.

NOTE: You can use counters on high-density modules with SNAP-PAC-R1T and SNAP-PAC-R1-B controllers,
and SNAP-PAC-EBT and SNAP-PAC-SB1 brains with firmware 8.1 or newer.
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Before using a counter, you must configure the point as a counter. (See “Adding a Digital I/0 Point”
on page 132, or use PAC Manager.) Counters on Ethernet and SNAP PAC1/0 units do not need to be
started, and they cannot be stopped. Therefore, do not use the Start Counter and Stop Counter
commands with SNAP PAC I/0 units. However, you can use Get Counter and Get & Clear Counter.

Counters on mistic 1/0 units must first be started using the Start Counter command. In addition to
Start Counter, you can use the following commands on mistic /O units: Stop Counter, Get Counter,
Get & Clear Counter, and Clear Counter.

Using a Count Variable for Repetitive Actions

A numeric variable for counting is useful when the same action needs to be repeated a specific
number of times. For example, suppose your process includes filling a packing box with a dozen
bags of cookies. You can use a count variable to track how many bags are dropped into the box.

Here's part of a chart showing how you would use a count variable in this way:

— Shipping_Area |'-_||'E|r2|
............. = = = :
- o B 1 Instructions - Shipping_Area - Set count to 1 r5__<|
Block 0
Mowve Add
. ' il From 1
7 S To Bag_Count
Move box #ito |- - |
posit”
Al ions - Shipping_Area - | by1 [X]
R S nstructions - Shipping_Area - Increase count by
2 g N
Set count to 1 Increment Variable Add..
Lo P Bag_Count
.o ..ST .o
I
e dropper ]
1 . [ Mest Blact |
C —L """"" # Instructions - Shipping_Area - Count = 127 @
.
Increase count
SOl = Bag_Count Add..
................... Equal?
To 12
....... Yoo .E. R C
LF ot - s T Atk to start o R
..... " N N prﬂ:e!: N 9
................... Mext Block.
.( .................. TR
(1) Sharteuts Operatar
[ATF T chare / @ 4ND
[ Cloze ][ Help ] “ommand Help O0oR

If you are an experienced programmer, you'll notice that this example is a for loop. You can use the

following OptoScript code within a single OptoScript block to accomplish the same result:

for Bag_Count = 1 to 12 step 1 //Count 12 items dropped into box
Bag_Dropper = 1; //Turn on bag dropper

next

See Chapter 11: Using OptoScript for more information on using code to streamline control

structures in your strategy.

Programming Case Statements

A frequent need in programming is to create case statements, also called “switch” statements,
“if/then/else” statements, or “nested if” statements. These statements create multiple decision

m PAC Control User's Guide



CHAPTER 4: DESIGNING YOUR STRATEGY

points: if the condition is A, then X will happen; if the condition is B, then Y will happen, and so on.
(This example uses regular PAC Control commands; seeChapter 11: Using OptoScript for another
option that takes up less space in your flowchart.)

For example, suppose you have a conveyor with three speeds: high (3), low (2), and stopped (1).
Sometimes it runs at high speed, sometimes at low speed; but before a box can be put on the
conveyor, the conveyor must be stopped. And it can be stopped only from low speed, not from high
speed. Here’s a portion of a chart showing the case statements that control this process:

Conveyor speed is
checked and moved
(copied) into a variable.

9 Instructions - Conveyer_Operation - Get conveyor s... @

= Conveyer_Operation

’ ' 1 v
. Box ready? . .

Add...

From Conveyor_Speed_Sensor
To Conveyor_Speed

Modify...

Delete

A Instructions - Conveyer_Operation - Speed high?

Each condition block

Get col .
s S a R Equ;f, Corveyor_Speed Add . checks for a particular
............ S To 3 Madiy... speed. This one checks for
............ high speed (3).
................. A Instructions - Conyveyer_0Operation - Shift to low
..... L Move i If speed is too high, it is
R : ' o ) : shifted down to the next
SN i S To Conveyor_Speed Modify... K K
----- - : . level, until the conveyor is
............... Delet .
________________ 1 s finally stopped and the
box can be put on.
Shift to low
N
ettt
& shmims | i [ Cloze ] [ Help ] Command Help
[AT> T2 Chart /

The example above shows three cases, because there are three possible speeds and each speed
demands a different action.

If you had only two possibilities
(for example, if the box could also

A Instructions - Conveyer_Operation - Conveyor stopped? r>_<|

be put on the conveyor at low . e Add.
speed), you could handle both To 1 Modity..
possibilities within one condition Is Conveyor_Speed Delete
block. For example, you could put | “7a .
two Equal? commands in the
same condition block, and check p
the Or operator, as shown at right. @ AND
[ oose [ Heb Command Help Oon
USing a Timer Or operator

Timers come in two forms:

«  Uptimers count up from zero and are generally used to measure how long something takes.
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«  Down timers count down to zero from a number you set and are frequently used to determine
when events should begin.

Here's an example of a down timer. This process starts every 1.5 seconds.

The condition block checks
whether the timer has

reached zero. If it hasn't, the

chart loops until it has.

When the timer has
expired, it is restarted and
the process begins.

When the process ends,

the logic loops back to —

check whether the timer
has expired again.

= Timer_Example_Chart

The starting value for the
timer is set in Block 0.

Block 0

1

Process Timer
Expired?
N

T

Start Process
Timer

Y

Start Proc ss

4

End Process

E

“Instructions - Timer_Example_Chart - Block 0 [g|
& Set Down Timer Preset Value Add...
= Target Value 1.5
A Down Timer Process_Timer Modify...
Start Timer Delete
Timer Process_Timer
Mest Block
B Previous Block
Delay 1 msec

()sh

[\, Chart /

A Instructions - Timer_Example_Chart - Process Timer E... [z|

Down Timer
Down Timer Expired?

Process_Timer

Add...
Madify...

Delete

Mext Block

“Instructions - Timer_Example_Chart - Start Process Ti... @

Start Timer

Timer Process_Timer

[ Cloze ] [ Help ] Caommand Help

Add...
adify...

Delete

Mest Block
Freviouz Block

For additional details, see “Using Timers”on page 341.

Using a Flag Lock

The Flag Lock and Flag Unlock commands allow you to give a task exclusive access to one or more

objects—such as tables, integers, or I/0 units—until the task is complete. For example, if you want
two different charts to change the values in the same table, it is important for one chart to complete
its task before allowing the second chart to access the table.

To demonstrate, the following charts show how to construct two charts in a strategy so that each
chart can access the same table without interference from the other chart.
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Chart 1 and Chart 2 are very similar. The main difference is that one block (D) in Chart 1 adds 2 to
each table element, while in Chart 2 it adds 3.

: 0

: Get Table
A- Lock

= =

B-_ - L Decrement

. “| Table Index
C—
D-— Add 2 to Table

: Element

"""" Chart 1

ﬁ.elease Table ;E
Lock

Chart 2

" Get Table
Lock

.“.

¢ Decrement
Table Index

.‘.

Add 3 to Table

Element

Release Table —E
Lock

Here's what each block accomplishes:

A—Get Table Lock. Uses the following instructions to wait until Chart 2 unlocks the flag before
it locks the flag on the table. It also tracks the number of times Chart modifies the table, and it gets
the length of the table. The Timeout value of -1 makes the chart wait the other chart has
successfully unlocked the flag on the table. See also, “Flag Lock Timeout Values”on page 94.

Flag lock will wait until
Chart 2 unlocks the fla
on the table. See also,
“Flag Lock Timeout
Values”on page 94.

9 Instructions - Chart1 - Get Table Lock

X

Tracks the number of
times the table has been
modified by Chart1

Gets the length of
the table and puts it
in Int_Table_Index

-1 Timeout = "Wait until lock succeeds" s
Flag Lock

Flag Int_Table_Flag

Timeout -1

Put Result in Int_Table_Flag_Result
Increment Variable

Modified_by_Chart1

Get Length of Table

Tahle Int_Table

Put in Int_Table_Index

~

Cloze ] [ Help
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Using the numeric variables Modified_by_Chart1 and Modified_by_Chart2 (from Chart 2), a watch
window can track the number of times the table has been modified by each chart. For more
information, see “Using a Watch Window” on page 37.

Natne Type TIVAL

Modified by Chartl Integer 32 Variable 91
Modified by ChartZ Integer 32 Variable 49
Int_Table Index Integer 3Z Variahle 17

B—Decrement Table Index. The table has 100 elements, numbered from 0 to 99. This
instruction block starts at element 99 and on each loop decrements by 1 to go to the next element.
This continues until it reaches index 0.

C—Index >=0. If the index is greater or equal to zero, the chart proceeds to D. If the index equals
-1, the chart goes to E.

D—Add 2 (or 3) to Table Element. Adds two (or three) to the value of the current table index.

E—Release Table Lock. This block uses a Force unlock of zero, which means it will unlock only for
the chart that locked the flag. In this case, if Chart 1 locked the flag, only Chart 1 can unlock the flag.

Flag Lock Timeout Values

The following chart shows the effect of different Timeout values used with the Flag Lock command:

Timeout Effect

Wait until success.

The application will wait (block) as long
-1 as it takes to lock the flag. Since it never
gives up, the only value that can be
returned is 0.

Don’t wait at all. Succeeds only if the flag
is available to be locked immediately.
Makes this a non-blocking call. If the flag
is not already locked, a return of 0 (Suc-
cess) is returned. If the flag is locked, a
-17 (Already Locked) error is returned.

Wait maximum of value milliseconds to
lock the flag. If it succeeds within the
specified time, 0 is returned; otherwise, a
-37 (Timeout on Lock) error is returned.

Value greater than 0

Value less than 0 Produces a-8 (Invalid Data) error
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Pointers and Indexing

The following examples show three possible ways to control 16 fans based on setpoints.

Without Pointers

The first way, shown below, uses individual fan outputs and setpoint variables to determine whether
to turn off or on the appropriate fan. It's a simple way to solve the problem but takes a long time to
program and produces a large, repetitive section in the flowchart. It also consumes more control
engine memory, due to the large number of conditional and action blocks.

1 Instructions - FanCtrl - 01 Too Warm?

Is
Greater?
Than

Each fan output (Motor01-Motor16) uses
a separate temperature input (Temp01-

rr e Temp16) and a separate setpoint variable
(SPO1-SP16). The flowchart cycles

through them all to control the fans.

O sr '
| Tum Fan Off - Turn Fan On
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With Pointers and Indexing

The second way uses pointers and indexing to accomplish the same result in a smaller space, using
less control engine memory and fewer programming steps. The fan outputs and the temperature
inputs are referred to by pointers. The setpoints, instead of requiring individual variables, are simply
numbers in a table.

0 Ity it kad - FasCiel - Load Poknbers

Indes

1 Imtrectiens - FanCirl - Too Warm?

Gresiet Than Burmeric Table Bement
FanClilndes
NScipures

M inviructions - FanCirl - Turn Fan ik

L

[ oo ][ vep | [ Commeition |

The flowchart sets initial values for the
pointers, and then cycles through the pointer

A Instructions - FanCtrl - Load Pointers

Move from Pointer Table Element e Add...
tables to control the fans. (Tables have already Index FanCtriindex
T . Modify...
been initialized in the Powerup chart.) . o

Move from Pointer Table Element

"""""""""" Index FanCtrlindex Mest Block
........ 13 Lo . Of Table ptTemps
Load P To Pointer pTemp Previous Black

A Instructions - FanCtrl - Too Warm?

2 . . . Is pTemp
Turn Fan Off Turn Fan On Greater Than Numeric Table Element?
e g . L At Index FanCtrlindex
. \ S A P . - Of Table fiSetpoints

13
Increment

Index

[ MestBiock |

1 Instructions - FanCtrl - Turn Fan On |§|

Mext Block
Previous Block

pMotor

Claze ] [ Help ] [ Command Help ]

m PAC Control User's Guide



CHAPTER 4: DESIGNING YOUR STRATEGY

Using OptoScript

The third way also uses pointers and indexing, but places all the action in an OptoScript block. See
“11: Using OptoScript” for more information on using OptoScript.

9 ) A OptoScript - Alarms - Stop Conveyor _
ﬁp date Fan X
States ) »3 Actions  +€> Conditions ) Wariables 4% Test Compile dh 4/

. = & as OptoScript Code:
Mfor FanCtrlIndez = 1 to 16 step 1

Optimizing Throughput

s#loop through element= 1-16 of the tables.

ssmove the AT and DO to the pointers
pHotor=ptMotors[FanCtrlIndex]:
pTenp=ptTenp=[FanCtrlIndex]:
ssocompare the walues and act.
if (*pTemp:ftSetpoints[FanCtrlIindex]ithen
*pHotor=1. ~~Turn on motor
else
*pHotor=0;: ~»Turn off motor
endif

next

For tips on how to design your PAC Project” system and program your PAC Control” strategy to
ensure optimum system performance see Opto 22 form 1776, Optimizing PAC Project System

Performance.

For additional information, see Opto 22 form 1702, the PAC Display User’s Guide.
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5: Working with Control
Engines

Introduction

This chapter shows you how to configure and work with control engines. See “Compatible
Controllers and I/0 Units” on page 6.

In this Chapter

Configuring CONLIOl ENGINES .....ovcooceeeeeecseeeeesscseeessssees e ssssseesssssssesssnsssesssns 99
Using Network Segmenting in PAC Control . . . . 104
Using Ethernet Link Redundancy in PAC Control . . O 104

Using Redundant Controllers

Changing or Deleting a Control ENGINe ..o

Inspecting Control Engines and the Queue
Archiving Strategies on the Control Engine

Restoring Archived Strategies from the Control Engme ....................................... 118
Downloading Files Using PACTErMING .....coocevveeesceeveesscnseeesssssseesssnsseesssnssenssns 120

Configuring Control Engines

Before you can use a control engine to run a strategy, you must first define the control engine on
your PC and then associate the control engine with your PAC Control strategy.

See “Defining a Control Engine on Your PC”" below to identify the connection through which
the PC and the control engine communicate. Because this process writes to the Windows
Registry on your PC, you must define control engines for each computer that uses your
strategy. (If your computer can boot to two operating systems, you must configure control
engines for each operating system.) You can define control engines in PAC Control or in the
software utility, PAC Terminal.

See “Associating the Control Engine with Your Strategy” on page 103 to identify which defined
control engine is the active control engine. Although you can associate several control engines
with the same strategy if necessary, the strategy can be downloaded to only one at a time. The
control engine set to receive the download is called the active engine. You must use PAC
Control for associating the control engine with your strategy.
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Defining a Control Engine on Your PC

You can use either PAC Terminal or PAC Control to define a control engine on your PC. Follow these
steps to define a control engine using the PAC tool of your choice.

1.

Start either PAC Terminal or PAC Control, and then open the Select Control Engine dialog box:
Using PAC Terminal:

- InWindows 7 and Windows Vista, press the Windows Start key &4, and then click

Programs > Opto 22 > PAC Project 9.6 > Tools > PAC Terminal.
- InWindows 10 and Windows 8.1, press the Windows Start key ':ﬂ::' type PAC Terminal
9.6 and then press the Enter key.

From PAC Terminal’'s menu bar, click Configure > Control Engines. When the Select Control
Engine dialog box opens, go to step 2.

Using PAC Control:

— InWindows 7 and Windows Vista, press the Windows Start key
Programs > Opto 22 > PAC Project 9.6 > PAC Control.

& and then click

— InWindows 10 and Windows 8.1, press the Windows Start key ':5.'3' type PAC Control
9.6 and then press the Enter key.

a. Open a strategy in either Configure mode or Online mode.

b. From PAC Control’s menu bar, click Configure > Control Engines. The Configure Control
Engines dialog box appears.

Configure Control Engines

Active Engine:

Cookie Controller

Engines Associated with Strategy:

Set Active
Add...

Modify.
Delete
Download Options...
oK Cancel Help
c. Click Add.
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The Select Control Engine dialog box appears.

Modify...

Delete

2. The Select Control Engine dialog box lists all the control engines configured on your system,
whether or not they are associated with your strategy.

- Ifthe control engine you want appears in the list, it has already been defined on this PC,
click to highlight the control engine’s name and then click OK. Then skip to “Associating the
Control Engine with Your Strategy”on page 103.

— Ifthe control engine you want is not in the list, click Add.

The Control Engine Configuration dialog box appears.

Conﬁgun: Ethemet Connection

Configure control engine name and parameters:
Control Engine Name: A

System Type
(@) Standard
() Redundant Networks (PRO only)
() Redundant Controllers (PRO only)

Settings
IP Address/Hostname: 0.0.0.0

Controller Pot: 22001
Software Retries: |0 ]
Software Timeout: 5000

mMmg N

3. Complete the fields as described in “Control Engine Configuration Dialog Box” below.
4. C(lickOK.
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5.

The Select Control Engines dialog box appears, displaying your new control engine in the list.

Select Control Engine

Configured Control Engines:

| Cookie Controller
|R1 Controller

0K Cancel

In the Select Control Engine dialog box, highlight the control engine you want to associate
with the strategy, and then click OK. Continue with “Associating the Control Engine with Your
Strategy”on page 103.

Control Engine Configuration Dialog Box

A—Control Engine Name. Enter a descriptive name for the control engine. Valid characters
are letters, numbers, spaces, and most other characters except colons and square brackets. Spaces
cannot be used as first or last characters.

B—System Type. Select the system type:

Standard: A normal system not using redundant networks or redundant controllers.

Redundant Networks (PRO only): A system that has redundant networks, which is also referred
to as link redundancy. When selected, two IP address boxes are available under Settings for the
primary and secondary networks. See “Using Ethernet Link Redundancy in PAC Control”on
page 104 for more information.

Redundant Controllers (PRO only): Use with a system configured with the SNAP PAC
Redundancy Option. When selected, three IP address boxes are available under Settings for
Controller 1, Controller 2, and Arbiter. For more information on setting up the Redundancy
Option, see form 1831, the SNAP PAC Redundancy Option User’s Guide.

C—IP Address/Hostname. The IP Address/Hostname text boxes available depend on your
System Type. Each IP address is entered in decimal notation (for example, 192.9.200.24).

Hostnames are supported only in standard configurations, not redundant ones. In order to use a
hostname, your network must have a domain name server (DNS) and the hostname must already
have been entered in your DNS either by you or someone in your IT department.

For Standard: Enter the IP address or hostname of the control engine.

For Redundant Networks (PRO only): Enter the Primary and Secondary IP addresses. The
Primary address is ETHERNET 1 on a SNAP PAC controller, and the Secondary IP address is
ETHERNET 2. Both IP addresses use the same port number. See “Using Ethernet Link
Redundancy in PAC Control”on page 104 for more information.

For Redundant Controllers (PRO only): For the SNAP PAC Redundancy Option. Enter addresses
for Controller 1, Controller 2, and Arbiter. For more information on setting up the Redundancy
Option, see form 1831, the SNAP PAC Redundancy Option User’s Guide.
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D—Port. Enter the control engine’s IP port number. The default of 22001 is the port of the host
task on the control engine; this default normally should not be changed.

E—Retries. Retries indicate the number of times PAC Control will reattempt communications
with the control engine. Since retries are automatically handled by the protocol (TCP/IP), enter zero
here.

F—Timeout. Enter the timeout value in milliseconds. Timeout value is the length of time PAC
Control tries to establish communication through the port. If it fails, it tries again as many times as
specified in D. Any positive integer is valid. For Ethernet, 3—5 seconds (3000-5000 milliseconds) is a
good starting point.

Associating the Control Engine with Your Strategy

After you have defined the control engine on your PC (see page 100), it can be associated with your
strategy.

1. Ifyou are in PACTerminal, close PAC Terminal. Open the strategy in PAC Control (Configure
mode or Online mode) and from the menu bar, click Configure > Control Engines.

In the Configure Control Engines dialog box, the engine’s name appears in the list.

Active Engine:

Active engine R1 Controller

List of control engines

Engines Associated with Strategy:

Cookie Controller

2. Check to make sure the correct control engine appears in the Active Engine field. If not,
highlight the one you want and click Set Active.

Only one control engine can be active. If only one control engine is listed, it automatically
becomes the Active Engine.

Your control engine configuration is complete.
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Using Network Segmenting in PAC Control

You can take advantage of the two independent Ethernet network interfaces on a SNAP PAC
controller to segment the control network from the company network. Because the two network
interfaces are completely independent and have separate IP addresses, they can be set up on two
separate networks. Host traffic can communicate on one, while the controller communicates with
the 1/0 units on the other.

To segment networks, start by assigning a secondary IP address to the controller in PAC Manager,
following instructions in Opto 22 form 1704, the PAC Manager User’s Guide. The secondary IP address
is used for communication through the controller's Ethernet 2 interface. Remember that this
interface must be on a completely separate network segment.

You don't need to do anything special in PAC Control. Configure only one control engine, using the
[P address of the Ethernet interface to be used for host communication. The control engine will
direct communication to /0 units through the other interface, based upon the I/0 unit’s IP address.
The IP addresses of the I/0 units must be compatible with the secondary IP address of the controller.

NOTE: PAC Display Basic and other hosts on the company network cannot communicate with I/0 units
when they are on a separate network. To solve this problem, you can purchase PAC Project Professional, or
PAC Display Professional and OptoOPCServer (version 7.0 and newer) separately; these applications
support network segmenting by communicating with 1/0 units through the controller. Also, you can add
a second network interface card (NIC) and assign it an IP address compatible with the I/O unit network.

Using Ethernet Link Redundancy in PAC Control

Ethernet link redundancy provides a backup network connection in case the primary connection
route becomes unavailable. If that happens, the controller uses a secondary communication route.

There are two types of link redundancy in PAC Project, which you can use individually or combined:

«  Controller to I/0: When link redundancy is configured from the controller to /0, if
communication to the primary 1/0 unit IP address fails, communication switches automatically
to the secondary I/0 unit IP address, which usually is the second Ethernet network interface on
a SNAP PAC R-series controller. See “Commands for Ethernet Link Redundancy”on page 315 for
more information on primary and secondary /0 units.

SNAP PAC S-series

NOTE: If your system has redundant controllers, in order to use link redundancy from the controller to
the I/0, you must connect ETHERNET 2 on the controllers and on the I/0 units to the same switch. No
other devices can be connected to that switch.

«  PACDisplay Pro to controller: When a PAC Display Professional project is installed on a PC
with two network interface cards (NICs), the project can be configured to use the primary and
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secondary IP addresses to access data from the PAC Control strategy running on the control
engine. One address is always active. If the primary address is unavailable, then the secondary
address becomes the active address, and the PAC Display scanner automatically shifts to the
secondary address. If the secondary address fails, then the primary address becomes the active
address and automatically tries the primary address again. For details, see form 1702, the PAC
Display User’s Guide.

PC with two NICs = = - | PC with two NICs
running PAC Display Pro  [[#&5 running OptoOPCServer

» L]

"E I IﬁLIL = Py

~

SNAP PAC S-series

NOTE: Ifyour system has redundant controllers, you cannot use link redundancy between PAC Display
Pro and the controller. For more information on using redundant controllers, see Opto 22 form 1831,
the SNAP PAC Redundancy Option User's Guide.

System Architecture for Ethernet Link Redundancy

Pro

As shown in the examples below, you can set up your system in several ways to take advantage of
the link redundancy capability in PAC Control. For additional information, see the SNAP PAC
controllers'user’s guides. For details on how PAC Display works with link redundancy, see form 1702,
the PAC Display User’s Guide.

Using a SoftPAC Controller. In examples 1 and 2 below, the PAC S-series controller can be
replaced by a SoftPAC controller. The PC running SoftPAC must have two network interface cards
(NICs) configured with static primary and secondary IP addresses on different subnets.

Example 1: Ethernet Link Redundancy

In this example, the primary concern is that the Ethernet network may need maintenance or may
fail, leaving the computer running PAC Display Professional, the computer running the
OptoOPCServer (as the PAC Display scanner), the controller, and the I/0 units unable to
communicate.

The solution is to connect all these devices on two networks; if one network goes down, devices can
communicate on the other. Note that each computer has two network interface cards (NICs). I/0
units are controlled by the controller. Each I/0 unit is connected to its own group of sensors and
actuators, but all are connected to the same two networks.

If one network needs maintenance, for example to replace a switch, you can safely shut it down
using the Set Target Address commands in PAC Control and options in PAC Display Professional.
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PC with two NICs PC with two NICs Opto 22 Redundant Network
running PAC Display Pro running PAC Display Pro
— =

CORE | ooRe
PAC Display

PAC Display

1

- — = |PCwith two NICs
Ethernet switch, — running OptoOPCServer Ethernet switch,

network #1 — T * (as PAC Display scanner) network #2

1l

:_,'H'.‘z

! I: SNAP PAC S-series controller
‘8 controlsall /O units

SNAP PAC R-series

SNAP PAC R-series

- i _____""'-\ = - ~ -_""--..\_
~~Sensors and ’ ~~Sensors and actuators, J
\._actuators, location #1 *_location #2 j

Example 2: Ethernet Link, Computer, and Software Redundancy

The second example of link redundancy illustrates concern not only about the stability of the
Ethernet network, but also about the computers and the software run on them. Any of these
things—the network, a computer, or the OptoOPCServer or PAC Display Professional software
running on the computer—may need maintenance or may fail.

The solution here is to provide duplicate computers and software, and connect all devices on two
networks. Each computer has two NICs. /0 units are all controlled by the controller. Each I/O unit is
connected to its own group of sensors and actuators, but both are connected to the same two
networks.

For more information on using Ethernet link redundancy with PAC Display, see form 1702, the PAC
Display User’s Guide.
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I_ Opto 22 Redundant Network

Two PCs, each with two NICs
running PAC Display Pro

Two PCs, each with two NICs running
OptoOPCServer (as PAC Display scanner)

N *

i | Wl 2

Ethernet switch, ILIJF ™ SNAP PAC S-series controller

SNAP PAC R-series

. i - EEEAI!EIHH
Sensors and actuators,
location #1

SNAP PAC R-series

|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
: network #1 \E ;o | controls all 1/0 units
|
|
|
|
|
|
|
|
|
|
|
|
|
|
I
|
|

Sensors and actuators,
location #2

Example 3: Ethernet Link Redundancy with Serial 1/0 Units

Ethernet switch,

|
[
|
[
[
[
|
|
|
[
|
[
|
[
|
[
|
|
network #2 |
[
[
[
|
|
[
|
|
[
|
[
[
[
|
|
|
|
[
|

This third example of link redundancy shows a SNAP PAC S-series controller with serial I/0 units. The
redundancy is in the Ethernet networks between the controller and computers running PAC Display
Professional and OptoOPCServer. This example provides link redundancy for the Ethernet network.

Again, note that the computers all have two NICs.
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Opto 22 Redundant Network

PC with two NICs running PCwith two NICs running
PAC Display Pro PAC Display Pro
PAC Display PAC Display = |

PCs, with two NICs running |
OptoOPCServer (as PAC Display scanner)

Ethernet switch, ﬁ e Ethernet switch,
network #1 mRESl network #2

éNAP PAC S—séries controller
controls all 1/0 units '

,.____________.____

“Sensorsand actuators,” J
\_location #1

ensorsandactuators J I_ Sensorsandactuators J

Iocatlon #2 \ Iocatlon #3

@ Configuring Ethernet Link Redundancy

Ethernet link redundancy from PAC Display Pro to a control engine is easy to configure. First, make
sure the secondary IP address has been assigned to the controller in PAC Manager. Then in PAC
Control, just enter both the primary and secondary IP addresses when you configure the control
engine (see page 99). Once you have set up link redundancy for the control engine you are using in
your PAC Control strategy, it works automatically in PAC Display.

To configure link redundancy from the control engine to I/0 units, enter both the primary and
secondary IP addresses when you configure the I/0 unit (see “Adding an I/0 Unit”on page 126).
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Using Strategies with Link Redundancy

Although PAC Display and OptoOPCServer (as the PAC Display Pro scanner) automatically shift to the
secondary address when the primary address is not available, the PAC Control debugger does not. In
PAC Control, you control which address receives communication, so you know exactly how
communication is occurring during debugging. To change between primary and secondary control
engine addresses, follow the steps in “Changing the Control Engine that Receives the Downloaded
Strategy”on page 110.

Once you have changed the address, when you enter Debug mode, you are communicating
through the address you chose. Downloading the strategy to a SNAP PAC controller through one of
its Ethernet interfaces replaces any strategy that was downloaded earlier through its other interface.

Using Redundant Controllers

The SNAP PAC Redundancy Option allows you to configure two redundant SNAP-PAC-S controllers
that use the same PAC Control strategy. By utilizing sync blocks in the strategy and
persistent/redundant variables, critical data is synchronized in both controllers so that the inactive
controller can take over at any time and become the active controller. To learn more about the SNAP
PAC Redundancy Option and how to set up a strategy using sync blocks and persistent/redundant
variables, see Opto 22 form 1831, the SNAP PAC Redundancy Option User’s Guide.

NOTE: If your system has redundant controllers, you cannot use link redundancy between PAC Display Pro
and the controller.

Changing or Deleting a Control Engine

See the following topics to change or delete a control engine:

«  “Changing a Control Engine’s Definition” (below)

»  "Changing the Control Engine that Receives the Downloaded Strategy”on page 110
«  “Removing a Control Engine’s Association with a Strategy”on page 110

+  "Deleting a Control Engine from Your PC"on page 110

Changing a Control Engine’s Definition

Whenever necessary, you can change a control engine’s definition on your PC—its name, the port
the PC uses to communicate with it, or the PC port setup (such as timeouts and retries). These
changes can be made either in PAC Control or in PAC Terminal.

1. Choose one of the following:

- InPAC Control: With the strategy open in Configure mode or Online mode, right-click the
control engine name on the Strategy Tree and choose Madify from the pop-up menu.

- InPAC Terminal: From the PAC Terminal menu bar, click Configure > Control Engine.

The Select Control Engine dialog box appears.
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2. Inthe Select Control Engine dialog box, click the control engine you want to change and click
Modify.

3. Make the necessary changes, following the same steps you would for configuring the control
engine initially. (For help, see “Defining a Control Engine on Your PC"on page 100.)

Changing the Control Engine that Receives the Downloaded
Strategy

You can configure several control engines for a strategy, but only one at a time can receive the
downloaded strategy. The control engine that receives the strategy is called the active engine.

NOTE: In PAC Control Professional, you can also configure a control engine for Ethernet link redundancy
(see “Using Ethernet Link Redundancy in PAC Control” on page 104 for more information). In this case, you
can also choose whether the primary or secondary IP address will receive the strategy.

To change the control engine that receives the downloaded strategy, follow these steps:
1. Make sure the strategy is open and in Configure or Online mode.

2. Onthe Strategy Tree, right-click the name of the control engine you want to set as the active
engine.

If its name does not appear in the Strategy Tree, follow the steps in “Configuring Control
Engines”on page 99.

3. From the pop-up menu, choose Set Active.
The active engine moves to the top of the list in the Strategy Tree.

4. Ifthe control engine is configured for Ethernet link redundancy, right-click the name of the
control engine on the Strategy Tree again. From the pop-up menu, choose Use Primary IP
Address or Use Secondary IP Address.

Removing a Control Engine’s Association with a Strategy

If you no longer want to use a control engine with a strategy, you can remove its association with
the strategy. This action does not delete the control engine’s definition on your PC.

CAUTION: Do not delete the control engine from within the Select Control Engine dialog box. Doing so
will delete it from the PC as well as the strategy.

1. Make sure the strategy is open in Configure mode or Online mode.

2. On the Strategy Tree, right-click the name of the control engine you want to remove. From the
pop-up menu, choose Delete.

The control engine is no longer associated with your strategy.

Deleting a Control Engine from Your PC

If you are sure that a control engine will no longer be used with your PC, you can delete it using
PAC Terminal. Deleting the control engine removes its definition only on the PC you are using.
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1. Start PACTerminal as follows:

- InWindows 7 and Windows Vista, press the Windows Start key (&) and then click

Programs > Opto 22 > PAC Project 9.6 > Tools > PAC Terminal.

— InWindows 10 and Windows 8.1, press the Windows Start key (&)
9.6 and then press the Enter key.

type PAC Terminal

2. Right-click the name of the control engine in the list.

CAUTION: Make sure you are highlighting the right one. You cannot undo a deletion.

3. From the pop-up menu, choose Delete.
The control engine is no longer defined on the PC.

Inspecting Control Engines and the Queue

You may want to inspect or change control engines while you are running the strategy in Debug
mode. See the following topics to view control engine information and the engine’s message
queue, either from PAC Control in Debug mode or from PAC Terminal:

«  “Inspecting Control Engines in Debug Mode" (below)
«  “Viewing the Message Queue”on page 113
«  “Inspecting Control Engines from PAC Terminal”on page 116

Inspecting Control Engines in Debug Mode

With the strategy running in Debug mode, choose Control Engine > Inspect.

You can also double-click the active engine (the first one under the Control Engines folder) on the
Strategy Tree, or right-click the control engine and choose Inspect from the pop-up menu.

The Inspecting dialog box opens.
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Inspecting: Cookie Controller,

A ==— Control Engine: SHAP-PAC-RZ at 10.192.54.115
B Firmware Yersion: RE3a [1223:25 September 18, 2008 )
C Volatile BAM: 4.33 MB free

Battery-backed BAM: 102396 KB free

File Storage RAM: 1.90 MB free
D Up Time: 12 days. 19 hours, 27 minutes, 25 seconds
E Device Time: 12:2359 June 22, 2009 Sync time ta PC —F
G Message Queue: 0 mezzages
H Strategy information

Active: Cookies  [17:33:19 June 17,2009
5 chart(z) running Archive: Mo |
J |  Run | @ Stop B Store to Flash /K
L Alternate: Mot Enabled /
M
tored in Flash: A strategy iz stored in Hash memaory
N 5 d in Flash: & i d in flash
O—— Autorun: () Enabled (%) Disabled
Communication

P Loop Time: 759 mzec
Q Comm Errors: Mone

Cloze

112 PAC Control U

Here you see data relating to the control engine. If you are using Ethernet link redundancy in PAC
Control Professional, remember that the information shown is for the IP address you chose before
entering Debug mode. (See “Using Strategies with Link Redundancy”on page 109 for more
information.)

A—Control Engine. Type of device the control engine is running on and the device's IP address.

B—Firmware Version. Version number of the firmware (kernel) loaded on the device, and the
date the firmware was released.

C—Memory Available. Amount of memory (RAM) available on the control engine. For
example, a SNAP R-series controller has a total of 16 MB of RAM on the control side, 2 MB of which is
battery-backed. Volatile RAM shows the amount of total RAM available for use. Battery-backed RAM
shows the amount available in battery-backed RAM, where persistent variables, variables initialized
on download, the autorun flag, and the strategy archive are stored. File Storage RAM shows the
space available in the control engine’s file system See the PAC Manager User’s Guide for more
information about the file system. See also form 1646, the SNAP PAC Memory Usage Technical Note.

D—Up Time. Total time that the control engine has been running since powerup.

E—Device Time. Current date and time recorded on the control engine.
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F—Sync time to PC. Click to synchronize the control engine’s time and date to that of the PC
running PAC Control.

G—Message Queue. Number of messages (information, warning, and error messages)
encountered when attempting to run the strategy on the control engine (up to a maximum of 1000
messages). (See "Viewing the Message Queue”below.) Click to open the View Messages dialog box,
listing the details of any information, warning, or error messages.

H—Active. Name of the strategy currently running on the control engine, the date and time it was
downloaded, and the number of charts currently running.

I—Archive. Information about the strategy currently archived on the control engine.
J—Run/Stop. Start or stop the active strategy.

K—Store to Flash. Click to store either the active or alternate strategy to flash memory. Only one
strategy at a time can be stored in flash memory. This button is enabled if there is a strategy stored in
RAM, even if the strategy is currently stored in flash. See Burned in flash (N) on this dialog box.
L—Alternate. Name of the alternate strategy, and the date and time it was downloaded.
M—Switch and Run/Switch. Click Switch and Run to make the alternate strategy the active
strategy and run it in the control engine. Click Switch to make the alternate strategy the active
strategy without running it.

N—Stored in flash. Shows whether a strategy is currently stored in flash memory.
O—Autorun. Click to indicate whether the strategy should automatically run when the control
engine is restarted. The strategy must be stored to flash to autorun. See Store to Flash (above) and

“Saving a Strategy to Flash”on page 178.

P—Loop Time. Time required to gather the inspection data from the control engine (the average
time taken for a single transaction).

Q—Comm Errors. Any communication errors.

Viewing the Message Queue

The message queue holds error, information, and warning messages. All may be helpful in
troubleshooting. When a message is placed in the queue, a blue INFO, yellow WARNING, or red
ERROR box appears in the PAC Control status bar, as shown in the following diagram.
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To see the message queue:
1. Click the INFO, WARNING, or ERROR box.

# Yiew Message Queue for “"Cookie Controller*

Messages have been placed in the queue.

“ZyRefresh _-ﬁCnpy all ETPDD Top Message X Clear all Messages

# Code | Sewerity

o -4 Irfo

1 -35 W arning
2 -3 W arning
3 35 W arning
4 700 Warning
A 13 Errar

E 13 Errar

Degcription

Device haz powered up. [Powerup clear e..
1/0 paint mizmatch: a configured paint doe. ..
1/0 paint mizmatch: a configured paint doe...
1/0 paint mizmatch: a configured paint doe. ..

FID Loop O haz been configured outside of ..

Overflow ermor.
Overflow ermor.

Murmber of meszages: 12

Chart

<aystem: _IMIT ..
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|

2. Tosee all the information in the column, drag the edge of a column heading.

3. Tosee all of the information for one message, double-click the message.
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4, Torefresh the display with the latest messages, click Refresh.

5. Tocopy all messages in table format for transfer to another program such as Excel, click Copy
All.

6. Todelete the top (oldest) message on the list, click Pop Top Message.
7. Todelete all messages, click Clear Messages.
8. (lose the dialog box to return to the Inspect Control Engine dialog box.

Any changes you have made to the queue are reflected there.

Message Queue Information

Fach message in the View Messages dialog box includes the following information:

Code. The message or error code number (see “List of Common Messages” on page 399) or User if
the message was placed in the queue using the command Add Message to Queue.

Severity. Information, Warning, or Error.

Chart and Block. The chart and block being executed when the error occurred. If the error
occurred someplace outside the strategy, for example when trying to connect to an I/0 unit, Chart
shows <system>. If the error occurred in a subroutine, Chart shows the chart that called the
subroutine, and Block indicates the name of the subroutine plus the block number in the format
<sub name>.<block number>.Forexample, error #4 above (“Cannot divide by zero”) occurred in
block 1 of the subroutine Variable_Increase_Notification, which was called by the
Temperature_Control chart.

Line. If you are in Full Debug mode, the line being executed when the error occurred.
Object. The table, I/0 unit, or other object affected by the message. In errors #1 and #2 above, the
control engine was unable to communicate with /0 unit EIO_C. The unit’s IP address is shown for

easy reference.

Time and Date. \When the error occurred.
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Inspecting Control Engines from PAC Terminal

You can also inspect control engines from PAC Terminal.
1. If PACTerminal isnt running, start it as follows:

In Windows 7 and Windows Vista, press the Windows Start key '@—"’ and then click

Programs > Opto 22 > PAC Project 9.6 > Tools > PAC Terminal.

In Windows 10 and Windows 8.1, press the Windows Start key @3' type PAC Terminal

9.6 and then press the Enter key.

The PAC Terminal window appears.

o .
- PAC Terminal - 0 IEl
File Tools Configure View Help
Control Engines:
Controller I:Jame System Type Address 1 Address 2 Status
$¥ Cookie Controller  Standard ¥127.0.0.1 &
$¥R1 Controller Standard v10.195.55.111
Status Scan
%, Scan Al
“%, Scan Selected
< >

2. Double-click the control engine you want to see (or right-click it and choose Status from the
pop-Up Menu).

The Inspect Control Engine dialog box appears. The dialog box is explained on page 111,

Archiving Strategies on the Control Engine

Archiving strategies on the control engine provides a backup in case original strategy files on the
computer are lost. When you archive a strategy to the control engine on an Opto 22 controller, a
Zipped file is saved in battery-backed RAM. On a SoftPAC controller, a zipped file is saved on the PC's
hard drive. In either case, if power to the control engine is lost, the archive is still there.

We recommend you archive both to the computer (during strategy development) and to the
control engine (when the strategy is completed). Archiving to the control engine as well as the
computer makes sure that an older strategy can always be found and updated, even after personnel
changes occur and years pass. See also, “Archiving Strategies on the Computer”on page 179.

Archive files are date and time stamped, and zipped for compact storage. The archive file name on
the control engine is in one of the following formats:

Path\Filename.Download.D02282000.1114351 zip
Path\Filename.Online.D02282000.T114351.zip

116 PAC Control User's Guide



CHAPTER 5: WORKING WITH CONTROL ENGINES

The date stamp (D) is in the format mm/dd/yyyy. In the examples above, the date is February 28,
2000. The time stamp (T) is in the format hh/mm/ss. In the examples above, the time is 51 seconds

past 11:43 AM.

Make sure the control engine has sufficient memory available to store the archive file. Since only one
strategy at a time can be on the control engine, only the latest archive for that strategy is on the
control engine. Other archives are erased during strategy download.

In addition to the archived strategy, the archive file also stores persistent variables and variables that

are initialized on strategy download.

To archive a strategy to the control engine:
1. In PAC Control, choose File > Strategy Options.

Strategy Options

Archive | Download | Legacy | Serial |40 Ports

X

[ Auchive strateqy to disk when strategy is downloaded

[ 0k H Cancel ][

Help ]

2. Onthe Archive tab in the Strategy Options dialog box, select “Archive strategy to disk when
strategy is downloaded” Also select “During download, save archive to the control engine and

save strategy to flash memory.”

Strategy Options

Archive |Download Legacy | Serial 1/0 Ports

[ &rchive strategy to disk when strategy is closed
Archive strategy to dizk when strategy i downloaded

Ok H Cancel H

Help

3. (ickOK.

The strategy will be archived to the computer and to the control engine when it is
downloaded. Any archive already on the control engine will be replaced by the new archive. In
addition, the strategy will be saved to flash memory, so it will still be available if power to the

controller is turned off.
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Restoring Archived Strategies from the Control Engine

If original strategy files are lost or damaged, you can use PAC Terminal to restore the strategy archive
from the control engine to a computer.

If PAC Terminal isn't already open, start it as follows:

- InWindows 7 and Windows Vista, press the Windows Start key E and then click
Programs > Opto 22 > PAC Project 9.6 > Tools > PAC Terminal.

- InWindows 10 and Windows 8.1, press the Windows Start key E type PAC Terminal
9.6 and then press the Enter key.

The PAC Terminal window appears.

File Tools Configure View Help

Control Engines:
Controller Name System Type Address 1 Address 2 Status Configure Control Engines
$§ Cookie Controller  Standard v127.0.0.1 * 1€ i
$¥'R1 Controller Standard v10.195.55.111 #§
Status Scan

2 sanal

“2, Scan Selected
< >

Right-click the control engine and choose Upload > Strategy Archive from the pop-up menu.

In the Save PAC Control Strategy Archive As dialog box, navigate to the folder where you want
to save the archive file. Keep the file name as it is, so you can see the date and time it was
originally downloaded to the control engine. Click Save.

A dialog box shows progress as the archive file is uploaded to the computer.

Navigate to the zipped archive file. Assuming you are using WinZip, double-click the file name.
Highlight all files and click Extract. Extract them to the location you want.

When all files are extracted, double-click the .idb file to open the strategy. If necessary, re-link
subroutines and files run before or after a strategy.

Re-linking may be necessary because the directory structure in the zip file may not match what
was originally on the computer. The zip file structure is as follows:

Root (.idb, chart files, .inf)
Subroutines
Control engine files
Control_Engine_Name_1
Before run file
After run file
Control_Engine_Name_2
Etc.
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Moving Control Engines from One PC to Another

Sometimes it's necessary to transfer a strategy to another computer, such as when the computer has
to be replaced, or when another PC will be used to run the control application. Instead of typing in
each control engine on the new computer, you can open the ControllerNames.ini text file and
merge the control engine names from a source PC with those on a target PC.

NOTE 1: Use this procedure only if you have PAC Control version R9.4a or newer. For versions prior to R9.4a,
see the OptoKnowledgeBase article KB80603 on the Opto 22 website, http.//opto22.com. However, the
best method is to install the newest software and use the method described here.

NOTE 2: When PAC Control version R9.4a or newer is first used, it automatically migrates the control engine
definitions from older versions. If you then use an older version of PAC Control to add another control
engine, the new control engine will not automatically be available in the R9.4 or newer version, because it
checks the older versions of control engine definitions only the first time it is run.

To move all the control engines from a source PC to a target PC:
1. Onthe source PC, locate the Controller.ini file. This file can be found in the following location:

C:\ProgramData\Opto 22\PAC Project\ControllerNames.ini

2. Send the file by email or other means so that it can be opened on the target PC.

3. On the target PC, open the ControllerNames.ini files for the source and target PCs with a text
editor such Notepad.

Source
&

File Edit Format View Help

R2 Control Engine 9.0.0.0 10.195.55.112
R1 Control Engine 9.0.0.0 10.195.55.111
Cookie Controller 9.0.0.0 127.0.0.1

File Edit Format View Help

S2-M Control Engine 9.0.0.0 10.195.56.102
S1-M Control Engine 9.0.0.0 10.195.56.101

4. Copy the list of control engines from the source PC file and paste them to the end of the list of
control engines in the target PC file.
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Target and Source merged on target PC
E “ontrollerNames.in
File Edit Format View Help
S2-M Control Engine 9.0 10.195.56

9.0.
S1-M Control Engine 9.0.0.0 10.195.56
R2 Control Engine 9.0.0.0 10.195.55
9.0.
0.0.

2.0 10.195.55
2.0 127.0.0.1

R1 Control Engine
Cookie Controller

<

5. Save the target ControllerNames.ini file on the target PC before closing it.
All of the control engines in the merged file will now be available in PAC Control.

Downloading Files Using PAC Terminal

Using PAC Terminal, you can download PAC Control strategies or Forth files related to the strategy,
such as library or initialization files, directly to a control engine, without having to open each
program.

For information on using the brain’s file system to store data and manipulate it within your strategy,
see "Using the Control Engine’s File System” on page 284.

NOTE: Ifyou are downloading a PAC Control strategy that requires other files, be sure to download the files
in the correct order (for example, library file, then strateqy file, then initialization file). If you need to set
initial values for individual table elements on strategy download only, see “Setting Initial Values in
Variables and Tables During Strateqy Download” on page 244.

1. If PACTerminal isn't already open, start it as follows:

- InWindows 7 and Windows Vista, press the Windows Start key E and then click
Programs > Opto 22 > PAC Project 9.6 > Tools > PAC Terminal.

- InWindows 10 and Windows 8.1, press the Windows Start key E type PAC Terminal
9.6 and then press the Enter key.

The PAC Terminal window appears.
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Eile Tools Configure View Help
Control Engines:

Controller Name System Type Address 1 Address 2 Status
4§ Cookie Controller ~ Standard v127.0.0.1 *»
#R1 Controlier Standard 410.195.55.111 %

Right-click the control engine and choose Download > Forth File from the pop-up menu.

In the Download File dialog box, click Browse.

In the Open dialog box, locate the file you want to download. When the full path appears,
click OK.

If necessary to find the file, choose All Files from the Files of Type drop-down menu.

The download begins, and a dialog box shows its progress.
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Introduction

In addition to configuring a control engine to run your strategy, you also need to configure
input/output hardware to do the work: turning things on, setting temperatures, monitoring
controls, and so on.

This chapter shows you how to configure and work with I/0 units, 1/0 points, and PID loops.

In this Chapter

Choosing a Configuration Tool
Adding an I/0 Unit........

AAAING 1/0 POINTS oeeereeerseeeeesieesseessssesssssess s sssssssssse s sssss s

Configuring a Serial Module...... . . . . . . . 140
Changing I/0 Unit and Point CONfIGUIAtioN .......c.ceeeereeesseeensseeesseesss e 140
Configuring PID Loops. . . . . . . . . 146
Inspecting I/0 in Debug Mode...... . . . . . . 152
Inspecting and TUNING PID LOOPS w....vvvvvcevrveescsseessssssees s ssssssesssssssessssssssessssssseesios 158
Using Watch Windows for Monitoring..... . . . . . 169

Choosing a Configuration Tool

Configuring I/0 is one of your major planning steps in developing a PAC Control strategy. Generally
it's best to configure all /0 units, points, and PID loops at once, before you start building flowcharts.

There are two tools you can use for configuration: PAC Control and PAC Manager. These two tools
serve different purposes, but they overlap when it comes to configuring I/0. The image on the next
page compares their functions.
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PAC Manager Tasks |
‘ ‘ PAC Control Tasks

Assign and change——) Conflgure /0 —Configure —j Programand
IP ad('jress a 110 Unit control engine debug
Load firmware [} A UI0_Staton_ (So PC running PAC control logic
Configure communications ; Coil e
and events E!G Ponts communicate with

T the SNAP controller)

i
I/0 can be configured in PAC Control.

Ethernet-based 1/0 can also be configured in
PAC Manager and imported into PAC Control.

/0 units and points must be configured to match the PAC Control strategy you will run. You can
configure most I/0 units and point functions either in PAC Control or in PAC Manager.

For most I/0 units, if you are already in PAC Control, configuration is easier there and you can use the
loopback IP address forSNAP PAC R-series /0 units controlling themselves. However, some functions
for 1/0 units cannot be configured in PAC Control.

If you use PAC Manager, you can save your configuration to afile, load it to multiple I/0 units at
once, and use it for referencing points in OPC. However, you cannot use the loopback address in PAC
Manager.

Choose your configuration tool based on what you need to do:

Use PAC Control for I/O configuration if Use PAC Manager for I/0 configuration if

You have only one I/O unit or I/O unit * You have multiple 1/0 units whose
configurations are different. configurations are exactly the same or similar.

» The strategy will run on SNAP PAC R-seriesl/O | * You are using a modem connection (PPP) or
units that are controlling themselves using the SNMP.
loopback IP address, 127.0.0.1 » You are using event messages or email.

* You are using an Ethernet network for « You are configuring events and reactions on the
communications (or using a SNAP PAC I/0O unit in addition to strategy logic.
controller with an SB brain). + You are not using PAC Control.

» The strategy handles all logic; you are not also
configuring events and reactions on 1/O units.

Whichever tool you use for configuring I/0, be aware of the impact if you later change configuration.
For example, if you configure I/0 in PAC Manager, download the configuration file to I/O units, and
then later add a point in PAC Control, remember that your configuration file doesn’t contain that
point.

If you use PAC Manager, follow instructions in Opto 22 form 1704, the PAC Manager User’s Guide.
When you have finished configuration and saved the configuration file, you can import it into PAC
Control following the steps in “Importing 1/0 Configuration into PAC Control”below.

If you use PAC Control, follow the steps beginning with “Adding an I/0 Unit"on page 126.
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Importing I/0 Configuration into PAC Control

If you have configured all I/O units, points, and PID loops in PAC Manager, follow these steps to
import the configuration file into a PAC Control strategy.

1. Open the strategy in PAC Control. In the Strategy Tree, right-click the I/O units folder. From the
pop-up menu, choose Import.

2. Navigate to the configuration file you created and saved in PAC Manager. Double-click it to
open it.
The configuration information is imported. You can expand the I/0 units folder to see the
imported units and their points.

If you need to configure additional I/0 units from within PAC Control, see “Adding an I/0 Unit”
on page 126.To tune PID loops, see “Inspecting and Tuning PID Loops”on page 158.

Copying I/0 Configurations

If you have two strategies that use similar I/0 units and points, you can export an I/0 configuration
from one strategy into a file, and then import it into the other strategy.

If you need similar configurations for several I/0 units, you can use PAC Manager to send it to
multiple 1/0 units at once. (You cannot use PAC Manager for serial-based /0 units.) For more
information on using PAC Manager, see Opto 22 form 1704, the PAC Manager User’s Guide.

Creating the Configuration Export File

1. Open the strategy you are copying from in PAC Control. In the Strategy Tree, right-click the 1/O
Units folder and choose Export from the pop-up menu.
The Export I/0 Units to an Opto Tag Database dialog box appears.

2. Navigate to the location where you want to place the export file. Type the file name, and click
Save.

The export file is created. It is a comma-delimited ASClI file. If you wish, you can open it in
Notepad or Excel.

Importing the Configuration File

When you import the I/0 configuration file, it does not delete any I/O units or points that are already
there. If the import file contains I/O units with the same names as those already in the strategy, you
can choose whether to update them. Updating changes points that have the same name and adds
new points, but does not delete points.

1. Open the strategy into which you want to import the I/O configuration.
2. Inthe Strategy Tree, right-click I/0 Units and choose Import from the pop-up menu.
3. Navigate to the location of the export file you created. Highlight its name and click Open.

The I/0 units and points are updated from the configuration file. To see them, click the plus sign
next to the I/O Units folder on the Strategy Tree.

E1and E21/0 units hold up to 16 points of digital (E1) or analog (E2) 1/0.
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Adding an I/0O Unit

In PAC Control, the term /O unit usually refers to a mounting rack with a brain or brain board and up
to 16 1/0 modules attached.

NOTE: If you have already configured I/0 in PAC Manager, you can also add I/0 units or points if necessary
from within PAC Control, as you add commands to the blocks in your strategy.

To enable legacy I/0 units in PAC Control for a specific strategy, see “Legacy Options”on page 211.

1. Make sure the strategy is open and in Configure mode. On the Strategy Tree, double-click the

I/0 Units folder.

You can also select Configure > I/0.

The Configure I/0 Units dialog box opens, showing all configured 1/0 units.

ﬁ Cenfigure |/O Units

Part

refcC...
2

Description

Close | Help

Add...
Modify...
Delete
IjO Points...
PID Loops...

Event/Reactions...

2. To configure a new I/0 unit, click Add or double-click anywhere in the box below any listed

units.
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The Add I/0 Unit dialog box appears.

& Add 1/0 Unit 4
Informatior
A — 1 Mame: | | |
B — | Description: | |
Type —
C—— Type |5NAP-PAC-R1 v|
Addressing
D——F— Frimary Address: B s0e 0 -0 [JLocal loopback)
E —— Secondary Address: [ e
F —— EthernetPort: 2001

Communication from control

G — o Enable communications from control engine

H ——— Timeout and disable communications after tries of III second(s) each.

Device Options —

For temperature points, use degreet () Fahrenheit  (®) Celsius

J—m— [Jwatchdog timeout after | 0.5 second(s) of no communications

Gl | [

3. Complete the fields as described in “Add 1/0 Unit Dialog Box" below.

Add I/0 Unit Dialog Box

Use this dialog box to add a new I/0 unit to the strategy or edit an existing unit.

For information on saving the 1/0 Unit Configuration, see “Inspecting I/0 Units and Saving Settings
to Flash”on page 153.

A—Name. Enter a name for the I/0 unit. The name must start with a letter and may contain
letters, numbers, and underscores. (Spaces are converted to underscores.)

B—Description. (Optional) Enter a description of the unit.

C—Type. When adding an I/0 unit, select the type of I/O unit from the drop-down list. When
upgrading an older I/0 unit to a SNAP PAC brain, possible upgrades are available in the drop-down
list.

D—Primary Address. For Ethernet I/0 units, type the IP address of the brain attached to the I/0
unit. If the unit is local (the same SNAP PAC brain on which the strategy will run), select Local
(loopback). This sets the address to a loopback address, 127.0.0.1. This tells the brain to talk to
itself, so if you change the brain’s IP address, you don't have to change the address for the I/0 unit.

For serial units, type the unit’s address (valid range is 0-255).
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E—Secondary Address. (Optional, Pro only, Ethernet-based I/0 units only) To designate a
secondary I/0 unit for communication if this I/0 unit is unavailable, enter the secondary unit's IP
address. Note that both I/0 units use the same port number.

F—Port. For Ethernet-based I/0 units, communication with the control engine is Ethernet, and the
default port number is 2001. If you have changed this port for security purposes, also change it here.
(See the controller's user guide for details.)

For serial-based I/0 units, the communication port and parameters are shown for you. binary/CRC
settings on your hardware are required. For more information, see “Changing the Baud Rate for
Serial I/0 Units”

G—Enable Communications. Select whether you want communication to the I/0 unit
enabled or disabled on startup. Enabled is the default. Disabling communication to an I/O unit is the
same as disabling communication to all points on the unit.

H—Timeout. Enter the number of times the control engine should try to communicate with the
I/0 unit, and enter the length of time the control engine should wait for a response when
communicating with this I/0 unit. If after the first communication attempt there is no response
within the timeout period, the control engine retransmits. If there is no response within the timeout
period, it transmits again. This repeats according to the number of tries specified. If no response is
received within the final timeout period, communication to the I/O unit is disabled. The default
number of tries is 3. The default timeout period is 1 second.

In most cases, it is a good idea to start with the default values and only make changes if your system
has problems using the defaults.

CAUTION: If the timeout is long and the I/0 unit is turned off or unreachable, the control engine could
take quite a while to execute a command that talks to I/0. See also, “Tuning the I/O Unit Timeout Value for
Ethernet I/0 Units” on page 130.

I—Fahrenheit/Celsius. (Analog and Mixed units only) Choose whether temperatures will be
handled in Fahrenheit or Celsius.

J—Watchdog. Select whether you want a Watchdog on the unit (not available on remote simple
I/0 units). The default is No (disabled). If you select Yes, a new field appears; enter the Watchdog
timeout value (in seconds). The default timeout is 0.5 seconds.

With a Watchdog, the 1/0 unit monitors activity on the port. If no communication is received for the
specified interval, the unit assumes a Watchdog state. All selected outputs will then immediately go
to a specified value, as configured in the Watchdog field of the Add Analog Point or Add Digital
Point dialog boxes. (See “Adding 1/0 Points”on page 132.)

K—Maximum Analog and High-Density Digital Scantime. (Ethernet-based I/0 units
only) You can decrease the analog and high-density digital scan time to make sure the scanner isn't
slowed or stopped by heavy communication on the network. The Default is 1000 msec. This feature
is also available in PAC Manager where you can fine tune the scan time on the fly.

NOTE: Digital Scantime applies only to non-PAC I/0 units. PAC I/O units use Digital feature Resolution
Value instead.
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For more information on optimizing scanner performance, see “Optimizing Throughput”on
page 97 in this guide.

Changing the Baud Rate for Serial I/0 Units

NOTE: This section is for PAC Control Basic users. If you have the Pro version, see “Changing the Baud Rate
and Mode for Serial I/O Units” on page 129.

If the default baud rate shown in the Add I/0 Unit dialog box is not correct, you can change it. This
baud rate is for communication through the RS-485 port to serial /0 units. It does not affect other
serial ports on the controller or communication handles using these ports.

NOTE: Once you have configured a serial port for use with an I/O unit, do not configure a communication
handle on the same port.

1. Make sure the strategy is open and in Configure mode.
2, Choose File > Strategy Options, then click the Serial I/O Ports tab.

Strategy Options *
Archive Download ~Serial I/O Ports  Legacy
The SMAP-PAC-51 and SNAP-PAC-52 controllers may use serial /0 units such as the SNAP-PAC-SB1.

The port type must first be set to R5-485, either by using default ports or by PAC Manager.

You must also corfigure which ports will be used for /0 within this strategy:

[ Port Ofor 140 with 115,200 baud (SNAP-PAC-52 only)
[ Port 1 for 140 with 115,200 baud (SNAP-PAC-52 only)
[ Port 2 for 140 with 115,200 baud (SNAP-PAC-52 or -51)
[ Port 3for 140 with 115,200 baud (SNAP-PAC-52 only)

Serial ports may also be used for communicating with other devices by using PAC Control
communication handles.

Cancel Help

3. Select the correct port for the controller, and then choose the correct baud rate from the
drop-down list and click OK.

NOTE: If you are configuring a SNAP-PAC-S1 controller you must use port 2. If you are using a
SNAP-PAC-S2, see Opto 22 form 1704, the PAC Manager User's Guide, for the default serial port
assignments or to change a serial port assignment.

Changing the Baud Rate and Mode for Serial /0 Units

This section is for PAC Control Professional users. If you have the Basic version, see “Changing the
Baud Rate for Serial I/0 Units”on page 129.

NOTE: Once you have configured a serial port for use with an I/0 unit, do not configure a communication
handle on the same port.
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If the default baud rate shown in the Add I/0 Unit dialog box is not correct, you can change it. This
baud rate is for communication through the RS-485 port to serial I/0 units. It does not affect other
serial ports on the controller or communication handles using these ports.

In addition you can also choose Binary or ASCI mode. The controller will talk to all 1/0 units on that
port in the same mode.

NOTE: There is no ASCll version of OptoMMP protocol (which is used on SNAP PAC SB brains), so if a port is
set to ASCII, you won't be able to mix mistic and SNAP PAC SB brains as you can in Binary mode.

1. Make sure the strategy is open and in Configure mode.
2, Choose File > Strategy Options, then click the Serial 1/0 Ports tab.

| Strategy Options *
| Archive Download Serial 10 Ports  Redundancy Legacy

The SMAP-PAC-51 and SNAP-PAC-52 controllers may use serial /0 units such as the B3000
or SNAP-PAC-5B1.

The port type must first be set to R5-485, either by using default ports or by PAC Manager.

You must also corfigure which ports will be used for /0 within this strategy:

[ Port Dfor 140 with 230,400 baud and  Binary mode (SMAP-PAC-52 only)
[ Port 1 for 140 with 230,400 baud and | Binary mode (SMAP-PAC-52 only)
[ Port 2for 140 with 230,400 baud and  Binary mode (SMAP-PAC-52 or-51)
[ Port 3for 140 with 230,400 baud and  Binary mode (SMAP-PAC-52 only)

Serial ports may also be used for communicating with other devices by using PAC Control
communication handles.

Cancel Help

3. Select the correct ports for the controller, and then choose the correct baud rate and mode
from the drop-down lists and click OK.

If you are configuring a SNAP-PAC-S1 controller, you must use port 2 for serial 1/0 units. If you
are using a SNAP-PAC-S2, see Opto 22 form 1704, the PAC Manager User’s Guide, for the default
serial port assignments or to change a serial port assignment.

In addition, make sure to jumper the non-SNAP PAC brain for the correct setting, either Binary
CRC (cyclic redundancy check) or ASCII CRC. Although at the brain level you can choose
Binary/ASCIl and CRC/Checksum independently, the Opto 22 drivers support only binary CRC
or ASCII CRC.

ASCII CRC is only for mistic brains. If a port is set for ASCIl but has a SNAP-PAC-SB1/2 on it, the
compiler will generate a warning.

Tuning the I/0 Unit Timeout Value for Ethernet I/0O Units
The default I/0 Unit timeout value is 1 second. However, for best overall performance you can tune
the value for your system.

A SNAP PAC controller automatically retries 2 times before disabling communication to an 1/0 unit
that is unresponsive, and it uses the same timeout value for the first attempt and the 2 retries. So,
with a 1 second timeout value and 2 retries, it takes 3 seconds before an unresponsive unit is taken
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offline. This means the chart or command that is trying to read or write to that I/O unit will be
delayed by 3 seconds.

When using SNAP PAC Ethernet brains (SNAP-PAC-R1, SNAP-PAC-R1-B, SNAP-PAC-R2,
SNAP-PAC-EBT, or SNAP-PAC-EB2) on a wired LAN (local area network), a timeout value of 0.1
seconds may be fine. When using a WAN (wide area network), a wireless network, the Internet, or
you are not sure what the networking technology is, it may be best to use the default value of 1
second. However, if the controller's message queue shows loss of communication with Ethernet /0O
units, it may be necessary to increase the timeout value.

For Advanced Users:
If you are an advanced user with a lot of Ethernet experience, you may want to determine normal
response times from a brain using an Ethernet capture utility such as Wireshark®

(www.wireshark.org). Look for the fastest response time, the normal or typical response time, and
the longest response time.

Adjust the timeout value to be larger than the maximum observed response time. It is best not to
use a timeout value that is too short because this will cause unnecessary communication retries and
timeouts. We recommend making the timeout be at least 50% to 100% longer than the maximum
observed response time. In addition, we recommend not using a timeout value that is less than 0.1
seconds. For example, if the value is 0.1 seconds, then communication to an unresponsive I/0 unit
will be disabled within 0.3 seconds. If the network connectivity is very slow, you may need to use a
significantly longer timeout value such as 3 to 5 seconds or longer.

Changing Configured 1/0 Units

1. Tochange a configured I/O unit, make sure the strategy is open and in Configure mode.

2. Find the I/O unit's name on the Strategy Tree. Double-click it to open the Edit /0 Unit dialog
box. See “Add I/0 Unit Dialog Box"on page 127.

3. Make the necessary changes and click OK.

You can also change an 1/0 unit from the Configure I/0 Units dialog box by double-clicking the
unit's name or highlighting it and clicking Modify.

Deleting Configured I/0 Units

You cannot delete an I/0 unit if it has I/O points configured or if the I/O unit is referenced in a PAC
Control command.

CAUTION: Be careful when deleting I/0 units. You cannot undo a deletion.

1. To delete a configured I/0 unit, make sure the strategy is open and in Configure mode.

2. Find thel/O unit's name on the Strategy Tree. Right-click it and choose Delete from the pop-up
menu.

The I/0 unit is deleted from the strategy.

You can also delete an 1/0 unit from the Configure I/0 Units dialog box by highlighting the unit’s
name and clicking Delete.
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Adding I/O Points

Before you add an individual I/0 point, such as a sensor or a switch, you must add the I/0 unit the
pointis on. See “Adding an I/0 Unit"on page 126.

Adding a Digital I/0 Point

1. With the strategy open and in Configure mode, double-click the I/0 Units folder (not the
individual unit’s icon) on the Strategy Tree.

The Configure I/0 Units dialog box appears.

# Configure 1/O Units >

Mame Type Port Address  Watch... Enabled RefC... Desciption I Add... |

Ethern... 127.0.... Disabled Enabled
R1 SMAP-.., Ethern... 10.19... Disabled Enabled 0

: PID Loops... !

Event/Reactions. ..

2. Highlight the I/0 unit the points are on, and click I/O Points.
The Configure I/0 Points dialog box appears.

3. Ifyouare using G1 or G4 single-point modules (for example with a G4EB2 or E1 brain),
double-click the point you want to use. Skip to step 11.
4. If you are using SNAP /0 modules, notice the module icons in the dialog box.

& Configure 170 Points — O X
1/0 Unit: |R1 | Type: | snaP-PACRI |
Modules and Points Type Features / Subty... | ~ Add...
Module icons ; :
N [01] Not Used Modify...

02] Net Used Delete
[03] Not Used
[04] Mot Used Mowe To...
[05] Not Used
[06] Not Used CopyTo »

[07] Mot Used
Expand All

[08] Not Used
[09] Mot Used j Collapse Al |
[10] Net Used )
1111 Not Used

Cloze | Help
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NOTE: This example shows a SNAP PAC I/O unit, so both digital and analog modules can be
configured on the same rack.

5. Highlight the number that represents the module’s position on the rack, then click Add.
Alist of available modules appears.

& Add Module x

Type: (@ Digital Input () Digital Output () Analog Input () Analog Output
Module:

Part Channels  Type(s) o
EjSNAP—IDCE—FAST 4 2.5-16VvDC
ESNAP—IDC SFAST-A 4 18 -32vDC
ESNAP-IDCT 4 2,5-28VDC
|jSNAP-IDC SMA 4 10 - 32 VDCVAC ManfAuto Switch
ﬂSNAP—IDC 5-5wW 4 Dry Contact Switch
|j SMAP-IDC5Q 2 4 -24VDC
ﬂSNAP—IDC 5G 4 35 - 75 VAC/NDC
EﬁSNAP—IDCS—HT 4 15-32VDC
EﬂSNAP-IDC S-SWHNC 4 Dry Contact Switch
4
4

|jSNAP-IDC 3FM 10 -32vDC

[I5NAP-IDCSDFM 2.5-28VDC

[JsNaP-IDC-32 32 10 -32VDC

[JsMAPIDC-32DN 32 2.5--12v0C

[JsMAP-IDC-32D 2 2.5-12VDC

[JsNAP-IDC-32N 32 -10 - 32VDC

[J5MAP-IDC-16 16 10 -32VDC

[sMAPIDCHT-15 18 15 - 28 VDCVAC

[IsNAP-IACS 4 90 - 140 VDCVAC

[ISNAP-IACSA 4 180 - 280 VDCVAC v
£ >

[] automatically create points within the new module

Mame Format: | %1_%2_ %3%4 q; Format information

Cancel Help

6. Choose the module type and then the exact module from the lists.
7. Toadd points automatically, select “Automatically create points within the new module.”

Use the “Name format”text field to create a format for the point names. Enter any combination
of text and the following format codes:

%1 = point type (for example, ai or do)

%2 =1/0 unit name

9%3 = module position

%4 = channel position

%5 = a unique identifier that is generated automatically

Example: %1_%2_%3%4 would expand to something like di_MyloUnit_0801.

Example: %1ABC_%5 would expand to something like aoABC_473

8. Click OK.
9. Inthe Configure I/O Points dialog box, click the plus sign next to the new module to expand it.
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Notice that the module icon is color-coded to reflect the type of module being configured:
white for digital DC input, red for digital DC output, yellow for digital AC input, and black for
digital AC output.

i Configure /O Points —

O b
. IjO Unit: | Sprinkler_Control Type: | SNAP-PAC-R1
Module icon | | | |
Modules and Points Features / Subty... | »~ Add...
. [00] SNAP-IDC5: 10 - 32 VDC/VAC Digital Input _
Expand or collapse points ™9 0 Not Used
on the module by clicking L8 1 Mot Used Delete |
the + or - sign in the box. £ 2 Not Used -
_Ilﬂ 3 Mot Used Maove To... |
POiﬂtS [01] Not Used
[02] Not Used LinEE L
[03] Not Used -
D =Ty
[05] Not Used | collapse all |
[06] Not Used
1071 Not Used v
>
I Close i | Help i

10. Highlight the point you want to configure and click Add.
11. Complete the fields as described in “Add Digital Point Dialog Box” below.
12. When you have completed the fields, click OK.

The new point appears in the list.
Here is an example of how it might look on a SNAP 1/O unit:

4 Configure 1/O Points — O il
1/0 Unit: | Sprinkler_Control | Type: | snappPacr1 |
Modules and Foints I Type I Features / Subty... I - Add...
=[] [00] SNAP-IDC5: 10 - 32 VDC/VAC Digttal Input _
10 Suicn o i o |
I 1 Not Used Delete |

T 2 Not Used

7 3 Not Used Move To...

[01] Not Used ———
[02] Not Used [
[03] Not Used .
[04] Not Used | Epand Al |
[D5] Not Used [ Collapse All |
[08] Not Used e
1071 Not Used v

£ >
I Close i | Help i

NOTE: If you need to add several similar points, see “Copying a Configured I/0 Point” on page 143.
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Add Digital Point Dialog Box

| Add Digital Point X
A ———— MName: | | |
B —————— Description: | |
C Type: Input

: Module: SNAP-IDCS: 10 - 32 VDC/MAC

D ——+— Features: Mone ~
E ———Default  ®No  (OYes
F ————— watchdog: @ No Yes
G [ Enable communication

Goncal | [l

A—Name. Enter a name for the point. The name must start with a letter and may contain letters,
numbers, and underscores. (Spaces are converted to underscores.)

B—Description. (Optional) Enter a description of the point.

C—Type/Module. For non-SNAP I/0 units, choose the module type and the exact module from
the drop-down lists. For a G4EB2, all 32 digital points are addressed as a single I/O unit; if you are
using the G4EB2 with Quad Pak modules, make sure you configure each group of four points as
either all inputs or all outputs.

For SNAP 1/0 units: Type and module are already filled in for you, as shown in the example above.
D—Features. To use a feature of the module, choose it from the drop-down list. You can
configure some input modules with a counter, totalizer, or other feature. (Inputs automatically have

both on-latches and off-latches.)

E—Default. To set a default state for the point when the strategy is run, click Yes and choose the
state (Off or On). To leave the point in the state it was before, click No.

F—Watchdog. (Output modules only) To set a Watchdog, click Yes and choose On or Off from
the drop-down list.

G—Enable Communication. Select whether you want communication to this I/0 point
enabled or disabled on startup. Enabled is the default.

Adding an Analog I/O Point

1. With the strategy open and in Configure mode, double-click the I/0O Units folder (not the
individual unit's icon) on the Strategy Tree.
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2. Inthe Configure I/0 Units dialog box, highlight the I/O unit the points are on, and click 1/0 Points.
The Configure I/0 Points dialog box appears.

3. (Proonly) If you are using a non-SNAP 1/0 unit (not including the B3000 or B3000-B),
double-click the channel you want to use. Skip to step 8.

4. If you are using a SNAP I/0 unit (including the B3000 or B3000-B), notice the module
icons in the Configure I/0 Points dialog box.

4 Configure 170 Points — O >
1/O Urit: | Sprinkler_Control | Type: [ snap-PACRL |
Modules and Points Type Features / Subty... | ~ Add...
|j [00] SNAP-IDC5: 10 - 32 VDC/VAC Digital Input -
[01] Mat Used
[02] Mot Used e
[03] Mot Used
[04] Not Used [ MoveTo... |
[05] Mot Used
[06] Net. Used CopyTo b
[07] Mot Used T !
[08] Not Uised | Expand Al |
05] Mot Used | Collapse all
[10] Mat Used - -
1111 Mot Used he
< >
| Close | Help

NOTE: In this example, a digital module has already been added in position zero. This example shows
a SNAP PACI/0 unit, so both digital and analog modules can be configured on the same rack.

5. Highlight the number of the analog module’s position on the rack, then click Add.
6. (Choose the module type (Analog Input or Analog Output).

& Add Madule x

Type: () Digital Input () Digital Output () Analog Input  (®) Analog Output

Module:
Part Channels  Type(s)
[lsMAP-AOA-3-16 1 4-20mA
[l SNAP-AQV-5 1 0-10VDC
[l sMAP-a0V-7 1 -10 - +10VDC
[ sMAP-80A-23 2 4-20mA
[ASMAP-80A-234H 2 4-20mA
[l SMNAP-AQA-2345RC 2 4-20mA
[ SMAP-AQV-25 2 0-10vDC
[ SNAP-AQV-27 2 -10 - +10VDC
[l SNAP-80A-28 5] 0-20mA
[ SNAP-AOD-29 2 5 - 60 VDC TPO
[lSMNAP-AOD-29-HFi 2 2.5-24\DC TPO
[ SNAP-AQVA-B 8 0-5VDC, 0-10VDC, 5- +5VDC, -10 - +1
£ >

[] Automatically create paints within the new module

Mame format: | %l %62_%3%4 Q') Format information
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To add points automatically, select “Automatically create points within the new module.”

Use the “Name format”text field to create a format for the point names. Enter any combination
of text and the following format codes:

%1 = point type (for example, ai or do)

%2 =1/0 unit name

9%3 = module position

%4 = channel position

%5 = a unique identifier that is generated automatically

Example: %1_%2_%3%4 would expand to something like di_MyloUnit_0801.
Example: 9%1ABC_%5 would expand to something like a0ABC_473

In the Configure I/0 Points dialog box, click the plus sign next to the new module to expand it.
Notice that the module icon is color-coded to reflect the type of module being configured:
blue for analog input, green for analog output.

4 Canfigure 170 Paints - O *
1/0 Urit: | Sprinkler_Control | Type: | snaP-PACRL |
Modules and Poirts | Type | Features / Subty... I - Add...

[ [00] SNAP-IDCS: 10 - 32 VDCAVAC Digtal Input _
0] SNAP AOV-27 A e e— |

Expand or collapse points
on the module by clicking
the + or - sign in the box.

Points S [0

o.

21 ) Not Used | Delete
/—+ 1 Net Used '
/[32; Not Used Move To... |
3] Not Used s
04] Not Used
05] Not Used
[D6] Not Used
[07] Mot Used | Collapse all |
[08] Not Used '
1091 Not Used b

Copy T6™

Expand All

Close Help

Highlight the point you want to configure and click Add.

10. Complete the fields as described in “Add Analog Point Dialog Box” below.
11. When you have completed the fields, click OK.

The new point is added.

NOTE: If you need to add several similar points, see “Copying a Configured /O Point” on page 143.
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Add Analog Point Dialog Box

Edit Analog Point ot
A —temes | |
B ——— Description: | TT-102 Temperature Transmitter |
C < Type: Input
™S Module: | SMAP-AICTD: ICTD Temp. Probe v
—
D ———————FullRange Clamping F
o
Clear Default
G —— []5end value
0
H ———— [Jsend values
0 G4 1 Default
| — 1 Default:  @mnNo  ()Yes
J ————— watchdog: (®)No Yes
K ———F— [~]Enable communication
Cancel Help

A—Name. Enter a name for the point. The name must start with a letter and may contain letters,
numbers, and underscores. (Spaces are converted to underscores.)

B—Description. (Optional) Enter a description of the point.

C—Type/Module. For non-SNAP I/0 units, choose the module type and the exact module from
the drop-down lists.

For SNAP 1/0 units: Type and module are already filled in for you. You may be able to choose a
different range from the drop-down list.

D—Full Range. Full range and units for this module.

E—Clamping. (Outputs only—optional) Enter upper and lower clamp if necessary to limit
output to the device attached to the point, no clamp is applied. To empty the fields, click Clear.
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F—Scaling. Use to assign custom units and values to the module. For example, you could scale
the readings of a -10 to +10VDC input point to measure its input as zero liters per second when the
real-world reading is zero VDC, and 1000 liters per second when the real-world reading is 5 VDC. This
example would look like this:

(Add Analog Point % |
Mame: | |
o In this example, units are changed
Description: | | .
to liters/second and lower and
uppervaluesare changed. Although
Type: QOutput

the module has an output of -10 to
Module: SNAP-AQY-27: -10 - +10 VDC v +10volts, the device attached to the
point outputs only 0-5 volts. Scaling

Tt _ 2EE h reflects the device's range.
Full Range Clamping Actual; Scaled: . .

) . In this case Clamping protects the

Units: | vDC | |[voc | [woc | |Litersjsed | : )
device by ensuring that
Lower: | -10 | |lo | [0 |[o | out-of-range voltage will never be
Upper: | 10 NIE | s | | 1000 | sentto it.
Clear Default
i e i T B T IT e .

Custom scaled values are floating point values.

« Analoginput points: Analog inputs typically have under-range and over-range capability,
which means you can specify a lower or upper value beyond the standard value. Also note that
with firmware R8.0a and higher, you can use regular or inverted scaling. Inverted scaling means
the lower value is greater than the upper value; inverted scaling can accommodate a sensor, for
example, that is wired to the SNAP module in a way that produces a negative current or
voltage.

«  Analog output points: Analog outputs do not have under-range or over-range capability.
Also, you cannot use inverted scaling. The upper value must be greater than the lower value.

Thermocouple values are not linear and cannot be scaled.

To return the units and upper/lower values to the defaults for the module, click Default.

G—Send Value (Filter Weight). (Inputs only—optional) To set the average filter weight for an
analog output point, check this box and enter the value. A filter weight smooths analog input
signals that are erratic or change suddenly. The formula used for filtering is Y = (X - Y )/W + Y, where
Y is the filtered value, X is the new unfiltered value, and W is the filter weight. The larger the filter
weight you enter, the smoother the analog signal. Filtering is applied to values in engineering units,
including minimum and maximum values. It does not apply to values in counts.

H—Send Values (Offset and Gain). (Inputs only—optional) To set offset and gain for the
analog output point, check this box and enter values. If you don't know what values to enter, you
can use PAC Manager to calibrate offset and gain for the point. See the PAC Manager User’s Guide for
steps.

I—Default. To set the initial state of the controller's interval value (IVAL) for this I/O point when
the strategy is run, click Yes and define the value. To leave the IVAL at its last state, click No.
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If communication to the point is disabled, only the internal values (IVALs) are accessed or updated
by the control engine. The real-world external values (XVALs) for inputs don't change because they
are controlled by external devices. The IVALs for inputs are set and will be overwritten by the XVALs
unless communication to the I/0 unit or point is disabled.

The default (value) is available for both inputs and outputs. It sets the IVAL for the point in the
strategy in the controller when the strategy is run. This can be useful when the 1/0 unit is not
accessible or communication to the I/0 unit is intentionally disabled when the strategy first starts.
When communication to an I/0 unit is disabled, any 1/0-related commands in the strategy will act
only on the I/O point IVALs because the controller is not able to access the XVALs at the I/0 unit
when communication to that I/O unit is disabled.

Once communication to the I/O unit is enabled and the I/O unit is accessible, then the first
command to access that point will update the IVAL. For example, if you use the Move command to
write a different value to an output, both the IVAL and XVAL are updated with the new value. If you
use a Move command to read an input, the XVAL is moved to the IVAL as part of reading the input
point.

J—Watchdog. (Outputs only) To set a Watchdog on this point, click Yes, and define the value to
be assigned to the output if the Watchdog is triggered. A Watchdog is triggered if no
communication activity is detected on the bus for the amount of time specified in the Watchdog
field of this point’s I/0 unit. For no Watchdog, click No.

K—Enable. Select whether you want communication to this 1/0 point enabled or disabled on
startup. Enabled is the default.

Configuring a Serial Module

Use PAC Manager to configure SNAP serial communication modules, including the PROFIBUS-DP
and CAN modules. For more information, see Opto 22 form 1704, the PAC Manager User’s Guide.

Changing I/0 Unit and Point Configuration

140

You can change configured I/0 units and points as follows:

« Ifyou replace a SNAP brain or rack-mounted controller, you can often change the entire 1/0
unit at once. This feature does not apply to serial B3000 or B3000-B brains. See the list of
allowed replacements in “Replace a SNAP Brain or Rack-mounted Controller”on page 141.

»  Youcan move an I/0 point or an entire I/O module to a different position on the same or a
different I/O unit. See “Moving a Configured I/O Module or Point” on page 142.

+  Youcanfillin empty points on a module or an I/0 unit, or copy a point to another position. See
“Copying a Configured I/0O Point”on page 143.

«  You can also change a point you've configured (page 145) or delete it (page 146).
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Replace a SNAP Brain or Rack-mounted Controller

In most cases you can change the entire I/0 unit type when you replace any of the following brains
or rack-mounted controllers as shown in the table below, and you won't need to reconfigure
existing /0 points.

However, if you're replacing an R1 or EBT with an R2 or EB2, and any points on the I/0 unit have the
digital features Counter, On Pulse, Off Pulse, Frequency, or Period, you'll need to change those I/0

points. You'll see a warning about this when you try to change the I/0 unit type.

Old /O unit type

New I/O unit type

Old /O unit type

New I/O unit type

SNAP-PAC-R1

SNAP-PAC-R2
SNAP-PAC-EB1
SNAP-PAC-EB2

SNAP-UP1-D64

SNAP-PAC-R1*
SNAP-PAC-R2*
SNAP-PAC-EB1*
SNAP-PAC-EB2*

SNAP-PAC-R1-B

SNAP-PAC-R1*

SNAP-B3000-ENET

SNAP-PAC-R1-B
SNAP-PAC-R1*
SNAP-PAC-EB1*

SNAP-PAC-R2

SNAP-PAC-R1
SNAP-PAC-EB1
SNAP-PAC-EB2

SNAP-ENET-RTC

SNAP-PAC-R1-B
SNAP-PAC-R1*
SNAP-PAC-EB1*

SNAP-PAC-EB1

SNAP-PAC-R1
SNAP-PAC-R2
SNAP-PAC-EB2

SNAP-UP1-ADS

SNAP-PAC-R1-B
SNAP-PAC-R1*
SNAP-PAC-EB1*

SNAP-PAC-EB2

SNAP-PAC-R1
SNAP-PAC-R2
SNAP-PAC-EB1

SNAP-ENET-S64

SNAP-PAC-R1
SNAP-PAC-R2
SNAP-PAC-EB1
SNAP-PAC-EB2

SNAP-PAC-SB1

SNAP-PAC-R1
SNAP-PAC-EB1

SNAP-UP1-M64

SNAP-PAC-R1
SNAP-PAC-R2
SNAP-PAC-EB1
SNAP-PAC-EB2

SNAP-PAC-EB2
SNAP-PAC-SB1

gm‘ﬁﬁﬁgﬁ; SNAP-PAC-R1
GENERIC OPTOMMP | SNAP-PAC-R2
SNAP-PAC-SB2 SNAP-PAC-EB1 DEVICE SNAP-PAG-EB1

SNAP-PAC-EB2

SNAP-ENET-D64

SNAP-PAC-R1*
SNAP-PAC-R2*
SNAP-PAC-EB1*
SNAP-PAC-EB2*

* This change requires a mounting rack change.

To change an I/0 unit type:
1. With the strategy open in Configure mode, double-click the I/O Units folder in the Strategy

Tree.

2. Select the I/0 unit you want to change and click Modify.
3. (lick the Type dropdown list to see the possible types you can change it to.
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4 Edit1/0 Unit X
Information
Mame: | Sprinkler_Control |
Description: | |
Type
Type: SMAP-PACR1 |1§1
dd g;;Pr?Pn:g-;T Eth t, SNAP Anal I:;lD'q't | points
Addressing ——| ernet, S nalog and Digital poin
IP Address: SNAP-T?.AC-R-Zl te Tvpes Ethernet, SNAP Analog and Simple Digita? ;
SMAP-PAC-EB1 Eihernet: SNAP Analog and Digital points Other |/O unit typeS yOU can
\SMAP-PAC-EE2 EthLet. SMAP Analog and Simple Digi Cha nge thls one to
Ethernet Port:

Communication from control

Enable communications from control engine

Timeout and disable communications after tries of second(s) each.

Device Options

For temperature points, use degree: (_) Fahrenheit (@) Celsius
[watchdog tmeout after | 0.5

o 1

second(s) of no communications

Cancel Help

4. Choose the new type, make any other necessary changes, and click OK.

Moving a Configured I/0 Module or Point

You can move a configured I/0 module or I/O point to an empty position on the same I/0 unit or a
different I/0O unit.

1. With the strategy open in Configure mode, double-click the I/O Units folder on the Strategy
Tree.

2. Inthe Configure I/0 Unit dialog box, highlight the unit the module or point is on and click 1/0
Points.

The Configure I/0 Points dialog box opens. For a SNAP 1/0 unit, it looks something like this:

i Configure |/0 Points — O X
1/O Unit: | Sprinkler_Control | Type: | SNAP-PACRL |
Modules and Paints I Type I Features / Subty... & Add...
[ﬂ [00] SMAP-IDCE: 10 - 32 VDCAVAC Digital Input -
[01] SNAP-AQV-27 |AnalogOutput | |
02] Nat Used | Delete
[03] Not Used -
[04] Not Used Move To... |
[05] Not Used ; :
[06] Not Used CopyTo ¥
[07] Not Used Gl ———
= = [ Expand al |
Close Help Colla_!_pse Al _l
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— To move a module, select it and click Move To.

i Mowve Module - SNAP-IDC5: 10 - 32 VDC/VAC *
Select a target IjO Unit: Select an available module position:
b3000enet Maodule [02] Mot Used A
Eﬂéias%nﬁer: Module [03] Not Used
ixe ni
B e

Maodule [05] Mot Used
Maodule [06] Mot Used
Maodule [07] Mot Used
Maodule [08] Mot Used
Maodule [09] Mot Used
Maodule [10] Mot Used
Maodule [11] Mot Used v

Cancel Help

~ To move a point, expand an individual module by clicking its plus sign [+], or expand all
modules by clicking Expand All. Select the point you want to move and click Move To.

i Move Point - Sensor_3 (Digital Input) et
Select a target IjO Unit: Select an available point position:
b3000enet Module [00] SMAP-IDCS: 10 - 32 VDC/VWAC Y
Back_Sprinklers Point 3 : Not Used
—=idesli g Module [01] SNAP-ODC5-: 5 - 60 VDC Tsolated

Module [02] SMAP-IDCSD: 2.5 - 28 VDC
Point 2 : Mot Used
Point 3 : Mot Used
Module [03] SMAP-QACS: 12 - 250 VAC
Module [04] SMAP-ATARMS
Module [05] SMAP-ADA-23
Madule [06] v

Cancel Help

3. Intheleft column, select the I/O unit you want to move the module or point to. (The 1/0 unit
it's on now is selected by default.) In the right column, select the position you are moving the
module or point to. Then click OK.

You return to the Configure /0 Points dialog box, and the point has been moved.

Copying a Configured I/0 Point

If you have several points on a SNAP I/0 module that are the same, you can copy a configured point:
«  Tofillempty points on the same module.
«  Tofill all empty points on the I/0 unit.

«  Toanother point on the same or a different I/O unit.

1. With the strategy open in Configure mode, double-click the I/O Units folder on the Strategy
Tree to open the Configure I/0 Points dialog box.
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2. (lick Expand All so you can see the points.

& Configure 170 Points - O d
1/O Unit: | Sprinkler_Control | Type: | sNAP-PACRL |
Modules and Points | Type | Features / Subty... & Add...
= |j [DO] SMAP-IDCS: 10 - 32 VDC/VAC Digital Input -
=1 0 Switch_DO Courter
'IJ‘:E' 1 Mot Used Delete |
T 2 Mot Used -
T 3 Not Used EELEE
= - [01] SNAP-ODCSSRC: 5 - B0 WVDC Source  Digtal Output -
efosam s ] Jhone AL
T 1 Not Used :
o=+ L
2 5 : Expand All |
. Close 1] Help Coll;pﬂe Al 5

3. Highlight the point you want to copy and click the Copy To button. From the pop-up menu,
choose one of the following:
To copy the point to fill empty points on the module, choose Fill In Module.

The point is copied to the other empty points on the same module.

& Configure /0 Points - O *
1/ Unit: | Sprinkler_Control | Type: | SNAP-PACRL |
Modules and Points | Type | Features / Subty... A Add...
= [ﬁ [00] SNAP-IDCS: 10 - 32 VDC/AVAC Digital Input : -
Original point L ) Swi Courter |
. _ L Switch_DO_0001 Counter Delets
Copied points L > Switch_DO_00D: Courter -
I8 3 Switch_DO_000 Counter ThieT
= . [01] SNAP-ODCSSRC: 5- 80 VDC Source  Digital Output
%‘ 0 Alam_1 Nane
10 Not Used :
n— L3
2 5 _ Expand all |
- Close - Help C""?‘F‘SE Al :

To copy the point to fill all empty points on the I/0 unit, choose Fill In 1/O Unit.

The point is copied to all empty points on similar modules (for example, to all empty points on
digital input modules, whether they are the same or a different part number), and the module
and point are copied to all compatible slots without configured modules.
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The copied point filled in all empty
points, even though the module is a
different part number.

No module existed in this slot.

Both the points and the module
were copied from the original.

4 Configure /0 Points — O >
L/O Unit: | Sprinkler_Control | Type: | snap-PaCR1 |
Modules and Poirts | Type | Features / Subty... I - Add...
# [ [03] SNAP-IDC5D: 25- 28 VOC Digital Input _
L1 Switch_D0_0300 Courter
& 1 Switch_DO_0301 Courtter Ddlete
L 2 Switch_DO_0302 Courter
U 3 Switch_D0_0303 Counter Move To...
$ [ [04] SNAP-IDC5: 10 - 32 VDC/VAC Digital Input
LM § Switch_D0_0400 Courter e [
& 1 Switch_DO_0401 Courter
x Expand All
U 2 Switch_DO_0402 Courter w
< 2 Collapse all
Close Help

To copy the point to one other point, either on the same or a different I/0 unit, choose To

Specific.
The Copy To dialog box opens.

ﬁ Move Point - Alarm_1 (Digital Cutput)

Select a target IfO Unit: Select an available point position:
b3000enet Module [00] SMAP-IDCS: 10 - 32 VDCVAC ”~
Back_Sprinklers Module [01] SMAP-CDCSSRC: 5 - 0 VDC Source
Mixed IO Unit

Point 1 : Not Used
Point 2 : Mot Used
Paoint 3 : Not Used
Module [02] SNAP-AQV-27
Module [03] SMAP-IDCSD: 2.5 - 28 VDC
Module [04] SMAP-IDCS: 10 - 32 VDC/VAC
Module [05] SMAP-IDCS: 10 - 32 VDC/VAC W
£ >

Cancel

Help

In the left column, choose the same or another I/0 unit. In the right column, choose the

location of the point to copy to.

Available points are shown in black. Already configured points, points on a different type of
module (digital output instead of digital input, for example), and point numbers not on the
rack (such as point 40 on an 8-module rack) are grayed out.

If the point is copied to an empty module slot, the module part number from the copied point

is added, too.

After you copy a point, change the new point as needed by double-clicking its point name. In

the Edit Digital Point dialog box, type the new name and make any other changes.

Changing a Configured 1/0 Point

1.

With the strategy open in Configure mode, expand the I/0 Units folder on the Strategy Tree

until you can see the I/0 point you want to change. Double-click the I/O point name.
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2. Inthe Edit Analog Point or Edit Digital Point dialog box, make the necessary changes. Click OK
to save.

Deleting a Configured 1/0 Point
You cannot delete an I/0 point that is referred to in the strategy.

CAUTION: Be careful when deleting I/0 points. You cannot undo a deletion.

1. With the strategy open in Configure mode, expand the 1/0 Units folder on the Strategy Tree
until you can see the I/0 point you want to delete.

2. Right-click the I/0 point’s name and choose Delete from the pop-up menu.

You can also delete an I/0 point from the Configure I/0 Points dialog box by highlighting its name
and clicking Delete.

Configuring PID Loops

146

PID loops (or simply PIDs) are used to drive an input (a process variable) toward a particular value
(the setpoint) and keep the input very close to that value by controlling an output. For example,
consider temperature control, where the input is a measurement of ambient temperature, the
setpoint is the desired temperature, and the output is a heater. The PID for this system will use a
mathematical formula that controls the output to maintain a desired temperature, efficiently adjust
to changes in setpoint, and compensate for changes in load, such as the influx of cold air. In this
example, a temperature sensor (analog input), a thermostat (analog input), and a heater control
(analog output) are components of one system, controlled by a PID loop.

This guide assumes that you are already familiar with using PIDs. PID calculations are complex and
the physical qualities of systems suitable for PID control differ greatly. This guide includes only basic
information for configuring PIDs.

SNAP PAC I/O units support 96 PID loops.

PIDs can control isolated systems or be part of cascaded systems where one loop controls the
setpoints or input variables of others. For maximum flexibility, any PID input, setpoint, or output can
be determined by PAC Control commands.

PIDs and Strategies

The PID operates at the 1/0 unit, independently of the controller. However, the controller supports
logic commands to read and write various PID parameters and modes. Once configured and
initialized, a PID operates until the I/0 Unit loses power.

When you change PID configuration in PAC Control, remember that changes are not written to the
/0 unit until the strategy is downloaded and run. For a SNAP PAC I/O unit, be sure to save PID
configuration to flash memory following instructions for the I/0 unit.

If you subsequently download a different strategy to the control engine, you'll receive an error
message (-700) reminding you that a PID loop is still running and that it may conflict with the new
strategy. To turn off a PID loop, open PAC Manager and use Inspect mode to change the PID’s
algorithm to None.
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Each PID loop must be individually configured and tuned.

Configuration steps start in “Adding a PID Loop”on page 147, and tuning steps are described in
“Inspecting and Tuning PID Loops”on page 158. For additional information, see “PID—Fthernet

CHAPTER 6: WORKING WITH 1/0

Commands"on page 326, form 1641, OptoTutorial: SNAP PAC PID, and form 2171, Tuning a PID Control
Loop Technical Note.

Adding a PID Loop
1.

2.

PAG, Ethernet I/0, and Ultimate With the strategy open and in Configure mode, double-click the
I/0 Units folder (not the individual unit’s icon) on the Strategy Tree.

The Configure I/0 Units dialog box opens.

& Configure 170 Units X
Name Type Port Address  Watch... Enabled RefC.. Add...
b3000enst SMAP-B3000-E... Ethern... 10.19... Disabled Enabled ©
Mixed_[O_Unit  SMAP-UP1-ADS  Ethern... 127.0.... Disabled Enabled 12 —

SMAPPACR1 Ethern... Dizabled 6 Delete
Sprinkler_Control  SMAP-PAC-R1 Ethern... 10.19... Disabled Enabled 3
IO Paints. ..
PID Loops...
Event/Reactions...
< >
Close | Help
Select the I/0 unit the PID will be on, and click PID Loops.
& Configure PID Loops - O X
L/O Unit: w|  Type: |SNAP-PACR1
# Name Input  Set.. Out.. Mode Enable Ref.. Desci ™ Add...
A el Modify...
01 Mot ...
02 Mot ... = Delete
a3 Not ... '
04 Mot ...
et .
< >
Close | Help

Double-click the lowest unused number.

The Add PID Loop Dialog appears.

Complete the fields as described in “Add PID Loop Dialog Box" below.

Click OK.

The new PID appears in the Configure PID Loops dialog box.
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6. When you have finished configuring PIDs, click Close.
PIDs appear in the Strategy Tree under the I/0 unit.

= IE5) Cookies
[C3) Control Engines
[ Subroutines Induded
C3) Charts
[C5) Variables
=
A0l b 3000enet
A Mixed_I0_Unit
= %‘ Sprinkler_B

51 Paints
B (3 PIDs
o PID loops
“—’}JSI Sprinkler_Contral
Add PID Loop Dialog Box
Add PID Loop *

A ——— Name: | | |
B—— Description: | |
C—— Input: yoPont v | ~| Osquare Root —— D
F ———setpont:  [yopont  ~| | v]
G ——— output: jopPont v | v|

H—— s [o | tpec o |
| —————— Min Change: D Max Change: I:I (0 dizables min/max change)

Output options for when the input is out of range

J - [ switch to manual mode when input goes out of range
[JForce output when input is out of range {auto mode only)
Oukpat walue w input is under-range: o and over-range: | g
N
1 Feed Forward
K—— Algorithm: | Velocity (Type C) ~ | Gain: | & |

L ——— Mode: | Auto v Tune It ICW IniT:iaI: ICI o)
M——sengoe: [ e S oy | 3 o

Enable communication

A—Name. Type a unique, descriptive name for the PID. The name must start with a letter and may
contain letters, numbers, and underscores (spaces are converted to underscores).
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B—Description. (Optional) Enter a description of the PID.

C—Input. Select the type of input: I/0 Point, Host, or PID Output.

+  Ifthe PID’s process variable comes from an I/0 point on the same unit, select I/0 Point. Choose
the point from the drop-down list or type a point name to configure a new point.

« Ifthe PID's process variable comes from the PAC Control strategy, select Host. Enter an initial
value for the input.

« Ifthe PID's process variable is the output of another PID on this brain (a cascading control loop),
select PID Output. Choose the PID from the drop-down list.

D—Square Root. (Optional) If you chose I/0 Point or PID for step C, check this box if the error
should be calculated based on the square root of the process variable (applies to flow control
systems where volumetric flow is proportional to the square root of a signal from a flow transducer).

E—Low/High Range. Set the valid range of the process variable by entering the low range and
the high range. (See Output Options for optional responses to out-of-range input.)

F—Setpoint. Choose the source for the setpoint: /0 Point, Host, or PID Output.

« To control the setpoint using a device (on the same brain) such as a potentiometer, select I/O
Point; choose an I/0 point from the drop-down list or type a new point name.

«  Tocontrol setpoint using PAC Control or PAC Display, select Host. For Initial Value, enter the most
common operating value.

« Ifanother PID loop will control the setpoint, select PID Output and choose the PID from the
drop-down list.

G—Output. Choose the destination for the PID output: I/0 Point or Host. (To use the output for
controlling the setpoint or input of another PID, choose Host.)

H—Lower Clamp/Upper Clamp. Enter upper and lower clamp values to prevent the output
from exceeding a desirable range. These values should equal the range of the output point, if used.
Or choose values to make sure that the output device doesn't shut off (for example, keeping a
circulation pump running regardless of the PID output) or that the output never reaches a
destructively high setting (for example, keeping a motor below maximum).

I—Min Change/Max Change. (Optional) Enter minimum and maximum change values. The
output won't respond until the minimum change is reached (for example, you may not want a
heater to turn on to correct a 1 degree error). Maximum change prevents too drastic a change in
output (for example, you could limit the increase in a pump’s output to prevent pipe breakage). The
default for both minimum and maximum is zero, which disables the feature.

J—Output Options. Choose how the PID should respond if the input goes out of range. To have
PAC Control logic or an operator respond, check Switch to manual mode. To force the output to a
specific value, check that option and type the output values.

NOTE: If both boxes are checked (forced output and manual mode), the output will be forced and the PID
putinto manual mode; but if the PID is already in manual mode, the output will not be forced. (You can
use the command Get PID Status Flags to determine current settings.)
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If neither box is checked and the PID input goes out of range (as defined by E- Low/High Range) then the
output will freeze, but only while the input is out of range.

K—Algorithm. Choose algorithm: Velocity, ISA, Parallel, or Interacting. For details on algorithms,
see "Algorithm Choices” on page 328.

L—Mode. Choose the Mode you want the PID to be initialized to. The main difference between
Automatic and Manual mode is that in Manual mode the PID loop stops its mathematical
calculation. In both modes the PID's output value is still copied to the analog output.

«  Auto mode: The PID makes calculations based on the difference between the input and the
setpoint resulting in changes to the output, which causes the input to move toward the
setpoint.

«  Manual mode: The PID stops making changes to the output, but continues to write the PID
output to the analog point (or configured destination for the PID output). Manual mode allows
PAC Control logic or an operator to control the PID output, which in turn is written by the PID
loop to the analog point (or configured destination of the PID output).

NOTE: If the value of the analog point or configured destination is changed, it will be overwritten by
the PID output.

PID

Setpoint .
Input Output \\* g:?:::ﬁ

M—Scan Rate. Enter a scan rate to determine how often the input is scanned and the controller
output is calculated. Minimum value is 0.001 (1 ms). Scan time should be greater than system lag
(the time it takes for the controller output to have a measurable effect on the system). Also consider
other PIDs and tasks on the brain competing for processing power.

N—Gain. Type a positive or negative value for Gain. Heating systems usually require a negative
value and cooling systems a positive value. NOTE: Gain is usually refined during the tuning process.

O—Fd Fwd Initial/Fd Fwd Gain. (Optional) Enter Feed forward Initial and Feed forward gain
values if you need to offset the controller output in your application. These values are constants that
are multiplied and added to the controller output; often they are not used in PIDs.

P—Tune I/Tune D. (Optional) Type Integral and Derivative settings if you know the desirable
settings. However, Integral and Derivative are not essential to basic configuration and are better
determined in the tuning process.
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Add PID Loop >
Name: | |
Description: | |
Mode: .ﬂ.uto 1.y ibph’ons. = Scan Rate: 8EC,
Input: iHost w| Initial Value: D—A
B—— Low Scale: -32768 High Scale: | 32767 —C
Output: v | MaxChg Rate: D
Setpoint: ;_Host o | Initial Value: E—— D
Lower Clamp: | -32768 Upper Clamp: | 32767
Gain: [ntegral: l:l Derivative: I:I
[+] Enable communication
o[ o [
Changing a PID Loop

You can change the PID loop's configuration and its position in the 1/0 unit.
Make sure the strategy is open and in Configure mode. On the Strategy Tree, expand the /0
Units folder until you see the PIDs folder for the I/0 unit you want. Double-click the PIDs folder.

The Configure PID Loops dialog box opens, listing all configured PID loops. Remember that the
number of PID loops available depends on the I/0 unit.

1.

i Configure PID Loops

Ijo Unit: | b3000b

V) Type: | B3000 Analog

# Name

01 Mot Used
02 MotUsed
03 MotUsed
04 Mot Used
05 Mot Used

Temperature_...

Input

Oven_Te...

Set...

Qutput Mode

QOwen_T...

Enable |

Close

Help

|
Up- and down-arrows

PID loops are scanned by the I/0 unit in the order that they appear in this list.

PAC Control User's Guide

151



INSPECTING I/0 IN DEBUG MODE

2. Tomove the PID loop to a different position on the I/O unit, use the up- and down-arrows in
the dialog box.

3. Tochange the PID loop’s configuration, double-click its name to open the Edit PID Loop dialog
box. Change the fields as necessary.

For help in completing the fields, see “Adding a PID Loop” on page 147.

Deleting a PID Loop
Only PID loops that have a reference count of zero can be deleted. Be careful when deleting PID
loops; you cannot undo a deletion.

1. Make sure the strategy is open and in Configure mode. On the Strategy Tree, expand the /0O
units folder until you see the PID loop you want to delete.

2. Right-click the name of the PID loop and choose Delete from the pop-up menui.
The PID loop is deleted.

You can also delete a PID loop in the Configure PID Loops dialog box by highlighting it and
clicking Delete.

Add Event/Reaction [‘zl

A—— Mame: | |

B—— Description: | |

C —1—scanonRun @ives (Mo

Interrupt an Event: (iYes (31 No

This figure shows the fields in the

D ——Event Type Watchdag Timeout v dialog box when you first openit.
Depending on the type of event
or reaction you select, other fields
may appear.

E—— Beaction Type: Mane w

F —/—— Enable communication

I 0K l [ Cancel ] ’ Help ]

Inspecting I/0 in Debug Mode

You may want to inspect or change I/O while you are running your strategy in Debug mode. This
section shows how to view information about I/0 and make changes while the strategy is running.
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To monitor several I/0 elements at once in a window you can save with your strategy, see “Using
Watch Windows for Monitoring” on page 169.

Inspecting I/0 Units and Saving Settings to Flash

1. With the strategy running in Debug mode, double-click an I/O unit in the Strategy Tree.

The Inspect I/0 Unit dialog box appears, showing information about the unit and its points. The
title bar shows the name of the I/O unit and whether scanning is occurring.

%< "Mixed_l0_ Unit" (scanning)

Mame:  Mimed_[0_nit
Emor:  |Mone Enable Comm.: [Yes e
Points [Detailed] | Points [Compact] | PID Loaps || Information
Module Ch#t MName Type WAl WAL ~
ﬂ [00] SHAP-IDCED ] Ererge.. [ Input
1 FOS D Input
2 Freezer_... [ Input
3 Phota 5... D Input
- 1] SMAP-ODCESRC 0 Alarm D Output
1 Freezer_... D[ Output
2 Inside_L... D Output
3 Outzide... D Output
ﬁ [02] SMAaP-A00-27 0 Fuel_Dis.. A QOutput 00000 -
1T Hatlleed e 00000 e
- [03] SHAP-AICTD ] Store_T... A lnput 0.0000 T8.3E16 w
[ Addwatch | [ Wiew. |[  Help |

NOTE: Scanning stops whenever you click a changeable field. It resumes once you click Apply, another
button, or an unchangeable field. If scanning resumes before you click Apply, any changes you made

are lost.

2. Tosave the current configuration of the I/O unit to its EEPROM (flash memory), click the
Information tab and then click the Set button under Stored Configuration (Flash EEPROM).

The following parameters are saved:

Analog

Digital

¢ |/O module configuration

¢ Initial output settings

e Comm link watchdog time

* Temperature conversion type
* Input offset and gain settings

* |/O module configuration
¢ Comm link watchdog time

NOTE: Use this option to protect the I/O unit configuration information from being lost when the
power is turned off. You should save the configuration settings to flash when they are final.
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Saving to flash memory this way is the same as saving to flash by other methods, such as using
PAC Manager (see Opto 22 form 1704, the PAC Manager User’s Guide), and is preferable to using
the command Write I/0 Unit Configuration to EEPROM.

To reset saved parameters to their powerup default values, click the Clear button.

To change the I/0 unit's current status, click an arrow in the Enable Comm field. Then click
Apply.

Yes on a green background means enabled; No on a red background means disabled. If you
change it, the background turns magenta until you click Apply.

To view an individual I/0 point, highlight its name in the list.

- Toadd an 1/O element to a watch window, click Add Watch. See page 169.

— Toopen an inspection window to change an I/0 point, click View. Then see “Inspecting
Digital I/0 Points” below for the 1/0 point you are changing (analog or digital).

6. When you have finished inspecting the I/0 unit, click Close.

Inspecting Digital I/0 Points

You can inspect a digital point’s data, change its status, or set its internal values or external values in
Debug mode. To monitor the point in a watch window, see page 169. To change the point, follow
these steps.

1.

With the strategy running in Debug mode, double-click the I/O point on the Strategy Tree. Or
double-click an I/0 unit in the Strategy Tree, click the Points (Compact) tab of the Inspect 1/0
Unit Dialog box, and then double-click the 1/0 point.

The small dialog box that appears shows the IVAL and XVAL.

— The XVAL, or external value, is the “real”or hardware value as seen by the I/O unit. This value
is external to the control engine.

— The VAL, orinternal value, is a logical or software copy of the XVAL that is in the control
engine. The IVAL may or may not be current, since it is updated to match the XVAL only
when a strategy in the control engine reads or writes to an 1/0 point.

3.5 "Sprinkler_Switch” h" (sc... g|

sl [ilEg S ~

If the digital point is configured with a counter, the counter values appear instead of the point’s
status.

3t “DO_Switch™ (scanning) E|

IvaL: o | WL 4 | G——— Maximize button

To change the value or to view more information, click the Maximize button.

The title bar shows the name of the digital point and whether scanning is occurring.
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8 *diDoughlevelSwitch® (scanning) gl
Name:  diloughlevelSwitch

Tepe:  Digital Input (i) More Info

[ wia.—— 2 B
A—statee DN 2 [DN 3
o EEG B
D—fCounter. |0 | [4 |
E ——- Communication

No wnae

10 Unit: _ =1 Open Parent
>

Scanning stops whenever you click a changeable field. It resumes once you click Apply, another
button, or an unchangeable field. If scanning resumes before you click Apply, any changes you
made are lost. Use the Clear button to immediately clear the field.

Asterisks in a field indicate an out-of-range value. Dashes in an XVAL field indicate a
communication error.

Change the fields as necessary:

A—State. The point's current internal value. Switch between On and Off; then click Apply.
B—XVAL. The point’s current external value. Switch between On and Off; then click Apply.
C—On-Latch/Off Latch. The state of the point’s on and off latches.

D—-Counter. Internal and external feature values if the point has been configured with any
special features, such as a counter.

E—~£nable comm. Current point status: Yes on a green background means enabled, No on a
red background means disabled. To change the status, click one of the arrows; then click Apply.

To add the point to a watch window, click Watch and see page 169.
To view configuration information for the variable, click More Info.
To inspection /0 unit’s configuration, click Open Parent.

(Pro only) To add a plot control, click Plot.
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3t diDoughl evelSwitch™ (scanning)

Mame:  diDoughLevelSwitch

Type:  Digital Input (i1 More Info

WAL HaL:

State: = | |ON £

OrvLatch: % | |on Z

Off-Latch: s on E

Communication

Paint:  [Enabled £ Off-Latch

10 Uriit: [Erabled = Open Parent

Plot<s | = [ Data v | [Timedus b | [dinclude WAL

The Data button allows you to save, copy, or print the current plot. Use the Time Axis button to

adjust the resolution. Click Include IVAL to see a concurrent plot of the IVAL.

Inspecting Analog I/O Points

You can review an analog point’s data, modify its status, or set its internal values or external values in
Debug mode. To monitor the point in a watch window, see page 169. To change the point, follow

these steps.

1. With the strategy running in Debug mode, double-click the I/O point on the Strategy Tree. Or
double-click an I/0 unit in the Strategy Tree, click the Points (Compact) tab of the Inspect 1/0
Unit dialog box, and then double-click the 1/0 point.

The small dialog box that appears shows the VAL and XVAL, as well as the units.

— The XVAL, or external value, is the “real”or hardware value as seen by the I/O unit. This value

is external to the control engine.

- The IVAL, or internal value, is a logical or software copy of the XVAL that is in the control
engine. The IVAL may or may not be current, since it is updated to match the XVAL only
when a strategy in the control engine reads or writes to an 1/0 point.

% "PID_Input” (scanning)

sl |0

Al | B1.44073

E_

—— Maximize button

2. Tochange the value or to view more information, click the Maximize button.

The title bar shows the name of the analog point and whether scanning is occurring.
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% "PID_Input” (scanning)

Mame: PID_Input
Type:  Analog Input tdore Infog
A— Chaal: 0 Al [B0.57FA +——B
C ——F Communication
Pairt:  'Enabled s
/0 Unit: 'Enabled =1 Open Parent
5

Scanning stops whenever you click a changeable field. It resumes once you click Apply, another
button, or an unchangeable field. If scanning resumes before you click Apply, any changes you
made are lost.

Asterisks in a field indicate an out-of-range value. Dashes in an XVAL field indicate a
communication error.

Change the fields as necessary:

A—IVAL. The point’s current internal value. You can change it to any value within the valid
range of the analog point. For an input, the valid range may exceed the apparent range; that is,
you may be able to enter a value lower than the zero-scale value or higher than the full-scale
value. For an output however, you cannot enter a value outside of the range defined by the
zero-scale and full-scale values. After you change it, click Apply.

B—XVAL. The point’s current external value. You can change it to any value within the valid
range of the analog point; then click Apply.

C—£nable comm. Current point status: Yes on a green background means enabled, No on a
red background means disabled. To change the status, click one of the arrows; then click Apply.

To add the point to a watch window, click Watch and see page 169.
To view configuration information for the variable, click More Info.
To inspect the I/0O unit's configuration, click Open Parent.

(Pro only) To add a plot control, click Plot.

3. "ail6,_Pot” (scanning)
allB_Pot

Type:  Analog [nput (i) More Info

Marne:

IVal: 4390768 sl 42001897

Communication

Paint; Enabled =
10 Urit: Enabled =1 Open Parent
Apply | [ wateh Flat << 5= || Data » | [Valuedsis v | [ Timessis » | [ Show VAL

The Data button allows you to save, copy, or print the current plot. Use the Time Axis and Value
Axis buttons to adjust the resolution. Click Include IVAL to see a concurrent plot of the IVAL.
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Inspecting and Tuning PID Loops

In Debug mode, you can view PID loops and tune them. This section gives you basic steps for

inspecting PIDs, determining system lag, and tuning PIDs. For additional information, see form 2171,
Tuning a PID Control Loop Technical Note, and form 1641, Optolutorial: SNAP PAC PID. Both forms are

available for download from our website at www.opto22.com.

Inspecting a PID

1. With the strategy running in Debug mode, double-click the PID on the Strategy Tree.

3. "pid0” - View PID Loop (scanning)

Name: | pidd Emar: |Mone
Input: 79.2753 Gain: 15 ScanRate: |3
Setpoint: |79 Tunel: (005 Scan Counts: [112783
COutput: | 2252621 Tune O | 0.02
Click a tab to see or
140 Detailz | Migc. Details | MAL || Welocity Algorithm (Type B)

change additional data. B i

Setpoint and Input plot.
Adjust resolution using |
the Input Axis button
below the plot. Click and
drag on the scale to

move the line.

Output plot.

Adjust resolution using
the Output Axis button.
Click and drag on the
scale to move the line.

Tl
0.0 4'_‘—'_'_'_,_,_,_"

13:44:00.0

Time axis. Adjust
resolution using the [
Time Axis button. Click

Data b | [Input Axis b | (Output Asis b | [ Time Asis » |

$BC. Mode: Auta

LR

Enable comm: fres

and drag left or right to

Cloze

[ Addwatch l [Save Tuning] [

Help ]

see other times.

2. Vieworchange PID parameters as necessary. Click the other tabs to see additional data. To tune

the PID, see page 163.

w

menu.

To add the PID to a watch window, click Add Watch and see page 169.
To save, copy, or print the current plot, click the Data button and choose from the pop-up

5. To save changes to any of the PID configuration parameters, click Save Tuning.
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Determining System Lag

You can directly control the PID output to determine system lag, which is essential to setting the PID

scan rate. Also see form 2171, Tuning a PID Control Loop Technical Note, available for download from

our website at www.opto22.com.

1. Determine two significantly different output settings that are within the capabilities of your
system.

2. With the strategy running in Debug mode, double-click the PID on the Strategy Tree.

*

Al
{}

« "pid0” - Yiew PID Loop (scanning)

Mame: | pidl Ermar: |Maone

Input; 79,2753 Gain: 15 Scan Rate: |3 IEC., Mode: Auta |
Setpoint: |79 Tunel: |0.05 Scan Counts: | 112783 Enable comm: [es &
Output; | 2.252521 Tune D: |0.02

Plat 1/0 Details | Misc. Details | AL | Yelocity Algorithm [Type B]

[ Data ][Input.f-\:-cis » ][Dutput.ﬂ\xisb ][Time Az b ]

[ Addwatch ] [Save Tuning] [ Help ]

3. Setthe Mode to Manual (if not set already) and click Apply.
4. Inthe Output field, type one of your two output settings and click Apply.

Use an output value typical of your system but low enough to allow you to change output by
20%.

5. Reset your time axis, if necessary, by clicking the Time Axis and choosing from the pop-up
menu. Then choose Reset Scale Tracking from the same menu.

The span setting varies according to your system; a 3-minute span is often suitable. Until you
are familiar with the PID plot, it is recommended that you avoid using the shortest settings
(10-seconds or 1-second). After you've observed a change in the input, you can zoom in on the
graph, which is described later.

6. Wait for your system to stabilize.
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The system is stable when the Input value does not vary significantly (some drift can be
expected). Stabilization may take several minutes, depending on the system.

b1

% TemperatureControl” - View PID Loop [scanning)

MName:  |pid0 Eraor: |Mone
A stable system exhibits little
‘y | Inpuk— | 7732614 Gain: -5 ScanRate: |1 FEC, Mode: arual =
change in the Input value, —
L . Setpoint: {90 Tunel: |0 Scan Counts: | 249642 Enable comm: [Yes £
which is shown numerically
Output; {20 TureD: |0

and graphically.
Plaot 170 Details | Mizc. Details | AL | Welocity Algorithm (Tyepe B)

Reset Scale Tracking

View S00% Span
View 200% Span
View 100% Span
View 50% Span
View 22% Span
View 10% Span
View 5% Span
View 1% Span

Center on Inpuk
Center on Setpoink

[ Data  » ][Input.’-‘mis » ][Dutput iz p ][Time.-’-\xis 3 ]

Adjust resolution of the
Input Axis by clicking the

Input Axis button. | Addwaich | [SaveTuning| [ Help |

7. Increase the resolution of the Input Axis by clicking the Input Axis menu and choosing a span
setting of 1 or 5 percent.

8. (Centerthe Input Axis, if necessary, by clicking the red line at its left end and dragging it up or
down until the plot is visible.

9. Under the Time Axis menu, choose Reset Scale Tracking.

This is a precautionary step, as changing settings on the plot can fix the plot at a certain point
in time. Resetting the time axis ensures that you are viewing the real-time values.

10

In the Output field, type the other of your two output settings and click Apply.

A 20% percent increase is a moderate, detectable change for most systems. Your system may
require a larger or a smaller change to stay within safety constraints.

11. Wait for a discernible change in the Input axis.
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Plat |/0 Details | Misc. Details | AL | Yelocity Algarithm [Type B)

The Input axis (indicated by
the upper white arrow
added to this picture)
begins to respond to the
change in output (lower
white arrow).

[ Data  p ][Input Az p ][Dutputhxis} ][Timeﬁ-\:-:is 3 ]

12. Increase the resolution of the Time Axis by clicking the Time Axis button and choosing a lower
percentage, such as View 1 Minute Span.

13. Scroll the Time Axis to locate the point at which you changed the Output.

Both the time and input axes should display the point at which the Output changed, the lag,
and the point the input changed. If not, adjust the Input axis and Time axis, until this
information is displayed.

Plat 140 Details | Migc, Details | MAL || Welocity Algorithm (Type B)

[ Data  » ][Input Bz B ][Dutput.-’-‘n.:-cisb ][TimeA:-:iS »

14. From the Data menu, select Cursor.
The data cursor, a line with a value bar attached to it, appears on the plot.

15. Right-click the data cursor and choose Delta X from the Style submenu, as shown below.
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Plat 140 Detailz | Migc. Details | MAL || Yelocity Algorithm [Type B)

Channel

v Yalue XY

Flip alignment Delta ¥

[ Data  » | [InputAsiz » | [Output dsis b | [ Time Asis » |

16. To measure the system lag (the time between the change in output and the change in input),
click and drag the first vertical red bar to just after the output change. Drag the second bar to
just before the change in input.

Plat 1/0 Details || Mizc. Details | WAL || Welocity Algarithm [Type B)

The Delta X cursor displays
the time difference
between the two vertical
bars.

Drag the first bar into
position after the Qutput
change.

Drag the second bar to a
position just before the [ Data  » | [Inputasiz » | [Output Axisk | [ Time dsis » |
change in Input.

If you are unable to get the precision you want, you can view the plot at a lower time span,
such as 10 seconds. You will need to reposition your plot and the measurement bars of the
Delta X cursor.

The example above shows a system lag of 1.88 seconds. Generally, a suitable scan rate can be
anywhere from one-third the system lag to two times the system lag. Considerations in setting scan
rate are:

«  Slower scan intervals may be easier to tune. The PID controller has time to see the effect of the
previous output before calculating a new output.
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Faster scan rates may be necessary to achieve the desired response. When scan intervals are
shorter than the system lag, tuning must compensate for any over-correction from the
controller output.

Tuning a PID Loop

Tuning a PID involves manipulating the P, I, and D constants in real time. The following steps should
be viewed as general suggestions to show you features that are available for tuning. We highly
recommend form 1641, OptoTutorial: SNAP PAC PID, and form 2171, Tuning a PID Control Loop
Technical Note, for more detailed information. These forms are available for download from our
website at www.opto22.com.

CAUTION: Before following these procedures, make sure you know the limits of the equipment being
controlled and monitored by your PID loop. Also, make sure that these points are configured properly. Any
values suggested in these steps are for example only and must be modified according to the capabilities
and constraints of your system.

1.

Make sure the following PID features have already been configured:

Scan Rate

Input

Input low range and high range
Output

Output lower and upper clamp.
Algorithm

Setpoint. If your setpoint changes during normal operation, tune your PID with the
setpoint configured to host, so you can simulate setpoints from an input point or from
another PID.

Gain. A final gain constant will be determined by tuning, but before you can tune your PID,
your gain constant must be either a positive or negative number according to the type of
system you have. For example, a heating system reports a negative error when heat needs
to be applied; a negative gain constant turns this error into a positive output for the heater.
Alternatively, a cooling system reports a positive error when the input exceeds the
setpoint; a positive gain constant maintains the positive output to the chiller.

Optional, depending on your system: Minimum and maximum changes to Output and
Output forcing when the Input is out of range.

Download and run your strategy.

The current PID configuration is written to the I/O unit. You can stop your strategy at this point
if you wish, as the PID will continue operating.

In Debug mode, double-click the PID on the Strategy Tree.
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a0

1/0 Details

MName: | pid0 Erar: |Mone
Input: 79.2753 Gain: -15 ScanRate: |3
Setpoint: |73 Tunel: |0.05 Scan Countg: |172783
Output; | 2252521 Tune D |0.02

Plat Misc. Details | WAL || Welocity Algorithm [Type B]

1T

03:44:000 03:44:300

[ [rata

» ][Input.&xis » ][Dutput.t‘-‘mis) ][Time Bz B ]

03:45:00.0

IEC.

03:

Close

[ Add W atch ] [Save Tuning] [

Help

|

Mode:

Auta

Enable comm: fres

LR

4, Setthe PID Mode to Auto (if not set already) and click Apply.

5. Change the Setpoint, if desired, by typing a new setpoint and clicking Apply. (Setpoint must be

configured as Host.)

Depending on the type of system, your PID may maintain a setpoint or respond to changes in
setpoint. Experiment with setpoint changes again after tuning the P, I, and D constants.

6. Adjust the span of the input, output, and time axes according to how much change you expect
from your system. To set a span, click the axis button and choose from the pop-up menu.

7. Ifdesired, type a new Scan Rate and click Apply.

For most systems, you should use an appropriate scan rate based on the system lag (see
“Determining System Lag”on page 159). However, you can experiment with Scan Rates before
tuning the P.1, and D constants or adjust scan rate after tuning.

Here is an example for Scan Rate:
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The lag for this system was
determined to be about 2
seconds. The left half of the
plot reflects a 0.5-second
scan rate, while the right
half shows a 3-second scan
rate. Notice both scan rates
have the same effect on the
input; however, the
3-second scan rate is using
less of the processor’s
resources.
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3.« "TemperatureControl” - View PID Loop (scanning)

Marne: TemperatureContral Erar: |Mone

Input: 80.24391 Gain: A ScanRate: |3 SEC. Mode: Auto &
Setpoint: |30 Tunel: |10 Scan Counts: [112783 Enable comm: [Yes &
COutput: | 0 Tuns D |0

Plat 140 Detailz | Migc. Details | MAL || Yelocity Algorithm (Type B)

[ Data  » ][Input Bz B ][Dutput.-’-‘n.:-cisb ][TimeA:-:iS » ]

[ Add Watch l [Save Tuning] [ Help ]

Experiment with gain settings by typing a new value in the Gain field and clicking Apply.

The easiest way to tune most PIDs is to experiment with the gain constant first. Try various
gains to see how well the system stays at setpoint and responds to setpoint changes.

In the example below, the white arrows (added for the example) show where gain constants of
-2,-5,-10, and -20 were applied:
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« “TemperatureControl® - View PID Loop (scanning)

£
¥

Marme: TemperatureContral Errar: |Marne

Input: a7.5289 Gain: -20 ScanRate: [1.4 ZEC. Mode: Auto %
Setpoint: |30 Tunel: |0 Scan Counts: |172783 Enable comm: |Yes E
Output;  |B1.7775 TuneD: |0

Plat 140 Details || Mizc. Details | WaL || Welocity Algorithm [Type B)

Input
airk
= (utput

[ Data  » ][Input.&xis » ][Dutput.t‘-‘mis) ][Time Bz B ]

[ Add W atch ] [Save Tuningl [ Help l

In this example, a gain setting of -30 revealed an offset error:

Flat 120 Details | Mizc. Details | WaL | Welocity Algorithm [Type B)

With only a gain constant 80.00
applied, the input often
stabilizes at an incorrect
value. In this heating
example, a gain setting of
-30 drove the input close
to the setpoint, but
subsequent increases 100
failed to eliminate the
offset. Itis time to try
integral constants to
eliminate the offset error.

[ Data b | [Inputduis » | [Cutput Az b | [ Time &xis b |

9. Experiment with the integral constant: in the Tune | field, type a number between 0 and 1 and
click Apply. (Your PID may require larger numbers.)
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In this example, an integral constant of 0.1 corrected the offset error.

Flat |/0 Details | Misc. Details | AL | Yelocity Algorithm [Type B)

The far left side of the plot
shows the offset before an
integral constant of 0.1 was
applied. This setting eliminated
the offset. Inmany applications,
a minor fluctuation around the
setpoint is acceptable, and
these applications use gainand
integral only. In some
applications, however, the
fluctuations at the setpoint
indicate that the gain is too
high (too much gain makes a
system unstable) or that a
derivative constant is required.

30.00

[ Data  p ][Input Az p ][Dutputhxis} ][Timeﬁ-\:-:is 3 ]

10. If derivative correction is needed, experiment with the derivative constant: in the Tune D field,
type 1 and click Apply. (Your PID loop may require a larger number.)

PAC Control User's Guide 167



INSPECTING AND TUNING PID LOOPS

In this example, a derivative of 10 makes a noticeable difference in keeping the input near the
setpoint.

Al

Many PID systems are effective\y %+ - TemperatureControl™ - Yiew PID Loop (scanning)

controlled with gain and integral Mame: | TemperatureControl Eror. |Mone

constants OI’1|)/ and no derivative Input: 3002623 Gair: 30 ScanRate: 1.4 = Muode: Autn 3
‘COHS‘[aI’]t. In 'thIS exampl'e' the'galn and Setpoint; |90 Tunel;, 01 Scan Counts; | 61281 Enable comm; [res ES
integral settings are mamtammg the Ouiput. |66.71089 s

temperature at 0.06 from setpoint. To

demonstrate the effect of the derivative Plat 1/0 Details | Misc. Details | WAL | Welocity Algorithm [Type B)

constant, the resolution of the input axis 0

was increased to show a 1 percent span. Input

At this resolution, the plot reveals
changes of 0.01 degrees F.

The left side of the plot shows the effect
of gain at -30, integral at 0.1, and no
derivative constant. The arrow shows
when a derivative constant of 10 was
applied. The right side of the plot shows
how the derivative constant is keeping
the input closer to setpoint.

[ Data ][InputA:-:is » ][Uutput.ﬂ:-:is} ][Time.t‘-‘mis » ]

[ AddwWatch ] [Save Tuning] [ Help ]

11. Click Save Tuning to save your tuning parameters to the strategy database.

Changes are lost unless you save them. You may wish to save your tuning parameters when
you see any improvement in performance, even if they are not final.

PAC Control Professional

AN

The Following walues will be saved to the strategy database:

Gain: -2,000000
Tune I 10.000000
Tune 200.000000
Scan rate: 3.000000
Feed forward: 0.000000
Feed forward gain: 0.000000
Output min change:; 0.000000
Oukput max change: 0.000000
Oukput when input is under-range: 0.000000
Cukput when input is over-range: 0.000000

Saving these values ko the strategy will require the strategy
to be compiled and downloaded before entering debug mode again,

Do vou want ko conkinue?

12. Click Yes.
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Values are saved to the PAC Control strategy. Remember to save PID parameters to the I/0 unit's
flash memory, too (see “Inspecting I/0 Units and Saving Settings to Flash”on page 153).

<. "Heater_Controller” - View PID Loop (scanning) >

Mame: | TemperatureContral

Wil
"~ Input: i}
A Output: 0
| Setpoint: 84.0032
Gain: 300
B { Integral: 1
| Derivative: ]

C I~ ScanBRate [secl [2
| Max Chg Rate: 10

- Mode: Automatic

F5.00

100

11:14.00.0

Cloze

Error: |Mone

AL

84.02603
4372345
B4.0032
300

1

2
10
| Automate | ¥

Lower Clamp  Upper Clamp

1]
70

10
a0

0,100t 10.000)

[ Addwatch | [

Help

]

Enable Comm: [Yes |+ | —— H

Mame
Fioom_Temperature
Heater
Host

Input Axiz w I
Olutput Auxis w
(Time &sis ~]_|

Using Watch Windows for Monitoring

While the strategy is running, you can monitor several strategy elements at once in a watch window:
I/0 units, digital and analog points, PID loops, variables, even charts. You cannot monitor subroutine
parameters or variables that are local to a subroutine in a watch window.

Unlike inspection windows, watch windows can be created the way you want, docked in a position
most convenient for you, and are saved with your strategy. You cannot change strategy elements in
a watch window, but you can open the inspect dialog box from the watch window and change the

element there.

Creating a Watch Window

1. With the strategy open and in Debug mode, choose Watch > New.

2. Inthe Create New Watch Window dialog box, navigate to the location where you want the
watch window file to be kept (usually in the same folder as the strategy). Enter the watch

window file name and click Open.
The empty watch window appears.
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«+ Waich 2 ¢ LEX
| Mewe  Type  TwaL  zwAL
< i

3. Add elements you want to watch in this window by clicking them on the Strategy Tree and
dragging them into place in the watch window, or by right-clicking them and choosing Watch
from the pop-up menu.

You can add I/0 units, digital and analog points, PID loops, variables, and charts. You cannot
add subroutine parameters or variables that are local to a subroutine.

Depending on which element you add and how you add it, it may appear immediately in the
window, as shown here.

L Watch 2 o |Z_|@[Z|

Name Type IVLL EWAL

2 X

For some elements, the Add Watch Entry dialog box appears, so you can specify what to watch.
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#1 Add Watch Entry

Mame: IDigitaI_Eontrol |

Select Portions Tow atch:

ltems in this area vary a‘a;“ Select &l
. ode
depending on the element By il

you are watching. This [] Block Paused &t
example shows a chart.

Select Watch Window

I Ok, H Cancel l[ Help ]

4, Ifan Add Watch Entry dialog box appears, click to place or remove the check mark next to any
item. When all the items you want to watch are checked, click OK.

The element is added to the watch window.

The watch window is automatically saved.

Opening an Existing Watch Window

If a watch window was open when you exited Debug mode, it will automatically open again when
you re-enter Debug mode. To open other watch windows, follow these steps.

1. Make sure the strategy is open and in Debug mode.
2. Choose Watch > Open.
3. Navigate to the watch window you want to open and double-click its name.

The window opens in the position you left it.

Working in Watch Windows

Watch windows are flexible. You can dock the window where you want it in the PAC Control main
window. You can also move, delete, and inspect elements in the window.
«  To dock the watch window, click the docking button B in its title bar.

The window moves to its own frame.
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"Docked” watch window

Expand or collapse the
item by clicking the +
or - sign in the box.

CEX
ﬁFile Edit Control Engine Debug Chart  Subroutine Mode Tools Wiew ‘Watch  Window Help - 8 x
m 0

ookie < (%]

A PAC Control Professional - [Oven_Inspection_Control]

¥ U

= I5) Cookies
I5) Control Engines

[

Subroutings Included
Charts
5 Wariables
I3 Mumeric Yariables
IC5) String Wariables
IC5) Pointer Yariables
I5) Communication Hanc
5 Mumeric Tables

=

IC5) Stiing Tables
IC5) Pointer Tables
= £ 140 Units
= 28 Mixed_10_Unit
# = Paines (4} - - - o DropDough | - - - - - - . . 3
=) PIDs < | Sl

| »

MDD,

< |
b Mext  qp Prev ﬂ’l Dough_Chip_Contral ﬂ’l Oven_lnspection_Control |
ount Watch — S P — Y |
Harme Type IVAL HWVAL L]
nCookieCounter Integer 32 Warisbhle 713
£ {02} diInspectionPassFail... Digital Input
e Ztate 0:) 0FF
- On-Latch OFF OFF
CQff-Latch OFF OFF v
Debug UM

See “Docking Windows"on page 61 for more information.

+  Toexpand or collapse watch window you have added to an I/0 unit, PID loop, chart, or
table, click its plus or minus sign.

1 Watch 2 o EEX
| Meme Type WAL WLL
{12t Tewperature... Analog Input - Deg... O -272.85985

SMAP Mixed Ultcimat...

Switch DO Counter
Sprinkl... Digital Cutput OFF OFF
{12} Tewpera... Analog Input - Deg... 0 -272.9154
Digital Control Chart
< |

+  Torearrange elements in the watch window list, click the item you want to move and drag it
to a new location, or right-click it and choose Move Up or Move Down from the pop-up menu.

You can also sort elements in the window by clicking on the column label. For example, to sort
by Type, click the label Type in the column heading. Click again to change the order from
ascending (A-Z) to descending (Z-A).

+  Tomove an element from one watch window to another, open both windows and drag the
element where you want it. To copy an element to another watch window (so it will appear in
both windows), hold down the Ctrl key while you drag it.
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To delete an element, right-click it and choose Delete from the pop-up menu.
To inspect an element, double-click it.

The inspect dialog box opens. For information on using it, see “Inspecting Control Engines and
the Queue”on page 111,
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7: Working with Strategies

Introduction

A strategy is the software program you create in PAC Control. A strategy is similar to a file in any
Microsoft Windows program. You use standard Windows menu items to create a new strategy, to
open an existing strategy, or to save a strategy. The strategy includes all the definitions and
instructions necessary to control your process. This chapter is a step-by-step reference for working
with strategies in all three strategy modes: Configure, Debug, and Online.

In this Chapter

Creating a New Strategy........c.eeeeeressssss
Opening a Strategy...............
Saving and CloSING wocvvvveeeccenee
Saving a Strategy to Flash
Archiving Strategies on the Computer.......... 179

Compiling and Downloading ........cccccceeeeeeee, 180
Running a Strategy Manually ... 189
(D23 oTUToTo 10T OO 190
Viewing and Printing ......eceveeeooeeersscseeesne 197
Searching and Replacing .......cveeereccceeeseee 208
Legacy Options

Advanced OPLIONS .......vvveeeeeeeeereeeenssssssissseeeees 214

Creating a New Strategy

Each PAC Control strategy must be located in its own directory. When you create a new strategy, you
must create a new directory or use an empty one. Each strategy in its own directory keeps all its files
in one place and makes it easy to copy a strategy to another location for modification or backup.

1. Tocreate a new strategy, select File > New Strategy, or press Ctrl+N, or click the New Strategy
icon ' on the toolbar.

2. Inthe New Strategy dialog box, navigate to the directory where you want the strategy to be
placed. Create a new folder if necessary.

3. Type the strategy name.
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As you can see in the Files of type field, PAC Control files have an extension of .idb.
4, (lick Open.

The new strategy is created. Its Strategy Tree and Powerup charts appear in the PAC Control
main window. For information on the main window, see “PAC Control Main Window” on
page 54. For programming information, see “4: Designing Your Strategy.” For steps to create
charts, see “8: Working with Flowcharts”

Opening a Strategy

Only one strategy at a time can be open in PAC Control. If you currently have a strategy open, it must
be closed before another is opened. You are prompted to save changes before it closes.

Opening an Existing Strategy

1. Toopen an existing strategy, select File > Open Strategy, or press Ctrl+0O, or click the Open
Strategy icon = on the toolbar.
2. Inthe Open Strategy dialog box, navigate to the strategy you want to open and click Open.

The strategy opens in Configure mode, with the windows in the same position they were when
the strategy was closed.

Opening an ioControl Strategy

If you have been using ioControl Basic or Professional with a SNAP PAC controller, migration to PAC
Project Basic or Professional is simple. Because the individual programs within the suite are
essentially the same (although they have new features and hardware support), you can simply open
a strategy in PAC Control and then save it. For safety, we recommend you back up all ioProject files
before opening them in PAC Project. See also, “Opening Strategies in PAC Control” below. For more
information on migrating your system to SNAP PAC, see form 1680, the SNAP PAC System Migration
Technical Note.

Opening a Recently Used Strategy

To open a strategy you have recently used, choose its name from the list at the bottom of the File
menu. The ten most recently opened strategies are listed.

Loading a Strategy or Mode at Startup
To have PAC Control automatically start up with the strategy that was open when you exited, choose
Configure > Options and click to put a check mark next to Load Last Strategy at Startup.

To have PAC Control open strategies in the same mode as when you exited PAC Control, choose
Configure > Options and click to put a check mark next to Load Last Mode at Startup.
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Opening Strategies in PAC Control

A strategy saved in ioControl version 6.1 or less can be opened in either PAC Control Basic or
Professional. A PAC Control Basic strategy can also be opened in PAC Control Professional. However,
PAC Control Professional strategies cannot be opened in Basic or in any earlier version of

PAC Control.

CAUTION: Once a strategy is opened in PAC Control Professional, it can no longer be opened in
PAC Control Basic.

Opening an OptoControl Strategy

If you are moving a strategy from OptoControl to PAC Control Professional, PAC Control will open it
and help you convert it. Although many things will convert without difficulty, planning ahead is
essential to make the job easier. Before opening an OptoControl strategy in PAC Control, read
form 1692, the FactoryFloor to PAC Project Migration Technical Note.

Pro

Saving and Closing

CAUTION: Once a strategy is opened in PAC Control Professional, it can no longer be opened in
PAC Control Basic.

Saving the Strategy and All Charts

To save all your work quickly, choose File > Save All. The strategy and all modified charts and
subroutines are saved.

Saving the Strategy and Some Charts

NOTE: You cannot save changes to a subroutine this way. To save a subroutine, use File > Save All, or use
Subroutine > Save or Subroutine > Save All.

1. Tosave changes to some charts but not others, click the Save Strategy icon & on the toolbar
(or choose File > Save Strategy, or press Ctrl+5).
The Save Strategy dialog box appears, highlighting all charts modified since the last save.

1 5ave Strategy E|

Save strategqy and zelected charts:

Digital_Control Select Al
Flag Example Chart =
Clear &l

)8 l[ Cancel ][W]
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2. To save some charts and not others, press Ctrl and then click any charts you don't want to save.
You can also click Select All to select all of the charts, or click Clear All to select none of them.
3.  When only the charts you want to save are highlighted, click OK.
The strategy and the highlighted charts are saved.

Saving the Strategy to a New Name

1. Tosave the strategy and all its charts under a new name, choose File > Save Strategy As.

2. Inthe Save Strategy As dialog box, navigate to where you want the new strategy to be. Create a
new folder if necessary.

Remember that each strategy must be in its own directory.
3. Inthe Strategy Name field, enter the new strategy name. Click Save.

The strategy and all its charts are saved under the new name in the new directory.

Saving Before Debugging

When you change to Debug mode, you are prompted to save a strategy you have modified. If you
don’t want to be prompted to save before entering Debug mode, choose Configure > Options and
click to remove the check box for Prompt To Save Strategy Before Running Debugger.

Closing a Strategy
To close a strategy, click the close box in the Strategy Tree or choose File > Close Strategy.

NOTE: Since only one strategy at a time can be open in PAC Control, creating a new strategy or opening an
existing strategy automatically closes any current strategy first. If you've made changes to the current
strateqgy, you are prompted to save them.

Saving a Strategy to Flash

178

When you finish working on your strategy and have downloaded it, you should save it to the control
engine’s flash memory. By default, a strategy is downloaded to the control engine’s RAM. Saving it to
flash protects the strategy in case of a power loss. You can save it to flash just once, when needed, or
save every time the strategy is downloaded.

Saving to Flash Once

You can save the strategy to flash at any time when you are in Debug mode. To do so, choose
Control Engine > Save Strategy to Flash.
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Saving to Flash on Every Download

CAUTION: It is possible to wear out flash memory if you save to it many, many times. Use the following
steps only when your strategy is finished.

1.  When you have finished the strategy and are in Configure mode, choose File > Strategy
Options.

2. Inthe Strategy Options dialog box, click the Download tab. Check Save strategy to flash
memory after download.

Strategy Options X
Archive Download  Seral I/ Pots  Legacy

Flash Memory

[liSave strateqy to flash memory fter download:
[ 5et autorun flag after download

Background Downloading

[] Use background downloading and fast strategy updating

The controller must be corfigured for this feature using PAC Manager.

Download Compression
None Full

Start Strategy
[ Start strateqy after download completes

Cancel Help

If a control engine loses power and then restarts, the autorun flag tells the control engine to
automatically start running the strategy that is in flash memory. If the autorun flag is not set,
the strategy must be started manually after power is restored to the control engine.

3. To have the strategy run automatically after a control engine restarts, check Set autorun flag
after download.

4. C(lick OK.

Archiving Strategies on the Computer

Archiving strategies to the computer helps you track changes during development and provides a
backup in case of a failure on the control engine. Archive files are date and time stamped, and
Zipped for compact storage that you can copy to another computer or disk for backup. Archives are
always placed in the same folder as your strategy. Since a new archive file is created each time you
archive a strategy, remember to manually delete any old archive files you do not want to keep.

We recommend you archive both to the computer (during strategy development) and to the
control engine (when the strategy is completed). Archiving to the control engine as well as the
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computer makes sure that an older strategy can always be found and updated, even after personnel
changes occur and years pass. See also, “Archiving Strategies on the Control Engine” on page 116.

PAC Control offers three ways to archive strategies to the computer:

»  Tomake an archive at any time, choose File > Archive Strategy. A dialog box shows you the
name and location of the archive file.

»  To have an archive automatically created whenever the strategy is closed, choose File >
Strategy Options. In the Strategy Options dialog box, click Archive strategy to disk when
strategy is closed.

+  Tohave an archive automatically created whenever the strategy is downloaded, choose File >
Strategy Options. In the Strategy Options dialog box, click Archive strategy to disk when
strategy is downloaded.

The archive file name will be in one of the following formats:

Archive method File name format

Manual archive or archive when strategy is closed Path\Filename.Archive.D02282007.T114351.zip

Archive on download Path\Filename.Download.D02282007.T114351.zip

Archive when downloading from online mode Path\Filename.Online.D02282007.T114351.zip

The date stamp (D) is in the format mm/dd/yyyy. In the examples above, the date is February 28,
2007.The time stamp (T) is in the format hh/mm/ss. In the examples above, the time is 51 seconds
past 11:43 AM.

Compiling and Downloading

180

TIP: To configure a strategy to start running at completion of the strategy download, select the "Start
strategy after download completes" check box on the File > Strategy Options > Download tab.

Before your strategy can be tested or run, it must be compiled and then downloaded to a control
engine. When a strategy is compiled, all the commands, OptoScript code, charts, and variable and
/0 definitions it contains are verified and converted into a format that the control engine can
understand. Then the strategy can be sent (downloaded) to a control engine. Only compiled
strategies can be downloaded.

NOTE: Before you can download your strategy, make sure you have downloaded the latest firmware to
your control engine. For instructions, see the controller’s user’s guide.

Compiling and Downloading in One Step

NOTE: If you are using Ethernet link redundancy in PAC Control Professional, make sure you are
downloading through the IP address you want to use, either the primary or secondary address. See “Using
Ethernet Link Redundancy in PAC Control” on page 104 for more information.

1. With the strategy open in PAC Control, click the Debug mode icon on the toolbar, or
choose Mode > Debug.
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Changing to Debug mode automatically saves and compiles the strategy, including all code in
OptoScript blocks.

2. [Ifyou see a Powerup Clear Expected message, click OK.

A download warning message may appear.

Download Warning,

X

r\ Strategy Mismatch
- -

The strateaqy to be downloaded does not match the strategy already in the contral engine.
Strategy To Download

 MName: Sprinkler_Control
2 Checksum: A4DCBOCSCOECE13D7E9F123FE148EB 11
Timestamp:  07/02/03 10:56:05

Strategy in the Controller

Mame: Sprinkler_Control
Checksum:  B2FF33307FFRC2B4EATDDAACIOGAE024
Timestamp: 06430709 1253:24

If pou chooge to continue, the strategy that is in the control engine will be replaced by this strategy.

Do you want bo continue the download?

Cvee J[He J[ tee ]

This message tells you that the strategy to be downloaded doesn't match the strategy already
loaded on the control engine, either because it is a different strategy or because it has been
changed since the last download.

3. To continue the download, click Yes.

As the strategy is compiled, the Compile Progress dialog box appears. This dialog may appear
only briefly. However, if there are errors or warnings, the dialog box will stay open. You can copy
the errors and warnings by clicking the right mouse button and selecting Copy All as Text.
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Compile Progress

E

Compiling tags...
“WwWARMIMG - Senal port 2 iz being uzed by [/0 Unit tixed 0" but has not been configured for [/0,

Compiling charts...
Condition_[elay
Corrveyer_Qperation
Powerup
Shipping_Area
Timer_Example_Chart

Compiling subroutines...

Building run file...

Darne.

0 error(g). 1 warninglz)

s | 2

Frogress: (HNNENNNNNRENRNRERRN RN NN RN AN ANAN| Eros O A Warmings: 1

Cloze

If there are errors, the strategy will not compile. Click Close to continue in Configure mode.
If there are only warnings, click Close to continue in Debug mode.
If no errors or warnings occur, the Strategy Download dialog box appears.

i | Strategy Download &l

E Downloading your strateqy
w

Download strategy: [lllllllllllllllllllllllq

=P Store to flash memaony: [lll l

Cancel

The Strategy Download dialog box will vary somewhat depending on your settings.

NOTE: If you are using background downloading (see “Background Downloading” on page 184), while the
strategy is downloaded, there may be a very slight degradation in performance. This is due to the overhead
on the controller to process the strategy download.

4, (Optional) If there is already an active strategy which is set up to have an alternate strategy, and
you want to switch strategies, click Switch & Run to stop the active strategy and run the
strategy you just downloaded. Or, you can click Switch to stop the active strategy and make the
new strategy the active one (but not yet running).

Cancel aborts the new download. The controller is left as it was before the download occurs.

When the download is complete, you are in Debug mode. (If you receive errors, see “A:
Troubleshooting.”)

After switching strategies, you can switch back to the original strategy by clicking Control Engine >
Inspect in Debug mode and use the Switch and Run or Switch button in the Inspect Control Engine

PAC Control User's Guide



CHAPTER 7: WORKING WITH STRATEGIES

dialog box, or you can use PAC Terminal. When the strategy is switched back, the persistent variables
are created and compared.

Switching the Strategy

If there is already an active strategy which is set up to have an alternate strategy (as described in
“Background Downloading”on page 184), and you want to switch strategies, do the following:

1. In Debug mode, choose Control Engine > Inspect to open the Inspect Control Engine dialog
box.

2. Choose either the Switch and Run or the Switch button.

The Switch & Run button stops the active strategy and runs the strategy you just downloaded.
The Switch button stops the active strategy and makes the new strategy the active one (but
not yet running).

When the strategy is switched (as described in the previous steps), the following operations occur:

«  Persistent variables are compared. If the type and size of the persistent variable are consistent,
the contents are copied. If the type and size do not match, a new persistent variable is created.
New persistent variables are initialized to zero and new persistent strings are initialized to NULL
(empty) strings.

+ /0 unit configurations are compared. If the I/O unit configurations match, I/0 will not be
initialized.

«  The Powerup chartis called.

See also, “Background Downloading” on page 184.

Compiling without Downloading

Sometimes you may want to compile without downloading, just to see if a chart, subroutine, or
strategy compiles correctly. You can compile the active chart or subroutine only, just the changes
you have made to the strategy, or the entire strategy.

Compiling the Active Chart or Subroutine

Whenever a chart or subroutine window is open and active, you can compile just that chart or
subroutine. To do so, in Configure mode, click the Compile Active View icon & on the toolbar, or
choose Compile > Compile the Active Chart. The menu option shows the name of the chart or
subroutine you are compiling.

As soon as you choose the menu option, the chart or subroutine is saved and compiled. You are
alerted only if errors are found.

Compiling Changes Only

To compile just the changes since the strategy was last compiled, choose Compile > Compile
Changes. The menu option shows the name of the strategy you are compiling.

As soon as you choose the menu option, the strategy and all modified charts and subroutines are
saved and compiled. You are alerted only if errors are found.
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Compiling the Entire Strategy

To compile the entire strategy including all charts and subroutines, in Configure mode, click the
Compile All icon & on the toolbar, or choose Compile > Compile All. The menu option shows the
name of the strategy you are compiling.

As soon as you choose the menu option, the entire strategy is saved and compiled. The Compile
Progress dialog box appears. You are alerted if errors are found.

Downloading Only

If your strategy has been compiled, you can download it again quickly. Downloading again is useful
if you want to run your strategy from a clean slate by reinitializing any variables that are set only on a
strategy download.

To download a strategy that has already been compiled, you must be in Debug mode. Choose
Control Engine > Download Strategy.

The Download to dialog box appears and your strategy is downloaded.

TIP: To configure a strategy to start running at completion of the strategy download, select the "Start
strategy after download completes" check box on the File > Strategy Options > Download tab.

Background Downloading

The Background Downloading feature allows you to download an alternate strategy to a controller
while the active strategy currently on the controller continues to run. With two different strategies
downloaded to the controller you can switch rapidly from one strategy to the other.

This allows you to:

«  Download a new or updated strategy to the controller and then optionally run it with minimal
downtime. For larger strategies, downtime is dramatically reduced.

«  Download and test a new or updated strategy but still keep the original strategy available. You
can bring back the original very quickly, either by manually switching from one strategy to the
other, or—if the original is still burned to flash—by cycling power.

You can use background downloading as an alternative to Online mode, which also allows you to
make changes while a strategy is running. The following table describes the differences between
Online Mode and Background Downloading:

Online Mode Background Downloading

Can you add variables, 1/0,

and charts? No Yes

Can you add and change
blocks, change instructions, | Yes Yes
and edit existing charts?

. . Only the edited charts are The entire alternate strategy is down-
What is downloaded in . . -
downloaded. All other charts loaded while the entire active strategy
Debug mode? . .
keep running. continues to run.
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Online Mode Background Downloading
Where does the strategy The affected charts restart at If you switch to the alternate stratggy after
download, the strategy restarts with the
restart after download? block 0.

Powerup chart.

When a chart is downloaded,
the old one is not deleted, so
How is the controller mem- this consumes additional mem-
ory affected? ory. To clear memory, the strat-
egy should be stopped and then
compiled and downloaded.

Controller memory is cut in half when
background download is set it in PAC
Manager. Also, one chart is used for the
alternate download port, so there is one
less chart that can run.

To enable Background Downloading:

NOTE: Controller memory is cut in half when background downloading is set in PAC Manager. Also, one
chart is used for the alternate download port, so there is one fewer chart that can run.

1. Open PAC Manager and do the following steps:

a. (lick the Inspect icon to open the Inspect window.

b. Inthe Inspect Window's IP Address field, type the IP address for the SNAP PAC controller.
c. Click Status Write, then scroll down to Strategy Download Method.

d. Click on the Value field for Strategy Download Method, select Background from the

drop-down menu, and then click Apply.

e. Under Operation Commands, highlight “Store configuration to flash,”and click Send

Command.
The configuration is stored to flash memory and a

For more information, see Opto 22 form 1704, the PAC

Success message appears.
Manager User’s Guide.

2. Turn off the power to the control engine, and then turn it back on again.
3. In Configure mode in PAC Control, choose File > Strategy Options.
4. Inthe Download tab under Background Downloading, select “Use background downloading

and fast strategy updating.”

5. (Optional) Under Flash Memory, select “Save strategy to flash memory after download.”

6. (Optional) To have the strategy run automatically after
autorun flag after download.”

| Strategy Options
Archive Dowrload  Seqal /0 Ports  Legacy

Flash Memony

Background Downloading
[] Use background downloading and fast strateqy updating

The controller must be configured faor this feature using PAC Manager

Download Compression
MNaone Full

Start Strategy
[ 5tart strateqy after download completes

Canl

a control engine restarts, select “Set

Help
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7. C(lick OK.

PAC Control is now set to download the strategy in the background when you click the Debug
mode icon ETM. Next, see “Compiling and Downloading” on page 180. See also, “Switching the
Strategy”on page 183.

Downloading Without Using PAC Control

If you are creating strategies for users who do not have PAC Control on their systems (for example, if
you are an integrator or OEM), you can make a control engine download file that can be
downloaded to a SNAP PAC controller by using either the graphical interface in PAC Terminal or the
command line interface with a batch file. This one download file is built for a specific control engine
but can also be downloaded to other similar control engines. It contains everything PAC Control
would download, including .per, .inc, and .crn files, control engine-specific files, and initialization
information.

In most cases you will want the downloaded strategy to be saved to flash memory and to start
automatically (autorun) when power is cycled to the control engine. Before you create the
download file, follow the steps in “Saving to Flash on Every Download” on page 179. Check the
boxes to have the strategy saved to flash memory after download and to set the autorun flag after
download. This information will become part of the download file.

Creating the Control Engine Download (.cdf) File

With the strategy open in PAC Control in Configure mode, right-click the name of the control engine
in the Strategy Tree and choose Compile Control Engine Download File from the pop-up menu. (You
can also choose Compile > Compile Control Engine Download File.)

The file is created in the same folder as the strategy, with a .cdf extension and a file name consisting
of the strategy’s name and the control engine’s name (for example, MyStrategy.MyEngine.cdf).

Once the control engine download file is created, it can be downloaded using either the graphical
interface in PAC Terminal or the command line interface with a batch file you create.

Downloading the .cdf File using PAC Terminal

1. Start PAC Terminal as follows:

- InWindows 7 and Windows Vista, press the Windows Start key :5/" and then click
Programs > Opto 22 > PAC Project 9.6 > Tools > PAC Terminal.

- InWindows 10 and Windows 8.1, press the Windows Start key (&) type PAC Terminal

9.6 and then press the Enter key.
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The PAC Terminal window appears.

Eile Tools Configure View Help

Control Engines:
Controller I;a'ne System Type Address 1 Address 2 Status
#'Cookie Controller  Standard v127.0.0.1 %
#R1 Controller Standard ¥10.195.55.111 #
Status Scan

S sanal

“% Scap Selected
< >

2. Right-click the name of the control engine you want to download the file to.
3. Inthe pop-up menu, choose Download > Control Engine Download File.

4. Enterthe path and file name of the .cdf file, or click the Browse button and navigate to it. When
the file name appears in the File to Download field, click OK.

The file is downloaded to the control engine.

Using Command Lines or a DOS Batch File to Perform PAC Terminal Tasks

If you do not want your end user to have to use PAC Terminal, you can use DOS-level commands or
create a DOS batch file to download a .cdf file. In addition to downloading a .cdf file, the DOS
commands can also run or stop a strategy, or define the control engine on the PC that will download
the file. PAC Terminal must be installed on the PC where the batch file is used.

The following table lists actions you may want to take within PAC Terminal:

Show help information for termcl -h control_engine_name

Download the specified file to the specified controller.

Compression can be between 0 (none) and 10 (max). ~d control_engine_name filename [-z compression]
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To do this Use this

Run the strategy in the specified control engine —-I control_engine_name

Stop the strategy in the specified control engine —S control_engine_name

Send a Forth command to the control engine —C control_engine_name Forth_command

existing definition.

Add a control engine definition to the system. Does not modify an

Example: -a MyCE tcp 10.20.30.40 22001 0 2000

—a control_engine_name tcp ip-addr port retries timeout_ms

Download the encrypted SSD file to the controller —-dp control_engine_name ssd_filename

Prevent response messages from printing to the DOS screen Append the DOS switch —q

This example shows lines included in a batch file that will define the control engine, download the
.cdffile to it, and then run the strategy:
termcl -a MyCE tcp 10.20.30.40 22001 0 2000

termcl -d MyCE ""c:\My_Project\MyStrategy.MyCE.CDF"
termcl -r MyCE

Changing Download Compression

If you have a very large strategy, short timeouts, and slow connections on your network, you may
need to decrease the compression level to download the strategy successfully. When you decrease
compression, the strategy takes longer to download because it is sent in smaller chunks. If you are
having difficulty downloading your strategy, follow these steps to decrease compression:

1. With the strategy open in Configure mode, choose File > Strategy Options.
2. Inthe Strategy Options dialog box, click the Download tab.

| Strategy Options X
Archive Download  Seral /0 Ports  Legacy

Hash Memary
[] Save strategy to flash memory after download
[] Set autorun flag after download

Background Downloading

[] Use background downloading and fast strategy updating

The caontroller must be configured for this feature using PAC Manager.

Download Compression
Mone Full |

. Slider

Start Strateqy
[] Start strateqy after download completes

Concel | [P
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3. Move the slider to the left to reduce compression, and then click OK.
You may need to experiment with the setting until the strategy downloads successfully.

Running a Strategy Manually

1.  With the strategy open, choose Mode > Debug.
2. (lickthe Run Strategy icon p (or press F5, or select Debug > Run).

You can also run a strategy from the Inspecting dialog box. See “Inspecting Control Engines in
Debug Mode”on page 111.

Running a Strategy Automatically (Autorun)

You can set the strategy to run automatically (autorun) if the control engine loses power and then
restarts. In traditional Opto 22 controllers, the OptoControl autorun function was controlled by a
jumper. For PAC Control, it's controlled by the autorun flag. If the autorun flag is not set, the strategy
must be started manually after power is restored to the control engine. The strategy must be saved
in flash memory for autorun to work.

You can set the autorun flag in two ways:

+  In Configure mode, save the strategy to flash memory and set the autorun flag every time the
strategy is downloaded. (Be careful you do not save to flash too often, as flash memory
eventually wears out.) See “Saving to Flash on Every Download”on page 179.

«  In Debug mode, save the strategy to flash memory by choosing Control Engine > Save
Strategy to Flash. Then right-click the control engine in the Strategy Tree and choose Inspect
from the pop-up menu. In the Inspect dialog box, enable Autorun. (See “Inspecting Control
Engines and the Queue”on page 111 for more on the Inspect dialog box.)

Protecting a Running Strategy
If you want a strategy to run automatically without interruption, you can protect the strategy by
disabling all host communications to the control engine.

To protect the strategy, first make sure the strategy is saved to flash and that the autorun flag is set.
To disable host communication, open PAC Manager and set the Control Engine port to 0, and then
save that change to flash. For more information on setting this port, see Opto 22 form 1704, the PAC
Manager User's Guide.

NOTE: This action also disables communication between PAC Display and the control engine.

Stopping a Strategy

To stop the strategy, click the Stop Strategy icon m (or press F3, or select Debug > Stop). You can
also stop a strategy from the Inspecting dialog box; see “Inspecting Control Engines in Debug
Mode"on page 111.
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DEBUGGING

Debugging

Once the strategy is running, if it doesn't appear to be working correctly, you can use several tools in
Debug mode to figure out what the problem is. You can pause a chart or subroutine; step into, over,
or out of each block; watch it slowly step through the blocks; or add a breakpoint to a block to stop
the strategy just before it executes that block.

The chart's or subroutine’s status is shown in the lower left-hand corner of its window. This corner
shows whether the chart or subroutine is running, stopped, or suspended, and whether the
debugging tools, such as stepping and breakpoints, are in effect. The chart or subroutine must be
running in order to use these tools.

Choosing Debug Level

You can choose one of two levels of debugging:

+  Minimal Debug lets you step from block to block, but does not allow you to step into blocks.
Less information is downloaded to the control engine for minimal debugging, so downloading
the strategy takes less time and less control engine memory. The strategy also runs slightly
faster.

»  Full Debug lets you step into blocks, so you can step through each instruction in an Action or
condition block and through each line of OptoScript code in an OptoScript block. If you are
using OptoScript, you will probably want to spend the additional time to download your
strategy at the full debug level.

To change debug level, make sure you are in Configure mode. From the Configure menu, choose
Minimal Debug or Full Debug. The next time you enter Debug mode, the strategy will be compiled
and downloaded with the new level.

Changing Debugger Speed

Before you enter Debug mode, you may want to consider changing debugger speed. Depending on
the number of charts and windows open in PAC Control, and depending on other processing your
computer is doing at the same time, you may find that running the debugger affects the computer’s
or the control engine’s performance of other tasks. If necessary, you can slow down the debugger by
increasing the time delay between debugging calls to the control engine, therefore leaving more
processing time for other tasks.

In addition, a slower setting may be useful when checking communication using PAC Message Viewer
(see page 392)).
To change debugger speed, follow these steps:

1. With the strategy in Configure mode, choose Configure > Options. Alternatively, in Debug
mode, choose Debug > Options.
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2. Inthe PAC Control Options dialog box, click the Debugger tab.

QPAC Contrel Options b4

Workspace Debugger Advanced

Debugger Peformance
Hi Low

‘When stepping, make sure the active block is visible

Prompt before starting or stopping a strategy

Concal | [Pl

3. (lickand drag the slider to the speed you want.

The default speed is shown in the figure above. Since performance varies depending on your
hardware and software, you may need to experiment to find the most efficient speed.

If you don't want the debugger to follow auto stepping, deselect “When stepping, make sure the
active block is visible.”

Pausing a Chart or Subroutine

You can temporarily stop any running chart or subroutine by pausing it. When you pause a chart or
subroutine, it finishes the instruction it was executing, then stops at the next block (in Minimal
Debug) or the next line (in Full Debug).

To pause the chart or subroutine in the active window, click the Pause Chart or Pause Subroutine
icon 1, or press F7, or select Debug > Pause Chart or Debug > Pause Subroutine.

Here's an example of a paused chart:

~ Powerup E| [E| le
-

This chart starts the program and all other charts.

0
Start Program

Wait until start flag is set
F | true (non-zero).

] Start the alarm monitoring,

Start Charts dough/chip control, pressure
control, and oven/inspection
charts.

v

Status bar—Step On —_|

< >
o [ oo o Lo o Jrvson-ro - G
% Chart /
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Hatch marks and a red outline appear on the Start block, indicating that this block is to be executed
next. The status bar shows Step On, which means you can step through the chart or subroutine if
you wish.

Stepping Through a Chart or Subroutine

When you step through a chart or subroutine, you control the timing and execution of its
commands in a running strategy. You can see what commands are being executed when, and you
can monitor the status of variables and I/0 that are affected by the commands.

There are two types of stepping: single-stepping and automatic stepping. Use single stepping to go
through flowchart blocks at your own pace. Use auto stepping to watch the flowchart step
automatically.

CAUTION: Since stepping through a running chart or subroutine—even auto stepping—slows down
execution, be cautious if your strategy is running on real equipment. For example, stepping through a
strategy might leave a valve open much longer than it should be.

Single Stepping

When you are debugging a strategy, start by using the Step Over icon to go through a chart one
block at a time. The Step Over icon may be all you need to find any problems. If necessary, go back
to Configure mode and change to full debug (see “Choosing Debug Level”on page 190) so you can
step into blocks and execute one line at a time.

1. Pause the chart or subroutine to be stepped through by pressing the Pause Chart or Pause

Subroutine icon I .

2. Tostep to the next command block, click the Step Overicon i (or press F10, or select Debug
> Step Over).

The commands in the highlighted block are executed, the hatch marks move to the next
command block, and the chart pauses again. Compare the chart below to the one on
page 191.

The hatch mark has moved to the next block.

= Dough_Chip_Control [Z| [E| rg|
M

i
as been started.
T

5 Drop the dough.

rop Dough
7 Drop the chips.
Drop Chips
W

£ >
ERNURARNII o= [ 5]

Chart
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If you need to step inside flowchart blocks and move through them one command at a time (or
in OptoScript blocks, one line of code at a time), make sure you have downloaded your strategy
at the full debug level. See “Choosing Debug Level” on page 190 for help.

If the chart or subroutine is not already paused, press the Pause Chart or Pause Subroutine icon
i .

To step inside the block you are on (the one with the hatch marks), click the Step Into icon ™
(or press F11, or select Debug > Step Into).

The Step Into button takes you inside the current block,
S0 you can step one command at a time.

The red arrow indicates the command

_ 10_Enabler_Chart M=l
— el o ['_IF’_IFX that will be executed next.

........ Initialization /- - - - - - . . A

"""" _ 10_Enabler_Chart (=13

A

// Check pointer table element to ses
if (ptIQ_Mnit=[nlI0 EnablerIndex] == nu.

s Ho I/0 unit i= loaded in the ptI0
ntI0 UnitCommEnableStatus[nlI0 Enable:

........ |-
..... N A it N
24,210 Enabler 52

----- " f<Enet & PACSS - -
5

..
B e e e e e e

""" iy i elsge ~ I0 Unit pointer is wvalid at th:
----- - - HumberToStringi{nlQO EnablerIndex. =10
..... 7 Get pointer to IO Unit

pl0_TnitEnetPAC = ptI0_Unit=[nlI0 Enal

---------------- <+ Check to see if the user wants tl

1if (ntIl _DnitUserDi=able[nlI0 Enabler:
iF (ToTallnd t CommFanahlad fen T Thad + B

b

L0/

Ch
Illllf*qlmf i'

hart /, OptoScript Block - *10 EnablerliEnet & PAC™ - Id #2 /_

The small gray tabs at the left The white tab shows you where
of the white tab show how you are:inside a chart, a block, ora
you got to where you are. subroutine called by a chart.

To move from line to line, click either the Step Into or the Step Over icon.

If a command within the block calls a subroutine, Step Into takes you into the subroutine. Step
Over skips over the subroutine.

To step from a command inside a block and go to the next block, click Step Out I .

Clicking Step Out when you are on a block, rather than inside it, causes the chart to resume. In
a subroutine, clicking Step Out takes you out of the subroutine.

Auto Stepping

Auto stepping lets you watch a chart’s or a subroutine’s logic in slow motion, one block at a time. A
chart or subroutine does not have to be paused before auto stepping can begin. To begin auto
stepping, click the Auto Step icon ¥, press F8, or select Debug > Auto Step Chart.

Step Auto appears in the status bar. The hatch marks move from block to block as each block’s
commands are executed. When you reach a block whose code is currently being executed, the
highlight around the block becomes changing shades of green instead of solid red (unless the block
is executed very quickly).
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A chart that contains flow-through logic stops when it has been stepped through. In a chart that
contains loop logic, the auto stepping continues until you stop it by pressing the Auto Step icon
again.

Setting and Removing Breakpoints

Sometimes you want to see the action at one or two blocks without having to step through an
entire chart or subroutine. You can use a breakpoint to stop a running chart or subroutine just
before a block is executed.

You can set a breakpoint at any block in any chart or subroutine, whether it is running or stopped,
paused or auto stepped. The strategy does not need to be running. You can set up to 16 breakpoints
in one chart or subroutine.

You can also set a breakpoint inside an OptoScript block, but not inside other types of blocks.

To set a breakpoint, follow these steps:

1. With the chart or subroutine open and in Debug mode, click the Breakpoint tool 4 .
The pointer turns into a hand.

2. Toseta breakpoint on a block, click the target block to mark it with the breakpoint hand.

E-STOF

Stop all control charts and
set all devices to a known
state.

Breakpoint hand

When all alarms are clear,
- restart system by starting
. Powerup chart.

£ >
[ iurnns ] o on [ reaon ]_oovosee. [
[0 > [»1\ Chart /

ﬁ Pawerup ﬁDough_Chi...

ﬁDough_‘u’es...ﬁOven_lnsp... ﬁ Alarms I

INFO Debug
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A red square appears around the block and Break On appears in the status bar.

J—-—QPM R h—f‘\f'_' o nF bl
Stop Charts
Stop all control charts and
set all devices to a known
B state.

Red square Set Devices

When all alarms are clear,
restart system by starting
Powerup chart.

Break On in status bar —|

>

<
I R B
] 4 % Chart

% Powerup |% Dough_Chi... |&F

|% Owen_lnsp... |% Alams

INFO Debug

To set a breakpoint within an OptoScript block:
- With the Select tool, double-click the block to open it.

— Inthe PAC Control toolbar, select the Breakpoint tool, place the palm of the breakpoint
hand over the line of code where you want the chart to stop, and then click the left
mouse button.

A red dot marks the breakpoint. The chart will stop running before executing the marked
line of code.

Note that in an OptoScript block, you can set breakpoints only on lines of code—you can't
set a breakpoint on a comment or within a comment block.

f OptoScript - Alarms - Stop Conveyor - Block 36 *

OptoScript Code:

< Ramp s=peed of conveyor to 0%, This is done by changing ac
s =mall increments over a 20 =s=econd period.

s Calculate the =mall increment= of change to acConwveyorSpe
fRampValue = (0.0 - aocConveyorSpesedControl) »~ 20.0;

Breakpoint set at this B Hoog Bemndle Hyes

line of code — & M for nloopCounter = 1 to 20 step 1
s Adjust aoConveyorSpesdControl
aoConveyorSpeedControl = aoConveyorSpeedControl + fRampVal

s Delay for one =s=econd
DelaySec(1.0):
next

<7 Wake sure aoConveyorSpesdControl is at exactly 0.0
aoConveyorSpeedControl = 0:

< >

Close Help Command Help Ln g, Col 2
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3. (lick other blocks or OptoScript lines to set additional breakpoints, or click blocks or lines
currently marked with a hand to remove the breakpoint. (Make sure that the palm of the
breakpoint hand is directly over the line you want to select.)

4. \When you have finished marking or removing breakpoints, click the Breakpoint icon again or
click the right mouse button within the window.

When the chart or subroutine runs, it pauses just before executing the breakpoint block or line.
You can inspect variables or I/0 points, disable strategy elements, change values, and so on to

see the effect the block has.

5. Tosingle step past the breakpoint, click the Step Block or Step Line button. Or to run the chart
or subroutine at full speed after the breakpoint, click the Pause Chart icon.

Managing Multiple Breakpoints

You can see all the breakpoints you have set, and you can remove breakpoints one at a time or all at
once. See also, “Setting and Removing Breakpoints”on page 194 to use the breakpoint tool.

1. Press Ctrl+B or click Debug > Breakpoints.

The Breakpoints dialog box appears, showing all the breakpoints set in the strategy.

ﬁ Breakpoints
Chart/Sub Name  Block ID Block MName Block Type
Alarms 36 Stop Conveyor OptoSaipt
Alarms 2 Set Devices Action
Corcel | [ b

Remove

Remave Al

*

2. Todelete a breakpoint, highlight it and click Remove. To delete all breakpoints in the strategy at

once, click Remove All.
3. When you have finished making changes, click OK.
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Interpreting Elapsed Times

As you debug your strategy, you may notice elapsed time readings appearing in a chart's or
subroutine’s status bar, as shown below.

*_ Sprinklers

...... ¥ Read
------ Hygrometer

Furn on sprinklers,

Wait 60 sec

':T:::fff

10

Wait 24 hrs

F 3

:1Jl'urn off sprinklers —

| Elapsed time
>

<
| Running || Step On [ Break OFf [[14180.050 S feyl-Tianet COll:res v

[T T2 Chart /

Elapsed time readings can help you determine how much time a chart, a subroutine, or a single
block takes to execute. The readings have slightly different meanings depending on what you did to
make them appear, as described in the table below:

When you. ..

Elapsed time represents . . .

Run a chart or subroutine and
pause it

Time since the chart or subroutine started or was last paused

Single step (by line or block)

Time to execute the previous block

Auto step

Time to execute the most recently executed block

Hit a breakpoint

Time since the last pause, or if the chart or subroutine was not
paused, elapsed time since it started running

Viewing and Printing

You can view and print several helpful things in a strategy as described in the following topics:

«  "Viewing Strategy Filename and Path” (below)

+  “Viewing an Individual Chart or Subroutine”on page 198

«  "Viewing All Charts in a Strategy” on page 198

«  "Printing Chart or Subroutine Graphics”on page 199
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«  "Viewing and Printing Strategy or Subroutine Commands”on page 202
«  "Viewing and Printing Strategy or Subroutine Elements”on page 203

«  "Viewing and Printing a Cross Reference” on page 204

«  "Viewing and Printing a Bill of Materials”on page 205

«  "Viewing and Printing I/0 Point Mappings”on page 206

For information on viewing and changing I/0 units, see “Inspecting I/0 in Debug Mode”on
page 152. For variables, see “Viewing Variables in Debug Mode” on page 248.

Viewing Strategy Filename and Path

To see an open strategy's file name and path, choose File > Strategy Information. A dialog box
appears showing the path and file name.

Viewing an Individual Chart or Subroutine

To view an individual chart or subroutine, double-click its name on the Strategy Tree, or choose
Chart > Open or Subroutine > Open. You can open as many of these windows as you need. The
names of open windows appear on tabs at the bottom of the PAC Control main window. Click a tab
to bring its window into view.

Viewing All Charts in a Strategy

You can see the status of all charts at once and change a chart’s status without having to open it.

1. Make sure the strategy is open and in Debug mode. On the Strategy Tree, double-click the
Charts folder.

The View Chart Status dialog box appears, showing every chart in the strategy:

=X View Chart Status

Mame Status tode Breakpoint Status Paused At
Digital_Control Fiurining Step OFf Break Off

Flag_Example_Chart  Stopped Step Off Break Off

Powerup Stopped Step OFf Break Off

Sample Stopped Step Off Break Off

Simple_Eror_Handli... Stopped Step Off Break Off

Sprinklers Fiurning Step On Break Off Turn off zprinklers
Timer_Example_Chart Stopped Step Off Break Off

2. Tochange the status of a chart, double-click the chart name.
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The View Chart dialog box appears, showing the chart name, chart status, run mode, and
breakpoint status. If the chart is paused (mode is Step On), the block at which it is paused is
shown in the Paused At field. In the figure below, the chart is not paused:

£ "Alarms” - View Chart (scanning) |Z||§|E|

Chat: | |
Status: |St0pped £ | Mode:|5tep o % | Breakpaints:
Pauzed At: | |
(e (o)

The title bar shows whether scanning is occurring. Scanning stops when you click one of the
changeable fields (Status, Mode, and Breakpoints) and resumes once you click Apply, another
button, or one of the other fields. If scanning resumes before you click Apply, any changes you
made are lost.

3. Tostop, run, or suspend a chart, click an arrow in the Status field to select the option. Click
Apply.

4. Toturn pausing on or off, click an arrow in the Mode field to select Step On or Step Off. Click
Apply.

5. Toobserve orignore any breakpoints set in the chart, click an arrow in the Breakpoints field to
select Break On or Break Off. Click Apply.

This action does not clear or set breakpoints, but just determines whether the chart stops at
breakpoints when it is running.

Chart changes occur as soon as you click Apply.

6. Toadd the chart to a watch window so you can monitor it with other strategy elements, click
Add Watch. In the dialog box, choose what to watch. Select an existing watch window to add
this chart to, or create a new watch window.

See “Using Watch Windows for Monitoring” on page 169 for more information on watch
windows.

7. When you have finished making changes, click Close to return to the View Chart Status dialog
box.

Printing Chart or Subroutine Graphics

You can print a chart or subroutine just as it appears on screen. You can also print all charts within a
strategy. When printing a single chart or subroutine, you can preview the image to make sure it's
what you want before you print it.

NOTE: If you have trouble printing graphics, set your printer for PostScript emulation.

Setting Up the Page

Before printing graphics, you should verify your page setup, which determines how each graphic
appears on a page.

1. In Configure mode, select File > Page Setup.
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The Page Setup dialog box appears.

1 Flowchart Graphics - Page Setup

Graphicz Scaling

(=) Adiust ta % normal size
O Fitto |:| I

Fage
Print Header

[ (] ]’ Cancel ] [ Help ]

2. Inthe Graphics Scaling area, choose whether you want each flowchart to print at a fixed
percentage of normal size or to span a specific number of pages.

- To print at a fixed percentage, click the Adjust To option and specify any scaling from one
percent to 1,000 percent.
You can type in a number or click the arrows to go up or down to the next increment of 25
percent. Typically, percentages between 50 percent and 200 percent work the best.

- To print to a specific number of pages, click the Fit To option and select the number of
pages wide and tall you would like each chart to print.

If you choose one for each dimension, each chart prints to a single page. For each
dimension, you can specify any integer between one and 255, but be careful. Selecting
values of five and five, for example, would cause each chart to print five pages wide and
five pages long, a total of 25 pages.

3. (Recommended) To print a header on each page, put a check mark in the Print Header box.

The header lists the strategy name, chart or subroutine name, date and time of printing, page
number, and column and row of the page with respect to the full chart printout.

4. C(lick OK to save your settings.

Previewing a Flowchart Printout

1. Tosee how a chart or subroutine will print before actually printing it, open the chart or
subroutine window.

2. From the Chart or Subroutine menu, select Print Preview Graphics.
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The preview window appears, showing the image as it will print. The cursor becomes a
magnifying glass.

AAPAC Control Professional - [Dough_Vessel Pressure_Control]

TR 0 o 4

Mest Page | | Prev Page || Two Page Zoom Jut

i chartmainins 1 provur n tre cough v e k. o Magnifying glass cursor

The Powsrup chart viarts  [F
e ehart

This chartruns
confinuoulyonce the
Caleulsts e curant program hai been rtarted.
reviure setpointminu s
e deadband.

‘When pra 1aura |s greatir
han ar squal to sipaint,
elong 18 pre s iure vaive.

‘When pre1aure (1 lens than
t1e wipolntminu ths 4
deadband, open the
Previure valve.

Page 1 Configure

3. Tozoom in at 200 percent, click where you want to see more closely. Click again to zoom in at
400 percent. Click a third time to return to 100 percent view.

You can also use the Zoom In and Zoom Out buttons at the top of the window to zoom in or
out with respect to the top left corner of the image.

4. Ifthe image spans more than one page, click the Next Page or Prev Page buttons to view the
next or previous page. To switch between a single-page view and a double-page view, click
the Two Page/One Page button.

5. To print, click the Print icon to open the standard Windows Print dialog box. To change settings
before printing, click Close and see “Setting Up the Page”on page 199.

Printing One Chart or Subroutine

1. To print one chart or subroutine, open its window.
2. From the Chart or Subroutine menu, select Print Graphics.
3. Inthe standard Windows Print dialog box, do one of the following:
- To print to a printer, select the printer, page range, and number of copies. Click OK.

— Toprintto a file, select Print to file and click OK. In the dialog box, type the file name and
location.
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Printing All Charts in a Strategy

CAUTION: You can print all charts included in a strategy, but be sure that's what you want to do before
you begin. You cannot cancel once printing has started.
1. To print all charts within a strategy, open the strategy and check the page setup.
For help, see “Setting Up the Page”on page 199.
2, Select File > Print All Graphics.

Printing begins immediately; no Print dialog box appears. Messages inform you of each chart’s
printing progress. To skip printing a particular chart, click Cancel when its message appears.

Viewing and Printing Strategy or Subroutine Commands

You must be in Configure mode to view and print commands.

1. Toview all commands (instructions) in a chart or subroutine, open its window and select
View/Print Instructions from the Chart or Subroutine menu. Choose whether to sort
instructions by block name or block ID number.

2. Toview allinstructions in an entire strategy, select File > View/Print > All Chart Instructions.

NOTE: Subroutine instructions are not included; you can print them separately.

PAC Control processes the information and displays it in the Instructions window.

Save  Search
Print

B Cookies - All Chart Instructions

H S #

:I‘ITLE: Elock Instructions for Every Chart -~
STEATEGY: Cockies
DATE: OZF05/10 TIME: 10:339:EL

CHART: Alarms
ACTIONS

Action Block: Powerup (Id: Z25)
Exit to: Goto 3tart (Id: Z8)

Restart Powerup chart. This will get system geoing again.
Start Chart

Chart Powerup

Put Status In nChartitatus

Action Block: Zet Devices (Id: Z)
Exit to: Stop Conveyor (Id: 32&)

Lower oven tempersture while conveyeor is stopped.
Move

From zoo.o

Tao aolvenTenperatureControl

Close all valves.
Turn Off

Ar Tl wh smancalfa s
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You may need to resize the window and use the scroll bar to see all the data. Blocks and their
instructions are listed in alphabetical or ID number order by type of block: action blocks first,
then OptoScript blocks, then condition blocks, and finally continue blocks.

To print the data, click the Printicon on the toolbar. To save it to a text file, click the Save icon. To
search the data, click the Search icon. When finished, close the window.

Viewing and Printing Strategy or Subroutine Elements

You must be in Configure mode.

1.

To view a summary of 1/0 elements and variables configured in a strategy, select File >
View/Print > Database.

To view the same summary for a subroutine, open the subroutine window and select
Subroutine > View/Print > Database.

The View/Print Database dialog box appears.

View/Print Database §|

Inciude

Murneric: Y ariables Murneric: T ables

Sting Y ariables Sting Tables

Puainter Variables Puointer Tables

1/0 Unitz & Paints Communication Handles

FID Loops Event/Reactions
[ Descriptions
I 0k, l [ Cancel l [ Help l

Make sure all element types you want to include are checked. Click to uncheck any elements
you do not want.

To include descriptive comments associated with the elements, click to put a check mark next
to Descriptions.

Click OK.
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PAC Control processes the database and puts the data in the Database window.

Save  Search
Print

B Sprinkler_Control - Database

IL.[‘ITLE: Strategqy Database
STRATEGY: Zprinkler Control
DATE: 08/21704 TIME: 1Z:45:44
NUMERIC VARIABLES
NAME TYPE INIT. VALUE REF. COUNT
Day of the Week INT BN o 4
Packer_ Busy INT LN a 3
Status INT BITH u] 3
Sum INT ity o] o]
Timer DN TIMER RUN z
COMMUNICATION HANDLES
NAME TYPE INIT. YALUE REF. COUNT
UID_East RITH 1024 i)

You may need to resize the window and use the scroll bar to see all the data. For each element

the name and reference count (that is, how many times the element is used in strategy

commands) are shown, plus other information depending on the element type. The figure

above shows numeric variables and communication handles.

6. To print the data, click the Print icon on the toolbar. To save it to a text file, click the Save icon. To
search the data, click the Search icon. When finished, close the window.

Viewing and Printing a Cross Reference

You can view and print a report of every operand in your strategy or subroutine—charts, I/O units,
analog points, digital points, communication handles, numeric variables, string variables, pointer
variables, numeric tables, string tables, and pointer tables. The operands are cross-referenced to the

charts, blocks, and instructions in which they are used.
1. To produce a cross reference for a strategy, open it and select File > View/Print > Cross

Reference.

2. Toview asimilar report for a subroutine, open the subroutine window and select Subroutine >

View/Print > Cross Reference.
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PAC Control processes the data and puts it in the Cross Reference window.

Save . Search

B Spiinkler_Control - Cross Reference

HES #

TITLE: Strategy Cross References b
STRATEGY : Unit 3 Monitoring
DATE: 10/05/06 TIME: 14:47:Z0

CHARTS

Interrupt - Mot referenced.
Morning
Chart Referenced Elock Referenced Instruction
Powerup Start Charts Start Chart
Powerup - Not referenced.

ANALOG POINTS
Refrigeration

Chart Referenced Elock Referenced Instruction

Morning Check refrigeration Line #32
Morning Check refrigeration Line #11
Morning Check refrigeration Line #11

You may need to resize the window and use the scroll bar to see all the data. Notice that the
Instruction column (at right) shows the line number the operand appears in when it is in
OptoScript code.

3. Toprint the data, click the Printicon on the toolbar. To save it to a text file, click the Save icon. To
search the data, click the Search icon. When finished, close the window.

Viewing and Printing a Bill of Materials

You can view and print a bill of materials (BOM) that lists all the I/O units and /O modules (analog
and standard digital) required to run the strategy. (Special-purpose modules, such as serial and
high-density digital modules, are not included in the BOM.)

1. To produce a BOM for a strategy, open it and select File > View/Print > Bill of Materials.
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PAC Control processes the data and puts it in the Bill of Materials window.

Save . Search

B Coukies - Bill of Materials

TITLE: Eill of Materials -
STRATEGY: Cookies
DATE: 0Z/1E5/05 TIME: 11:15:132

Brains
1 GENAP Mixed Ultimate I/0 (SNAP-UP1-ADE)

Digital Input Modules
1 SMNAP-IDCED: Z.5 - 28 VDC

Digital Output Modules
1 SMNAP-ODCESSRC: 5 - &0 VDC Source

hnalog Input Modules
1 ENAP-AICTD

1 SNAP-AIV

hnalog Output Modules
1 GENAP-AOV-Z7

Totals
Total Brains: 1
Total Modules: &

NOTE: Controllers, power supplies, and mounting racks are not specified.
Contact your local distributor or Opto ZZ for help or to purchase products.

You may need to resize the window and use the scroll bar to see all the data.

2. To print the data, click the Print icon on the toolbar. To save it to a text file, click the Save icon. To
search the data, click the Search icon. When finished, close the window.

Viewing and Printing /0 Point Mappings

You can view and print a report that shows the location and mappings of I/0 points. You can use
this report as a look-up table for programming purposes. This can be useful with some commands
that use different point mappings such as Move 1/0 Unit to Numeric Table Ex, Move Numeric Table
to I/0 Unit Ex, and IVAL Move Numeric Table to 1/0 Unit Ex.

This report basically provides the same information provided in “Table Index Offset Examples,”
in form 1701, the PAC Control Command Reference, but for the actual points in the strategy.
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1. To produce an I/O point mappings report for a strategy, open the strategy and select File >
View/Print > 1/0 Point Mappings.

View/Print I/0 Point Mappings

This report shows where all the configured points are located on modules and
how they map out to various point mappings. Thiz can be useful with zome
commands that use different point mappings. like "Move 140 Unit to Numernc
Table Ex".

Report Style: (8 Formatted () Commarseparated

Options
todule Positions 4-channel mappings 1B-channel mappings
Channel Positions 8-channel mappings 32-channel mappings

[ ok |[ Cancel ]

2. On the View/Print I/0 Point Mappings dialog box, select the report style, either Formatted or
Comma-separated, and select the position and mappings types, then click OK.

A report window appears.

B Cookies - Point Mappings

TITLE: I/0 Point Mappings -~
STRATEGY: Cookies
DATE: 04/07/08 TIME: 1Z:35:E0

Point mappings for I/0 Unit "Mixed I0 TUnit":

I70 POINTE MOD CH 4 g 18 3z
diDoughLeve LSwit el oecrin s o riari B ra i B e i i u] u] u] u} u] u}
di Chifp Lietwail St ST niien v iz, [ i, s i B u] 1 1 1 1 1
dilnspectionPassFaillwicch. ... ... .. ... ... ... u] z z zZ z zZ
L I o] x] 3 3 3 3
doloughPressureControlVWalwe . . .o oo o oo oo on 1 u] 4 a2 1 2
deDiotighDid spienselfalire s m e g, 0t Bagim [ s, s e, 1 1 1 E 9 17 23
deEhipDispenselalyre o e oo sy i s s n s s 1 z 3 10 1z a4
doRede ot Walure . . e e e e e e 1 el 7 11 13 2k
aocbwenTemnperatureControl o e ol oo S r ol s e z u] g 1 2z 54
aoConweyor SpeedBoriEayo s £, 0 Bagin [ e s, T e T z 1 9 1 a3 &5
o B B e T T e 3 o 1z 4 48 =l
ailonghlessel Pressur e, o . . o h ot i e e e e 4 o 1le 2 &4 1zZ3

What the columns mean:

Column Description

MOD The module number on the rack

CH The channel number within the module
4 4-channel mapping

8 8-channel mapping
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Searching and Replacing

You can search a chart, subroutine, or strategy for missing connections, empty condition blocks, or
any command or operand. An operand is anything that can be affected by a command, including
charts, I/0 units, analog points, digital points, and all kinds of variables. Searching includes
OptoScript code within OptoScript blocks.

You can also replace instructions or operands with similar items.

Searching

You can search a strategy or one of its charts, or you can search a subroutine.
1. Open the strategy or subroutine and select Edit > Find.

The Find dialog box appears.

Search Scope

Find

7 Lacal

Search For
(@) Operand () Instruction () Missing Connections ) Empty Cond, Blocks

Tupe: Marme: Help
I Diigital Output W | | doRgjecty alve w |

Or, if the item you want to find is listed in the strategy tree, such as a variable, table, or point,
right-click the item and select either Find in the pop-up menu.

= 1) Paints
H1 §DoughLevelSwitch

Point name i
= Modify...
T dilmspectionPassh F.Y
W et Configure...
T+ fk=iop Celete

8 doDoughPressure
DL_"," doDoughDizpens
308 JoChipDispensey’ Replace, @

The item appears in the Find or dialog box automatically.

2. Under Search Scope, to search the entire strategy, click Global. To search one chart only, click
Local and choose the chart name from the drop-down list.

If you are searching a subroutine, the search is Local and the subroutine’s name is shown.
3. Under Search For, choose one of the following:

- Tosearch fora chart, an I/O unit or point, or a variable, click Operand. In the Type and Name
fields, choose the operand you want from the drop-down list.
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- To search for an instruction, click Instruction. Click Action or Condition, and choose the
instruction you want from the drop-down list.

- To search for blocks that are not connected to other blocks, click Missing Connections.

- To search for condition blocks that have no instructions, click Empty Cond. Blocks.
4. C(lick Find.

The dialog box expands and the search results appear at the bottom.

Search Scope
Find
i o
OLDCBI 1l ) 0 Stop
Search For
() Operand (&) Instruction () Missing Connections () Empty Cond. Blocks
@ Action () Condition
Instruction: Help
|Delay [mSec) v [ Select... ]
Chart Block Mame Block |0 Command
Flag_E=ample_Chart Delay 1 mzec 5 Delay [mSec]
Simple_Emor_Handling_C... Delay 100 mzec 9 Delay [mSec] L Sea rc h
2 ocourrence(s] found.
results

For more information on any item in the search results, try double-clicking the item.

5. Tosave the search results to a file or to print them, click Print. In the window that opens, click
the Save icon to save or the Print icon to print your search results.

6. When you have finished your search, close the Find dialog box.

Replacing

You can also replace any operand, instruction, or tag with a similar item. As in searching, you can
replace items in a strategy or one of its charts, or you can replace items in a subroutine.

1. Open the strategy or subroutine, and select Edit > Replace.
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The Find and Replace dialog box appears.

1 Find and Replace

Search Scope Find Mest
@8
-_Fle lace
() Local ZEE
Replace All
Search For
© Gperand
() Instruction
O Tag
Tvpe: Mame:
Find what: |AII Walid Types L% | |aiDough\-fesselF'ressure R |
Replace with: |AII Walid Types “ | |aiDough\-fesselF'ressure - |

Or, if the item you want to find is listed in the strategy tree, such as a variable, table, or point,
right-click the item and select Replace in the pop-up menu.

= [ Paints
‘ I giDoughlLevelSwitch
Point name ——— fru S ch
L dilrspectionPassF Modify. .

I G Stop Colnfigure...
Delete

DL_",'I doDoughPressure
DL_",'I doDoughDispense  Find...
DL_",'I doChipDispensey.

1 Find and Replace

Search Scope
(#) Global
Replace
e
Replace All
Search For
© Operand
() Instruction
Help
Sl
Type: I amne;
Find what |Digital Iriput v | |diEhipLeveISwitch v |
Replace with: |AII Walid Types “ | |ai‘| E_Fppt w |

Point name

2. Under Search Scope, to search the entire strategy, click Global. To search one chart only, click
Local and choose the chart name from the drop-down list.
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If you are searching a subroutine, the search is Local and the subroutine’s name is shown.
3. Under Search For, choose one of the following:

- Tosearch fora chart, an I/O unit or point, or a variable, click Operand. In the Find Type and
Name fields, choose the operand you want to replace from the drop-down list. In the
Replace With Type and Name fields, choose the operand you want to use instead.

- To search for an instruction, click Instruction. Click Action or Condition, and choose the
instruction you want to replace from the Find drop-down list. In the Replace With
drop-down list, choose the instruction you want to use instead.

- To search for a substring within tag names, click Tag. In the “Find what”text box under
Substrings, enter the substring you want to replace. In the “Replace with” text box, enter
the replacement text. For example, if you have several tag names that contain the
substring, “Generic,” such as nGenericCount, fGenericTemperature, and diGenericlnput, you
could replace “Generic” with “Station1,”and the tagnames would become nStation1Count,
fStation1Temperature, and diStation1input.

4, C(lick Find Next.

When the first occurrence of the operand or instruction is found, the Instructions dialog box it
appears in is displayed.

5. Toreplace this occurrence, click Replace. To skip it and find the next one, click Find Next.

If you are replacing operands, you can replace all occurrences at once by clicking Replace All. If
you are replacing instructions, you must verify each one.

6. Ifthe Edit Instructions dialog box appears, make any necessary changes and click OK to save
them before moving on.

7. When replacements are finished, close the Find and Replace dialog box.

Legacy Options

By default, PAC Control initially shows only SNAP PAC I/O units and the commands used with them.
When you're using the SNAP PAC system only, hiding legacy 1/0 units and commands makes it
simpler and less confusing to build your strategy. However, the legacy capabilities can be made
visible as needed in a specific strategy.

NOTE: If you enable legacy I/0 units and commands in PAC Control, see the legacy versions of the PAC
control guides for information on how to use them:

Opto 22 form 1710, the PAC Control User's Guide, Legacy Edition
Opto 22 form 1711, the PAC Control Command Reference, Legacy Edition
Opto 22 form 1713, the PAC Control User's Guide, Legacy Edition

Existing Strategies

When you open an existing ioControl strategy in PAC Control, either Basic or Professional, PAC
Control will automatically show the 1/0 units and commands appropriate to that strategy.
For example, if you have been using SNAP Ultimate I/0, SNAP Ultimate I/0 units will be visible in the
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strategy. In addition, commands used with SNAP Ultimate 1/0 but which are now deprecated
(obsolete) because they are not needed with SNAP PACs are also available.

Similarly, if you open an existing strategy that contains mistic serial 1/0 units, all the mistic /0 unit
types and commands—such as event/reaction and mistic PID commands—are automatically shown.

New Strategies
When you create a new strategy in PAC Control, either Basic or Professional, the strategy will show
only the SNAP PAC System. This means:

«  When you use a command such as Get I/O Unit as Binary Value, the only I/0 units shown for
Argument T will be SNAP PAC I/0 units (SNAP-PAC-RT, SNAP-PAC-R1-B, SNAP-PAC-R2,
SNAP-PAC-EB1, SNAP-PAC-EB2, SNAP-PAC-SB1, and SNAP-PAC-SB2).

«  Commands that are used only with legacy hardware—such as Enable Communication to Mistic
PID Loop or Get All HDD Module Off-Latches—won't be listed.

Since some Opto 22 customers work with multiple systems, legacy options can be set individually
for each strategy or subroutine. If you are using legacy hardware, you can choose the options that
apply to each strategy you're working with, without affecting other strategies.

IMPORTANT: Once you have enabled a legacy option for a specific strategy or subroutine, you cannot
disable it later for the same strategy or subroutine.

Enabling Legacy Options

Here's how to set legacy options:
1. In PAC Control, open the strategy or subroutine for which you want to change options.
2. (Choose File > Strategy Options. Click the Legacy tab.

Depending on the hardware you're using, you can set one or more of the following options:
— Enable Ethernet, Ultimate, and Simple I/0 units and commands (see page 213).
— Enable high-density digital commands (see page 213).

- (PAC Control Pro only) Enable mistic I/0 units and commands (see page 213).

3. (lick the option you want to enable. At the confirmation dialog box, make sure it is correct, and
then click Yes. Repeat to enable other options.

The options are changed for the strategy or subroutine.
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Enable Ethernet, Ultimate, and Simple I/0 Units and Commands

If you're using any of the I/O unit types shown in the following table, you should enable Ethernet,
Ultimate, and Simple 1/0 units and commands. When you do, both the I/O unit types and the
commands shown in the table will become available in the strategy.

1/0 Unit Types Commands

IVAL Set Digital-64 1/0 Unit from MOMO Masks [DEPRECATED)]
IVAL Set Mixed 64 1/0 Unit from MOMO Masks [DEPRECATED]
IVAL Set Mixed I/0O Unit from MOMO Masks [DEPRECATED)]
IVAL Set Simple 64 1/0 Unit from MOMO Masks [DEPRECATED]
Set Digital-64 1/0 Unit from MOMO Masks [DEPRECATED]

Set Mixed 64 1/0 Unit from MOMO Masks [DEPRECATED)]

Set Mixed 1/O Unit from MOMO Masks [DEPRECATED)]

Set Simple 64 1/0 Unit from MOMO Masks [DEPRECATED]

SNAP-ENET-D64
SNAP-B3000-ENET
SNAP-ENET-RTC
SNAP-UP1-D64
SNAP-UP1-ADS
SNAP-UP1-M64
SNAP-ENET-S64

Enable High-Density Digital Module Commands

All SNAP high-density digital modules are fully supported by the SNAP PAC System using regular
digital point commands. However, three of our older HDD modules can also be used with
analog-capable SNAP Ultimate, SNAP Ethernet, and SNAP Simple I/0 units, if you use the older
“legacy”HDD commands.

If you are using SNAP-ODC-32-SNK, SNAP-ODC-32-SRC, or SNAP-IDC-32 HDD modules with these
older I/0O units, you should enable High-Density Digital module commands. When you do, the
following commands become available in the strategy:

Commands
Clear HDD Module Off-Latches Get All HDD Module On-Latches
Clear HDD Module On-Latches Get All HDD Module States
Get & Clear All HDD Module Off-Latches Get HDD Module Counters
Get & Clear All HDD Module On-Latches Get HDD Module Off-Latches
Get & Clear HDD Module Counter Get HDD Module On-Latches
Get & Clear HDD Module Counters Get HDD Module States
Get & Clear HDD Module Off-Latches Set HDD Module from MOMO Masks
Get & Clear HDD Module On-Latches Turn Off HDD Module Point
Get All HDD Module Off-Latches Turn On HDD Module Point

Enable mistic 1/0 Units and Commands

If you're using legacy mistic hardware with a SNAP PAC S-series controller and PAC Control
Professional, you should enable mistic I/0 units and commands. When you do, the following I/0 unit
types and commands will become available in the strategy.

I/0 Units Types.
1/0 Unit Types Other Types
G4D16R B3000 or B3000-B (Digital) Mistic PID Loop
G4D32RS B3000 or B3000-B (Analog) Digital Event/Reaction
G4A8R, G4RAX B100 Analog Event/Reaction
B200 SNAP-BRS Event/Reaction Group
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Commands.

Commands

Clamp Mistic PID Output

Clamp Mistic PID Setpoint

Clear All Event Latches

Clear Event Latch

Convert Mistic /0O Hex String to Float

Convert Number to Mistic 1/0 Hex String

Disable Communication to Event/Reaction

Disable Communication to Mistic PID Loop

Disable Event/Reaction Group

Disable Mistic PID Output Tracking in Manual Mode
Disable Mistic PID Output

Disable Mistic PID Setpoint Tracking in Manual Mode
Disable Scanning for All Events

Disable Scanning for Event

Disable Scanning of Event/Reaction Group

Enable Communication to Event/Reaction

Enable Communication to Mistic PID Loop

Enable Event/Reaction Group

Enable Mistic PID Output Tracking in Manual Mode
Enable Mistic PID Output

Enable Mistic PID Setpoint Tracking in Manual Mode
Enable Scanning for All Events

Enable Scanning for Event

Enable Scanning of Event/Reaction Group

Event Occurred?

Event Occurring?

Event Scanning Disabled?

Event Scanning Enabled?

Event/Reaction Communication Enabled?
Event/Reaction Group Communication Enabled?
Get Analog Filtered Value

Get Analog Square Root Filtered Value

Get Analog Square Root Value

Get Analog Totalizer Value

Get & Clear Analog Filtered Value

Get & Clear Analog Totalizer Value

Get & Clear Event Latches

Get & Restart Off-Time Totalizer

Get & Restart On-Time Totalizer

Get & Restart Period

Get Event Latches

Get Frequency

Get Mistic PID Control Word

Get Mistic PID D Term

Get Mistic PID | Term

Get Mistic PID Input

Get Mistic PID Mode

Get Mistic PID Output Rate of Change
Get Mistic PID Output

Get Mistic PID P Term

Get Mistic PID Scan Rate

Get Mistic PID Setpoint

Get Off-Time Totalizer

Get On-Time Totalizer

Get Period

Get Period Measurement Complete Status
IVAL Set Analog Filtered Value

IVAL Set Digital Binary [DEPRECATED]
IVAL Set Frequency

IVAL Set Mistic PID Control Word

IVAL Set Mistic PID Process Term

IVAL Set Off-Totalizer

IVAL Set On-Totalizer

IVAL Set Period

Mistic PID Loop Communication Enabled?
Read Event/Reaction Hold Buffer

Set Analog Totalizer Rate

Set Digital I/0O Unit from MOMO Masks [DEPRECATED)]
Set Mistic PID Control Word

Set Mistic PID D Term

Set Mistic PID | Term

Set Mistic PID Input

Set Mistic PID Mode to Auto

Set Mistic PID Mode to Manual

Set Mistic PID Output Rate of Change
Set Mistic PID P Term

Set Mistic PID Scan Rate

Set Mistic PID Setpoint
Transmit/Receive Mistic 1/0 Hex String

Advanced Options

Very few applications require changes to the “Advanced” options, which involve adding and
changing variables and points in the strategy. However, these options can be useful for strategies

with a very large number of charts.

Three options are available. Unless you are certain you need these options, do not select them.

1. To see the options, choose Configure > Options. Click the Advanced tab.

By default, these options are not selected:
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PAC Control Options *

Workspace Debugger Advanced

[]When adding Pairts and Variables, do not check OptoScript blocks
[]When renaming Points and Variables, do not update OptoScript blocks
] Allow Points and Variables with references to be deleted

Cancel Help

2. [Ifyou are sure you require one or more options, choose the one(s) you need.

When adding Points and Variables, do not check OptoScript blocks: If you check this
box, when you add a point or variable, OptoScript blocks will not be searched to see if it is
already being used in the block. That makes it faster to add points and variables in a
strategy that has a large number of charts. However, reference counts are not updated
during this process. When you have finished adding all the points and variables, choose
Tools > Regenerate Reference Counts.

When renaming Points and Variables, do not update OptoScript blocks: If you check
this box, you can rename a variable or point in the Strategy Tree, and it will not be renamed
in any OptoScript block. Renaming points and variables is faster in a strategy with a large
number of charts that have no OptoScript blocks; but if any renamed items exist in
OptoScript blocks, the strategy will not compile. You will have to manually edit those
OptoScript blocks.

Allow Points and Variables with references to be deleted: Use this feature on
variables or points that are used only in OptoScript blocks. If the variable or point is used in
an Action or Condition block, the strategy will not compile.

NOTE: If you want to delete a variable or point that shows a reference count greater than zero,

but itis not being used in the strategy, don't use this advanced option. Instead, choose Tools >

Regenerate Reference Counts to recalculate all reference counts. Then you will be able to delete
the variable or point.

PAC Control User's Guide 215



ADVANCED OPTIONS

216 PAC Control User's Guide



8: Working with Flowcharts

Introduction

This chapter shows you how to work with flowcharts, the building blocks of your strategy. When you
create a new strategy, one chart is created for you: the Powerup Chart. You must create all the other
charts to do the work of the strategy.

In this Chapter

Creating a New Chart ...
Working with Chart Elements... .
Opening, Saving, and Closing Charts..........

Copying, Renaming, and Deleting Charts
PHNTING CRAIS oo ssmssses s sssssess s sssmssoes oo
Exporting and Importing Charts.......

Creating a New Chart

1. With your strategy open and in Configure mode, select Chart > New, or right-click the Charts
folder on the Strategy Tree and select New from the pop-up menu.

The Add New Chart dialog box appears.

1 Add New Chart 3

Marne:

Description;

QK H Cancel ][ Help
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2. Enteraname for the new chart.

The name must start with a letter, but may also include numbers and underscores. If you type
spaces, they are converted to underscores. All other characters are ignored.

3. (Optional) Type a description.

4, C(lick OK.
The new chart s listed on the Strategy Tree under the Charts folder, and the new chart window

appears. Block 0, the starting block, is shown automatically. No matter how many other blocks
you add or where you place them, block 0 is always the first block to be executed in the chart.

= Mew_Chart |Z| |E| El
o

(LA T Ghart /

NOTE: Because chart windows show a small portion of a potentially large chart, a small movement
with the scroll bar can mean a big change in what you see. If you lose your flowchart in the window,
select View > Center on Block and choose the block you want to see in the middle of the screen. Or
just right-click inside the flowchart and choose Center on Block from the popup menu.

Working with Chart Elements

Chart Components

Charts can contain five kinds of flowchart blocks, lines connecting the blocks, and text.

Action Blocks are rectangles that contain one or more commands (instructions) that do the work
of the strategy, such as turning things on or off, setting variables, and so on. See “9: Using Variables
and Commands” for more information. Action blocks can have more than one entrance but only
one exit.

Condition Blocks are diamonds containing questions that control the logical flow of a strategy.
Condition blocks can have many entrances, but only two exits: True and False.

OptoScript Blocks are hexagons containing OptoScript code, a procedural language you may want
to use to simplify certain tasks. See “11: Using OptoScript” for more information. OptoScript blocks
can have more than one entrance but only one exit.
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Continue Blocks are ovals that contain no commands, but simply route chart logic to a new
location, such as to the top of a chart. These blocks help keep charts neat by avoiding awkward
connections between two blocks that are far apart.

Sync Blocks are used in charts that control systems with controller redundancy. When a sync block
is encountered, the redundant controllers are synchronized. For more information, see Opto 22
form 1831, the SNAP PAC Redundancy Option User’s Guide.

Connections are lines with arrows that connect one block to the next, directing the flow of strategy
logic.

Text explains the chart’s purpose and elements for anyone who needs to understand them later.

Using the Drawing Toolbar

The drawing toolbar includes tools for each of the elements plus a Select tool, or pointer, for
manipulating elements:

Action block
OptoScript block
Condmon block
éCommue block
Select TEXt

Connect

Changing the Appearance of Elements in a Chart Window

You can change the background appearance of charts or subroutines, the color and size of blocks
and text, and the color of connection lines. Depending on the scope you want to affect, you can
change these window properties at three levels:

«  Across PAC Control—to change the appearance of all new charts in all new strategies, and all
new subroutines.

«  Across a strategy—to change the appearance of all new charts in the open strategy.
«  Forthe open chart or subroutine—to change the appearance of all new elements in the open
chart or subroutine window.

IMPORTANT: Note that most changes affect only new charts and their elements. Existing charts,
subroutines, and elements are not changed. To avoid having to go back and change each item
individually, make sure you set the defaults the way you want them before you create new charts. Once
you have changed the defaults, see “Changing Existing Elements to Match New Defaults” on page 221 to
change existing elements to match the new defaults.

To change the appearance of charts and elements, follow these steps:
1. Choose one of the following, depending on the scope you want to change:

- Tochange all new charts in all new strategies and all new subroutines, choose Configure >
Default Properties to open the Configure PAC Control Default Properties dialog box.

— Tochange all new charts in the open strategy only, choose File > Strategy Properties to
open the Configure Strategy Properties dialog box.
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— Tochange new elements in the open chart or subroutine only, choose Chart > Properties
or Subroutine > Properties to open the Configure Chart Properties or Configure Subroutine
Properties dialog box.

The dialog box that opens looks like this, except that its title may be different.

2. Complete the fields as described in “Configure Chart Properties Dialog Box” below.
3.  When you have made all the changes, click OK.

Configure Chart Properties Dialog Box

Configure Chart Properties

Flowizhart Farameters

A —1— Background Colar: Grid Color: [ [“lDzplay Grid Digplay Block 1Dz [ Smooth Scroling
Action Block Parameters
N . . C tion:
it Height; Calar: Farnt: | Arial - 10 point m
Condition Block Parameters
: . True | —
Widthe [95 | Height Colar: Fart: | Arial - 10 point e

False: —
OptaScript Block

B — it Height; Calar: l_ Farnt: | Arial - 10 point %

Checkpoint Black

width (96 | Height: (48 | Color: Fart: | Arial - 10 point

Continiue Black Parameters Alzo Apply Ta 1D
Ll Wwidth: Height; Color: ’_ Font; | Arial - 10 point [1PAC Control
Tex a Rt
C—1 widh Height: Font; | Arial - 10 point
L ok J[ cancel || Hep | [ Besetai— E

A—Flowchart Properties. Specify general chart display in this area. To apply these changes to
existing charts as well as to new ones, click All charts in D.

«  Tochange the chart background color from the default of white, click the Background Color
box. Choose a new color from the Color dialog box.

«  Tochange the chart's grid color from the default of black, click the Grid Color box.

+  Thegrid and block ID numbers are displayed by default. To remove them, click Display Grid or
Display Block ID’s to remove the check mark.

«  Toenable or disable smooth scrolling in a flowchart, click Smooth Scrolling; this option is
disabled by default.

B—Action Block Parameters. Define the appearance of action blocks, condition blocks,
OptoScript blocks, and continue blocks in this area. These changes affect new blocks only, not

existing blocks. (To change existing blocks, see “Changing Existing Elements to Match New Defaults”
below.)

« Inthe Width and Height fields, type the block size in pixels. For action and continue blocks, the
default width is 96 and the default height is 48; the minimum parameters are 48 (width) and 32
(height). For condition blocks, the default height is 64. (Note that the numbers you enter are
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rounded down to be evenly divisible by 16; for example, if you enter 81, click OK and then
reopen the dialog box, the parameter reads 80.)

«  To change the color of the blocks from the default, click the Color box.

«  Tochange block name text formatting, click the Font box. In the Font dialog box, change the
font, font style, size, effects, and color. The default font is black 10-point Arial bold.

«  Tochange text alignment, right-click the Font box and choose left, center, or right from the
pop-up menu.

«  Tochange the color of connection lines, click a Connection line at the far right. Choose the new
color from the Color dialog box.

C—Text. Define width, height, and font of text blocks that appear as comments in a chart or
subroutine. Default width is 192; default height is 128; the minimum for both is 16. The default font
is black 10-point Arial bold.

D—AIso Apply To. To expand the scope of the changes you've made, click these boxes. Click
PAC Control to apply the changes to all new strategies and subroutines in PAC Control. Click Strategy
to apply the changes to all new charts in the current strategy. Click All Charts to apply the changes
to all new charts and all new graphic objects added to the current strategy.

Depending on which dialog box you are in and what is currently open, one or more of these options
may be grayed out. For example, if you are in the Configure PAC Control Default Properties dialog
box, it is assumed that the changes are to be applied throughout PAC Control, and that option is
therefore grayed out.

E—Reset All. To reset all parameters and options to their factory default settings, click Reset All.

Changing Existing Elements to Match New Defaults

Once you have changed the defaults for the way elements appear in a chart, you can update
existing blocks, connections, and text to match.

CAUTION: When you update existing objects to match, you cannot undo the update.

1. Right-clickon an empty space in the chart whose elements you want to change. Choose Select
from the pop-up menu. From the sub-menu, choose the item type you want.
For example, to select all action blocks, choose Select > Action Blocks.

2. Right-click again in the chart, and choose Properties > Copy from Default from the pop-up
menu.

The color, size, and font of all selected items change to match the flowchart defaults.

Drawing Blocks

Action, condition, OptoScript, and continue blocks are all drawn the same way.

1. With the chart open and the strategy in Configure or Online mode, click the tool you want to
use.

—  foran action block
<»  for a condition block
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> foran OptoScript block
@ fora continue block.

As you move the mouse into the window, you see an outline representing the block.
2. (lick where you want to place the block.

The new block appears.

= Mew_Chart |Z| |E|[g

E

(LA TE T Ghart /

3. (ickin anotherlocation to place other blocks of the same type. When you have finished using
the tool, click the right mouse button, click another tool in the toolbar, or press Esc.

Naming Blocks

1. With the chart open and the strategy in Configure or Online mode, click the Select tool ; ' and
click the block to select it.

2. Right-click the block and choose Name from the pop-up menu.

#1 Name Block
QK
Help

3. Inthe Name Block dialog box, type the name and click OK.

Renaming Blocks

1. With the chart open and the strategy in Configure or Online mode, click the Select tool ;' and
click the block to select it.

2. Right-click the block and choose Name from the pop-up menu.

3. Inthe Name Block dialog box, change the name. Click OK.
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Connecting Blocks

To connect blocks, start with the chart open and the strategy in Configure or Online mode.
Remember that action blocks and OptoScript blocks have only one exit, and condition blocks have
two.

Action Blocks and OptoScript Blocks

1. To connect an action block or an OptoScript block to the next block in a program sequence,
click the Connect tool + .

2. First click the source block and then click the destination block.
Although you can click anywhere inside the blocks to make a connection, the connection is

attached at the side closest to where you clicked. In the figure below, Block 0 is the source
block and Block 1 is the destination block:

= Mew_Chart

(i) Shortcuts | 100 -

(LT Ghart /

To keep your charts neat, try to draw the most direct connections possible. To do so, after
clicking the source block, move your cursor out of the block at a point closest to its destination.

3. Tocreate a bend or elbow in a connection, click wherever you want the bend while drawing
the connection.
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For example, to draw the connection in the following figure, we selected the Connect tool,
clicked Block 0, moved the cursor out of the block to the right, clicked at point A, clicked again
at point B, and then clicked the right side of Block 1:

—~ New_Chart

Block 0

(i) Shortcuts | 100 -

(LT Ghart /

While you're still drawing a line, to delete an elbow you don't want, click the right mouse
button once to undo it.

If you created several elbows, you can eliminate them in reverse order with repeated right
mouse clicks. If no more elbows remain and you right-click again, you delete the connection.
Once you have completed a connection, however, you cannot undo it this way.

Condition Blocks

1.

N

To connect a condition block to the next block in a program sequence, click the Connect tool
5

Click the source block.

t Connection Type

[ True Connection H False Connection ” Cancel ]

Indicate whether you are drawing the True connection or the False connection, and then click
OK.

Click the destination block you chose (True or False).
The connection is labeled T or F depending on its type.
Draw another connection to the second destination block.

Itis labeled the opposite exit type.
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For example, the following figure shows the True and False connections from the condition
block, Block 1. If the conditions in Block 1 are true, Block 2 is executed next. If the conditions in
Block 1 are false, Block O is executed next:

— New_Chart E| @lg

E

(i) Shortcuts | 100 -

(LT Ghart /

Adding Text

One of the best places to put comments about a strategy is directly on its flowcharts. Start with the
chart open and the strategy in Configure or Online mode.

1. Toadd text to a chart, click the Text tool & .
When you move the mouse onto the chart, a rectangle representing the text area appears.

2. (lickthe mouse button and type your comments.
If you type in more text than the text frame holds, it expands in length.

3.  When you have finished typing, click anywhere on the chart outside the text frame.
The frame becomes invisible, and only the text appears. To change the size or shape of the text
block, see “Resizing Blocks or Text Blocks” on page 228.

4. (lickin another location to create another text frame, or release the tool by right-clicking in the
chart or choosing another tool from the toolbar.

Editing Text

1. With the chart open and the strategy in Configure or Online mode, click the Select tool i .

2. Double-click the text block you want to change.
A blinking cursor appears at the beginning of the text.

3. Change the text as needed.
You can use any standard Windows Ctrl key combinations when editing, including Ctrl+arrow
keys and Ctrl+-Home or End for navigation. You can also use Ctrl+X (cut), Ctrl+C (copy), and
Ctrl+V (paste).

4. When you have finished changing text, click outside the text frame.
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The text block stays the same width but changes length to accommodate additional or deleted
text. To change the size or shape of the text block, see “Resizing Blocks or Text Blocks” on
page 228.

Selecting Elements

Before you can manipulate most elements, you need to select them. Start with the chart open and
the strategy in Configure or Online mode.

1. Clickthe Select tool I .

2. Toselect an action, OptoScript, condition, continue, or text block, click the block.

Handles appear around the block:

T/ \‘>Hand|es

Block 25

h

3. Toselecta connection, click it.

Handles appear at the elbows and end points of the connection:

—im Block 0

—
]

1
I—FI Block 1

4. Toselectall connections entering or exiting a block, click the block, click the right mouse
button, and choose Select Connections from the pop-up menu.

Handles

5. Toselect more than one element, do one of the following:
- Select the first element, hold down the Shift key, and select additional elements.

- (lickand drag the mouse to draw a rectangle completely around the elements you want to
select.

- Toselect all items of the same type, right-click anywhere in the window and choose Select
from the pop-up menu. From the sub-menu, choose the item type you want.

Moving Elements

1. With the chart open and the strategy in Configure or Online mode, click the Select tool I

2. Tomove any action, OptoScript, condition, continue, or text block, click it. Then click and hold
the mouse button anywhere on the selected item except on its handles, and drag it to the
position you want.

You can also use the arrow keys on your keyboard to move a block in any direction. Note that
when you move a block, any connections attached to it also move.
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To move a connection, click it. Then click and drag any handle in any direction.

You can also move an end point from one block to another, as long as the result is a valid
connection. A disallowed move is ignored.

To move several elements at once, select them, and then click and drag them.

If elements end up stacked on top of each other, you may need to change their z-order before
you can move them. Seethe following section.

Moving Elements in Front of or Behind Other Elements (Changing Z-Order)

If elements are stacked on top of each other, you can select only the one in front. To change their
position (z-order), follow these steps:

1.
2.

Click the element to select it.

Right-click the element. From the pop-up menu, choose Z-order. From the sub-menu, choose
the action you want to take:

- Bring Forward—moves the element one position closer to the front.
- Bring To Front—moves it all the way to the front.

- Send Backward—moves the element one position closer to the back.
- SendTo Back—moves it all the way to the back.

Cutting, Copying, and Pasting Elements

You can cut, copy, and paste most chart or subroutine elements. Cut or copied elements are placed
on the Windows Clipboard, and they can be pasted in the same chart or subroutine, in a different
chart or subroutine, or in a different strategy.

A connection can be cut or copied, but it cannot be pasted unless its original source and destination
blocks have also been pasted. Block 0 cannot be cut.

1.
2.

With the chart open and the strategy in Configure or Online mode, click the Select tool i .
To cut or copy element(s), click them. Press Ctrl+X to cut or Ctrl+C to copy.

You can also select the element(s) and then click Edit > Cut or Edit > Copy, or click the right
mouse button and choose Cut or Copy from the pop-up menu.

To paste blocks, press Ctrl+V, click Edit > Paste, or right-click anywhere on a chart and then
select Paste from the pop-up menu.

Text blocks are pasted immediately. For action, condition, or continue blocks, a message
appears asking if you want to keep the original name of the block being pasted.

If you paste to a different strategy or to a subroutine, PAC Control checks the referenced
variables to make sure they match. Variables that do not exist are created. Variables that exist
but are different—for example, a table with the same name but a different table length—are
noted in a log file that appears when the paste is complete.
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Deleting Elements

1. Make sure the chart is open and the strategy is in Configure or Online mode.
2. C(lickthe Select tool s . Click the element(s) to select them.

CAUTION: Make sure you have selected the element you want. You cannot undo a deletion!

3. Press Delete.

You can also select the element(s), right-click them, and select Delete from the pop-up menui.
Block 0 cannot be deleted. If you delete a block, you'll be asked to verify the deletion.

Changing Element Color and Size

You can change the colors and sizes of blocks, connections, and text in your chart. To change one
element (for example, the color of one block), use the steps in this section. To change more than
one at a time, see “Changing the Appearance of Elements in a Chart Window” on page 219.

Start with the chart open and the strategy in Configure or Online mode.

Resizing Blocks or Text Blocks

1. Click the Select tool 1;  and click the block to select it.

2. (lick one of the handles, then drag it in the direction you want. To resize horizontally and
vertically at the same time, drag a corner handle.

Changing Block Colors

1. Clickthe Select tool i; = and click the block to select it.
2. Right-click the block and choose Color from the pop-up menui.
3. Pick the color you want and click OK.

Changing Text

You can change the size, font, font style, or color of the text in any block.
1. Clickthe Select tool 1; = and click the block to select it.

2. Right-click the block and choose Font from the pop-up menu.

3. Inthe Font dialog box, make the changes you want. Click OK.
4

To change whether text appears at the left, the center, or the right of a block, select the block
and click the right mouse button. From the pop-up menu, choose Justify; from the sub-menu,
choose Left, Center, or Right.

Changing an Element Back to the Defaults
1. Select the item and click the right mouse button.
2. From the pop-up menu, choose Properties. From the sub-menu, choose Copy from Default.

To change defaults, see “Changing the Appearance of Elements in a Chart Window” on
page 219.
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Opening, Saving, and Closing Charts

Opening a Chart

Make sure the strategy is open. In the Strategy Tree, double-click the chart you want to open.

You can also open a chart by selecting Chart > Open, and then double-clicking the chart name in
the Open Chart dialog box, which lists all charts that are not currently open.

If a chart is open but not visible on the screen, click the chart’s name tab at the bottom of the
window to make it visible.

Saving a Chart

1. Make sure the chart is open and is the active window.
2. From the Chart menu, choose Save.

Charts are automatically saved when you choose File > Save All. If you choose File > Save Strategy
or click the Save Strategy icon g on the toolbar, you can choose which charts to save in the Save
Strategy dialog box.

Closing a Chart

To close a chart, click the close box in the upper-right corner of the chart’s window (not the PAC
Control window). You can also close a chart by pressing Ctrl+F4 when the chart window is active. If
you have made changes to the chart, you are prompted to save them.

Copying, Renaming, and Deleting Charts

Copying a Chart

If an existing chart is similar to one you want to create, it is easier to copy it than to create a new one
from scratch. To copy a chart in the same strategy, follow the steps in this section. To copy a chart to
another strategy, see “Exporting and Importing Charts”on page 231.

1. With the strategy open and in Configure mode, select Chart > Copy.
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The Copy Chart dialog box appears.

Copy Chart

X

Fram To

Mame: Marne:

D escription: Drescription:

Check the E-Stop button &
the: two lervel alarms.

[ QK H Cancel ][ Help ]

2. Inthe From field, choose the chart you want to copy from the drop-down list.
3. IntheTofield, enter a name for the new chart.

The name must start with a letter and include only letters, numbers, or underscores. (Spaces
are converted to underscores).

4. (Optional) Enter a description for the new chart.
5. Click OK.

The new chart is created and appears as the active window on the screen.

Renaming a Chart

1. Make sure the strategy is in Configure mode and that the chart you want to rename is the
active window.

2. From the Chart menu, choose Rename.

1 Rename Chart

Drescription:

Controls sprinklers for the front lawn.

I (1] 4 H Cancel ][ Help ]

3. Enteranew name and description (optional). Click OK.
The chartis renamed.
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Deleting a Chart

You can delete any charts except for the Powerup chart. However, you cannot delete a chart if it is
called or used by another chart in your strategy.

1. Make sure the strategy is open and in Configure mode.

2. Inthe Strategy Tree, right-click the name of the chart you want to delete and choose Delete
from the pop-up menu. Or, if the chart is the active window, choose Chart > Delete.

3. Atthe confirmation message, make sure you are deleting the correct chart.
CAUTION: You cannot undo a deletion!

4, C(lick Yes to delete the chart.

The chart window disappears (if it was open), the chart is removed from the Strategy Tree, and
the strategy is saved.

Printing Charts

You can print any flowchart. To print a chart as it appears on the screen, see “Printing Chart or
Subroutine Graphics”on page 199. To print commands (instructions) for the chart, see “Viewing and
Printing Strategy or Subroutine Commands”on page 202.

Exporting and Importing Charts

To copy a chart to another strategy, you must export it as a PAC Control chart export file (.cxf file) and
then import it into the strategy where you want it.

Exporting a Chart

1. With the strategy open and in Configure or Online mode, choose Chart > Export.
The Export Chart dialog box appears.

Export Chart E|
Frarm To
Mame: M ame:

Sprinkler_Control | | [53|E'3L-- ]

Description: Description:

Controlz sprinklers for the front
lawn.

Qk. ]’ Cancel ][ Help
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2. Inthe From section of the dialog box, select the chart to be exported from the Name
drop-down list.

3. IntheTo section of the dialog box, click Select.

Select Destination for, Export File

Save in: | I PALC Contral vl O 11- s [~
Filz hame: || | [ ST ]
Save as lype: | FALC Contral Chart Expart Files (% cxf) v | ’ Cancel ]

4. Navigate to where you want the exported chart file to be saved. In the File name field, enter a
name for the exported chart. Click Save.

You return to the Export Chart dialog box, which now shows the path and file name in the To
section.

5. (Optional) Enter a description for the new chart.
6. Click OK.

The exported chart is saved. You can import it into any PAC Control strategy. See the next
section for information on importing charts.

Importing a Chart

Use the Automatic Chart Import dialog box to import a chart previously exported. Also see
“Exporting a Chart” on page 231.

1. With the strategy open and in Configure mode, choose Chart > Import.
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The Automatic Chart Import dialog box appears.

Automatic Chart Import

|_ | [ﬁelect... ] |

Description: D gscription:

[ QK. H Caticel ][ Help ]

At the top of the dialog box, click Create new chart or Replace existing chart.

CAUTION: If you choose Replace existing chart, the old chart will be completely overwritten with
the chart you are importing.

Click Select. Navigate to the exported chart. Click OK.
In the To section of the dialog box, enter a name for the new chart.

If you wish, enter a description. If you are replacing an existing chart, select it from the list. To
copy the imported chart description, select the text in the left description field, copy it, and
paste it in the right description field.

Click OK.

The chartis imported. A Chart Import Report window shows you how the tags in the chart
match with those already in the strategy. Any tags from the chart that do not already exist in
the strategy are created and added.
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9: Using Variables and
Commands

Introduction

This chapter discusses the seven types of variables used in PAC Control: numeric, string, pointer,
numeric table, pointer table, string table, and communication handle variables.

This chapter also shows you how to use the commands, or instructions, in PAC Control and discusses
the mechanics of adding commands to your strategy flowcharts. For command information to help
you program your strategy effectively, see Chapter 10.To find out how to use commands in
OptoScript code, see Chapter 11. For a list of all standard PAC Control commands and their
OptoScript equivalents, see Appendix E.

In this Chapter
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Changing a Configured Variable ... 247
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Adding Commands.......
Changing a Command
Deleting @ COMMANG ...ococvvceseeveeesssnseeesssssessssssses s ssssssessssmssesssssssessssisssessins

Cutting or Copying @ COMMANG ....coooeverreerreeeseess s 258

Configuring a Continue Block... . . . . . . 259

Viewing and Printing Chart Instructions... . . . O 259
About Variables

As Chapter 2 mentions, variables store pieces of information in a strategy. You create a variable for
each piece of information in your control process that must be acted upon. These pieces of
information might include the name of a chart, the on or off state of a switch, communication
parameters for a peer on the network, or a table that holds a series of numbers.

Each variable has a name and a value. You assign the variable’s name in plain English, so you know
what it is. The variable’s value is the current information it represents. As a strategy runs, the
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variable’s name remains the same, but its value may change. For example, the name of the variable
Oven_Temperature stays the same, but its value (the temperature of the oven) may change several
times while the strategy is running.

To illustrate variables, suppose you are regulating the

amount of water in a tank. You must keep the tank filled >

beyond a minimum level, but you cannot let it get too full. Level_ :f

You've already configured the I/O points: Meter _— Pump_1
an

+  Level_Meteris an analog input point that registers the
quantity of water in the tank.

«  Pump_1isadigital output point that turns the pump y

on or off. Drain_1

«  Drain_1 s a digital output point that opens or closes
the drain.

Next, you configure variables as places to hold information that these I/0 points must work with:

«  Toavoid constantly polling Level_Meter to find out the quantity of water in the tank, you create
avariable called Tank_Level_Reading in which to store the level. The input point Level_Meter is
periodically checked and the value of Tank_Level_Reading updated.

«  Toestablish the maximum and minimum levels, you create variables called Tank_Max_Level
and Tank_Min_Level. The value in Tank_Level_Reading can be compared to the values in these
two variables to determine whether the pump should be turned on or off, or the drain opened
or closed, to maintain the proper level. (You could create constant values, called literals, for the
minimum and maximum levels, but creating them as variables lets you change their values in
Debug mode.)

Types of Data in a Variable

A variable stores one of six types of data: floating point, integer, timer, string, pointer, or
communication handle. When you create the variable, you designate the type of data it contains. It
is always best to choose the most appropriate data type for the information you are storing. PAC
Control can store an integer in a floating point variable, but it has to convert the data first.
Unnecessary data conversions take up processor time.

«  Numeric data stores numbers and can be one of the following types:

- Afloating point (or float) is a numeric value that contains a decimal point, such as
3.14159, 1.0, or 1,234.2. A good example of a float variable is one that stores readings from
an analog input such as a thermocouple. PAC Control uses IEEE single-precision floats with
rounding errors of no more than one part per million.

- Aninteger is a whole number with no fractional part. Examples of integer values are -1, 0,
1,999, or -4,568. The state of a switch, for example, could be stored in an integer variable as
1 (on) or 0 (off).
Most integers used in PAC Control are 32-bit signed integers, which can range from
-2,147,483,648 10 2,147,483,647. These 32-bit integers should be used for general integer
use, such as status variables, mathematics, and indexes. . 64-bit integers address the entire
I/0 unit at once but are slower than integer 32 commands.
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- Atimer stores elapsed time in units of seconds with resolution in milliseconds. Up Timers
count up from zero, and Down Timers start from a value you set and count down to zero.
Timers can range from 0.001 to 4.611686 x 10'°.

+  Astring stores text and any combination of ASCII characters, including control codes and
extended characters. For instance, a string variable might be used to send information to a
display for an operator to see. A string variable is also used to set parameters for peer-to-peer
communication. When defining most string variables, you must specify the width of the string.
The width is the maximum number of characters that the variable may hold.

A string variable can contain numeric characters, but they no longer act as numbers. To use
them in calculations, you must convert them into floating point or integer numbers.
Conversely, a numeric value to be displayed on a screen must first be converted into a string.

» A pointer does not store the value of a variable; instead, it stores the memory address of a
variable or some other PAC Control item, such as a chart or an 1/0 point. You can perform any
operation on the pointer that you could perform on the object the pointer points to. Pointers
are an advanced programming feature and are very powerful, but they also complicate
programming and debugging.

« A communication handle stores information used to communicate with other entities, for
example other devices on the network or files that store data. The communication handle’s
value is a string containing the parameters needed to make a connection with a specific entity.
For outgoing Ethernet communication, for example, these parameters usually include the
protocol, the IP address of the device you are communicating with, and the port number used
on the device.

After the initial connection is made, the communication handle is referenced during
communication with the entity, and then used to close communication.

Variables in PAC Control

In PAC Control there are seven types of variables:
e numeric

«  numeric table

e string

« string table

e pointer

«  pointer table

« communication handle

Numeri, string, and pointer variables contain individual pieces of data. Numeric table, string table,
and pointer table variables contain several pieces of related data in the form of a table.
Communication handle variables contain parameters used by PAC Control for communicating with
other devices and files.

Table Variables

In a table variable, the variable name represents a group of values, not just one. Table variables are
one-dimensional arrays, which means that each table is like a numbered list of values. You refer to
each item in the list by its number, or index. Indexes start at 0, not at 1. Here are two table examples:
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In a float table, values are floating point numbers:

Index Value

0 82.0
1 86.1
2 85.0
3 74.8
4 72.3
5 72.7

In a string table, values are strings:

Index Value

0 Maria
1 Tom
2 Siu
3 Andre

When you define a table, you must specify its length, which is how many values the table can store.
The length of a table is NOT the value of the last index. Since indexes start at 0, a table with a length
of 100 contains indexes 0 through 99. Table length is limited only by the amount of memory in the

control engine. (For more information on the available memory, see “If You Have Memory Problems”
on page 389)

Numeric tables store either integer values or floating point numbers (but not both in the same
table). String tables store strings. Because pointers can point to any data type (for example, an 1/0O
point, a chart, or even another table), pointer tables can store an assortment of data types.

Persistent Data

Most variables can be either global or persistent in scope. Global variables are set to an initial value
(which you specify during configuration) either whenever the strategy is run or whenever it is
downloaded.

Persistent variables, however, are initialized only when the strategy is first downloaded. Numeric
variables (and tables) are initially set to 0. String variables (and tables), pointer variables (and tables),
and communication handles are initialized as blank, or empty. The key point about a persistent
variable is that its value is saved in the controller's memory; it does not get initialized when the
strategy is run, stopped, or started, and it does not get initialized if the strategy is modified and
downloaded again. A persistent variable’s value remains the same until one of the following events
occurs:

+  Astrategy with a different name is downloaded.

»  The RAM memory on the controller is cleared.

+  Anew firmware kernel is downloaded to the controller.
«  The persistent object is changed as follows:
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— Apersistent table's length (integer, 64-bit integer, float, and string) was modified.
- Apersistent string variable's length was modified.
- Apersistent string table element's string length was modified.

— Apersistent variable's type has changed. For example, a persistent float variable is deleted
and a new persistent integer variable is created with the same name.

Persistent data can be very useful in certain situations. For example, suppose you have a PID setpoint
that is fine-tuned as your process runs. If the setpoint is configured as persistent, its value won't be
lost if you must re-download the strategy after making a program change.

Pointer variables, pointer tables, and timers are not allowed to be persistent; but all other variables
and tables can be. Persistent variables cannot be configured on-the-fly.

Literals
A literal is used like a variable, but it is constant data that never changes. A literal has no variable
name, only a fixed value, which may be a floating point number, an integer, or a string.

If you are using subroutines, see the information on literals in “Data Types for Subroutines”on
page 374.

Adding Variables

This section includes steps for adding numeric, string, pointer, and communication handle variables.
(For numeric, string, and pointer tables, see “Adding Tables”on page 242.)

1. With the strategy or subroutine open in Configure mode, choose Configure > Variables.

The Configure Variables dialog box opens.

1 Co nfigure Variables

AWM umenic Y aniables Scope: | Global v
I amne Type Init Type Init W alue Deszcription Fef Count Add...

bStartFlag Integer 32 D ovanload 2 -
diCookiebotionTi... Down Timer Run For animation inio... 1
fDoughPressureS... Float Persistent i} Desired dough ve... 2

fRampYalue Float Run 1} For ramping the c... 4
fSetpointtdinusDie... Float Run 1] Dough veszel pre... 2

nChartStatus Integer 32 Persistent ]

nCookieotionPre. . Integer 32 Run Far animation inio... 1

nLoopCounter Integer 32 Run 2

< I ?

’ Claze ] [ Help ]

This dialog box lists all the variables in the strategy or subroutine that are of the type shown in
the Type field. You can sort the data in this dialog by clicking any one of the column header
buttons.

2. IntheType drop-down list, choose the type of variable you want to configure.

If you are adding the variable to a subroutine, select Subroutine in the Scope drop-down list.

4. Toadd anew variable, click Add.

w
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The Add Variable dialog box appears.

5. Complete the fields as described in “Add Variable Dialog Box” below.

6. Click OK.

The Add Variable dialog box closes and the new variable appears in the Configure Variables

dialog box.

Add Variable Dialog Box

This dialog box varies depending on the type of variable.

Add Variable =3
A — Mame: | |
B —{ Desciiption: | |
C— Tvpe: |String v| String WwWidth:

Initizlization

= () Initialize on strategy download
E < (%) Initialize on strateqy rn

™ () Persistent
F——— Iritial Value: |

[ Ok ] [ Cancel ] [ Help ]

Field at D varies
depending on
variable type.

The figure above shows the Add Variable dialog box as it appears for string variables. Fields are
slightly different for other variables.

A—Name. Enter a name for the variable. The name must start with a letter and may contain
letters, numbers, and underscores. (Spaces are converted to underscores.)

B—Description. (Optional) Enter a description of the variable.

C—Type. In the Type drop-down list, select the type of data for the variable. Possible types are
shown in the following table. For more information, see “Types of Data in a Variable”on page 236.

Variable

Possible Data Types

Numeric

Integer 32, integer 64, floating point, up or down timer

Numeric table

Integer 32, integer 64, or floating point

String String
String table String
Pointer Pointer to any data type

Pointer table

Pointer to any data type, and the data type may change
over time

Communication handle

Communication handle

D—String Width. This field varies depending on the variable type.
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(Table variables only) In the Table Length field, enter an integer between 1 and 1,000,000
representing the number of elements in the table. The greater the number, the more memory
required to store the table.

(String variables and string tables only) In the String Width field, enter the maximum number of
characters permitted in the string. The number must be an integer between one and 1024. The
greater the number, the more memory required to store the string.

(Pointer variables only) From the Pointer to Type drop-down list, select the type the pointer points
to. Note that void pointers are not allowed; a pointer must point to a specific type. Also note that
you cannot point a pointer to another pointer; PAC Control has only one level of indirection for
pointers. If you try to point to a pointer, PAC Control assigns to the new pointer the address of the
object being pointed to.

E—Initialization. (For all variables except up timers and down timers)
Select one of the following:

Initialize on Strategy Run: Sets the variable to the initial value (F) each time the strategy is run (either
manually from the debugger or automatically via the autorun flag).

Initialize on Strategy Download. Sets the variable to the initial value (F) only when a strategy is
downloaded. The variable retains its current value when the strategy is stopped and then run again,
either through the debugger or autorun. It also retains its value if power is cycled. Note that this
choice means the variable is stored in battery-backed RAM, which is limited in size. To keep a
variable’s current value through both power cycles and strategy download, make the variable a
persistent variable (see the Persistent option below and “Persistent Data” on page 238). See “If You
Have Memaory Problems”on page 389.

Persistent: Data in the variable will be persistent. Pointer variables and timers cannot be persistent.
For more information, see “Persistent Data” on page 238.

The following table shows how your choices about variable initialization and persistence affect what
happens to variables (applies to all variables and tables except up timers and down timers).

Variable What happens to the variable’s value when...?
Strategy stops, then starts . Same strategy is
(through debugger or autorun) ALADG L downloaded
Variable initialized on Set to initial value Set to initial value Set to initial value
strategy run (default)
Variable initialized on Retains current value Retains current value | Set to initial value
strategy download
Persistent variable Retains current value Retains current value | Retains current value

F—Initial Value. (For all variables except pointers, up timers, and down timers) Enter the value
to which the variable is to be set initially. You can use either decimal or hexadecimal form. If you
leave this field blank, the initial value is set to zero.

(For pointer variables only) When you have selected the Pointer to Type, the drop-down list in this
field shows all the valid objects for that type that are currently defined in your strategy. Choose one
or leave the initial value as NULL. A NULL value means that the pointer is created but does not
initially point to anything.
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(For communication handles only) Enter a string containing communication parameters in the
correct format for the type of communication handle you are using. The type (for example, tcp,
Ttp, File) must be in lowercase letters, and parameters are separated by colons and commas
according to the format required. See “Communication Commands”on page 264 for information
and examples.

To communicate with a serial module, use the IP address of the brain the module is attached to,
and use the serial module’s port number according to its position on the rack, for example:
tcp:10.192.55.185:22502. For port numbers, see “Establishing an Ethernet Connection”in form
1191, the SNAP Serial Communication Module User’s Guide. See also, form 1940, TCP and UDP Port
Assignments.

To communicate with another SNAP PAC brain, be aware of port numbers that are reserved for
a specific protocol. For more information, see form 1940, TCP and UDP Port Assignments.

For other peers on the Ethernet network, be aware of port numbers they may use for specific
purposes. Ports 22000 and 22001 are reserved for the control engine. For a list of standard
Ethernet port numbers, refer to http://www.iana.org/assignments/port-numbers. See also,
Opto 22 form 1940, TCP and UDP Port Assignments.

If you are using the Accept Incoming Communication command to listen for communication
requests, leave out the IP address and use the following format: tcp:port

For tables, each value in the table is set to the initial value. If you need to set individual table
elements to differing values initially, you can do so in the Powerup chart. If you need to use an
initialization file to set values on strategy download, contact Opto 22 Product Support.

Adding Tables

See the following topics to add numeric, string, and pointer tables:

“Adding Table Variables” (below)
“Setting Initial Values in Variables and Tables During Strategy Download”on page 244

Adding Table Variables

1.

With the strategy or subroutine open in Configure mode, choose Configure > Variables.

The Configure Variables dialog box opens, listing all variables of one type in the strategy.
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Aco nfigure Variables

RN urneic W ariables v | Scopes | Global v
Mame Type Init Type It % alue: Description Ref Count Add...

bStartFlag Integer 32 Download 2 -
diCookietationTi... Down Timer Fiun Far animation inio... 1
fDoughPressuresS... Float Persigtent 0 Desired dough ve... 2

fRampy alue Float Fiun il For ramping the c... 4
fSetpointtinuzDe... Float Run i} Douagh vessel pre.. 2

nChartStatus Integer 32 Pergigtent 5

nCookiekotionPre... Integer 32 Fiun Far animation inio... 1

nLoopCounter Integer 32 Run 2

] | >

[ Cloze ] [ Help ]

In the Type drop-down list, choose the type of table variable you want to add.

If you are adding the table variable to a subroutine, select Subroutine in the Scope drop-down
list.

To add a new table variable, click Add.
The Add Variable dialog box appears.

Hame: |

Add Variable X
|
|

Description: |

Tuvpe: |Stling vl Strirg Wafidth:

Initialization

) Initialize on strateqy download
() |nitialize on strateqy n
) Persistent

Initial alue: |1

I 1] ” Cancel ” Help ]

The figure above shows the dialog box as it appears for string tables. Fields are slightly different
for other table variables.

Complete the fields as described in “Add Variable Dialog Box” on page 240.

NOTE: If you need to set individual table elements to differing values initially, you can do so in the
Powerup chart. If you need to use an initialization file to initialize the values on strategy download,
see the next section, “Setting Initial Values in Variables and Tables During Strategy Download.”

To have data in the table be persistent, select Persistent.

Pointer tables cannot be persistent. For more information, see “Persistent Data” on page 238.
Click OK.

The Add Variable dialog box closes and the new table variable appears in the Configure
Variables dialog box.
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Setting Initial Values in Variables and Tables During Strategy
Download

When you are adding table variables in PAC Control, you can set all table elements to one initial
value in the Add Variables dialog box. If you want to set each individual table element to its own
value, however, you need to create an initialization file and download it with your PAC Control
strategy.

In addition to setting initial values for table elements, sometimes it is easier to initialize all variables
during strategy download using an initialization file.

This section shows you how to create an initialization file and download it with your strategy.

Creating the Initialization File

A sample initialization file, Init.txt, is copied to the local hard drive when you install PAC Control. The
file’s location is C:\Users\Public\Documents\Opto 22\PAC Project <version number>\Control Basic
Examples <or Control Pro Examples, if you have PAC Control Professional>\InitVariables.

You can open this file with a text editor to see the proper syntax for each initialization entry, and
then modify it as necessary for your strategy.

IMPORTANT: Every initialization file should include the following line near the top:
\ """"DOWNLOAD_COMPRESSION_OFF

Make sure to enter a backslash and a space at the beginning of the line. Download compression removes
the newlines necessary for string initialization. This line tells PAC Control to turn off download compression
so strings can be initialized.

IMPORTANT: Each file must end with a carriage return so that the last line in the file is blank, and each
line within the file must end with a carriage return. If you add comments to the file, they must be preceded
by a backslash (\) and a space.

Text Examples

NOTE: Variable names are case-sensitive and can include both upper- and lower-case letters.

Integer Example. To set an initial value of 123 for the variable INTEGER_VARIABLE, you would
include the following text in the initialization file:
123 ~INTEGER_VARIABLE @!

Float Example. Floating point values must contain a decimal point. To set an initial value of 456
for the variable FLOAT_VARIABLE, you would include the following text (with the decimal point and
zero) in the initialization file:

456.0 "FLOAT_VARIABLE @!

String Example. To set an initial value of “String Variable Test String” for STRING_VARIABLE, you
would include the following text in the initialization file. The spaces and newline are very important:

*STRING_VARIABLE $INN
String Variable Test String
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Communication Handle Example. To add the parameters of a communication handle
named COMM_Handle, you would include the following text in the initialization file. The spaces and
newline are very important.

*COMM_Handle $INN
tcp:10.0.0.1:1000

Pointer Example. To have the pointer PTR_POINTER_VARIABLE point initially to
INTEGER_VARIABLE, you would include the following text in the initialization file:
~NINTEGER_VARIABLE MoveToPointer PTR_POINTER_VARIABLE

Integer 32 Table Example. To set initial values of 10, 20, 30, 40, and 50 for elements zero
through four of an integer table named My_Int_32_Table, include the following text:

10 0 My _Int_32 _Table TABLE!

20 1 My Int_32_Table TABLE!

30 2 My Int_32_Table TABLE!

40 3 MMy Int_32_Table TABLE!

50 4 My Int_32_Table TABLE!

Integer 64 Table Example. To set initial values of 10, 20, 30, 40, and 50 for elements zero
through four of an integer table named My_Int_64_Table, include the following text:

10.. O }My_Int_64 Table 2TABLE!

20.. 1 }My_Int_64 Table 2TABLE!

30.. 2 Iy _Int_64 Table 2TABLE!

40.. 3 My Int_64 Table 2TABLE!

50.. 4 My Int_64 Table 2TABLE!

Float Table Example. For a float table, the initial values must include a decimal point. To set
initial values of 1.1,2.2,3.3,4.4,and 5.5 for elements zero through four of a float table named
My_Float_Table, include the following text:

1.1 0 }My Float_Table TABLE!

2.2 1 My _Float_Table TABLE!

3.3 2 }My_Float_Table TABLE!

4.4 3 }My_Float_Table TABLE!

5.5 4 }My Float_Table TABLE!

String Table Example. To set initial values of “zero’,“one’, “two’, “three”, and “four” for elements
0—4 of a string table named My_String_Table, include the following text. Make sure you turn off
download compression and use new lines as shown:

0 {My_String_Table $TABLE@ $INN

zero

1 {My_String_Table $TABLE@ $INN

one

2 {My_String_Table $TABLE@ $INN

two

3 {My_String_Table $TABLE@ $INN

three

4 {My_String_Table $TABLE@ $INN

four

Pointer Table Example. Each index in a pointer table points to another item within the
strategy, for example an 1/0 point, a variable, or a chart. Setting initial values for pointer tables
means designating the items the pointer table initially points to. For example, you would include
the following text to have a pointer table named My_Ptr_Table initially point to Oven_Temperature
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(a variable), Alarm_Handler (a chart), Thermocouple (an analog input), Fuel_Pump (an analog
output), and Fan_1 (a digital output):

~Oven_Temperature O PTBL_My_ Ptr_Table TABLE!

&Alarm_Handler 1 PTBL_My Ptr_Table TABLE!

~Thermocouple 2 PTBL_My Ptr_Table TABLE!

~Fuel_Pump 3 PTBL_My_Ptr_Table TABLE!

~Fan_1 4 PTBL_My Ptr_Table TABLE!

Special Characters in the Initialization File. Note that the initial character on each line of
the initialization file is a special character that identifies the object type. Possible characters include
the following:

Character Object Type

A float, integer, or timer
* string

PTR_ pointer variable
~ 1/0 point
& chart
} float table or integer table
{ string table

PTBL_ pointer table
% 1/0 unit

Saving the Initialization File. \When you have finished modifying the file, save it as a text file
(.txt file extension) to your strategy directory. You can name the file anything you like. (You can also
save it to any directory you like, but it is good practice to save each initialization file to the directory
of the strategy that references it.)

Downloading the Initialization File

To use the file, you need to download it with your strategy.

1. With the strategy open in Configure or Online mode, choose Configure > Control Engines, or
double-click the control engine’s name.

2. Highlight the control engine and click the Download Options button.

The Download Options dialog box appears. The initialization file must be downloaded
immediately after your strategy is downloaded.
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#1 Download Options @

Filez To Download After The Strategy:

[ add. |

[ 0K, l[ Cancel ][ Help

3. (lick Add.

4. Navigate to the initialization file you created. Double-click the file name.
The file appears in the Download Options dialog box.

5. dlickOK.
The initialization file sets values for the variables and table elements immediately after your
next full strategy download.

IMPORTANT: When you create each variable in the strategy, you must check “Initialize on Strategy
Download” in the Add Variable dialog box.

Since download options are specific to each control engine, make sure you set the initialization file as
a download option for every control engine on which the strateqy will run. Because control engines
have separate initialization files, you can use the same master strateqgy for two or more control
engines and configure differences in variables by customizing the initialization files.

Starting the Strategy Automatically

If you want your strategy to start automatically as soon as the strategy finishes downloading to the
controller using PAC Control Debug mode, modify the Init.txt file as follows:
1. Add the following to the end of the Init.txt file:
_RUN
2. Add 1 ormore blank lines after the _RUN line
This is required; it won't work without at least 1 blank line at the end of the file.

If you are not using the other features of the Init.txt file to initialize variables after strategy download,
you can delete the rest of the content of the file.

Changing a Configured Variable

You can change a variable, but you cannot change a variable’s type.

1. Tochange a configured variable, make sure the strategy or subroutine is open and in Configure
or Online mode.
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2. [Ifyou are working in a strategy, on the Strategy Tree, expand the Variables folder until you see
the name of the variable you want to change. Double-click its name to open the Edit Variable
dialog box.

3. Ifyou are working in a subroutine, choose Configure > Variables. In the Configure Variables
dialog box, double-click the name of the variable you want to change.

4. Inthe Edit Variable dialog box, make the necessary changes and click OK.
If you need help, see “Adding Variables”on page 239 or “Adding Tables” on page 242.

You can also change a variable from the Configure Variables dialog box by double-clicking the
variable’s name or by highlighting it and clicking Modify.

Deleting a Variable

You cannot delete a variable that is referenced within the strategy or subroutine. Be careful when
deleting variables, since you cannot undo a deletion.

1. Make sure the strategy is open and in Configure mode.

2. On the Strategy Tree, expand the Variables folder until you see the name of the variable you
want to change. Right-click the name and choose Delete from the pop-up menu.
The variable is deleted.

You can also delete a variable from the Configure Variables dialog box by highlighting the variable’s
name and clicking Delete.

Viewing Variables in Debug Mode

While the strategy is running in Debug mode, you can view its variables and modify the value of a
variable or of entries in a table. You can also view several variables at once—as well as other strategy
elements—»by putting them into a watch window.

Viewing Numeric, String, and Communication Handle
Variables

1. Make sure the strategy is running in Debug mode. On the Strategy Tree, double-click the
variable you want to view.

The Inspect Variables dialog box opens. The animated icon at the upper left assures you that
the data is fresh. The title bar includes the name of the variable and indicates whether scanning
is occurring.

et

“nCookie_Counter” (scanning)

Yalue 42836 | S Maximize button

2. Toview more options, click the Maximize button.
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3. "nCookie_Counter” (scanning) L8  Communication handle variables
Marne: nCookie_Counter show S”g ht|y different fields.

Value: 42508 |

DMt 5

— Minimize button

Scanning stops whenever you click a changeable field. It resumes once you click Apply, another
button, or an unchangeable field. If scanning resumes before you click Apply, any changes you
made are lost.

If you do not want to change the value of the variable, you can click the Minimize button to
shrink the dialog box back to its original size.

3. Toview the configuration information about the variable, click More Info.

‘ir) hStartFlay

HNAME: hitarcFlag
DEACRIPTION:

TYPE: Integer 32 Variable
SCOPE: Global

INITIALIZED: Dowmload

INITIAL VALUE: 1}

Eau:e.—‘ 8]

|
.
[watch | [DEC » | ;(i)Mc.rquEr_gg =

4. To select the display format, click the button to the right of the Watch button.

%+ bStartklag™ (scanning)
Mame: bStartFlag

Walue: | u} |

i = Decimal

Binary !

A numeric variable can appear as decimal, hexadecimal, or binary. A string variable can appear
as ASCll or hexadecimal.

5. Tochange the value of the variable, type the new value in the Value field and click Apply.
The field turns magenta until you click Apply.

For a string variable, if your change lengthens the string beyond its maximum width, the string
is truncated to fit.

For a communication handle variable, changing the value of the variable here has the same
effect as using a Set Communication Handle Variable command. If the communication handle
is currently open, the value will be changed but will not affect the connection.

6. To monitor the variable in a watch window, click Watch.

If you have only one watch window and it is already open, the variable appears immediately in
the window for monitoring.

Otherwise, the Add Watch Entry dialog box appears.

PAC Control User's Guide 249



VIEWING VARIABLES IN DEBUG MODE

250

#1 Add Watch Entry

Mame: | Time_of_[ay

Select Portions To W atch:

Select Watch Window

N v| [ ew.. ) (oo ]

I Ok, H Cancel l[ Help ]

Check the items you want to watch.
Items to watch vary depending on the variable type.
In the Add Watch Entry dialog box, do one of the following:

- If the watch window you want to use to monitor the variable is open, choose it from the
Select Watch Window drop-down list.

- Ifthe watch window you want is not open, click Open. Navigate to it and double-click it to
open it.

- If you want to monitor the variable in a new watch window, click New. (For help, see
“Creating a Watch Window” on page 169.)

When the Add Watch Entry dialog box shows the correct items to watch and the watch

window you want, click OK.

The variable appears in the watch window.

Viewing Pointer Variables

1.

Make sure the strategy is running in Debug mode. On the Strategy Tree, double-click the
pointer variable you want to view.

The View Pointer dialog box appears, showing the pointer's name, type, and item pointed to.

%= "Pointer_A" (scanning)

MName: Fointer_A
Type:  Puointer Yarnable

Item Pointed To:  nLoopCounter

To view the status or value of the item pointed to, click the Inspect icon.
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If you need help, follow the steps in “Viewing Numeric, String, and Communication Handle
Variables”on page 248.

Viewing Numeric and String Tables

1.

Make sure the strategy is running in Debug mode. On the Strategy Tree, double-click the table
variable you want to view.

The View Table dialog box appears, showing the table’s name, length (maximum number of
entries), width for a string table, initialization method, and security level. It also lists the index
and value of each table entry. The title bar includes the name of the variable and indicates
whether scanning is occurring.

Here's an example for a string table.

2% "Days_Table” (scanning)

MName: Daps Table

Index Y alue

0 Sunday

1 [Monday

2 Tuezday
Wednesday
Thursday
Friday
Saturday

3
4
5
B

[ Apply | [ watch | [A5CHp | Mo Info

Scanning for an individual table element stops whenever you select an element in the table. It
resumes for that element if no changes are made and another table element is selected, or
when you click Apply. A magenta background indicates that scanning is stopped.

To change the format of the elements, click the button to the right of the Watch button.

[ apply | [(watch | [EECTY JW
Hexadecimgl

For string tables, you can select either ASCII or Hexadecimal. For numeric tables, you can select
Decimal, Hexadecimal, or Binary.

3. To view the configuration information, click More Info.
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. ™y
1 ) Days Table
& “Days_Table™ |scar \HJ =
Mame: Daps_Table NAME: Days_Table
DESCRIPTION:
Index | "Walue TYPE: String Table
0 [Suncay | MAX LENGTH: 7
1 Monday Max WIDTH: 10
2 Tuesday SCOPE: Global
3 Wednesday | INITIALIZED: Fun
4 Thursday | INITIAL VALUE:  Sunday
5 Friday
B Saturday \_‘
V/ ]
(_&pely ] [ Watch J [ASCI ] {More Info:

4. Tochange a table entry, click its index number, highlight the value, and type in a new value.
Click Apply.

5. To monitor the table in a watch window, click Watch.
The Add Watch Entry dialog box appears.

#1 Add Watch Entry

Mame: |Da_l,Js_TabIe Length:

Select Indewxes Towatch:

O
() Single Index I:I

() Bange from | | ta | |

Select Watch Window
| v [t (oen. ]

I Ok, H Cancel l[ Help ]

6. Inthe Add Watch Entry dialog box, do one of the following:

- If the watch window you want to use to monitor the table variable is open, choose it from
the Select Watch window drop-down list.

- If the watch window you want is not open, click Open. Navigate to it and double-click it to
open it.

- If you want to monitor the variable in a new watch window, click New. (For help, see
“Creating a Watch Window" on page 169.)
7. Select the indexes you want to watch.

8. When the Add Watch Entry dialog box shows the correct items to watch and the watch
window you want, click OK.

The table variable appears in the watch window.
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Viewing Pointer Tables
1. Make sure the strategy is running in Debug mode. On the Strategy Tree, double-click the
pointer table you want to view.

The View Table dialog box appears, showing the pointer table’s name, length, and the items
pointed to. You cannot change a pointer table entry in this dialog box.

\£ "Pointer_Table” (scanning)

Mame: Pointer_T able

Index | “alue

0[Total _Count

1 Previous_Count
2 3tatus

3 Alarm-

Moo

2. Toview the status or value of the item pointed to, highlight it in the table and click More Info.

If you need help, follow the steps in “Viewing Numeric and String Tables” on page 251.

Adding Commands

To make a block in a strategy flowchart do the work it's intended to do, you add one or more
commands. Commands use the I/0 points and variables you've already configured, as well as other
elements in your strategy. A command, for example, might turn on a digital point, move a value to a
variable, or check to see whether a chart is running. PAC Control contains more than 500 commands
you can use. A command in PAC Control is often called an instruction.

You can add commands to action blocks, condition blocks, and OptoScript blocks. Continue blocks
just move flowchart logic to another block. (See “Configuring a Continue Block” on page 259.)

To add commands to an action or condition block, follow the steps below. (To add commands to an

OptoScript block, see “OptoScript Functions and Commands”on page 352 and “Using the

OptoScript Editor” on page 366.)

1. With the strategy open in Configure or Online mode and the flowchart open, double-click the
block to which you want to add a command.

The Instructions dialog box appears. The highlighted area shows where the new command will
be added.
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i Instructions - Mew_Chart - Block 4 >
Highiighted arca ——
Modify. ..
Delete
Next Block
| Previous Blodk !
_______ _ The Operator grou
Operator — P . 9 . P
® AND appears in the dialog
®. box quy for
. . . condition blocks, not
| Goss || wep || Commandriep for action blocks.
2, (lick Add to open the Add Instruction dialog box.
# Add Instruction x
Instruction:
| Absolute Value ~ I Select... i
Comment:
Type MName
of | All Valid Types ~ | | ailoughVesselPressure e |
Put Resultin | All Valid Types ~ | | aoConveyorSpeedControl w |
I OK I | Cancel | | Help | | Command Help |

3. Ifyou know the command you want, enter its name in the Instruction field by typing it in or by
choosing it from the drop-down list. Skip to step 7.
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If you don't know the command name, click Select.

& Select Instruction

Groups:

Analog Point

Chart

Communication
Control Engine
Deprecated

Digital Paint

Error Handling

1/O Unit

1/O Unit - Event Message
1/O Unit - Memory Map
1/O Unit - Seratch Pad
Logical

Miscellaneous

PID - Ethernet

Instructions:

—

Absolute Value ~

Add

Arccosine

Arcsine

Arctangent

Clamp Float Table Element
Clamp Float variable
Clamp Integer 32 Table Element
Clamp Integer 32 Variable
Complement

Cosine

Decrement Variable

Divide

Generate Random Number
Hyperbolic Cosine

pd

Pointers Hyperbalic Sine -
Sirnnil=tinn Hunerhnlic Tannant
| Cancel Help | Command Help |

Click the name of a command group in the left column to display all the commands in that
group. In the right column, click the command you want.

For more information on any command, click the command name and click Command Help to
open help. You can also look up the command in the PAC Control Command Reference.

When the command you want is highlighted, click OK to return to the Add Instruction dialog

box.

(Optional) Enter a comment about the purpose of the instruction.

Comments help explain the command'’s purpose in this block and are helpful to anyone who

debugs or updates the strategy later.

Complete each argument for the command by typing in the Type and Name fields or by

choosing from the drop-down lists.

@ Add Instruction *
Instruction:
| Subtract v| | select.. |
Comment:
| Open pressure valve when vessel pressure is less than setpoint of 0.5 psig
~

Type Mame

| Float Variable w | | fDoughPressureSetpoint vl
Minus | Float Literal ~| 0.5 V]
Put Resultin | Float Variable w | | fSetpointMinusDeadband vl =

Cancel | | Help | Command Help |
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If the argument type is a literal (or constant), you must type it in. You can use either decimal or
hexadecimal form.

If you type in the name of an item that doesn't exist, for example a variable or I/0 point, you are
prompted to add it to the strategy.

Each command requires a certain number of arguments, from zero to eight. For help in
completing arguments, see the PAC Control Command Reference or the online help for the
specific command you're using.

8. When the arguments are complete, click OK.

You return to the Instructions dialog box, which now shows the command you just added.
Notice that the comment you entered appears just above the command. The arguments you
entered appear as part of the instruction. The highlight shows where the next command will
be placed if you add another command to this block.

Here is an example of an Instructions dialog box for an action block:

ﬁ Instructions - New_Chart - Adjust Pressure Valve - Block 1 *
Comment T Open pressure valve when vessel pressure is less than setpoint of 0.5 psig Add...
Command Subtract
fDoughPressureSetpoint Modify...
Arguments —=— Minus e
—— Put Result in f5etpointMinusDeadband Delete

b v e Next Block

| Previous Block

Highlight ——

Close Help Command Help

9. Toadd another command, click to place the highlight where you want the command to
appear. Click Add and repeat the steps in this section.

If you highlight a command that’s already in the dialog box, the new command will appear just
before it.

TIP: If you are adding commands to several blocks at once, you can quickly move from block to block
in the chart by clicking the Next Block or Previous Block buttons in the Instructions dialog box.

If you're working with a condition block, clicking Next Block opens a dialog box so you can select
which block to choose, since condition blocks have two exits. The same dialog box appears if you click
Previous Block and the block you're working with has connections coming from more than one block.

10. If you put more than one command in a condition block, complete the Operator group as
follows:

- If both commands must be true to exit the block true, click AND.
- Ifonly one of the commands must be true to exit the block true, click OR.
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Here is an example of an Instructions dialog box for a condition block with two commands. In
this case, the block will exit true if either of the commands is true.

ﬁ Instructions - New_Chart - Sunday or Wednesday? - Block 4 *
Is dayoftheweek Add...
Equal?
To 3 Modify...
Is dayoftheweek Delete
Equal?
To 0 Next Block Either the first

command OR the

I | Prevous Bock
second command

Operator can be true for this
8”‘”0 condition block to
5 exit true.

Close Help Command Help

Changing a Command

1.

With the strategy open in Configure or Online mode and the flowchart open, double-click the
block containing the command you want to change.

NOTE: To change commands in OptoScript blocks, see “Using the OptoScript Editor” on page 366.

In the Instructions dialog box, double-click any line of the command you want to change.
You can also click the command to highlight it and click Modify.

In the Edit Instruction dialog box, make the necessary changes.

For help, see “Adding Commands”on page 253.

Click OK to return to the Instructions dialog box, where you can see the changed command.

Deleting a Command

You can delete a command permanently, or you can comment out a command so it is temporarily
skipped, usually for debugging purposes.

Permanently Deleting a Command

1.

With the strategy in Configure or Online mode and the flowchart open, double-click the block
containing the command you want to delete.

NOTE: To delete commands in OptoScript blocks, see “Using the OptoScript Editor” on page 366.

In the Instructions dialog box, click any line of the command you want to delete.

CAUTION: Make sure you select the correct command. You cannot undo a deletion!

Click Delete or press Delete on the keyboard.
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Commenting Out a Command

You can mark certain commands so that the strategy temporarily ignores them. Commenting out

one or more commands can help you pinpoint problems in a strategy.

1. With the strategy in Configure or Online mode and the flowchart open, double-click the block
containing the command(s) you want to comment out.

NOTE: To comment out commands in OptoScript blocks, see “Using the OptoScript Editor” on
page 366.

2. IntheInstructions dialog box, click the first command you want to comment out. Click Add.
3. Inthe Add Instructions dialog box, choose the instruction Comment (Block). Click OK.

You return to the Instructions dialog box, and all the instructions in the block from that point
on are grayed out, indicating that they will be ignored when the strategy runs.

4. (lickjust beyond the last command you want to comment out. Add another Comment (Block)
instruction.
When you return to the Instructions dialog box, all commands between the two Comment
(Block) instructions are grayed out.

5.  When you no longer want the strategy to ignore the command(s), delete the two Comment
(Block) instructions.
NOTE: The Comment (Block) command is used for this purpose. The Comment (Instruction)

command just places an explanatory comment in the Instructions dialog box. It does not affect any
commands.

Cutting or Copying a Command

258

For commands in action, condition, and continue blocks you can cut or copy commands to the
Windows clipboard and then paste them in the same block or in another block, or even in a block of
another chart within the same strategy. For OptoScript blocks, see “Using the OptoScript Editor”on
page 366.
1. With the strategy in Configure or Online mode and the flowchart open, double-click the block
containing the command you want to cut or copy.
2. IntheInstructions dialog box, click any line of the command you want to cut or copy.
To cut or copy more than one command, hold down the Shift key while you click all the
commands to be cut or copied at once.

NOTE: To cut and paste all commands in a block, copy and paste the entire block, and then change
its name if necessary.

3. Press Ctrl+X to cut the command(s) or Ctrl+C to copy them.
You can also click the right mouse button and choose Cut or Copy from the pop-up menu.

The command is cut or copied to the Windows clipboard.
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Pasting a Command

Once you have cut or copied a command, you can paste it into any block in the same strategy.
Choose one of the following, and then press Ctrl+V:

To paste the command in the same block, click where you want to insert the command.

To paste the command at the end of the instruction block, move the cursor just below the last
instruction and click to highlight the empty space.

To paste the command to another block, click Close to exit the current Instructions dialog box
and double-click the block where you want to place the command. Click where you want to
insert the command.

Configuring a Continue Block

Continue blocks do only one thing: jump to another block. Thus, the only information you need to
provide in a continue block is the name of the block to jump to.

1.

With the strategy in Configure or Online mode and the flowchart open, double-click the
continue block you want to configure.

You can also click the block, click the right mouse button, and choose Detail from the pop-up
menu.

The Select Continue Block Destination dialog box appears, listing all blocks in the chart.

ﬁ Select Continue Block Destination *
A

Block Id: Marme Type (2

21 Restart Condition

2 Set Devices Action

[i] Start Action

36 Stop Conveyar OptoScript

3 Stop Charts Action

W

< >

Cancel Help

2. C(lick the destination block and click OK.

Viewing and Printing Chart Instructions

To view or print commands in a chart, see “Viewing and Printing Strategy or Subroutine Commands”
on page 202.
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10: Programming with
Commands

Introduction

Commands (or instructions) in PAC Control are roughly grouped by function. This chapter tells you
what you need to know about each group in order to program your PAC Control strategy effectively.
For detailed information on using a command, see Opto 22 form 17071, the PAC Control Command
Reference or form 1711, the PAC Control Command Reference, Legacy Edition.

In this Chapter

Analog Point Commands........
Chart Commands .
Communication Commands
Control Engine Commands......
Digital POINt COMMANTS ...voooceeveeeseeveeeesssseessssseesssssseessssoseeessssssseessssssseessssssessis
Error HaNAliNG COMM@NGS.....oooiooeeveeeeeeeeecceeeeeeeseesseeeesssesssssseeesssssssseeess s
I/0 Unit Commands....... . . . .
I/0 Unit—FEvent Message ComMMANGS .........occcvvrvvvvrmssseeesssssseessssseessssssessns 3
/0 Unit—Memory Map COMMANGS ......coveerrmerrreerrseeesseessssssesessss e 3
1/0 Unit—Scratch Pad COMMANGS ..o esecceeeeeeseeeeeeeeeeeesssessee 319
LOGICAl COMMANGS ....ooce s sssssessssssssesssssssees oo
Mathematical Commands
Miscellaneous COMMANTS ........v.eeeeeeeeeeceerreseeseseeeseseeeeeeeeeeeeeseesesessesesesesssssssessessssssssesseen 326
PID—Ethernet COMMANGS ... eeeeeeeseeseesesseeseeseeeeeessee 326
Pointer Commands........c.......

Simulation Commands
String Commands.................
Time/Date Commands
TIMING COMMANAS oo
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ANALOG POINT COMMANDS

Analog Point Commands

262

The following commands are used with analog points:

Offset and Gain Totalizers
Calculate & Set Analog Gain Get Analog Totalizer Value
Calculate & Set Analog Offset Get & Clear Analog Totalizer Value
Set Analog Gain Set Analog Totalizer Rate
Set Analog Offset

Others
Minimum/Maximum Values Get HART Unique Address
Get Analog Maximum Value Receive HART Response
Get Analog Minimum Value Receive HART Burst Response
Get & Clear Analog Maximum Value Send/Receive HART Command
Get & Clear Analog Minimum Value Set Analog Filter Weight

Set Analog Load Cell Fast Settle Level
Set Analog Load Cell Filter Weight
Set Analog TPO Period

Offset and Gain Commands

Although you normally calibrate analog points in PAC Manager, PAC Control provides commands to
set the values for a point’s offset and gain. (For more information about calibrating offset and gain, see
“Reading and Writing to Analog Points”in Opto 22 form 1704, the PAC Manager User’s Guide.)

If you already know a point’s offset and gain, you can set the values in PAC Control by using the Set
Analog Offset and Set Analog Gain commands. If you don't know the offset and gain, you can use
the Calculate & Set Analog Offset command, and then use Calculate & Set Analog Gain to have the
brain calculate the offset and the gain for you—»but again, calibration is typically performed in

PAC Manager, and not within a strategy’s logic.

Analog Totalizers

Analog totalizers are used to track total volume or quantity. For example, if an analog point
measures gallons per minute, you could use an analog totalizer to determine the total number of
gallons moved over a period of time.

To read the value and leave the totalizer running, use the command Get Analog Totalizer Value. To
read the value and set the totalizer back to zero, use the command Get & Clear Analog Totalizer Value.

Minimum/Maximum Values

The Opto 22 brain automatically keeps track of minimum and maximum values for analog input
points. Min/max values are often used to monitor pressure or temperature.

To read the minimum or maximum value and leave it as is, use Get Analog Minimum Value or Get
Analog Maximum Value. To read the minimum or maximum value and clear it—for example, to
record the minimum pressure in each 24-hour period—use Get & Clear Analog Minimum Value or
Get & Clear Analog Maximum Value.
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Analog Points and OptoScript Code

In OptoScript code, an analog I/0 point can be used directly, wherever a float variable can be used.
For example, you can assign an analog point a value, or use points directly in mathematical
expressions and control structures. For more information, see “Using 1/0 in OptoScript” on page 352.

Reading or Writing Analog Points

The Move command is the main command used to read or write analog points.

Chart Commands

The following commands control charts in the strategy:

Call Chart Continue Calling Chart
Calling Chart Running? Continue Chart
Calling Chart Stopped? Get Chart Status
Calling Chart Suspended? Start Chart

Chart Running? Stop Chart

Chart Stopped? Suspend Chart

Chart Suspended?

For information about charts in a PAC Control strategy, see "PAC Control Terminology” on page 49.

About the Task Queue

How do subroutines fit into the task queue?

Whenever a chart calls a subroutine, the subroutine temporarily inherits the task in use by the
calling chart along with its priority.

Does a task always use all of its allocated time?

Not always. If a chart or subroutine runs in a loop, all allocated time is used. If a chart or subroutine
does not need all of its allocated time to complete its job, all remaining time (including any portion
of a time slice) is given up.

The following conditions cause a chart to use less than a full time slice:
«  Thechart or subroutine stops.

«  The chart or subroutine is suspended.

«  ADelay command is used.

Using the command Delay (mSec) with a value of 1 millisecond is a handy way to give up the time
slice while waiting in a loop for a condition to become True. For more information, see form 1776,
Optimizing PAC Project System Performance.

When does the requested change to a chart or task status take effect?

Not immediately. In any multitasking system, timing and synchronization issues are always a
concern. The time required for a particular request to be implemented depends on the number of

PAC Control User's Guide 263


http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=3965

COMMUNICATION COMMANDS

tasks currently running and the specified chart's location in the task queue. We recommend using
commands such as Calling Chart Suspended? and Chart Running? to determine the status of a

chart.

Communication Commands

The following commands refer to moving data among entities that store and transfer data:

Accept Incoming Communication

Clear Communication Receive Buffer

Close Communication
Communication Open?

Get Communication Handle Value
Get End-Of-Message Terminator
Get Number of Characters Waiting
HTTP Get

HTTP Post Calculate Content Length

HTTP Post From String Table

Listen for Incoming Communication

Open Outgoing Communication
Receive Character

Receive N Characters

Receive Numeric Table
Receive Numeric Table Ex

Receive Numeric Variable

Receive Pointer Table

Receive String

Receive String Table

Send Communication Handle Command
Set Communication Handle Value
Send Email

Send Email with Attachments

Set End-Of-Message Terminator
Transfer N Characters

Transmit Character

Transmit NewLine

Transmit Numeric Table

Transmit Pointer Table

Transmit String

Transmit String Table

Transmit/Receive String

Communication Handles

A communication handle (also known as comm handle or COM handle) is a variable in PAC Control
that stores the parameters needed to connect to a specific entity for the purpose of exchanging
data. The entity may be another device on the network, a file located on the control engine, or some
other thing that stores or transfers data. The value of a communication handle variable is a string
consisting of communication parameters, separated by colons.

Communication handles are used to open and close communication channels, and to transmit and
receive data. You can use communication handles to:

« Communicate with devices (including serial communication modules) via an Ethernet connection
» Communicate with devices via a physical serial port on a SNAP PAC controller
« Create, read, and write data to local and remote files and tables

For example, you might use a UDP communication handle to communicate with another device on
the network via a UDP/IP connection, and use an FTP communication handle to send data from a
controller to a file on a PC.

NOTE: A communication handle is not required to use the SNAP PAC REST API. To configure HTTPS access
to your PAC’s RESTful server and learn how to call the API, visit developer.opto22.com.
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In many cases you'll define a communication handle variable and never change it, because the
parameters rarely change. However, in some cases it might be useful to change it. (Just remember
that if you change parameters while a communication handle is open, you must close the comm
handle and reopen it for the new parameters to take effect.)

PAC Control provides these types of communication handles:

For Ethernet communication via TCP/IP, or with SNAP PAC serial
modules.

TCP Note that outgoing (client) TCP communication handles in PAC
firmware R9.5a (or higher) support secure data exchange via
SSL/TLS. Currently, SSL is not supported in incoming (server) TCP
communication handles.

See page 266.

UDP For lightweight Ethernet communication via UDP/IP. See page 260.

For creating files to be stored on a control engine, and for reading or

File writing to files on a control engine.

See page 284.

For accessing files on a local file system (like a network drive), or on

FTP an FTP server. Also used to transfer files between two servers.

See page 291.

For communication with serial devices that are physically connected
via an RS-232 or RS-485 connector on a SNAP PAC R-series or
S-series controller. (Not used for serial communication modules or
serial-based I/O units.)

Serial

See page 295.

Communication Timeout Values

Each type of communication handle has a predefined default timeout value (the amount of time
the system waits for a command to complete). Timeouts prevent systems from wasting resources
when something is wrong.

Communication Handle Type Default Timeout Value
TCP 10 seconds
UbDP 10 seconds
File 1 second
FTP 30 seconds
Serial 1 second

For the TCP, UDP, and Serial communication handles, you can set a different timeout value and read
the current timeout value for an already open communication handle. For TCP and UDP only, you
can also set the timeout values for receiving data, and for opening both incoming and outgoing
communications. For details, see the “Communication Commands” section in Opto 22 form 1701,
PAC Control Command Reference.

Adding Communication Handles

Using the Add Variable dialog box, you can create variables for each type of communication handle.
For more information about variables, see “Adding Variables”on page 239.
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To add a communication handle:

1. Inthe Strategy Tree, under Variables, right-click Communication Handles, and then choose Add
to open the Add Variable dialog box.

=I5 Variables
+ |25 Mumeric Yariables
I3 String Variables
[C5) Painter Yariables
& - crimunication Handles

|5 Murneric Tables %
IC5) String Tables Configdte. ..
|5 Painter Tables

2. Atthe minimum, complete the following fields:

— Name: Create an appropriate name, such as TCP_Handle.
- Type: Select Communication Handle.
- Initial Value: Varies with type.

—  ForTCP and UDP, see page 266.

- For File, see page 284.

—  For FTP see page 291.

- For Serial, see page 295.

Name —1 Mame: | |
Description: | |
Type—— Tvpe: | Communication Handle

Initialization
() |nitialize on strateqy download
(%) Initialize oh strategy wn
() Persistent

Initial Value —f— Initial ¥alue: |

[ u] 4 ” Caticel ][ Help ]

Using TCP and UDP Communication Handles

TCP and UDP communication handles exchange data with accessible devices anywhere on a
network and even over the Internet.

»  Use TCP when you need reliable data transmission with error handling and message retries.

«  Use UDP when bandwidth is a concern and possible data loss is not an issue.

NOTE: If the two devices that are sharing data are both control engines, it may be easier to use the Scratch

Pad areas on each to transfer data, rather than using communication commands. See “1/0 Unit—Scratch
Pad Commands”on page 319 for more information.

Because SNAP serial communication modules are IP-addressable, you communicate with them by
using a TCP or UDP communication handle (not a Serial communication handle). This way, a
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strategy running on a PC or SNAP PAC device can access serial devices connected to modules on a
remote SNAP PAC R-series or EB-series device (which in this case, acts as an Ethernet-to-Serial
converter).

NOTE: Be sure to use a separate TCP (or UDP) communication handle for each chart in a strategy. If two
charts were to run simultaneously while sharing an open communication handle, each chart would be
able to read and write data from the communication handle as if the other running chart didn't exist.
Because these reads and writes are not synchronized between the charts, it is possible for one chart to read
the other chart's data.

TCP Connections

TCPis a connection-oriented protocol, which means a connection must be established between the
client (the device requesting the data) and the server (the device providing the data) before the
devices exchange data. This connection is typically called a handshake. TCP ensures reliable data
transmission, but the handshake and reliable data transmission require more bandwidth than UDP.

Outgoing (client) TCP communication handles in PAC firmware R9.5a (or higher) support secure
data exchange via SSL/TLS—two similar types of Internet protocols that provide authentication
(that is, established proof of identification) over an encrypted network channel. Lower versions of
PAC Control and PAC firmware support SSL over TCP only with the HTTP Get, HTTP Post, Send Email,
and Send Email With Attachment commands. (UDP protocol does not support SSL/TLS.) For more
information about SSL/TLS, see “Installing CA Root Certificates”on page 298.

Incoming and Outgoing Communication
TCP and UDP communication is normally requested by the device that needs the data.

For example, when a PAC Control strategy running on a SNAP PAC /O unit needs the value of a set
of variables from another strategy running on a different SNAP PAC controller:

«  The controller (the client) requests communication using the command, Open Outgoing
Communication.

«  Thesecond controller (the server) uses the Listen for Incoming Communication command, and
then the Accept Incoming Communication command to establish the connection.

Once connected, data is transmitted and received in both directions.

Depending on the situation, you may want to have both devices request communication and
establish two connections between them. That way if one device goes offline and then comes
online, you can have the flowchart logic set up to immediately open communication again.

In some cases, however, one of the devices may be incapable of requesting communication; for
example, a serial device such as a barcode reader attached to a serial communication module on a
controller. The serial device is incapable of requesting Ethernet communication; essentially it can
only listen and provide data when asked. In cases like this, the controller must use Open Outgoing
Communication to initiate communication. (For serial devices attached directly to a serial port on a
SNAP PAC controller or brain, see “Using Serial Communication Handles to Communicate with Serial
Devices"on page 295.)

Outgoing Communication. For outgoing communication (that is, communication initiated by
the client), the communication handle’s value is in the format:

ubP udp:<Server's IP address or hostname> - <port that is listening for requests>
Basic TCP tep:<Server's IP address or hostname>: <port that is listening for requests>
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SSL/TLS over TCP tcp=<Secure server's [P address or hostname> - <port that is listening for
requests>,ssi[]

Note the comma after the port number and the empty square brackets
after “ssl”

NOTES:
«  "tcp”and “udp”are lowercase.

»  Ahostname is user-friendly name for the IP address. Hostnames are usually created by a
company’s IT department. (Before you substitute a hostname for a controller's IP address, use
PAC Manager to configure the DSN parameter for the controller. For details, see Opto 22
form 1704, the PAC Manager User’s Guide.)

«  Forinformation about ports, see page 269.

+  OnlyTCP supports outgoing (client) communication with SSL/TLS authentication and
encryption. To use SSL/TLS, your controller must have an installed security certificate. (For
information about security certificates, see “Installing CA Root Certificates”on page 298.)

The following table shows examples of TCP and UDP communication handles for outgoing
communication.

Communication Handle Value
Outgoing Communication

Protocol:Server’s IP Address or Hostname:Port,

Ethernet TCP - to a serial communication module on

another rack tcp:10.192.54.10:22506

Ethernet TCP - to a remote server (using the

server's hastname) tcp:mmy_server:255

Ethernet TCP (with secure SSL/TLS) - to a remote

tcp:10.192.56.185:443,ss1[]
server

Ethernet TCP - to a serial communication moduleon | tcp:10.192.55.90:22511
the same rack (uses SNAP PAC R-series IP address | or
or loopback IP address) tcp:127.0.0.1:22511

Ethernet UDP - to a serial communication module on

another rack udp:10.192.54.10:22506

To add a communication handle to a PAC Control strategy, see the steps starting on page 265. In the
Add Variable dialog box, enter the communication handle value in the Initial Value field.
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Add Variable 3
Marne: TCP_Comm_Handle_Outgaing
Dezcription:
Tvpe: Communication Handle
Initialization
() Initislize on strateqy download

(%) Initialize on strategy wn
() Persistent

Communication
handle value

Iritial W alue; |top:10,192.56.185:22004

[ Ok, H Cancel H Help ]

Port Numbers. To communicate with other control engines or other devices on a network, you
can use any port number that is not already in use by that device. For example, you can safely use
ports 22004 and 22005, which have been assigned to Opto 22 by the Internet Assigned Numbers
Authority (IANA). Opto 22 has allocated these Ethernet port numbers for customer use. In general,
anything below 1024 is already predefined and shouldn’t be used unless you are implementing a
predefined protocol that already has a reserved port.

If you do not know what port number to use, ask your network administrator or check the list of
standard reserved Ethernet port numbers at www.iana.org/assignments/port-numbers to see ports
that may apply to your devices on your network.

The following port numbers are the defaults, reserved by Opto 22 devices for the purposes shown.

Port# | Purpose

FTP (file transfer protocol) for get, send, and dir

20 functions

21 FTP (file transfer protocol)

25 SMTP (simple mail transfer protocol)

161 SNMP-based enterprise management systems

502 Modbus/TCP

2001 Main command processor, OptoMMP-bgsed (also
used by SNAP PAC controllers and brains)

4214215?8 Ethernet/IP

22000 | Opto 22 controllers and brains

Host port (for information on configuring the host
22001 port, see Opto 22 form 1704, the PAC Manager User’s
Guide)

22002 Opto 22 controllers and brains

22003 Opto 22 controllers and brains

22500

29531 Serial communication modules
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Port# | Purpose

50000-

50999 Internal messaging

Note that port numbers on the SNAP PAC controllers and brains are the default ports; some may
have been changed for security reasons. (For more information, see the section on Security in
Opto 22 form 1704, the PAC Manager User's Guide.)

Incoming Communication. For incoming communication (that is, communication requested
by another device), the communication handle value includes just the protocol and the port
number: Protocol : Port. TCP automatically tracks senders so there is no mix-up in the data sent
and received. Here are a couple of examples of communication handles for incoming
communication:

Communication Handle Value
Incoming Communication

Protocol:Port

Ethernet TCP (for example, to use a controller as an HTTP server) | tcp:80

Ethernet UDP (for example, to listen for packets being streamed

from a remote 1/O unit) udp:5001

To add a communication handle, see the steps starting on page 265. In the Add Variable dialog box,
enter the communication handle value in the Initial Value field.

Add Variable 3
Marne: TCP_Comm_Hahdle_|ncoming
Dezcription:

Tupe: Communication Handle
Initialization
() Initislize on strateqy download

(%) Initialize on strategy wn
() Persistent

Communication

Iritial W alue; |top:22004
handle value

[ Ok, H Cancel H Help ]

client

Opening and Closing TCP Communication Handles

When using TCP communication handles, keep in mind that the controller has a limited amount of
TCP/IP resources, so you need to be careful about how frequently these communication handles are
opened and closed. TCP communication handles are meant to be left open as long as possible.

Per the TCP/IP specification, each time one of these resources is closed, the closed resource
unavailable for 120 seconds. Rapidly attempting to open and close TCP communication handles
quickly places all available resources in the unavailable condition.
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Once this unavailable state occurs, a communication handle will be unable to gain a resource upon
the next Open Outgoing Communication command. This effectively causes a lock out of any new
TCP/IP connections to be made with the controller (whether from the strategy or externally).

The lock out affects applications such as PAC Control, PAC Display, PAC Manager, OptoOPCServer,
and PAC Terminal. These applications will either have intermittent or no connectivity with the
controller.,

The solution to this dilemma is to control the rate at which TCP communication handles are opened
and closed. When a TCP communication handle is closed (whether a result of a prior successful or
unsuccessful opening), it should be reopened no sooner than 3 seconds. If this reopening fails to
succeed, double the delay to 6 seconds. If this subsequent reopening fails, double the delay to 12
seconds. And thereafter, subsequent reconnections should be performed no shorter than every 24
seconds. This throttling of the opening allows several TCP/IP resources to expire their closing timer.

TCP and UDP Communication Handle Examples

The following diagram shows an example of a communication handle value for outgoing
communication:

Outgoing Communication

SNAP R-series 1/0 Device A
IP address: 10.192.59.45 [P address: 10.192.59.31

B Request communication

Receives communication
on port 22004

: H ¢ Communicate >

Communication Handle value:
tcp:10.192.59.31:22004 or udp:10.192.59.31:22004
L

\

/
IP address Port number

For incoming communication, the communication handle value could be:

Incoming
Communication

SNAP R-series I/0 Device A
IP address: 10.192.59.45 IP address: 10.192.59.31
B L
" Request communication o
o H Sends communication to

10.192.59.45 on port 22004

.
Communication Handle value:
tcp:22004 or udp:22004

i Communicate
4 > T

Communication Handles for Serial Communication Modules. For communication
with serial devices through a serial communication module, the communication handle value
consists of the IP address of the brain the module is attached to, plus the serial module’s port
number according to its position on the rack.
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NOTE: For port number information, see “Establish an Ethernet Connection” in Opto 22 form 1191, the
SNAP Serial Communication Module User’s Guide.

Here are two examples of communication handles for communicating with serial modules, the first
showing communication through a module on the same rack as a SNAP PAC R-series controller, and

the second showing communication through a module on a different rack.
For a serial module on the same

To a Serial Module on the Same Rack rack, use the loopback IP address
127.0.0.1, which tells the brain to
SNAP R-series /0 talk to its own rack. You can also use

Serial Device the brain’s own IP address (in this
example, 10.192.59.45), but the
loopback address allows you to
change the IP address of the brain

%f" e without having to change the
communication handle.

Communication Handle value:
tcp:127.0.0.1:22507 or udp:127.0.0.1:22507
ortecp: 10 192.59.45: 22507 or udp:10.192.59.45:22507

IP-address: 10.192.59.4

SNAP-SCM
port 22507
il

IP address Port number  NOTE: For port number information, see “Establish an
Ethernet Connection”in form 1191, the SNAP Serial
Communication Module User's Guide.

To a Serial Module on a Different Rack

SNAP R-series I/0 SNAP EB-series I/0
IP address: 10.192.59.45 IP address: 10.1 92 5962
Serlal Dewce
Ethernet network
| Ay I o SNAP-SCM
e S o> o PO 22507
.

Communication Handle value:

tcp:10.192.59.62:22507 or udp:10.192.59.62:22507
| ! |

P address{ po>t number  NOTE: For port number information, see “Establish an
Ethernet Connection” in form 1191, the SNAP Serial
Communication Module User's Guide.

Using Flowcharts to Control TCP or UDP Communication

When a control engine is communicating with another device using TCP or UDP, it runs a
PAC Control flowchart or charts to control communication.

«  For outgoing communication on controller COM ports and serial modules, the
flowchart uses the command Open Outgoing Communication to request a connection.

»  Forincoming communication on controller COM ports, which is requested by another
device, the flowchart must first use Listen for Incoming Communication and then use Accept
Incoming Communication to establish a connection.
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+  Forincoming communication on serial modules, which is requested by another device,
the flowchart uses the Open Outgoing Communication and Communication Open?
commands to establish a connection.

The control engine’s TCP/IP flowcharts should open communication once and then continue to
transmit or receive using the communication handle. Constantly opening and closing
communication for each transaction wastes time and is inefficient.

As a simple example, the flowchart at right is

designed to receive data from a serial device, such
as a barcode reader, through a serial :
communication module on the same rack as a oo - - - | Block0
SNAP PAC R-series /O unit. L

Communication with serial modules in this
example is done via TCP. It can be done from the
SNAP PAC R-series system itself, as in this example,

~ Serial_Comm™

-
1
Open outgoing
communication

or from another TCP/IP device on the network. . 5
In this example, the R-series |/0 unit establishes " eetwofchar
communication through the serial module using o

the communication handle: e m

tcp:127.0.0.1:22507 : _I‘ e

The loopback IP address is used, since the serial : .I 2

module is on the same rack. _ .

When characters are detected in the receive buffer, ff [

the I/0 unit receives the string and processes it, . | Recenve String

and then after a short delay checks for another o e

message. Communication remains open for L -

additional messages. (jshoieuts 1o
fLLe T2 Chart /

This simple flowchart illustrates the basics of
handling communication, without any error checking. However, while receiving and transmitting,
TCP/IP control charts should also monitor the status value returned by commands such as Transmit
Numeric Table and Receive Numeric Table, and close communication if there are errors. If your

PAC Control application opens sessions but does not close unused or bad sessions, the maximum
number of sessions could be used up. Note that communication should not be closed for timeout
errors from Receive commands (error numbers —37 and —39), however, because these errors simply
mean that there was no data waiting in the receive buffer for the specified session.

To save time, before using a Receive command (such as Receive String or Receive Numeric Table),
TCP/IP charts should use the command Get Number of Characters Waiting. If there are zero
characters waiting, then there is no reason to use the Receive command. It is also a good idea to
start a down timer, and then loop on the Get Number of Characters Waiting command until either
there are more than zero characters waiting, or the timer expires.

The following chart is also an example of TCP/IP communication on controller COM ports, but with
three differences: in this case another device is requesting communication, the peer will both
transmit and receive, and error checking is shown for the commands Get Number of Characters
Waiting and Receive Numeric Table. Similar error checking should be used for transmit commands,
which in this strategy are in another chart.
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*= Incoming_Comm_Control

o
haracter
count -37 or
39?2

©Lcomimu

nication

_[# Clear receive
buffer

?Call Transmit chart

(1) Shortouts :‘ID_D°/° v

[1> T2 Chart /

If the devices communicating with each other are all SNAP R-series, be careful not to have one of
them send information to another faster than the receiving system can pull it out of its receive
buffer. When a control engine receives data from the Ethernet network, it holds the data in memory
(the buffer) until the PAC Control flowchart removes it with a Receive command. If the data is not
removed fast enough, the receive buffer will fill up. You can prevent this problem by transmitting
the information less frequently. If the same chart is transmitting and receiving, you can alter the
chart so that it receives more often than it transmits.

Ethernet Connections and Ports

The number of Ethernet connections available varies by hardware, type, and in some cases firmware
version, such as 80 on current SNAP PAC R-series I/O systems.

The host connection is on port 22000 or 22001 and is used to communicate with the PC that runs
PAC Control. These port numbers are reserved for this purpose, but they can be configured. For
information see Opto 22 form 1704, the PAC Manager User's Guide.

Peer-to-peer connections can be on any other port number that is not already used on the network;
these connections are used to communicate with other control engines or other devices on the
network. When you assign port numbers for peer-to-peer connections, make sure you do not assign
port numbers that devices on your network may use for specific purposes. For a list of standard
Ethernet port numbers, refer to: www.iana.org/assignments/port-numbers

IMPORTANT: If you are using TCP/IP or UDP connections, consult commercially available texts on
TCP/IP or UDP that discuss client/server architectures, so you'll understand how the protocol works and
what to expect during communication.
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UDP Communication Handles

The User Datagram Protocol (UDP) is a fast, lightweight communications protocol that is sometimes
used as an alternative to TCP (see page 266). UDP is used to transmit messages—called
datagrams—across an IP network from a source IP address and source UDP port to a destination IP
address and destination UDP port. UDP communication handles most often used when bandwidth
is a concern and reliable data transmission is not required.

Important Characteristics of UDP
«  Uses port numbers to help distinguish different types of requests.
«  Hasan optional checksum function to ensure the datagram is delivered intact

«  Uses a connectionless transmission model, which means it doesn’t do a “handshake” or
otherwise ensure that the receiving IP address is available and ready to receive.

+  Does not guarantee datagram delivery. If a delivery fails, it does not perform retries.

+  Does not preserve datagram sequencing. Datagrams may arrive at the destination in a different
order than they were sent.

« Isunaware of congestion at the receiving IP address. If the receiver's queue becomes full,
subsequent datagrams are dropped.

The following table describes the available categories of PAC Control UDP communication handles:

chelD Local Characteristics Remote Characteristics e
Category Handle Value

May be used to communicate with
multiple remote IP addresses and
ports by using the command “Send
Communication Handle Com-
mand, “set.dst:<ip

The local UDP port is speci-

Local Bound | fied by the communication udp:<local port>

handle. address>:<port>" or “set.dst:<host-
name with fully qualified domain
name>:<port>.
Remote Local UDP port is chosen by Co.mmumcate‘s with ?he communi- udp:<remote IP
. cation handle’s specified remote IP )
Bound the operating system. address>:<remote port>

address and port.

Can be used to communicate with
multiple remote IP addresses and
ports by using the command “Send
Local UDP port is chosen by | Communication Handle Com-

the operating system. mand” with a destination string like
“set.dst:<ip address>:<port>" or
“set.dst:<hostname with fully quali-
fied domain name>:<port>.

Unbound udp:

NOTE: Be sure to use a separate UDP (or TCP) communication handle for each chart in a strategy. If two
charts were to run simultaneously while sharing an open communication handle, each chart would be
able to read and write data from the communication handle as if the other running chart didn't exist.
Because these reads and writes are not synchronized between the charts, it is possible for one chart to read
the other chart's data.
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Configuring a Local Bound UDP Communication Handle

Alocal bound communication handle is used to receive UDP datagrams through a known UDP port.
You can also configure the communication handle to transmit data to a specific destination. For
details, see the “Set Communication Handle Value” command.

To add a communication handle to a PAC Control strategy, see the steps starting on page 265. In the
Add Variable dialog box, enter the communication handle value in the Initial Value field.

The local bound communication handle value has the following format:
udp:<local bound port number>

Example:

udp:23456

Optoscript example:

SetCommunicationHandleValue(“udp:23456”, cmhMyLocalBoundCommHandle);
Action block example:

configure the local bound communication handle value add...

Set Communication Handle Value
From "udp:23456" Madify. ..

To cmhMyLocalBoundCommHandle
Delete

Mext Blodk

Previous Block

Command Help

In this example, any data sent via UDP to UDP port 23456 will be received by the PAC Control
strategy. UDP datagrams sent to the bound port will be received on all active Ethernet or Wireless
Ethernet interfaces.

The communication handle value may be configured when defining the communication handle in
the strategy tree. Set the “Initial Value”field when the communication handle is set to be “Initialize
on strategy download” or “Initialize on strategy run.”
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Edit Variable “

Mame: cmhMyLocalBoundCommHandle

Description: | Bound UDP comm handle.

Type: Communication Handle
Initialization
(") Initialize on strategy download
(®) Initialize on strategy run

() Persistent

Initial Value: | udp: 23456

For more information about defining variables in the strategy, see “Adding Variables”on page 239.

Configuring a Remote Bound UDP Communication Handle

A remote bound UDP communication handle is typically used to communicate to another device
that receives UDP datagrams on a bound (preset) port number. The remote port number allows
transmitters to direct the datagram’s destination.

To add a communication handle to a PAC Control strategy, see the steps starting on page 265. In the
Add Variable dialog box, enter the communication handle value in the Initial Value field

The remote bound communication handle value has the following format:
udp:<remote IP Address>:<remote port number>

Example:

udp:192.168.1.100:23456

Optoscript example:

SetCommunicationHandleValue(“udp:192.168.1.100:23456",
cmhMyRemoteBoundCommHandle) ;
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Action block example:

configure the remote bound communication handle value Add. ..

Set Communication Handle Value
From "udp:192.168.1.100:23456" Modify...

To cmhMyRemoteBoundCommHandle
Delete

Mext Block

Previous Block

Command Help

The example configures a communication handle that transmits data to the destination host IP
address 192.168.1.100, UDP port 23456.

Configuring an Unbound UDP Communication Handle

The unbound communication handle is very similar to the remote bound category. The only
difference is the communication handle value does not specify the local port.

To add a communication handle to a PAC Control strategy, see the steps starting on page 265. In the
Add Variable dialog box, enter the communication handle value in the Initial Value field.

The unbound UDP communication handle value has this format:
udp:
Optoscript example:

SetCommunicationHandleValue(“udp:”, cmhMyUnboundCommHandle);
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Action block example:

configure the unbound communication handle value Add. ..

Set Communication Handle Value
From "udp" Modify...

To cmhMyUnocundCommHandle
Delete

Mext Block

Previous Block

| Command Help

Opening the UDP Communication Handle

To open either an unbound or bound communication handle, use the OpenOutgoingCommunication
command.
Optoscript example:

i320penUnboundResult =
OpenOutgoingCommunication(cmhMyRemoteBoundCommHandle) ;

1320penBoundResult =
OpenOutgoingCommunication(cmhMyLocalBoundCommHandle) ;

Action block example:

open the remote bound communication handle Add. ..

Open Qutgoing Communication
Communication Handle cmhMyRemoteBoundCommHandle Modify...
Put Result in i220penUnboundResult
Delete
open the local bound communication handle
Open Outgoing Communication Mext Block
Communication Handle cmhMyLocalBoundCommHandle
Put Result in i320penLocalBoundResult Previous Block

M

| Close || Help | Command Help
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To find out if the handle opened successfully, inspect the result from the
OpenOutgoingCommunication command. A zero result means the opening succeeded. A negative
value indicates the communication handle was not opened.

Closing the UDP Communication Handle
To close any communication handle, use the command “CloseCommunication.”

Optoscript example:
CloseCommunication(cmhMyRemoteBoundCommHandle) ;

Action block example:

Close Communication
Communication Handle cmhMyLocalBoundCommHandle
Put Status in i32CloseResult Modify...

I, O

Mext Blodk

Previous Block

Command Help

Many applications never close a communication handle once they are opened. If a communication
fault were to occur on an unbound communication handle, the handle continues to remain open
and may still be used to resume communications. If the communication handle was bound, it too
remains open and datagrams will be received once the network problem is corrected.

Transmitting Datagrams with a Remote Bound Communication Handle

The following commands may be used to transmit data with an open UDP communication handle.
»  Transmit Character®

+  Transmit Numeric Table

«  Transmit Pointer Table

«  Transmit String

«  Transmit String Table

»  Transmit/Receive String

*|f transmitting several sequential characters of a string, use Transmit String instead.

When using these commands, the data may be transmitted to the IP address and UDP port specified
when the UDP communication handle was opened.
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To add a communication handle to a PAC Control strategy, see the steps starting on page 265. In the
Add Variable dialog box, enter the communication handle value in the Initial Value field.
Optoscript example:

i32TransmitResult = TransmitNumTable(4, 2, i32tMyDataTable,
cmhMyRemoteBoundCommHandle) ;

Action block example:

transmit data from remote bound to local bound communication handle Add. ..
Transmit Numeric Table
Length 4 Modify. ..
Start at Index 2
Of Table i32tRemoteBoundReceivedData Delete
Communication Handle cmhMyRemoteBoundCommHandle
Put 5tatus in iJZRemoteBoundTransmitResult Mext Block

I, < io-s Sock

|| Help | Command Help

This example transmits elements 2, 3, 4, and 5 of table i32tMyDataTable to the IP address
192.168.1.100, UDP port 23456. All 4 elements are transmit in a single datagram over the network.

Transmitting Datagrams with a Local Bound Communication Handle

Transmitting with a bound communication handle requires the communication handle’s
destination (the IP address and port) to be set. Use the command “Send Communication Handle
Command”to configure these destination parameters. Once the destination is set, the same data
transmit commands may be used.

To add a communication handle to a PAC Control strategy, see the steps starting on page 265. In the
Add Variable dialog box, enter the communication handle value in the Initial Value field.

Optoscript example:

i32SendResult = SendCommunicationHandleValue(cmhMyLocalBoundCommHandle,
“set.dst:192.168.1.101:12345");

i32TransmitResult = TransmitNumTable(4, 2, i32tMyDataTable,
cmhMyLocalBoundCommHandle) ;
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Action block example:

i Instructions - Powerup - Example “
Send Communication Handle Command ~ Add. ..
Communication Handle cmhMyLocalBoundCommHandle
Command "set.dst:192.168.1.101:12345" Modify...
Put Status in ijJ25etResult
Delete
Transmit Humeric Table
Length 4 Mext Block
Start at Index 0
Of Table i2tLocalBoundModifiedData Previous Block
Communication Handle cmhMyLocalBoundCommHandle
Put Status in idJ2LocalBoundTransmitResult

e

Close Help Command Help

This example first configures the local bound UDP communication handle to transmit the data to
the IP address 192.168.1.101, UDP port 12345. Subsequent data transmissions will be sent to the
same IP address and UDP port until a SendCommunicationHandle with a new destination IP address
or UDP port is commanded.

Determining when a Datagram Has Arrived

Use the command “Get Number of Characters Waiting”to determine if datagrams have arrived on
the UDP communication handle.

Optoscript example:
i32BytesWaiting = GetNumberOfCharsWaiting(cmhMyLocalBoundCommHandle) ;
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Action block example:

& Instructions - Powerup - Example
Get Number of Characters Waiting Add. ..
Communication Handle cmhMyLocalBoundCommHandle
Put in i3Z2LocalBoundDataWaiting Modify...

I, O

Close Help Command Help

Mext Block

Previous Blodk

The strategy should inspect the result value from the command. When positive, this indicates the
amount of data pending. When receiving a positive result, the value indicates the amount of data
contained in the current datagram.

In some cases, a timer is used to limit how long the chart will wait for data to arrive. This is usually
configured as a loop and includes either an up- or down-timer to monitor the elapsed time. Within
the loop, checking for the number of characters waiting, include a “Delay Millisecond”command
with a reasonable delay time to allow the chart to release its timeslice.

Receiving Datagrams

Use the following commands to receive datagrams from a bound or unbound UDP communication
handle.

«  Receive Character

+  Receive N Characters

+  Receive Numeric Table

«  Receive Numeric Table Ex
»  Receive Numeric Variable
«  Receive Pointer Table

+  Receive String

+  Receive String Table

When the chart logic has determined that a datagram is pending on the communication handle,
the data may be received.

When receiving the datagram, ensure that all of the bytes contained within the current datagram
reported by the command “Get Number Of Characters Waiting”are received. Once all the data of the
current UDP datagram is received, the next datagram may be received. The reading of the entire
datagram within PAC Control's implementation of UDP messaging differs from typical programming
environment “socket”implementations.
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Retrieving The Received Datagram’s Source IP address And Source UDP port

When a datagram is received, the identity of the transmitter can be retrieved using the “Send
Communication Handle Command”command. The command returns the values in a numeric
format. To set a destination address and port so that a reply can be sent on the same
communication handle, these values must be converted to strings and formatted into a command
string understandable by Send Communication Handle Command.

OptoScript example:
// retrieve the datagram’s source IP address and source port

i32SourcelpAddress = SendCommunicationHandleCommand(cmhMyBoundCommHandle,
'get.src');

i32SourcePort = SendCommunicationHandleCommand(cmhMyBoundCommHandle,
"'get.srcport');

// convert numeric source values to strings
Int32TolpAddressString(i32SourcelpAddress, sSourcelpAddress);
NumberToString(i32SourcePort, sSourcePort);

// create a command string for the “Send Communication Handle Command”
sReplyAddress = “set.dst:” + sSourcelpAddress + ":" + sSourcePort;

The result stored in sReplyAddress (for example “set.dst:192.168.1.100:54321") is used as the
command string to set the next transmission destination to send a datagram to IP address
“192.168.1.100," port 54321.

Using the Control Engine’s File System

The memory available for file storage is about 4 MB on a PAC S-series controller, or 2 MB on a PAC
R-series controller. File storage on a SoftPAC controller is limited only by the size of your hard drive
and the volumes available on your network. Any types of files can be stored there, and files can be
sorted into directories or folders just as they can on a PC. These stored files are then available for use;
for example, the control engine can read them, add data to them, and even send data from them via
FTP to another device on the network. SNAP PAC controllers also allow you to store data or files
using a microSD card. For more information about using a microSD card, see the user’s guide for the
controller.

NOTE: Certain FTP commands may also be useful when dealing with files, even if the files are all local. For
example, the dir command is available with comm handles.

The file communication handle is used to create, write to, and read from stored files on the control
engine. The format for the handle’s value is: file:<open mode>,<filename>

Note that File isall lowercase. Open modes are:

Open mode Description

r Opens a file for reading. If the file does not exist or cannot be found,
the open call fails.
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Open mode Description

w Creates a new file and opens it for writing. If the file already exists, its
contents are destroyed.

a Opens a file for writing at the end of the file (appending). If the file
doesn’t exist, it is created.

Here are some examples of file communication handle values:

Creates the file myfile.txt and opens it

for writing. file:w,myfile.txt

Opens the existing file myfile.txt so data

can be appended to it. Filea,myfile.txt

Creates the file Temperature data. txt in
the directory Data_files and opens it for
writing. If the directory doesn’t exist, it is
created.

file:w,/Data_files/Temperature data.txt

Opens the file Temperature data.txt in

the directory Data_files for reading. file:r,/Data_files/Temperature data.txt

To add a communication handle, see the steps starting on page 265. In the Add Variable dialog box,
enter the communication handle value in the Initial Value field.

Add Variable =3
Mame: Cornm_Handle_File
Dezcription:
Tupe: Communication Handle s
Initializ aticn
() Initialize on strateqy download
(®) Initialize on strateqy run

() Persistent
Communication

handle value

Initial Walue: |filesw, myfile. bt

[ 0K H Cancel H Help ]

Keep the following limitations in mind as you use the file communication handle with the
controller's file system (see below for microSD card):

Maximum length for file names and directory names 127 characters

Filename characters allowed All ASCII characters except *, ?, null, and /
Path name component separator /

Maximgm number of files and directories that can be 16

open simultaneously

Maximum directory depth Limited only by available memory

Limited only by available memory. Each file uses 516
Maximum number of files bytes of overhead plus its number of bytes rounded
up to the nearest multiple of 516 bytes.
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Maximum number of directories

uses 516 bytes.

Limited only by available memory. Each directory

engine’s file system

Maximum amount of memory available in the control

Approximately 4 MB on a SNAP-PAC-S1, or 2 MB
on a SNAP PAC R-series controller (varies slightly
depending on the control engine firmware version)

If power to the control engine is turned off, files are destroyed unless they have been saved to flash
memory. See “Commands Relating to Permanent Storage” on page 310 for information on saving
files to flash using PAC Control commands.

Using a File on a microSD Card

If your SNAP PAC controller has a microSD card slot in the top of the controller's case, you can use
PAC Control commands with files on a microSD card just as you would with any other file in the
controller's file system. Just remember two things:

» Include the card’s directory name in the path in the file communication handle, for example:
file:a,/sdcard0/VoltLog.txt

+  Filename length: See your controller's user's guide for card compatibility information.
Filenames up to 127 characters can be used on higher-capacity microSDHC cards. However, on
lower-capacity standard microSD cards (2GB or less, formatted with FAT16), all files you store on
the card must be named with a maximum of eight characters in the name plus three

characters in the extension (8 dot 3 format), for example: datafi le. txt

For more information on using the microSD card, see the controller’s user guide.

Working with Files in Your Strategy

The commands you use with a communication handle vary according to the action (the open
mode) defined in the handle’s value. To change actions—from read to write, for example—you can
use Set Communication Handle Value to change the handle’s value.

Commands to use with any file
communication handle

Commands to use with file comm
handles in Read mode

Commands to use
with file comm
handles in Write or
Append mode

Close Communication

Communication Open?

Get Available File Space

Get Number of Characters Waiting
Open Outgoing Communication

Send Communication Handle Command
(delete, getpos, or setpos)

Set Communication Handle Value

Set End-of-Message Terminator

Receive Numeric Table

Receive Pointer Table

Receive String

Receive String Table

Send Communication Handle Command
(find)

Transfer N Characters
Transmit Character
Transmit NewLine
Transmit Numeric Table
Transmit Pointer Table
Transmit String
Transmit String Table

To work with files in your strategy, first use the command Open Outgoing Communication.

Writing to a File. For example, suppose you have data in your strategy in a string table
(Product_Table) that you want to write to a file (Products.txt) in a directory (Company Data) on the
control engine. Here’s how you would do it:

1. Use Open Outgoing Communication to open a file communication handle. The value of the
handle would be: File:w,/Company Data/Products.txt
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2. Use the condition Communication Open? to make sure the communication handle opened.

3. To put the data from the string table into a comma-delimited file (which is easy to open in
database software), use the command Set End-Of-Message Terminator to indicate that a
comma should be used as the delimiting character. Or, if you want each line of your data to end
with a LF (line feed), set the EOM (end-of-message) terminator to 10 (decimal), which is the
ASClI code for LF. See “ASClI Table” on page 339 for other EOM characters.

4. Use the command Transmit String Table to transmit data from Product_Table directly into the
Products.txt file. ltems from the string table are separated by commas in the file.

Strategy L
Control Engine File System

Product_Table Company Data/ Products.txt

0 Bats

1 Baseballs Bats,Baseballs,
Batting gloves,

2 | Batting gloves Catcher’s mitts

3 Catcher’s mitts

5. Usethe command Close Communication to close the communication handle.

Reading a File. As another example, suppose you have a file on the control engine that was
placed there via FTP. (See the next section for details on using the FTP communication handle.) You
want to read this file (New_Data.txt) and place the data in it into a string table (Data_Table) in your
strategy.

1. Use Open Outgoing Communication to open a file communication handle. The value of the
handle would be: File:r,New Data.txt

2. Use the condition Communication Open? to make sure the handle opened.

3. Use the command Set End-Of-Message Terminator to indicate what character in the
New_Data.txt file should be read as the delimiting character. (In the example shown below, it's
aslash.)

TIP: If the lines of data in the text file end with LF (line feed), set the EOM (end-of-message) terminator
to 10 (decimal), which is the ASCII code for LF.

4, Use the command Receive String Table to receive the data from New_Data.txt directly into
Data_Table. To read the whole file, use a value of -1 for the Length parameter.
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Control Engine File System Strategy
New_Data.txt Data_Table
0 | 485
485/622/35/56/
7841/20 1 | 622
2 |35
3 | 56
4 | 7841
5 | 20

Notice the numbers used in this example. These are numbers represented as strings. For the
purpose of storing and sending data, this is the simplest way to represent them. If you need to
use them in calculations, however, you must first convert them to numeric values. You can do
so in your PAC Control strategy by using a command such as Convert String to Float or Convert
String to Integer 32. (See “String Commands” on page 332 for more information.)

5. It might also be helpful to use the command Send Communication Handle Command which
provides the following commands that you can use when accessing files.

find: locates data in the file if each line has a unique identifier.
getpos returns an integer that indicates the current position in the file.
setpos:<position> jumps to the specified position within the file.

find:<mystring> (strings only) searches for the string within the file and returns its location as
an offset from the current position in the file. The file must have been opened in r (read) mode.

n

6. Finally, close the communication handle by using the command Close Communication.

A More Complex Example. Here's a more complex example which shows the actual
OptoScript code. In this example, someone on the network needs the value of several variables in
the PAC Control strategy running on the control engine. This person has sent to the control engine
via FTP a comma-delimited text file (ProductRequest.txt) containing the names of the variables. (See
page 291 for information on FTP)

This section of the PAC Control strategy reads the variable names from the text file in the control
engine’s file system and places the names in a string table (Product_Names). Next, the strategy uses
the command Get Value From Name to place the values of the variables into another table
(Product_Info). The data from this table is then written to another text file (Productinfo.txt) on the
control engine, which can later be sent via FTP to the person who requested the data.
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The whole operation (including the FTP portions, which are not covered in this code example),
might look like this:

Requestor Control Engine PAC Control Strategy
I:I File System
— ProductRequest.txt Product_Names String Table
ProductRequest.txt FTP Num_Widgets, e 0 | Num_Widgets
Num_Widgets, 0 Num_Gadgets, 1 | Nom_Gadgets
Num_Gadgets, Num_Thingies, -
Num_Thingies, Num_Whatnots 2 | Num_Thingies

Num_Whatnots

3 Num_Whatnots

Get Value
From Name

ProductSales.txt productinfo it Product_Info String Table
9556, 10867, oduer o 5 | ooo0
5432, 23 9556, 10867,
FTP e 5432,23 o 1 | 10867
2 5432
3 |23
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The OptoScript code in this example also makes use of the command Set Communication Handle
Value to change the value of a specific communication handle during the operation.

Sets the value for the
communication handle
chAFile.

SetCommunicationHandleValue('file:r,ProductRequest._txt",chAFile);

Opens the communication
handle and checks to make
sure it opened.

status =
if (status ==

OpenOutgoingCommunication(chAFile);
0) then

Sets the end-of-message
terminator to a comma
because the file to be read
is comma-delimited.

SetEndOfMessageTerminator(chAFile, *,");

Reads the contents of the
file Product_Namesinto a
string table.

status = ReceiveStrTable(4,0,Product_Names,chAFile);

Loops through the items in
Product_Names table and
places the values they
represent into another
string table, Product_Info.
(Note that the “numbers”in

index = 0;
while ((index < 4) and (status == 0))
status = GetValueFromName(Product_Names[index], Pro-
duct_Info[index]);

the Product_Info table are index = index + 1;

not true numbers, but wend

string representations of

numbers.)

Closes communication. status = CloseCommunication(chAFile);

Changes the value of the
communication handle; it
is now set to write to the
file Productinfo.txt on the
control engine.

SetCommunicationHandleValue("file:w,Productinfo.txt",chAFile);

Opens the communication
handle and checks to make
sure it opened.

Makes the Productinfo.txt

status = OpenOutgoingCommunication(chAFile);
if (status == 0) then

SetEndOfMessageTerminator(chAFile, *,");

file comma-delimited, too.

Writes the data from the ; ;
Product Info string table status = TransmitStrTable(4,0,Product_Info,chAFile);
o the Proguctoixt fle | SM9IF

into the Productinfo.txtfile | o4

on the control engine.

Deleting Files and Moving Within Them. Another command you'll find useful with file
communication handles is Send Communication Handle Command. Using these commands, you
can delete files, find a position within the file, and jump to a specific position within the file. See the
PAC Control Command Reference or online Help for details.

For example, in order to find specific data in a file, you can use following commands within the
command Send Communication Handle Command.
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+  find:<mystring>

(for strings only) Use this command to search for a string within the file and return its location
as an offset from the current position in the file. The file must have been opened in r (read)
mode.

+ getpos

Returns an integer that indicates the current position in the file.
+  setpos:position

Jumps to the specified position within the file.

Moving Files via FTP

As explained in the previous section (“Using the Control Engine’s File System,” starting on page 284)
the control engine’s memory includes a substantial area available for file storage. You can move files
to and from file storage using the File Transfer Protocol (FTP):

«  Tomove files to and from file storage using another device such as a PC, use any
standard FTP software. See instructions in Opto 22 form 1704, the PAC Manager User's Guide. A
maximum of five devices can FTP files to a control engine simultaneously.

+  Tomove data to and from file storage programmatically, a strategy can request or send a
file using an FTP communication handle, explained in this section. A maximum of 16
communication handles can be used simultaneously to move data via FTP.

FTP also allows you to get a directory listing of files on a remote server or in the local file storage
area. In addition, if your SNAP PAC controller has a microSD card slot in the top of the controller’s
case, you can use the FTP communication handle to manipulate files on a microSD card.

FTP Communication Handle Examples

The value for the FTP communication handle is in the format;
ftp:<IP address>:<port>,<username>,<password>,<optional timeout>

ftp Use all lowercase letters.
IP address (or URL) of the destination device (where the file
IP address .
will go).
port Default port is 21, with 20 for the data port.
username Entgr the username a.nd pas§wo.rd set up for the desthatlon
device. If the destination device is another control engine or
password

the local server, use anything except an empty string.

Specify a communication timeout value in seconds, or leave

optional timeout this parameter out to use the default of 30 seconds.

Here are two examples of FTP communication handle values:
ftp:10.22.55.35:21, jsmith,2towers,60 (timeout increased to 60 seconds)
ftp:10.192.54.195:21,m,m (no timeout specified)

To add a communication handle, see the steps starting on page 265. In the Add Variable dialog box,
enter the communication handle value in the Initial Value field.
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Marne: | Cormm_Handle_FTP |
Dezcription: | |
Tvpe: | Communication Handle |

Initialization
() Initislize on strateqy download
(%) Initialize on strategy wn
() Persistent

Communication

Initial Yalue: |ftpr10.22.55.35:21 jsmith, 2towers 60 — Handle val
andle value

[ Ok, H Cancel H Help ]

Setting the FTP Mode

If you are connecting to an FTP site behind a firewall, you may need to set a mode for the session.
After the communication handle is open, you can set the FTP mode by issuing one of the following
commands:

. For Active FTP:
i32ResultCode = SendCommunicationHandleCommand(cmh, "active'™);

«  ForPassive FTP:
i32ResultCode = SendCommunicationHandleCommand(cmh, '‘passive™);

Using FTP Communication Handles in Your Strategy

Suppose you have data you need to send via FTP to a device on the network whose IP address is
10.192.56.45. Your user name on this device is JoeG and your password is hello. You expect the
default timeout of 30 seconds to be adequate.

There are two ways you can send the data: all at once, or in pieces over time. If your data file is less
than 1 MBin size, you can send it all at once. If it is larger, or if you want to append additional data to
a file that already exists, you send it in pieces.

Sending or Retrieving the Data All At Once. This method is better for small data files; files
larger than TMB may take a long time to transfer, and the control engine may become unresponsive
during the process.

For Sending: Suppose you want to send the data currently in the file SendThisData.txt on the
control engine to a file HunkoData.txt on the device.

Here's how you would send the data in your PAC Control strategy.

1. Use the command Open Outgoing Communication to open an FTP communication handle.
The value of the handle would be: ftp:10.192.56.45:21,JoeG,hello

2. Use the condition Communication Open? to make sure the communication handle opened.
3. Use the command Send Communication Handle Command to specify the file name and send
the file in one step.
Use the communication handle command send:<local filename>, <remote filename> as
follows:
send:SendThisData. txt,HunkoData. txt
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If the remote file name already exists, it is overwritten.

4. When you have finished sending data to the file, use the command Close Communication to
close the communication handle.

For Retrieving: Suppose you want to get the data from the file GetThisData.txt on the device, and
retrieve it to the file HunkoData.txt on the control engine.
Here's how you would retrieve the data in your PAC Control strategy.

1. Use the command Open Outgoing Communication to open an FTP communication handle.
The value of the handle would be: ftp:10.192.56.45:21,JoeG,hello

2. Use the condition Communication Open? to make sure the communication handle opened.
3. Use the command Send Communication Handle Command to specify the file name and
retrieve the file in one step.
Use the communication handle command get:<remote filename>,<local filename> as
follows:
get:GetThisData.txt,HunkoData.txt
If the local file name already exists, it is overwritten.

4. When you have finished retrieving data from the file, use the command Close Communication
to close the communication handle.

Sending the Data in Pieces. To append data to an existing file, or to send a very large file
(larger than 1T MB), you can send data in pieces.

Suppose you want to append data from a strategy variable or table to an existing file named

HunkoData.txt on the device. Here's how you would send the data:

1. Use the command Open Outgoing Communication to open an FTP communication handle.
The value of the handle would be: ftp:10.192.56.45:21,J0eG,hello

2. Use the condition Communication Open? to make sure the communication handle opened.

3. To specify the file name on the remote server, use the command Send Communication Handle
Command. The communication handle command you send is:
dest:HunkoData.txt

4, Use aTransmit command (such as Transmit String or Transmit Numeric Table) to send the data.
In the command, use the name of the FTP communication handle you just opened.

The data is appended to the file. (If the remote file name is new, the file is created and the data
placedin it

5.  When you have finished sending data, use the command Close Communication to close the
communication handle.

If you are sending a large file from the control engine to the device, you would need to open up two
communication handles: an FTP handle just like the one in the example above, and a File handle for
the file on the control engine. Then use the Transfer N Characters command to send the file in
chunks.

For another example, see the diagram in “A More Complex Example”on page 288, which shows
how FTP communication handles and file communication handles might be used together. See the
PAC Control Command Reference or online Help for detailed information on commands.
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Retrieving a Directory Listing

The OptoScript code in this example makes use of the command Set Communication Handle Value
and the dir option to retrieve a directory listing.

Sets the value for the
communication handle
chAFile.

// Configure the chFTP comm handle to log into itself. The username and
// password don"t matter--they just can"t be left empty. We"ll use the
// loopback address of 127.0.0.1 so this code is more portable.
SetCommunicationHandleValue("ftp:127.0.0.1:21,noimporta,whocares', chFTP

);

Opens the communication
handle and checks to make
sure it opened.

// Open the communication handle (log in to the local server)
nStatus = OpenOutgoingCommunication( chFTP );
if (nStatus 0) then

Requests directory listing,
returns number of listings.

nStatus = SendCommunicationHandleCommand( chFTP, "dir" );

Makes sure “dir" worked—
firmware must be version
7.1 or greater.

if (nStatus >
nFileCount

0) then
nStatus;

Reads in listings to stList.

NOTE: Each listing from an
Opto 22 device serverends
with these hex bytes: 0D
OA and is delineated from
the next by a 00.

// Set the EOM character to 00
SetEndOfMessageTerminator( chFTP, 0x00 );
nStatus = ReceiveStrTable( nStatus, 0, stList, chFTP );

if ( nStatus 0 ) then

Optional: parses each
listing into separated
tables for:

1. date/time stamp (first 17
characters)

2. file size (next 21
characters)

3. file name (remaining
characters) and removes

for nindex = 0 to (nFileCount - 1) step 1
GetSubstring( stList[nlndex], 0, 17, stDateTimeStamps[nindex] );
GetSubstring( stList[nlndex], 18, 21, sTemp );
ntSizes[nlndex] = StringTolnt32( sTemp );
GetSubstring( stList[nlndex], 39, 1000, stFilenames[nindex] );

nLength = GetStringLength( stFilenames[nindex] );
GetSubstring( stFilenames[nindex], 0, nLength - 2,
stFilenames[nindex] );

stamps, depending on
how those values will be
used.

next
the OD 0A left over on the
end of the file name.
Further parsing could be endif
done on the date/time endif

endif
CloseCommunication( chFTP );
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Using Serial Communication Handles to Communicate with
Serial Devices

Serial connectors are located on the top of SNAP PAC controllers. These ports can be used for
maintenance, such as loading new firmware, or for Point-to-Point Protocol (PPP) communication via
a modem. They can also be used to send or receive data directly from a serial device, such as
barcode readers, weigh scales, /0, or any intelligent device. Serial communication handles are used
to communicate with these intelligent devices (see examples below).

When using the (faster) on-board serial connections available on PAC R- and PAC S-series controllers,

the communication handle value start with “ser:"followed by the baud settings. If you're using a PAC

R-series controller, you'll need to configure the onboard Port 0 to be None rather than the default of

PPP; otherwise, the Open command will fail with a -20 (Resource busy) error.

To set the serial port to None in PAC Manager:

1. Open the Inspect window in PAC Manager and enter the IP address for your device.

2. (lick Communications and choose Communication Port Control.

3. IntheValue field for the Control Function of the serial port you want to use, select None from
the drop-down menu.

NOTE: For a SNAP-PAC-S2, you can configure any of the serial ports as a either RS-232 or RS-485 by
changing the Value field for the Mode for Communication parameter.

For more detailed information on setting serial communications, see Opto 22 form 1704, the
PAC Manager User’s Guide.

IMPORTANT: Serial communication handles are used only for direct connection to serial devices. If you
are connecting to serial devices through serial communication modules on the I/O unit, use a TCP
communication handle instead. See page 266.

NOTE: Serial I/0 units are wired to an RS-485 port on the controller and do not require serial
communication handles. Communication is defined when the /O unit is configured.

NOTE: Be sure to use a single communication handle for each of a controller's physical serial ports used
with the subroutines. If two charts were to run simultaneously while sharing an open communication
handle, it is possible for one serial port to transmit data (on the wire) at the same time the remote device
is transmitting a response.

Serial Communication Handle Examples

To enter a serial communication handle, you can use either of the following two methods for SNAP
PAC controllers.

Method 1. With this method, the value for the serial communication handle is in the format;
ser:<port number>,<baud rate>,<parity>,<data bits>,<stop bits>

Setting Valid Values

SNAP-PAC-S1: 0, 1, or 2
port number SNAP-PAC-S2:0,1,2,0r3
SNAP-PAC-R1, R1-B, and R2: 0

230400, 115200, 76800, 57600, 38400,

baud rate 19200, 9600, 4800, 2400, 1200, or 300
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Setting Valid Values
parity n, o, or e (none, odd, or even)
data bits 8or7
stop bits 1or2

296

Here is an example of a serial communication handle value:
ser:0,115200,n,8,1 (port0, baud rate of 115,200, no parity, 8 data bits, and 1 stop bit)

To add a communication handle, see the steps starting on page 265. In the Add Variable dialog box,
enter the communication handle value in the Initial Value field.

Add Variable %]

Mame: | Serial_Device_Communication_Handle

3

Degcription: |

Tvpe: | Communication Handle |

Initialization
() Initialize on strateqy download
(#) Initislize on strategy wn
() Persistent

Communication
handle value

Initial Yalue: | ser0.115200.0.8.1 :

[ u] 4 H Caticel ][ Help ]

Method 2. Using keywords, this method offers more flexibility. For example, use this method if
you want to specify RTS / CTS on a serial port on a SNAP S-series or R-series controller. Keywords
may be used in any order. Each keyword must be lowercase and followed by an equal sign and a
value, with no spaces (even after commas), as shown in the following examples:

ser:port=0,baud=115200,data=8,parity=n,stop=1,rts-cts=0
ser:baud=115200,data=8,parity=n,rts-cts=1,stop=1,port=0, timeout=1.5

In the Add Variable dialog box, enter the communication handle value in the Initial Value field. (Due
to the long value, part of the value is hidden.)

Add Variable Ed

Mame: |Comm_HandIe_FTF'

(X

Diezcription: |

Tvpe: | Communication Handle |

Initialization

() Initialize on strateqy download

(3 Initialize on strategy wn

() Persistent
Communication
handle value

|mitial % alue: |ser:porl=ﬂ,baud=‘l 15200.data=8.parity=n s

Ok, H Cancel ][ Help ]
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NOTE: You must include at minimum the port number and at least one parameter. Otherwise, it will not

work.

The keywords and possible values are:

Keyword | Valid Values Comments
The ports available depends on the controller type. For a list of
port 0,1,2,3 available ports, see the documentation that came with your
controller.
230400, 115200, 76800,
baud 57600, 38400, 19200, 9600,
4800, 2400, 1200, or 300
parity E,e, O,0,N ,n, 9* * A value of 9 is used for RS-485 multi-drop communications.
data 8,7 The number of data bits
stop 1,2 The number of stop bits
mode 0, 522* * 522 enables 1/0 mode. 0 should be used for everything else.
0 turns rts/cts off.
rts-cts 012 1 enables symmetrical rts-cts flow control.
T 2 enables asymmetrical rts-cts flow control. By default the sys-
tem waits up to one second for cts to be asserted.
timeout float, seconds

If a parameter is not specified, the current value is used, so you should include any parameter whose
current value you are not sure of.

IMPORTANT: As described earlier in this section, be sure to use PAC Manager to set the control function
ofany port you want to use to None. Otherwise, you will get a-20, (Resource Busy), error. For more
information, see Opto 22 form 1704, the PAC Manager User’s Guide.

Using Serial Communication Handles in Your Strategy

To use a serial communication handle in your strategy, first use the command Open Outgoing
Communication. Verify that the communication handle opened by using the condition
Communication Open? Then use Transmit, Transfer, and Receive commands to send or receive data
as necessary. Remember to check for any errors. When you have finished sending and receiving
data, use the command Close Communication to close the communication handle.

Make sure your strategy receives data promptly. Incoming serial communication is buffered up to
127 characters. If more than 127 characters come in before the strategy receives them, the
additional characters are lost.

See Opto 22 form 1701, the PAC Control Command Reference, or online Help for details on using
specific commands.

Sending an Email

Use the email commands to have a strategy send an email automatically from your control engine
to recipients via SMTP.

»  Send Email sends a text-only email.
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Send Email with Attachments sends text and one or more attached files such as log files,
status reports, and images.

The following examples are just a few of the many possible uses for these commands:

Send out updates of a system's status.

Have a critical system send hourly status emails; if no email arrives after an hour, it means
something is wrong.

Send an email in case of an alarm condition.
Send a daily status report.

For more information on these commands, see Opto 22 form 1701, the PAC Control Command
Reference.

A sample chart to send email is available on our website, www.opto22.com. Go to Support >
Downloads and then search for Sample PAC Control Basic Chart to Send Email in Samples and
Freeware.

Before you begin:

Make sure to assign to the controller an IP address as well as the appropriate Subnet Mask, DNS,
and Gateway for the network. For more information, see Opto 22 form 1704, the PAC Manager
User's Guide.

The Send Email commands require you to use an existing email account. You may be able to
use a corporate email account, but check with your network administrator first. Your SMTP
server must support either AUTH LOGIN or AUTH PLAIN authentication (neither AUTH MD5 nor
AUTH CRAM-MD5 can be used with the Send Email commands). Or, you can use a free email
account such as Gmail™ or Yahoo!® Mail.

If you will be using a corporate email account, ask your network administrator for the following
information about the SMTP server:

- Outgoing SMTP server name or IP address
- Port

- Security type: Choices are ss/, tfs, or none

SSL (Secure Sockets Layer) and TLS (Transport Layer Security) are standard security
technologies for establishing an encrypted link between a web server and a browser.

If no root certificate is required for the connection, select “None”and the connection will
not be authenticated. If the target mail server doesn't require SSL or TLS, the login will
succeed. However, if it requires SSL or TLS, the login will fail. Most servers require
encryption, so unless you're using an in-house server, you'll probably need a root
certificate.

- Root certificate (if applicable): A root certificate, which is used to validate an SSL or TLS
secure connection, may be required for your SMTP server. If so, you must obtain the root
certificate and then install it on your SNAP PAC controller as described below.

Installing CA Root Certificates

NOTE: You do not need to install a root certificate:

— Tosend email using a SoftPAC controller. In this case, the necessary certificates are preinstalled
with Windows.
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—  When your controller has PAC firmware R9.5a (or higher) and the server you are communicating
with uses a certificate derived from an Equifax or Digicert certificate. In this case, the PAC
firmware includes built-in certificates for Equifax and Digicert.

An installed security certificate is required if you want to have secure network communications using
SSL/TLS Internet protocols. A security certificate is a digital tool used by Web browsers and other
network services to validate the identity of the server your computer is connecting to. For example,
before you access email or make a payment over an HTTPS Internet connection, the server and your
computer verify their identities by exchanging information about their security certificates. If
something is wrong with the certificates, your browser typically displays a warning that the
connection is not secure.

A CA certificate is a type of security certificate that is issued by a Certificate Authority, which is a
trusted entity (for example, Digicert® and GoDaddy®) that issues legitimate digital security
certificates. A root certificate is a kind of security certificate that ensures the certificate’s authenticity
by identifying the root CA (that is, the original source of the certificate’s verification). Root
certificates use a special kind of cryptography known as public key infrastructure.

PAC firmware R9.5a and higher include certificates for Equifax and Digicert (two of the most
commonly used CA root certificates for email service providers, including Google Gmail™ and
Yahoo! Mail®). This means that if you are using PAC firmware R9.5a (or higher) and PAC Manager
R9.5a (or higher), you don't have to install Gmail's or Yahoo! Mail's CA root certificates to send emails
to these two email service providers. However, to use a SNAP PAC device (as a client) to make a
connection to other secure devices via a TCP communication handle, or to use an HTTPS Get or
HTTPS Post communication handle, you can easily install a CA root certificate using PAC Manager.

Before you can install a CA root certificate, you must:

1. Have a CAroot certificate that uses Base64 ASCII format. (Your company’s IT department
should be able to provide this, as they will know the server it needs to match. For example, if
the certificate is for email, it must match the email server.)

- You can tell a certificate file is Base64 ASCll format if:
— Thefile has a .PEM extension; or
- You open the file in a text editor (such as Notepad) and you see the line:

SNAP PAC controller can accept only one certificate per file. You can tell whether there is only
one certificate in a file by opening the file in a text editor and verifying there is only one line
that says, “=———- BEGIN CERTIFICATE----—- ”

2. Know where to locate the certificate on your network (that is, its path and filename).

Install a CA root certificate

To use these instructions, you must have PAC firmware R9.5a (or higher) and PAC Manager R9.5a (or
higher). If you don't, see page 300.
1. If PAC Manager isn't already open, start it:

o

— InWindows 7 and Windows Vista, press the Windows Start key &2, and then click
Programs > Opto 22 > PAC Project 9.6 > PAC Manager.

)

- InWindows 10 and Windows 8.1, press the Windows Start key &, type PAC Manager
9.6 and then press the Enter key.

El

2. Inthe PAC Manager menu bar, click Maintenance )
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In the Command list, select Install CA Root Certificate.

4. Click the Browse button | and browse to the location of the certificate. Select the certificate,

and then click OK.

-
Command
Install Firmware CA Root Certificate Filename: P Addresses Add...
Install Module Firmware . > =
Install I/O Coprocessor Firmware |C.\.Equlfax_Secure_Cerhﬁcahe_Al J Lk i b Modify
e o Port: Timeout (msec) : 4 =

ownload File From ni
Upload File To IO Unit 2001 1000 Delete
Delete File On IO Unit .
Read Filenames On IO Unit I Restart Device * z
Save Files To Flash AiZee
Read Files From Flash
Clear Flash Files *Required for certificates to take effect Load...
Sync 1O Unit to PC Time
Execute

i I I I T S

Select the IP address of the SNAP PAC device that you want to install the certificate on.
(Optional) Change the Port number and the Timeout value.

Select Restart Device, and then click Execute to install the certificate, reboot the device, and
activate the certificate.

Foen il
Z 2001
g ¥ Restart Device =

*Required for certificates to take effect

Repeat steps 3 through 7 if you have additional certificates to install.

Install a CA root certificate (PAC Firmware R9.4c and lower / PAC Manager R9.4c and lower)

To place a root certificate in the /pki/root-certs folder on your controller:
1. If PAC Manager isn't already open, start it:

- InWindows 7 and Windows Vista, press the Windows Start key (k)
Programs > Opto 22 > PAC Project 9.6 > PAC Manager.

- InWindows 10 and Windows 8.1, press the Windows Start key &
9.6 and then press the Enter key.

2. Inthe PAC Manager menu bar, click Maintenance i}
In the Command list, select Upload File To 1/0 Unit.

4. Click the Browse button | and browse to the location of the certificate. Select the certificate,

and then click OK.

5. Inthe Destination field, type /pki/root-certs/ and the name you want the certificate to have on

the controller; for example:
/pki/root-certs/Equifax_Secure_Certificate_Authority.cer
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6. Select the IP address of the SNAP PAC device t

hat you want to install the certificate on.

-
5 1/0 Unit Maintenance

Command -

Install Firmware Filename:

IP Addresses Add...

Install Module Firmware
Install 1O Coprocessor Firmware
Install CA Root Certificate [

| C:\Equifax_Secure_Certificate_AL

_] 99.999.98.920
Modify...

Download File From I/0 Unit
oad File To I/ Unit J Jpkifroot-certs/Equifax_Secure_Ck

Delete File On IO Unit
Read Filenames On IO Unit
Save Files To Flash

Read Files From Flash

Clear Flash Files

Sync 1O Unit to PC Time

7. Click Execute.

. e el G ettt o

Delete

Save...

Load...

e

8. Repeat steps 2-6 if you have additional certificates to install.
9. Select the Save Files To Flash command, and then click Execute.
10. Restart the SNAP PAC device to activate the certificates.

Send Email with Attachments Example

The simple example strategy below demonstrates how to use OptoScript to create and send an

email using the Send Email with Attachments com

mand. You can of course use the PAC Control

versions of the Send Email commands. However, with OptoScript you can more easily see and edit
each of the email components—the Server information, Recipients, Message Body, and Attachment

File Names. For more information on these comma
Command Reference.

nds, see Opto 22 form 1701, the PAC Control

A sample chart to send email is available on our website, www.opto22.com. Go to Support >
Downloads and then search for Sample PAC Control Basic Chart to Send Email in Samples and

Freeware.
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The strategy is comprised of only one chart, the Powerup chart, which has two OptoScript blocks,
Init Tables and SMTP Send. The first OptoScript block, Init Tables, contains the email body. The
second one, SMTP Send, uses the Send Email with Attachments command to send the email
and attachments.

To send an email and attachments using the example:

1. Create a new strategy and then choose Configure > Control Engine to configure a control
engine. For more information, see “Associating the Control Engine with Your Strategy” on

page 10

3.

2. (Create a numeric variable and a string variable as follows. For more information, see “Adding
Variables”on page 239.

Name

Type

nResult

Integer32

3. Create astring variable as follows.

Name

Width

CRLF

256
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4. C(reate the following string tables. For more information, see “Adding Tables”on page 242.

Name Table Length String Width
arrstrAttach 10 256
arrstrBody 100 1024
arrstrRecipients 10 256
arrstrServer 10 256

5. Tothe Powerup chart, add an Action Block followed by two OptoScript Blocks and then one
more Action Block.

Position Name Type Function

First Init Tables Action Start

Second Init Tables OptoScript Contains the email body

Third SMTP Send OptoScript Sends the email and attachments
Fourth End Action End

6. Connect the blocks starting with the first Action Block.

Begin

;

SMTP Send

5
C
vl
C
5
3

Init Tables

Init Tables contains the email body

—— SMTP Send sends the email and attachments

End

7. Add code to the InitTables OptoScript Block.

This block creates the contents of the string tables which includes server information, a
recipient list, the body of the email, and a list of attached files.

The first line in the block defines CRLF as a carriage-return / linefeed combination,
chr(13)+chr(10), which starts a new line in the email body. Defining this value allows you to use
CRLF instead of having to spell out the chr(13)+chr(10) combination each time. For a double
carriage-return / linefeed combination, use CRLF+CRLF.

NOTE: If multiple emails with the similar subject and body text are sent through the same email
account, the emails may be flagged as SPAM by the email service provider and not be delivered. To
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avoid this, you may need to add code to the subject and body text that changes the text dynamically
with each new email.

CRLF = chr(13)+chr(10); // For convenience |
— arrstrServer[0] = "myaccount@speedmail.com”™; // User Account
arrstrServer[1] = "mypassword"; // Password
A — arrstrServer[2] = "smtp.speedmail.com™; // Server
arrstrServer[3] = "587"; // Port#
L arrstrServer[4] = "tls"; /7 Ussi, "tls™, "none"
— arrstrRecipients[0] = "xyz@mymail.com™; // Recipient list
arrstrRecipients[1l] = "abc@yourmail .com™;
B arrstrRecipients[2] = "'; //This blank ends the recipient list
arrstrRecipients[3] = "johndoe@hismail.com™; //This recipient will be ignored
— arrstrBody[0] = "Opto Email Example'; // Subject line
arrstrBody[1] = "Hello:"+CRLF; // Body starts here
arrstrBody[2] = CRLF; // Could have been combined above
arrstrBody[3] = "This is an example of an email that can be sent from a PAC ";
C — arrstrBody[4] = "controller. It includes three attachments: two JPG images, "';
arrstrBody[5] = "and this strategy."+CRLF+CRLF;
arrstrBody[9] = "Sincerely,"+CRLF;
arrstrBody[10] = "Opto Controller";
L arrstrBody[11] = "*; // This blank denotes end of body
arrstrBody[12] = "This is not included in the body.";
arrstrAttach[0] = "My_image_Tile.jpg"; // List of files to attach
D — arrstrAttach[1] = "Another_image file.jpg";
arrstrAttach[2] = "A_zip_file.zip"; ||
L arrstrAttach[3] = "*; // This blank ends the attachment list
arrstrAttach[4] = "Attachment.jpg"; // This attachment will be ignored
4 3

A—Server Information. The server table must have each of these five entries in the order
shown in the example. Make sure all server information table elements are filled in.

Here are the ways that you can specify the account and “from” names in element 0:

If you want this: Use this:
No user account and no “from” arrstrServer[0] = "";
User Account only, (“from” uses the arrstrServer[0] = "MyAccount';

account name)

Account only (no “from”) arrstrServer[0] = "MyAccount:";
“from" only (no user account) arrstrServer[0] = ":FromName";
Separate account and “from” names arrstrServer[0] = "MyAccount:FromName™;

If you want to change the timeouts for transmitting, receiving, and connecting, you need to
add a sixth element [5]. The default is 10,000 milliseconds (10 seconds) for each. For more
information, see “Setting Timeouts for the Send Email Commands”on page 306.

For a corporate email account, use the server, port, and security values for the SMTP server
you obtained previously from your network administrator.
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If no root certificate is required for the connection, use “none” for element 4 of the server
information table and the connection will not be authenticated. If the target mail server
doesn't require SSL or TLS, the login will succeed. However, if it requires SSL or TLS, the login
will fail. Most servers require encryption, so unless you're using an in-house server, you'll
probably need a root certificate.

PAC firmware R9.5a and higher includes root certificates for both Gmail and Yahoo! Mail. For
details, see “Installing CA Root Certificates”on page 298.

If you aren’t using PAC firmware R9.5a (or higher) and PAC Manager R9.5a (or higher), you can
use these values for Gmail and Yahoo! Mail:

—  For a Gmail account, use these values:

Server smtp.gmail.com
Port 587
Security |l

S

— For a Yahoo! Mail account, use these values:

Server smtp.mail.yahoo.com
Port 465

Security |ssl

B— Recipients. Enter the email address for each recipient. Make sure the recipients list
contains at least one valid entry.

C—Message Body. Element zero is always the subject line. Each line is entered as a separate
string. However, they will be concatenated in the body of the email. The email body starts with
element one, and continues to the first empty element or the end of the table, whichever
comes first. Note that a blank line is not the same as an empty element.

D—Attachment File Names. Files specified in the attachments table must exist on the
controller's file system, (RAM, flash, or SD card), and must include the full directory
specification. For example, if a file is in the root directory, just use the file name. However, if it is
in the temp directory of the SD card, you must put /sdcard0/temp/ in front of the file name.
Any kind of file may be attached, so long as there is room in the file system. However, be
cautious about file size, many Internet service providers still have a 10 MB attachment limit.

8. Add code to the SMTP Send OptoScript block.
This block invokes the Send Email with Attachments command to send the email with

attachments:
// Send email with attachments, using the tables set up previously
nResult = SendEmai lWithAttachments(
arrstrServer, // Table with server info
arrstrRecipients, // List of recipients
arrstrBody, // Body text
arrstrAttach ); // List of attachments
[ b

9. (lick Debug, and then click Run Strategy.

The email and attachments are sent to the recipient(s) in your list.
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Setting Timeouts for the Send Email Commands

The default Send Mail commands timeout for transmitting, receiving, and connecting is 10,000
milliseconds (10 seconds) when you have filled in elements 0-4 of the Server Information table (see
page 304). If you want to change one or more timeouts from the default, add an element 5 and
specify the value as follows:

Use this command

LOCOUNES where “nnnn” is the timeout in milliseconds

Set transmit timeout “to.tx:nnnn”

Set receive timeout “to.rx:nnnn”

Set connect timeout “to.cx:nnnn”

Each timeout command is independent of the others so you can use one, two, or all three of the
commands in any order. If you use more than one command, put a space between each one.

The following example sets the transmit timeout to 20 seconds and the receive timeout to
15 seconds. The connect timeout is not changed.

arrstrServer[5]="to0.tx:20000 to.rx:15000"

Table'name Element 5 Transmit timeout Receive timeout

Retrieving a Webpage

Use the HTTP Get command to retrieve non-secure (HTTP) or secure (HTTPS) content from a web
page. The example provided here uses the HTTP Get command in OptoScript to retrieve secure
content from www.google.com. For more information on this command, see Opto 22 form 1701,
the PAC Control Command Reference.

To retrieve HTTPS content from a website, you will first need to:

»  Obtain the root certificate used by the target website to validate an SSL secure connection.
(Your company’s IT department should be able to provide this, as they will know the server it
needs to match.)

« Install the root certificate on your SNAP PAC controller. For instructions, see “Installing CA Root
Certificates”on page 298.

NOTE: If you are using a SoftPAC controller, you don't need additional root certificates to use
HTTP Get— the necessary certificates are preinstalled with Windows.
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4" PAC Control Professional - [Powerup] E@
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)%
(3] Config =1 Debuo 117 0nin- [INNINEER= IR Y
GoogleHttps <[5 4" OptoScript - Powerup - Get Content (=250
T [ variables - e a | & | \ | 84 25 | 4 [ ab
B (5 Numeric Variables
% nhittpStatus 0 OptoScript Code:
Iz _
by Begin HoveToStrTableElements( ', 0, —1, HITP SrcStrTblBody): .
g nSendStatus MoveToStrTableElements("". 0, -1. DstStrTblHdr):
=[5y String Varisbles HoveToStrTableElement=s("". 0. -1, DstStrThlBody):
gla strCmd strlRL = "wyw.google.con"
B8 strURL J strimd = "o

[ Pointer Variables E Get Content nPortSSL = 443;
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|5 Numeric Tables
= [ String Tables
] DststrTbiBody i
2 DststrTbiHdr
B HTTP_SreStrThiBody

nSendStatus = HttpGet(

D=tStrThlBody. ## Return body data dest string table
DstStrThlHdr, ~# REeturn header data dest string tabls|
HTTP_SrcStrThblBody. -~ Source body data string table (may be
1, <+ 0 for non-securs. <>0 for SSL
strCnd. <7 TRI

nHttpStatus, #7 Status returned by HTTF serwver

TR | ] | [\Chaﬂ nPortSSL. ## Port to which y¥ou want to connect
strURL ): <o Address. (numeric or www.google.com. -
b @Next ﬁPrev —‘% Powerup r
Confi| Output:
Save ] [ Cancel ] l Help ] [ Command Help Ln 18, Col 1

For this example, you'll need to install the Equifax Secure Certificate Authority (DER encoded X.509)
root certificate, which is available on our website, www.opto22.com. (Go to Support > Downloads

and then search for Equifax Root Certificate in Samples and Freeware.) For instructions to install the
certificate, see page 298.

1. Make sure the controller is assigned an IP address as well as the appropriate Subnet Mask, DNS,
and Gateway for the network. For more information on how do this, see Opto 22 form 1704,
the PAC Manager User's Guide.

2. In PAC Control, create a new strategy.

3. Create the following numeric (Integer 32) variables set to “Initialize on strategy run.” For more
information, see “Adding Variables” on page 239.

Variable Name Type

nHttpStatus Integer32
nPortSSL Integer32
nSendStatus Integer32

4, C(reate the following string variables.

Variable Name | Type Width

strCmd String 100

strURL String 256
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5. Create the following string tables. For more information, see “Adding Tables”on page 242.

Table Name Type Length | Width
DstStrTbiBody String | 100 1024
DstStrTbIHdr String 100 1024
HTTP_SrcStrTbiBody | String | 10 256

6. Add an Action Block named Begin, and an OptoScript Block named Get Content to the

Powerup chart.

7. Connect the Begin block to the Get Content block.

Beqgin

1
Get Content

8. Add the following code to the OptoScript Block.

MoveToStrTableElements(**"', 0, -1, HTTP_SrcStrTblBody);

A MoveToStrTableElements(*"', 0, -1, DstStrTblHdr);

B ——+—strURL =
C ——strCmd = "/";
D — L nPortSSL = 443;

nSendStatus = HttpGet(

DstStrThlBody, //
DstStrTblHdr, //
E ——+———HTTP_SrcStrTblBody, //
F——1, //
strCmd, //
nHttpStatus, //
nPortSSL, //
strURL ); //

4 |

MoveToStrTableElements(**, 0, -1, DstStrTblBody);

"www.google.com™;

Return body data dest string table

Return header data dest string table

Source body data string table (may be empty)
0 for non-secure, <>0 for SSL

URL

Status returned by HTTP server

Port to which you want to connect

Address, (numeric or www.google.com, etc)

A—MoveToStrTableElements. These lines ensure that the tables are empty.

B— Web address. The text string used for argument 7. For example “www.google.com”.

C—Sub-page. A forward slash (/) indicates the root level.

D—Port number. 80 is the standard port if you want to retrieve HTTP content. 443 is the
standard port if you want to retrieve HTTPS content.

E—Timeouts. Use element [0] of the table for Argument 2 to change the timeouts for
transmitting, receiving, and connecting. For details, see “Setting Timeouts for the HTTP Get and
HTTP Post from String Table Commands” on page 309.
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F—Security mode. Use 0 to retrieve non-secure connection HTTP content. Use a number
other than zero (such as 1) to retrieve secure HTTPS content.

9. (lick Debug, and then click Run Strategy.
10. Double-click the DstStrTblBody table to see whether the webpage content was retrieved. If
content was retrieved, you will see html code.

%, "DstStrTblBody” (scanning) @
Mame: DstStrThlBody

| »

Index  Value
0 <'doctype html»<html itemscope="itemscope” itemtype="http://schema.org/WebPa...
1 02693,4004334,40046844,4004949, 4005865, 4005875,4006426,4006442,4006727,400705. ..
2 mers={};google.startTick=function(a,b) {google.timers[a]={t: {start:google.tim...
3 :position:absolute;top:-999px;visibility:hidden:z-index:998;right:0}.gbto #g...
4 :0}#gbg .gbm{right:0}.gbxms{background-color:#ccc;display:block;position:abs...
5 moz-box-shadow:0 2px 4px rgba(0,0,0,.2);-webkit-box-shadow:0 2px 4px rgba(0,...
6 ¢cdcdc;background-image:none; background-image:none;background-posicion:0 -1...
7 background:url (//ssl.gstatic.com/gb/images/b_8d5afc09.png) ;_background:url (/...
8 bmt:focus{background: #eee;cursor:pointer;outline:0 solid black;text-decorati...
8 c .gbps, .gbpc .gbps2Z{display:block;margin:0 20px}#gbmplp.gbps{margin:0 10px}...
10 :8px 20px 10px}.gbmpiaw{display:inline-block;padding-right:10px;margin-botto...
11 = 1px rgba(0,0,0,.1):box—shadow:inset 0 0 0 1px #fff,0 1px 1px rgba(0,0,0,.1...

[Lm

13 ge:-ms-linear-gradient (top, #£5E£5£5, #£1£1f1) ;background-image:-o-linear-gradi...
14 d-image:-ms-linear-gradient(top,$fff, #fbfbfb) ;background-image:-o-linear-gra...
m [

<

Setting Timeouts for the HTTP Get and HTTP Post from String Table
Commands

The default timeout for transmitting, receiving, and connecting is 10,000 milliseconds (10 seconds).
If you want to change one or more timeouts from the default, specify the value in element [0] of the
table for Argument 2, as follows:

Use this command

LOCHUNES where “nnnn” is the timeout in milliseconds

Set transmit timeout “to.tx:nnnn”

Set receive timeout “to.rx:nnnn”

Set connect timeout “to.cx:nnnn”

Fach timeout command is independent of the others so you can use one, two, or all three of the
commands in any order. If you use more than one command, put a space between each one.

The following example sets the transmit timeout to 20 seconds and the receive timeout to
15 seconds. The connect timeout is not changed.

HTTP_SrcStrTblBody[0]=""to.tx:20000 to.rx:15000"

Table’name Element 0 Transmit timeout Receive timeout
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Control Engine Commands

The following commands refer to the control engine:

Calculate Strategy CRC Get Firmware Version

Erase Files In Permanent Storage Load Files From Permanent Storage
Get Available File Space Retrieve Strategy CRC

Get Control Engine Address Save Files To Permanent Storage

Get Control Engine Type Start Alternate Host Task

Commands Relating to Permanent Storage

The term “Permanent Storage”in three of the commands listed above refers to the control engine’s
flash memory. Files that are saved to flash memory remain in the control engine even when power
to it is turned off. On a SoftPAC controller, files are saved to the PC's hard drive.

These commands do NOT affect firmware files, configuration data, or strategy files saved to flash;
they affect only files at the root of the control engine’s file system. For more information on the file
system, see “Using the Control Engine’s File System” on page 284. For the specifics on individual
commands, see online help or the PAC Control Command Reference.

CAUTION: Since these commands write to flash memory, use them sparingly within your strategy and
make sure they do not end up in a loop. You can literally wear out flash memory if you save to it or erase it
too many times.

Digital Point Commands

The following commands are used with digital points.

Basic Commands

Latches

Off? Clear All Latches
Oon? Clear Off-Latch
Turn Off Clear On-Latch
Turn On Get Off-Latch

Get On-Latch
Totalizers Get & Clear Off-Latch

Get Off-Time Totalizer
Get On-Time Totalizer
Get & Restart Off-Time Totalizer
Get & Restart On-Time Totalizer

Get & Clear On-Latch
Off-Latch Set?
On-Latch Set?

Pulses
Counters' Generate N Pulses
Clear Counter Get Off-Pulse Measurement
Get Counter Get Off-Pulse Measurement Complete Status
Get & Clear Counter Get & Restart Off-Pulse Measurement
Start Counter Get On-Pulse Measurement
Stop Counter Get On-Pulse Measurement Complete Status
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Get & Restart On-Pulse Measurement

Period and Frequency Start Continuous Square Wave
Get Frequency Start Off-Pulse
Get Period Start On-Pulse

Get Period Measurement Complete Status
Get & Restart Period

Set TPO Percent

Set TPO Period

" Some digital point commands are available only in PAC Control Professional. Some commands are available
only on some I/O units. For details, see specific information for each command in Opto 22 form 1700, the

PAC Control Command Reference, or in Online Help.

States, Latches, and Counters

The following diagram illustrates states, latches, and counters. While states and latches apply to
digital points on all I/O units, counters depend on the capability of the brain. See the brain’s data
sheet for specifications.

States, Latches, and Counters

State is ON Off latch is true (1) State is ON
ON: when value changes —
from ON to OFF.
On latch is true (1)
T when value changes l
from OFF to ON.
OFF: e
State is OFF State is OFF
State: OFF ON OFF ON
On Latch: OFF ON ON (nochange) ON (no change)
Off Latch: OFF OFF ON ON (nochange)
Counter: 0 1 1 (nochange) 2
Latches

Latches are an extremely high-speed digital function. Both on-latches and off-latches are available.
Latches are automatic and do not have to be configured.

When the value of a digital input point changes from off to on, an on-latch is automatically set.
While the value of the point may return to off, the on-latch remains set until cleared, as a record of
the change. Similarly, an off-latch is set when the value of a digital point changes from on to off, and
it remains set until cleared.

To read a latch and clear it at the same time, use the command Get & Clear On-Latch or Get & Clear
Off-Latch.
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Counters

Most standard digital inputs can be used as counters to count the number of times the input
changes from off to on. The availability of counters depends on the brain’s capabilities, and the
speed of counters depends on the module.

For information on brain capabilities, see form 1689, the SNAP PAC Brains Data Sheet.

For more information on module counting speed, see the module’s specifications on the Opto 22
website, www.Opto22.com. On the website, select Products > SNAP PAC System > Brains and I/0 >
Digital I/0.

NOTE: You can use counters on high-density modules with SNAP-PAC-RT and SNAP-PAC-R1-B controllers,
and SNAP-PAC-EBT and SNAP-PAC-SBT brains with firmware 8.1 or newer.

Before using a counter, you must configure the point as a counter. (See “Adding a Digital I/0 Point”
on page 132 or use PAC Manager.) Counters on Ethernet and SNAP PAC I/0 units do not need to be
started, and they cannot be stopped. Therefore, do not use the Start Counter and Stop Counter
commands with SNAP PAC I/O units. However, you can use Get Counter and Get & Clear Counter.

Quadrature Counters

Quadrature counters require a special module and configuration, but once they are configured, you
use the same commands (such as Start Counter and Clear Counter) for them as for regular counters.

NOTE: You can use counters on high-density modules with SNAP-PAC-R1 and SNAP-PAC-R1-B controllers,
and SNAP-PAC-EBT and SNAP-PAC-SBT brains with firmware 8.1 or newer.

Before using a counter, you must configure the point as a counter. (See “Adding a Digital I/0 Point”
on page 132 or use PAC Manager.) Counters do not need to be started, and they cannot be stopped.
Therefore, do not use the Start Counter and Stop Counter commands. However, you can use Get
Counter and Get & Clear Counter. A positive value means that phase A leads phase B. See additional
details in the PAC Control Command Reference or online Help.

Totalizers

Digital totalizers track the total time a specific input point has been on or off. For example, you could
track how long a pump, fan, or motor has been on. Digital totalizers are useful for periodic
maintenance. Before using a totalizer, you must configure the point with this feature. (See “Adding
I/0 Points”on page 132 for help.) The availability of totalizers depends on the brain; see the brain’s
data sheet for more information.

To check total time and leave the totalizer running, use Get Off-Time Totalizer or Get On-Time
Totalizer. To check total time and reset the totalizer to zero, use Get & Restart Off-Time Totalizer or
Get & Restart On-Time Totalizer.

Pulses

Pulsing commands send on- and off-pulses to an output point. The availability of pulsing depends
on the brain; see the brain’s data sheet for specifications.
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Generate N Pulses. The command Generate N Pulses is frequently used to flash a light or sound
an alarm. For example, you could sound a two-second alarm four times. In the arguments, you set
the number of times the on-pulse is sent, the length of the on-pulse, and the length of the off-pulse.
Generate N Pulses always starts with an off-pulse. If you resend this command, make sure to leave
sufficient time in between so it does not interfere with itself.

Start On Pulse and Start Off Pulse. The commands Start On Pulse and Start Off Pulse send a
single pulse cycle:

«  Start On Pulse starts with an on-pulse of a length you determine, and ends with an off-pulse.
«  Start Off Pulse starts with an off-pulse of a length you determine, and ends with an on-pulse.

Both of these commands can be used as time delays. For example, if a light is on and you want to
turn it off after 30 seconds, you can send a Start On Pulse command, setting the on-pulse to be 30
seconds long. At the end of that time, the off-pulse is sent to turn off the light.

You can also use this type of command in a loop to turn a digital point on or off for short intervals.
For example, you could create a loop that checks the level of liquid in a tank and pulses on a drain if
the level is too high. The advantages of using a pulse command are that the point does not have to
be turned off, and if communication is lost to the point, the point does not remain on.

Pulse Measurement commands measure pulses on digital input points. For details, see the
specific command in the PAC Control Command Reference or online Help.

IVAL and XVAL

All'1/O points have two associated values: XVAL and IVAL. If you are using PAC Control in Debug
mode to manipulate /0 values or to disable an I/O point or I/O unit, you need to understand these
values.

XVAL. The external value, or XVAL, is the “real”or hardware value as seen by the I/0 unit. This value
is external to the control engine and strategy logic.

IVAL. The internal value, or IVAL, is a logical or software copy of the XVAL that is in the control
engine. The IVAL may or may not be current, since it is updated to match the XVAL when strategy
logic accesses the I/0 point.

If the IVAL does not match the XVAL, a mismatch just means that your strategy logic is not reading
from or writing to the I/O point in question at the moment.

Simulation and Test: The “Real” Use for XVAL and IVAL

To test output performance, you may want to force an XVAL for a specific output to a particular
value. If the program is actively writing to the output, you need to disable the output to do so. If the
program is stopped, there is no need to disable it.

To test program logic, you may want to force an IVAL for a specific input to a particular value. To do
50, you must disable the input first.

You can disable an I/0 point or unit in two ways. The more common way is from within Debug
mode, by double-clicking a point on the Strategy Tree and modifying the point’s settings and values
through the Inspection dialog box. The second way is from within the strategy, using commands
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such as Disable Communication to Digital Point, Disable Communication to Analog Point, or Disable
Communication to I/0 Unit. (See “Simulation Commands”on page 331)

Additional Commands to Use with Standard Digital Points

Although not listed under Digital Point commands, several other commands can be used for digital
operations:

«  Use Move to cause an output to assume the state of another input or output. A digital input or
output that is on returns a True (non-zero). A True (non-zero) sent to a digital output turns it on.

«  Use NOT to cause an output on one I/0O unit to assume the opposite state of an input on
another I/0 unit.

«  Use Get I/0 Unit as Binary Value to get the state of all points at once. Then use Bit Test to
determine the state of individual points. This method is much faster than reading each point
individually.

«  Use Set 1/0 Unit From MOMO Masks to control all outputs at once.

Standard Digital Points and OptoScript Code

In OptoScript code, a standard digital I/0 point can be used directly, wherever a numeric variable
can be used. For example, you can turn a point off by assigning it a value of zero, or turn it on by
assigning it a non-zero value. You can also use standard digital points directly in mathematical
expressions and control structures. For more information, see “Using I/0 in OptoScript”on page 352.

Reading or Writing Digital Points

The Move command is the main command used to read or write digital points.

Error Handling Commands

The following commands refer to handling errors:

Add Message to Queue Get Error Code of Current Error

Add User Error to Queue Get Error Count

Add User /O Unit Error to Queue Get ID of Block Causing Current Error
Caused a Chart Error? Get Line Causing Current Error

Caused an I/0 Unit Error? Get Name of Chart Causing Current Error
Clear All Errors Get Name of I/O Unit Causing Current Error
Copy Current Error to String Get Severity of Current Error

Disable 1/O Unit Causing Current Error Remove Current Error and Point to Next Error
Enable I/O Unit Causing Current Error Stop Chart on Error

Error on 1/0O Unit? Suspend Chart on Error

Error?
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All good programmers must deal with errors. These error handling commands are used to monitor
errors, figure out which I/0 unit caused an error, disable or re-enable communication to the I/O unit,
and clear errors and other messages from the message queue. For a simple example of an error
handler chart, see page 89. For more on the message queue, see “Queue Messages”on page 398.

You can use the command Add User Error to Queue to add your own information, warning, or error
message to the queue. This command can be helpful in troubleshooting.

0 Enabler Sample Strategies

Sample “I0 Enabler”strategies are available on the Opto 22 website. The logic in these sample
strategies is designed to automatically recover communications to any I/0 unit that temporarily
goes offline (that is, has communications disabled) for any reason. Choose a sample that is
compatible with your system configuration. Each sample has the same basic code:

www.opto22.com/site/downloads/dl_drilldown.aspx?aid=3605

www.opto22.com/site/downloads/dl_drilldown.aspx?aid=3603

www.opto22.com/site/downloads/dl_drilldown.aspx?aid=3604

I/0 Unit Commands

The following commands are used to communicate with an I/0 unit, which controls a group of I/0
points:

Clear 1/0O Unit Configured Flag Move 1/O Unit to Numeric Table Ex

Get I/O Unit as Binary Value Move Numeric Table to I/O Unit

Get I/O Unit as Binary Value 64 Move Numeric Table to I/O Unit Ex

Get Target Address State' Set All Target Address States’

1/0 Unit Ready? Set I/0O Unit Configured Flag

IVAL Move Numeric Table to 1/0 Unit Set 1/0 Unit from MOMO Masks

IVAL Move Numeric Table to I/O Unit Ex Set Target Address State'

Move 1/O Unit to Numeric Table Write /O Unit Configuration to EEPROM

TPAC Control Professional only

CAUTION: Write I/0 Unit Configuration to EEPROM is not the recommended method for saving
configuration to flash memory. If it is used too often or is in a loop within a strategy, flash memory can
literally wear out. Instead of using this command in the strategy, it is better to store configurations to flash
manually using either PAC Manager (see Opto 22 form 1704, the PAC Manager User’s Guide, for
instructions) or PAC Control in Debug mode (see “Inspecting I/0 Units and Saving Settings to Flash”on
page 153).

Commands for Ethernet Link Redundancy

The three target address commands (Get Target Address State, Set Target Address State, and Set All
Target Address States) are used to manually change the path of communication between the
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controller and the I/0 unit(s), based on the IP address used for the I/0 unit. These commands let you
switch communication from a primary to a secondary IP address (or vice versa) or enable or disable
communication to the primary or secondary address.

Ethernet link redundancy to I/0 units is available only in PAC Control Professional. The secondary IP
address for an I/0 unit may be for the second Ethernet network interface on a SNAP PAC R-series
controller, or it may be for a separate I/O unit. If it is a separate unit, the primary and secondary I/0
units must be the same type (for example, SNAP-PAC-EB1) and have exactly the same points,
because they are configured together under one name.

One or both target addresses (primary and secondary) can be enabled, but only one address (the
active address) will be used by the controller at one time. For link redundancy, both the primary and
secondary addresses must be enabled. When an 1/0 unit is configured with two IP addresses, the
default is for both to be enabled and the primary address to be active.

One address is always active. If communication fails through the primary address, the control engine
automatically switches to the secondary address. It continues to use the secondary address until
communication fails through the secondary address or until you change the active address using
Set Target Address State (for one I/0 unit) or Set All Target Address States (for all I/O units on the
control engine).

You may also want to use these commands to disable one address, for example if you are doing
maintenance or repair on a network segment and need to switch communication to another
segment temporarily. Disabling one address, of course, means that you no longer have link
redundancy.

If both addresses are disabled or unavailable, then communication is not possible and
communication to the I/O unit becomes disabled. If both addresses are disabled, and you want to
bring the I/0 unit back online, you must first enable one or both of the addresses and then enable
communication to the I/0 unit.

You can find out which addresses are enabled for an I/0 unit and which address is currently active
by using Get Target Address State. If an address is enabled but is not functional when a strategy is
started or when communication for an 1/0 unit is changed from Disabled to Enabled, an error is
posted in the controller's error queue.

To use these commands, you must have already designated primary and secondary IP addresses
when configuring I/0 units. For steps, see “Adding an /0 Unit"on page 126. For additional
information about link redundancy, see “Using Ethernet Link Redundancy in PAC Control”on
page 104.

Table Commands

The table commands for I/0 units affect the states or values of all points on the I/O unit at once. For
example, you can use the command Move /O Unit to Numeric Table to read the states of all digital
points and the values of all analog points on one I/O unit and place them into a table for easy
retrieval. Table commands move data very quickly for faster throughput.

Three of the table commands—IVAL Move Numeric Table to I/0 Unit Ex, Move I/O Unit to Numeric
Table Ex, and Move Numeric Table to I/O Unit Ex—provide support for high-density points. A Points
per Module parameter lets you specify the number of points required. For example, if you are using
32-channel modules, you would pass a 32. But if you are only using 8-channel modules, you could

pass an 8 instead. This allows table sizes to be as small as possible.
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Other commands relating to tables can be found in the following topics:

“Miscellaneous Commands”on page 326
“Logical Commands”on page 321
“Mathematical Commands”on page 322
“Pointer Commands”on page 330
“String Commands”on page 332.

I/0 Unit—Event Message Commands
The following commands refer to event messages sent from SNAP PAC I/0 units.

Get I/0O Unit Event Message State
Get I/O Unit Event Message Text
Set I/O Unit Event Message State
Set 1/0O Unit Event Message Text

A SNAP PAC1/0 system can send a message as a response to an event that occurs within strategy
logic. For exampile, if pressure in a pipe reaches a certain level, the system can send a warning email
message to a technician. Or data about a process can be streamed to a computer every 30 seconds
for monitoring.

CAUTION: Events and reactions (including event messages that are processed separately from your
strategy) can conflict with strategy logic. If you are using PAC Control, use strategy logic instead of local
events and reactions on the I/O unit, or be very careful that local events and reactions do not conflict.

Use PAC Manager to configure event messages, following the steps in Opto 22 form 1704, the
PAC Manager User's Guide. You can configure the following types of event messages:

«  Email or paging messages sent to a person

«  Simple Network Management Protocol (SNMP) traps sent to an enterprise management
system

«  Serial messages sent through a serial communication module to a serial device
+  Streamed data sent to a device for processing by a software application.

I/0 Unit—Event Message commands are commonly used to find out the state or text of an event
message, or to set its state. Event messages can be in the following states:

+  Active—The message has been triggered by the event. If it was configured to be sent just
once, it has been sent. If it was configured to be sent at intervals, it is continuing to be sent.

+ Inactive—The message is not currently triggered by the event.

+  Acknowledged—The message has been triggered by the event but has been acknowledged
by the receiver so it will not be sent again. (Acknowledgments occur only if the receiving
application writes them to the brain’s memory map.) Acknowledged is functionally equivalent
to Inactive, but can be useful in some cases to determine whether the receiver has received the
message.

The command Set I/0 Unit Event Message Text is used to dynamically change a message or to
“recycle”a message if you run out of event messages on an I/0 unit (128 event messages are
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available for each I/0 unit). For more information, see individual commands in the PAC Control
Command Reference or online help.

I/0 Unit—Memory Map Commands

318

The following commands refer to the memory map in an Opto 22 memory-mapped device, either a
controller or an I/0 unit. In the case of a controller/brain, they can refer to the device's own memory
map or a memory map on another device.

Read Number from I/O Unit Memory Map

Read Numeric Table from 1/O Unit Memory Map
Read String from 1/0 Unit Memory Map

Read String Table from I/O Unit Memory Map
Write Number to 1/0 Unit Memory Map

Write Numeric Table to I/O Unit Memory Map
Write String Table to 1/0O Unit Memory Map
Write String to 1/0 Unit Memory Map

Memory map commands make it possible for advanced users to read from or write to any Opto 22
memory-mapped device, such as a SNAP PAC controller or brain. You can use these commands to
read or write to any address within the memory map. The commands are especially useful for
reading data from a SNAP device using newer features that may be available in the memory map
but are not yet incorporated into PAC Control.

NOTE: If you are reading or writing to the device’s Scratch Pad area, use the I/0 Unit—Scratch Pad
commands instead (see page 319). If you are changing event messages, use the l/O Unit—FEvent Message
commands instead (page 317).

In order to use these commands with a SNAP PAC S-series or SoftPAC controller, first you need to
create an I/0 Unit of the type Generic OptoMMP Device to represent the controller. Use the
controller's IP address or the loopback address, 127.0.0.1.

When you use these commands, make sure that you read or write the correct type of data (integer,
float, string) to match the specified memory map address. The control engine doesn’t know what
type of data is in any particular address, so it cannot convert the data type.

Since these are 1/0 unit commands, remember to check all return values and errors to make sure the
command was successful. If a command variable contains a value that is obviously wrong—for
example, a memory map address in an incorrect format—communication to the I/0 unit will be
automatically disabled.

See Opto 22 form 1465, the OptoMMP Protocol Guide, to determine the memory map addresses
and data types you need to use.
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I/0 Unit—Scratch Pad Commands

The following commands are used for peer-to-peer communication for sharing strategy data with
other Opto 22 memory-mapped controllers on the network. These commands are used by PAC
Control to read or write to the Scratch Pad area in the memory map of a SNAP PAC controller.

Since each read (get) or write (set) command is completed before another occurs, commands
cannot interfere with each other. For example, a get command won't read a partial string while a set
command is writing the string.

Get I/O Unit Scratch Pad Bits Set I/O Unit Scratch Pad Bits from MOMO Mask
Get I/O Unit Scratch Pad Float Element Set 1/0 Unit Scratch Pad Float Element

Get I/O Unit Scratch Pad Float Table Set I/O Unit Scratch Pad Float Table

Get I/0O Unit Scratch Pad Integer 32 Element Set 1/0O Unit Scratch Pad Integer 32 Element
Get I/O Unit Scratch Pad Integer 32 Table Set I/O Unit Scratch Pad Integer 32 Table

Get I/0O Unit Scratch Pad String Element Set I/O Unit Scratch Pad String Element

Get I/0O Unit Scratch Pad String Table Set I/0 Unit Scratch Pad String Table

Because these are I/0 unit commands, in order to use these commands with a SNAP PAC S-series or
SoftPAC controller, first you need to create an I/0O Unit of the type Generic OptoMMP Device to
represent the controller. Use the controller’s IP address or the loopback address, 127.0.0.1.

Also because these are I/0 unit commands, remember to check all return values and errors to make
sure the command was successful. If a command variable contains a value that is obviously
wrong—for example, a memory map address in an incorrect format—communication to the I/0
unit will be automatically disabled.

Each controller running a PAC Control strategy can place data in its own or another’s Scratch Pad
area, and each can retrieve data that has been placed in the Scratch Pad area by other devices using
other applications. Using these commands eliminates the need to open communication handles
(see "Communication Commands”on page 264), thus speeding up peer-to-peer communication.

The memory map Scratch Pad area supports four data types: bits, integer 325, floats, and strings.
«  For details on the Scratch Pad area, see Opto 22 form 1704, the PAC Manager User's Guide.
+  For the complete memory map, see Opto 22 form 1465, the OptoMMP Protocol Guide.

«  Fordetails on using the Scratch Pad for peer-to-peer communication with a controller, see the
controller's user's guide.

The following page shows a simple example of how Scratch Pad area data exchange would work
between two SNAP R-series I/O systems.

Create two tables for PAC_R_A, one for its own data that will be shared (A_Shared_Data) and
another for data it will read from PAC_R_B (B_Data). Also create two tables for PAC_R_B, one for its
own data (B_Shared_Data) and one for PAC_R_A's data (A_Data).
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Suppose PAC_R_A and PAC_R_B are sharing 600 integer elements
of the 10,240 integer elements available in the Scratch Pad

PAC_R_A writes data from its PAC Control Tables: Memory Map Scratch Pad:
own PAC Control strategy A Shared D it | " <
| its own Scratch P _Shared_Data nteger elements
;igae\;?h itcShOS PAS " tE caid (indexes 0-599) >-o% 5
4 —— -B Data o
then read. 1/ &£
Meanvvhﬂg, PAC_R_B writes PAC Control Tables: ’ Memory Map Scratch Pad:
data from its B_Shared_Data m
table to its Scratch Pad area, B_Shared_Data Integer elements ®
which PAC_R_A reads. (indexes 0-599) 0-599 o
)
=

NOTE: When the SNAP R-series /0 unit is writing
to its own Scratch Pad, use the loopback IP
address. 127.0.0.1

This portion of the flowchart in PAC_R_A (without error checking) might look like this:

As you can see, PAC_R_A uses the Set I/0 Unit
~ Scratch_Pad_Peer* Scratch Pad command to write the data from
.................... its own table to its own memory map.
S . PAC_R_A also reads data from PAC_R_B's
Write Datato | memory map and places it in table B_Data.

— | ScratchPad | I

Set 10 Unit Serateh Pad Integer 32 Table
170 Unit PAC_R_A
Length 600

To Index L]
From Index 0
From Table A_Shared_Data

Put Status in Scratch_Pad_status

Get 0 Unit Scratch Pad Integer 32 Table Add..
1/0 Unit PAC_R_B
Length GO0

A similar flowchart would be in A 0
PAC_R_B's strategy, to handle To Indes 0 ek
writing to its own Scratch Pad ity g

K Put Status in B_Data_status _Next Block
area and reading from PAC_R_A. FETEE

[ Cloze ] [ Help ] Command Help
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Logical Commands

The following commands perform logical functions.

Commands ending a question mark (for example, AND? and OR?) indicate an instruction for a

condition block.

AND

AND?

Bit AND

Bit AND?

Bit Change

Bit Clear

Bit Copy

Bit NOT

Bit NOT?

Bit Off in Numeric Table Element?
Bit Off?

Bit On in Numeric Table Element?
Bit On?

Bit OR

Bit OR?

Bit Rotate

Bit Set

Bit Shift

Bit Test

Bit XOR

Bit XOR?

Equal to Numeric Table Element?
Equal?

Flip Flop JK

Float to Int32 Bits

Get High Bits of Integer 64

Get Low Bits of Integer 64
Greater Than Numeric Table Element?
Greater Than or Equal to Numeric Table Element?
Greater Than or Equal?

Greater?

Int32 to Float Bits

Less Than Numeric Table Element?
Less Than or Equal to Numeric Table Element?
Less Than or Equal?

Less?

Make Integer 64

Move 32 bits

NOT

Not Equal to Numeric Table Element?
Not Equal?

NOT?

Numeric Table Element Bit Clear
Numeric Table Element Bit Set
Numeric Table Element Bit Test

OR

OR?

Set Variable False

Set Variable True

Test Equal

Test Greater

Test Greater or Equal

Test Less

Test Less or Equal

Test Not Equal

Test Within Limits

Variable False?

Variable True?

Within Limits?

XOR

XOR?

Understanding Logical Commands

For condition blocks, the Instructions dialog box provides options to designate AND or OR for
multiple commands. If you have more than one command in the same condition block and you
choose the AND option, all of the commands must evaluate true for the block to exit true. If you
have more than one command in a condition block and choose the OR option, the block exits true if

any of its commands evaluates true.
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Logical actions and conditions work with integers, individual bits within an integer, a single digital
I/0 point, or a digital I/0 unit. These values are treated as Boolean; that is, they are either True or

False.

For complex logical operations, you may find OptoScript code easier to use than standard PAC

Control commands. See “Using Logical Operators”on page 361 for more information.

Logical True and Logical False

PAC Control always returns a value of +1 to indicate True in an integer variable.

A digital input or output that is on also returns a True (+1). Any non-zero value sent to a digital

output turns it on. False is defined as zero (0).

For individual bits within an integer variable, bits that are set (1) indicate on. Bits that are cleared (0)

indicate off.

While floats can be used in logic, integers are strongly recommended whenever any bits are
referenced. Since PAC Control does not permit bits in a float value to be altered, float values must be
converted to integers before bits can be evaluated. See “Mathematical Commands” on page 322 for

further information on integers and floats.

Mathematical Commands

The following commands perform mathematical functions:

Absolute Value

Add

Clamp Float Table Element
Clamp Float Variable
Clamp Integer 32 Table Element
Clamp Integer 32 Variable
Complement

Decrement Variable

Divide

Generate Random Number
Increment Variable
Maximum

Minimum

Modulo

Multiply

Natural Log

Raise e to Power

Using Integers

Raise to Power

Round

Seed Random Number
Square Root

Subtract

Truncate

Trigonometry
Arcsine

Arccosine
Arctangent

Cosine

Hyperbolic Cosine
Hyperbolic Sine
Hyperbolic Tangent
Sine

Tangent

In PAC Control, an integer 32 is a 32-bit signed number ranging from -2,147,483,648 to
2,147,483,647 (2 billion). An integer 64 ranges from -9,223,372,036,854,775,308 to

9,223,372,036,854,775,807.
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An integer can only be a whole number (-1, 0, 1, 2, 3, etc)). In other words, integers do not include a
decimal point. The result of an integer operation is always an integer, even if it is placed in a float
variable. For example, if 9 is divided by 10, the result is zero (0.9 truncated to an integer). To receive a
float result, at least one of the operators would have to be a float. Use the Truncate command to
round down to the nearest whole number.

Controlling Rounding

Use the Round command to round up or down to the nearest whole number. Note that 1.50 rounds
up t0 2.0, and 1.49 rounds down to 10.

Using Floats

While computers, CPUs, and electronic devices (such as Opto 22 controllers) store numbers in binary
format, most often they represent real numbers as floating point numbers, or floats. For example, in
industrial automation applications, all analog values read from an 1/0 unit are floats. Floats represent
real numbers in scientific notation: as a base number and an exponent.

The IEEE Standard for Binary Floating-Point Arithmetic (IEEE 754) is the most widely used standard
for floating-point computation. It defines how to store real numbers in binary format and how to
convert between binary and float notations.

Opto 22's SNAP PAC System uses IEEE single-precision floats, which have 32 binary digits (bits). The
IEEE 754 32-bit float format is as follows:

1 bit 8 bits 23 bits
X XXXXXXXX XOXKKXXXXHKXOKKXXXXKXXXXX
Sign Exponent Significand

Float calculation: (-1)>9"x [1 + Significand/2%3] x 2 (Bxponent-127)

While this is an excellent standard for the purpose, it has limitations that could cause issues if you're
not aware of them. Squeezing infinitely many real numbers into a finite number of bits requires an
approximate representation. Most floats cannot be exactly represented using this fixed number of
bits in a 32-bit IEEE float. Because of this, rounding error is inherent in floating-point computation.

In PAC Control (and in PAC Manager and the OptoMMP protocol), a float is a 32-bit IEEE
single-precision number ranging from +3.402824 x 1078 to +3.402824 x 10+38 These
single-precision floats give rounding errors of less than one part per million (1 PPM). You can
determine the limit of the rounding error for a particular float value by dividing the value by
1,000,000.

This format guarantees about six and a half significant digits. Therefore, mathematical actions
involving floats with seven or more significant digits may incur errors after the sixth significant digit.
For example, if the inte%er 555444333 is converted to a float, the conversion yields 5.554444e ™8
(note the error in the 71" digit). Also, converting 5.554444e™8 back to an integer yields 555444352
(note the error starting in the 7t digit).

Float Issues and Examples

Accumulation of Relatively Small Floating-point Values. When adding float values, the
relative size of the two values is important. For example, if you add 1.0 to a float variable repeatedly,
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the value of the float variable will correctly increase in increments of 1.0 until it reaches 1.677722e™/
(16,777,220).

Then the value will no longer change, because 1.0 is too small relative to 1.677722e™ to make a
difference in the significant digits. The same thing will occur if you add 0.0001 to 2,048.0, or add
1,000.0 to 1.717987e™'0 The key is the relative size of the numbers.

Here's another way to think of it. Suppose your bank could keep track only of seven digits. If you
were fortunate enough to have one million dollars ($1,000,000) in your account and tried to add 10
cents (50.10) to it, you would not be able to, because the 10 cents is not big enough relative to the
total to be significant. Since the bank has only seven digits to keep track of your money (in this
example), one digit has to fall off the end: either the 10 cents falls off the right side or the million
digit falls off the left side. Which would you rather see in your bank account?

Seven digits available: 112(3|4|5|6|7
Amount in account: 11]0({0|0|0|O0]O
Add 10 cents (0.10)? (digit falls off on right) 1710(0(0|0]|0]|O
Add 10 cents (0.10)? (digit falls off on left) 0|0|0|0O|0]0.]1 Oops!

Note that moving the point indicator doesn't help, because the exponent is separate. If the seven
digits for the account represent millions of dollars (1.000000) rather than dollars (1,000,000), the 10
cents would be 0.0000001—still too small to be represented by the seven digits:

Seven digits available: 112(3|4|5|6|7
Amount in account 1./0]0|0|0|0O|O
Add 10 cents (0.0000001)? (digit falls off onright) 1./ 0|0 [0 | 0| 0|0
Add 10 cents (0.0000001)? (digit falls off on left) 0[{0|0]|0|0|O0]|1]| Oopsagain!

The key is that it is not the size of the numbers that matter, but rather their relative size.

So if you are accumulating relatively small values in a float variable over a long period of time, at
some point, the float value will stop increasing even though you continue to try to add to it.

Comparing Floating-point Values for Equality. Due to rounding errors and the way
floating-point calculations are performed, comparing two floats for equality can yield inaccurate
results. The precision of comparisons depends on the relative size of the float values as compared to
the difference between them.

For example, if 2,097,151.0 is compared for equality with 2,097,152.0, the result will indicate that the
two floats are equal, even though it's obvious they are not. The reason is that the difference between
the two values is 1.0, and 1.0 compared to one of the compared values (2,097,151.0) is too small; it is
less than one part per million.

In this case, 2,097,152.0 divided by 1,000,000 is 2.1. If the difference between the two values is at
least 2.1, then the equality comparison is guaranteed to be correct. So if 2,097,152.0 and 2,097,149.0
were compared for equality, the result will indicate they are not equal, because the difference (3.0) is
greater than one part per million (2.1). Any time the difference is at least one part per million, the
result is guaranteed to be accurate. If the difference is less than 1 PPM, it may or may not be
accurate.

One method that programmers use to work around this issue is to subtract one float from the other
and then compare the absolute value of the result to a limit.

For example:
Float Diff = Floatl - Float2;
1T (AbsolutevValue(Float Diff) < 1.0 ) then
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SetVariableTrue(EqualityFlag);
Else

SetVariableFalse(EqualityFlag);
Endif

Helpful Links for More Information

From Wikipedia, the free encyclopedia: http://en.wikipedia.org/wiki/IEEE_754
Real numbers: http://en.wikipedia.org/wiki/Real _number

Good example: http://en.wikipedia.org/wiki/Single_Precision

Rounding error: http://docs.sun.com/source/806-3568/ncg_goldberg.html

Comparing floating point numbers:
http://www.cygnus-software.com/papers/comparingfloats/comparingfloats.htm

Mixing and Converting Integers and Floats
An analog value read from an I/0 unit and put into an integer is converted from float to integer
automatically.

To maintain the integrity and accuracy of a numeric type (float or integer), keep all item types the
same. For example, use the Move command to copy an integer value to a variable float when you
want float calculations.
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Miscellaneous Commands

The following commands are used with tables and for other purposes. Many of them are commonly
used.

Comment (Block) Get Value From Name

Comment (Single Line) Move

Flag Lock Move from Numeric Table Element

Flag Unlock Move Numeric Table Element to Numeric Table
Float Valid? Move Numeric Table to Numeric Table
Generate Reverse CRC-16 on Table (32 bit) Move to Numeric Table Element

Get Length of Table Move to Numeric Table Elements

Get Type From Name Shift Numeric Table Elements

Comment Commands

The comment commands listed above are used with standard PAC Control commands in action
blocks and condition blocks. For information on using comments in OptoScript blocks, see step 10
in “Using the OptoScript Editor” on page 366.

Comment (Single Line) and Comment (Block) commands are used in two entirely different ways:

«  Comment (Single Line) enters a comment to help explain a block or an instruction within a
block. Usually block names and comments within instructions are sufficient, but you can use
Comment (Single Line) if you need more room for explanations.

«  Comment (Block) comments out instructions. In other words, it tells the strategy to
temporarily ignore certain instructions within a block. It can be useful in debugging or for
saving work when a strategy is temporarily changed.

To use it, place one Comment (Block) command at the beginning of the area you want to
ignore, and place another Comment (Block) command at the end of the area. If you do not place
the second Comment (Block) command, all the remaining instructions in that block are
ignored. Areas that are commented out appear in the Instructions dialog box as gray.

PID—Ethernet Commands
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The following commands are used with PID loops on SNAP PAC I/0O units. Since PID loops are
configured and tuned in Configure Mode while creating your PAC Control strategy, you may not
need to use these commands. PID commands are typically used to change input or output location
(for example, if the input is on another I/0 unit) or to change tuning parameters based on a change
that occurs while the strategy is running (such as a recipe change).

For steps to configure and tune PIDs, see “Configuring PID Loops” on page 146. For more
information about PID loops, how to tune them, and how to use them in PAC Control, see Opto 22
form 1641, OptoTutorial: SNAP PAC PID.

Get PID Configuration Flags Get PID Tune Integral
Get PID Current Input Set PID Configuration Flags
Get PID Current Setpoint Set PID Feed Forward
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Get PID Feed Forward

Get PID Feed Forward Gain

Get PID Forced Output When Input Over Range
Get PID Forced Output When Input Under Range
Get PID Gain

Get PID Input

Get PID Input High Range

Get PID Input Low Range

Get PID Max Output Change

Get PID Min Output Change

Get PID Mode

Get PID Output

Get PID Output High Clamp

Get PID Output Low Clamp

Get PID Scan Time

Get PID Setpoint

Get PID Status Flags

Get PID Tune Derivative

What is a PID?

Set PID Feed Forward Gain

Set PID Forced Output When Input Over Range
Set PID Forced Output When Input Under Range
Set PID Gain

Set PID Input

Set PID Input High Range

Set PID Input Low Range

Set PID Max Output Change

Set PID Min Output Change

Set PID Mode

Set PID Output

Set PID Output High Clamp

Set PID Output Low Clamp

Set PID Scan Time

Set PID Setpoint

Set PID Tune Derivative

Set PID Tune Integral

A proportional integral derivative (PID) control system (often referred to as a PID loop) monitors a
process variable, compares the variable’s current value to a desired value (a setpoint), and calculates
an output to correct error between the setpoint and the variable. Because the calculation is
complex, it is done by a mathematical formula that is adjusted (tuned) for each PID loop. The
mathematical formulas vary, but all PID systems share these fundamental concepts:

«  They evaluate a process variable against its setpoint.

«  They control an output to correct the process variable.

«  The output comprises proportional, integral, and derivative calculations.

«  The effect of proportional, integral, and derivative calculations is modified by user-determined

P 1, and D constants.

« TheP1,and D constants need to be tuned for each system.

PID Loops on I/0O Units

SNAP PAC controllers and brains provide 96 PID loops per 1/0 unit. Because PIDs run on the I/0 side
of the SNAP PAC R-series controller, not on the control side, these PIDs will keep running on the
SNAP PAC R-series I/0 unit even if the PAC Control strategy stops.

In PAC Control, you can configure each of the PID loops with unique settings for a large number of
parameters. For a simple PID loop, you must configure at least the following:

« Input (the process variable being monitored)

«  Setpoint (the desired value)

»  Output (the I/O point that effects change in the system)

«  Scan time (how often the input is sampled)
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«  PID algorithm used (four algorithms are available; see “Algorithm Choices” on page 328.
«  Valid range for input

«  Upperand lower clamps for output

«  Minimum and maximum change for output

You can also configure the following parameters if necessary:

«  Forced output value or use of manual mode if input goes out of range

+  Feedforward gain

«  Square root of input

In the SNAP PAC, the derivative is applied only to the process variable (the input) and not to the
setpoint. This means you can change the setpoint without causing spikes in the derivative term.
These PIDs also prevent integral windup by back calculating the integral without the derivative

term. The feed forward term ("bias”) is added before output clamping and has a tuning factor.

If desired, you can cascade PIDs by simply using the output point of one PID loop as the input point
for another.

Algorithm Choices

When you configure a PID loop, choose one of these algorithms':
«  Velocity (Type C)

« ISA

«  Parallel

« Interacting

Velocity (Type C) is typically used to perform velocity control. The ISA, Parallel, and Interacting
algorithms are derived from the article “A Comparison of PID Control Algorithms”by John P. Gerry in
Control Engineering (March 1987). These three equations are the same except for the tuning
coefficients; converting from one equation to another is merely a matter of converting the tuning
coefficients.

'The following obsolete algorithms support PID loops configured before PAC Project R9.5 (for details, see Op-
toKnowledgeBase article KB82058):

- Velocity (Type B) Obsolete

- ISA (Obsolete)

- Parallel (Obsolete)

- Interacting (Obsolete)
You can continue to use these obsolete algorithms, but Opto 22 recommends you use the new algorithms
when configuring new PID loops.
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Key to Terms Used in Equations

. ) . Derivative tuning parameter. In units
Process variable; the input to the ) .
PV PID TuneD of seconds. Increasing magnitude
increases influence on output.
SP Setpoint Output Output from the PID
InL - i-
c_), Range of the input Err 1 The Error (PV — SP) from the previ
InHi - ous scan
outLo Integrator. Anti-windup is applied
OutHi ’ Range of the output Integral | after the output is determined to be
utne within bounds.
Gain Prqportlonal tuning pargmeter. PV1, PV2 PV from the previous scan and the
Unitless. May be negative. scan before that.
Integral tuning parameter. In units ) . . .
Tunel of seconds. Increasing magnitude ScanTime Actual scan time (time since previ-
. . ous scan)
increases influence on output.

Equations Common to All Algorithms

Err = PV - SP

Span = (OutHi - OutLo) / (InHi - InLoO)
Output = Output + FeedForward * TuneFF

Equations Common to ISA, Parallel, and Interacting

Integral =
TermP = Err
Terml = Tunel * ScanTime * Integral

TermD = (TuneD / ScanTime) * ( PV - PV1 )

Velocity (Type C) Algorithm
ATermP = ( PV - PV1 )
ATerml = Tunel * ScanTime * Err

Integral + Err

In this part of the formula, you adjust Tunel.

ATermD = TuneD / ScanTime * ( PV - 2 * PV1 + PV2 )

In this part of the formula, you adjust TuneD.

Aoutput = Span * Gain * ( ATermP + ATerml + ATermD )

In this part of the formula, you adjust Gain.
ISA (or “Ideal”) Algorithm

Output = Span * Gain * ( TermP + Terml + TermD )

Parallel (or “Independent”) Algorithm

Output = Span * ( Gain * TermP + Terml + TermD )

Interacting (or “Classic”) Algorithm

Output = Span * Gain * ( TermP + Terml ) * ( 1 + TermD )

To enable legacy 1/0 units and commands in PAC Control, see “Legacy Options”on page 211.
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Pointer Commands
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The following commands are used with pointers:

Clear Pointer Move to Pointer
Move to Pointer Table Element
Pointer Equal to NULL?

Pointer Table Element Equal to NULL?

Clear Pointer Table Element
Get Pointer From Name

Move from Pointer Table Element

See also:

“Understanding Pointers”on page 330
“Advantages of Using Pointers”on page 331
“Referencing Objects with Pointers”on page 331

Understanding Pointers

Like integer and float variables, a pointer variable stores a specific number. However, the number is
not data—it is the memory location (address) of data. The pointer “points”to data rather than
containing the data.

A pointer in PAC Control can point to many different types of objects:
»  Another variable

«  Adigital point or object

«  Ananalog point or object

« Anl/Ounit

« Achart

Pointers cannot point to other pointers, however. If you try to move a pointer to a pointer, PAC
Control just duplicates the existing pointer.

The following table lists the objects that pointers can point to:

- . . . . Other
Digital Objects Analog Objects | I/O Units Variables Objects
Integer Variable
SNAP-PAC-R1 Float Variable
SNAP-PAC-R1-B String Variable
Digital Input SNAP-PAC-R2 Pointer Variable
Digital Output Analog Input SNAP-PAC-EB1 Down Timer Variable Chart
Counter Analog Output SNAP-PAC-EB2 Up Timer Variable
Quadrature Counter SNAP-PAC-SB1 Integer Table
SNAP-PAC-SB2 Float Table
String Table
Communication Handle
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Advantages of Using Pointers

For certain types of operations, pointers can speed up programming and make the strategy more

efficient. Pointers are usually recommended only for experienced programmers, however, because
their misuse can result in unpredictable behavior. They also complicate strategy debugging. If you

use too many pointers, it's easy to lose track of what's pointing to what.

If you choose to use pointers, be sure you use the text tool to document your charts in detail.

Referencing Objects with Pointers

There are two types of pointers—pointer variables and pointer tables.

Pointer Variables. A pointer variable contains a single pointer to a single object. You can set the
initial value for a pointer variable when you configure it, or you can set it later by using the
command Move to Pointer.

Once the initial value is set, you can reference it using any command you would use for that type of
object. For example, if the pointer points to a string variable, you can use any command for the
pointer that you would normally use for a string variable, such as Append String to String or Convert
String to Float.

Pointer Tables. A pointer table contains a list of objects of different types, each of which can be
pointed to. For example, the object at index 0 could be a chart, the object at index 1 a digital point,
and the object at index 2 a string variable. An example of using a pointer table for indexing is shown
on page 95.

When you create a pointer table, no initial values are set. You can use the Move to Pointer Table
command to set individual values in the table.

A pointer table element cannot be directly referenced. It must be copied to a pointer variable first,
using the command Move From Pointer Table Element. Once it is in the pointer variable, you can
reference it as you would any object of that type. For example, if index 3 in a pointer table points to
a counter input, use Move From Pointer Table Element to put the counter input address in a pointer
variable. Then you can use any command for the pointer variable that you would normally use with
a counter input, such as Start Counter or Clear Counter.

Simulation Commands

The following commands are used for simulation and program testing:

Communication to All I/O Points Enabled? IVAL Set Analog Point
Communication to All I/O Units Enabled? IVAL Set Counter

Disable Communication to All /O Points IVAL Set Frequency

Disable Communication to All I/O Units IVAL Set 1/0 Unit from MOMO Masks
Disable Communication to 1/0 Unit IVAL Set Off-Latch

Disable Communication to PID Loop IVAL Set Off-Pulse

Disable Communication to Point IVAL Set Off-Totalizer

Enable Communication to All I/O Points IVAL Set On-Latch

Enable Communication to All I/O Units IVAL Set On-Pulse

Enable Communication to 1/0 Unit IVAL Set On-Totalizer

PAC Control User's Guide 331



STRING COMMANDS

IVAL Set Period

IVAL Set TPO Percent

IVAL Set TPO Period

IVAL Turn Off

IVAL Turn On

PID Loop Communication Enabled?

Enable Communication to PID Loop
Enable Communication to Point

1/0 Point Communication Enabled?
1/0 Unit Communication Enabled?
IVAL Set Analog Maximum Value
IVAL Set Analog Minimum Value
The Disable commands disconnect the strategy from the real-world device, so that it can be tested
without affecting field devices. While the real-world devices are disabled (or if they don't exist) the
IVAL commands can be used for testing and simulation. For details on individual commands, see the
Opto 22 form 1701,the PAC Control Command Reference, or Online Help.

String Commands

The following commands are used with strings:

332

Append Character to String

Append String to String

Compare Strings

Convert Float to String

Convert Hex String to Number

Convert IEEE Hex String to Number
Convert Integer 32 to IP Address String
Convert IP Address String to Integer 32
Convert Number to Formatted Hex String
Convert Number to Hex String

Convert Number to String

Convert Number to String Field
Convert String to Float

Convert String to Integer 32

Convert String to Integer 64

Convert String to Lower Case

Convert String to Upper Case

Find Character in String

Find Substring in String

Generate Checksum on String
Generate Forward CCITT on String
Generate Forward CRC-16 on String
Generate Reverse CCITT on String

Using Strings

Generate Reverse CRC-16 on String
Get Nth Character

Get String Length

Get Substring

Move from String Table Element
Move String

Move to String Table Element
Move to String Table Elements
Pack Float into String

Pack Integer 32 into String

Pack Integer 64 into String

Pack String into String

Set Nth Character

String Equal to String Table Element?
String Equal?

Test Equal Strings

Trim String

Unpack String

Verify Checksum on String

Verify Forward CCITT on String
Verify Forward CRC-16 on String
Verify Reverse CCITT on String
Verify Reverse CRC-16 on String

NOTE: All numbers in this discussion of strings are decimal unless otherwise stated.

A PAC Control string is a sequence of characters that can be grouped together. Characteristics of

strings include the following:

«  Strings are always referred to by name (and, if in a table, by index).
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»  Each character is represented by one byte.
»  Fach character is represented by its ASCll code (0 to 255).
« Astring containing no characters is referred to as an empty string.

«  Strings are frequently used in serial communication as a container for moving numeric
characters from one device to another.

«  Although a string may appear to contain numeric values, it does not. Digits “0"through “9" are
characters just as much as “A”through “Z”; they do not represent numeric values.

Toillustrate, let's look at the number 22. This is a decimal number representing a quantity of 22.
The number 22 can be represented in a string in several ways; here are two of them:

— As 22" two character 50's (The ASCII code for 2 is 50.)
— As"16" a character 49 (“1") and a character 54 (“6") (The hex value of 22is 16.)

Note that the string representation of the number 22 is no longer a number. It is simply one or
two ASCII characters. The string representation of a number must be converted to a numeric
value if it is to be used in calculations. Several Convert commands are available for this purpose.

« Instandard PAC Control commands, do not use double quotes around string literals. You can
use single quotes, but they are not required.

«  In OptoScript code, you must use double quotes for string literals. See “11: Using OptoScript”
for more information.

String Length and Width

The width of a string is the maximum length a string can be; length is the actual number of
characters contained in the string. A string with a width of 100 may currently be empty, which
means its length is zero. A string with a width of 10 containing the characters “Hello "has a length of
six (five for "Hello" and one for the space after the “0”). Although a string’s length may change
dynamically as the string is modified by the program, its width remains constant.

When you configure a string variable or string table, you set the width of the string. All the strings in
a PAC Control string table must be of the same width.

PAC Control supports a maximum string width of 1024. For applications requiring wider strings, you
can use several strings to hold the data, use string tables, or use numeric tables, as described in the
next section.

Using Numeric Tables as an Alternative to Strings

Since a string is nothing more than a sequence of characters, you can store a string in a numeric
table, with each table element holding a character. The advantage of using numeric tables for
strings is that a numeric table can store strings of any size. The disadvantages are:

«  Memory usage is much greater.

«  No string conversion functions are available for numeric tables. An intermediate temporary
string would be required to use string commands for these tables.

Strings in PAC Control can have a width of up to 1024.
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Strings and Multitasking

Although string commands are completed before the current task loses its time slice, it is important
to note that a string that is constructed in more than one step may require more than one time slice
to complete.

For example, if a string is being constructed in two steps (such as Move String “Hello” and Append
String to String “ World"), after the first step a task switch could occur, and another chart looking at
the resulting string might see "Hello” rather than “Hello World."

If another chart is relying on a completed string, you can use a temporary string for building the
string, and then move it to the final string. This idea is illustrated in the following example, where a
string variable named MSG_String is built in two steps using a temporary string:

1. Move the string literal “The pressure is “ to a temporary variable named sTemp.
2. Append a string variable, sPressure, to sTemp.
3. With the complete string now built, move sTemp to MSG_String.

Adding Control Characters to a String

You can input most control characters in a string by typing a backslash (\) followed by the
two-character hex value of the character. For example, to add an ACK (Ctrl+F) character, enter \06 as
part of the string.

This technique works for all control characters except null (\00), carriage return (\OD), line feed (\0A),
backspace (\08), and Ctrl+Z (\1A).To add these characters to a string, you must use the Append
Character command.

To input a single backslash in a string, type in a double backslash (\\).

Sample String Variable

«  Declared Name: String_1

+  Declared Width: 22

«  Maximum Possible Width: 1024
«  Bytes of Memory Required: Declared Width + 4 =22 + 4 =26
Width is

swingt | | [ [ [ [ LTI TI PP PP TT]]

Length is O

A string is referred to by its name. Initially the previous string is empty, giving it a length of zero.
Later, during program execution, seven characters are added to String_1, increasing its length to
seven:

Width is
string 1 [O[P|T]O] J2l2] | | | [ [ [ [ ] []]

<— lengthis ——>
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Sample String Table

«  Declared Name: Promo_Messages

«  Declared Width: 26

«  Maximum Possible Width: 1024

«  Declared Length (Number of indexes, or items, in table): 5

«  Maximum Possible Length (Size): 1,000,000

+  Bytes of Memory Required: (Declared Width + 4) x Declared Length = (26 +4) x 5 = 150

Width is
Index 0 O|P|T|O 212 SIN|/A|P PlA|(C S|Y|S|T|E|M|S
Index 1 Ilninjo|v|a ilv|e 11/10
Index 2 Dlie|l|i|v|e|r|s cloln|t|r|o]|l],
Index 3 plrioflg|lrlaimmialb|i|l]|i|t]|y], ajn|d
Index 4 e|ln|tle|rip|r|i|s|e clojninje|c|t]|i|v]|i|t|y]|!

A string table is a collection of strings. Each string is referred to by the name of the table it is in and
the index where it can be found. The length of the table is the number of strings it can hold. Because
string table indexes start with zero, indexes can range from zero to the table length minus one.

The width of each string in the table is the same. The length of each string can vary from zero to the
configured width of the table.

String Data Extraction Examples

To extract various pieces of information from a string, use the command Find Substring in String.
Consider the following example:

swing1 Jo[P[7Io] [212] [ 11 111111111 1]

One way to get two separate pieces of information from this string is to get characters 0-3 and then
get characters 5 and 6, as shown in the following examples.

Find Substring in String: Example 1

String_1 stringvariable

Start At 0 integer literal

Number Of 4 integer literal
Move To Sub_String1 string variable (width = 5)

Results in:

0O 1 2 3 4
Sub_String1|o\P\T\o\ \
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Find Substring in String: Example 2

String_1 string variable

Start At 5 integer literal

Number Of 2 integer literal
Move To Sub_String2 string variable (width = 5)

Results in:
0 1 2 3 4
\Sub_Stringz| 2 \ 2 \ \ \ \

String Building Example
Strings are assembled using commands Move String, Append Character to String, and Append
String to String. Consider the following original string and the examples that follow:

01 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21
string 1 [S|NJAIP| [P[AfC] | | [ [ [ ][ [[]]]]

Move String
From OPTO string literal
To String_1 stringvariable

Results in (note that Move String erased the previous contents of the string):
0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21
string 1 [O[P[T[o] [ [ [ | [ [ [ [[[[[[[[[T]]

<lengthis—=>

Append Character to String

From 32 integer literal (represents a space)
To String_1 stringvariable

Results in (note the space character in position 4):

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21
string 1 [O[P|TIO] [ | | [ [ | [ [ [ ][] ][]

<—lengthis —

Append String to String
From 22 string literal
To String_1 stringvariable
Results in:

01 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21
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sting1_[o|P|T[o| Jaf2| | [ [ [ | [ [ [ ]]]]

<——Lengthis——

Append Character to String

From 13 integer literal (carriage return)
To String_1 stringvariable
Results in:

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21
string_1_[O[P|T[o] [2]2]w] [ | [ [ [ [ [ [ [ [ [ [[]

<——lengthis ———>

Comparison to Visual Basic and C

The following table lists PAC Control string commands and their equivalents in Microsoft Visual
Basic and C. If you are using OptoScript, see “E: OptoScript Language Reference,” for additional
comparisons.

PAC Control Command Visual Basic C
i = strlen(str);
Append Character to String S$ = S$ + Chr$(MyChar%) str[i] = MyChar;
strli + 1] =0;
Append String to String S$ = S$ + “Hello” strcat(str, “Hello”);
Convert Hex String Number 1% = “&h” + S$ sscanf(str,“%x”,&Num);

Convert Number to
Formatted Hex String

S$ = Hex$(1%)

sprintf(str,“%x”,iNum);

Convert Number to String

S$ = CStr(1%)

sprintf(str,“%d”,iNum);
sprintf(str,“%f”,fNum);

Convert String to Float

F = CSng(S$)

sscanf(str,“%f",&Num);
fNum = atof(str);

Convert String to Integer 32

1% = CInt(S$)

sscanf(str,"%d”,&Num);
iNum = atoi(str);

Get Nth Character

MyByte% =
ASC(MID$(Str$,n%,1))

MyByte = str[n];

Get String Length

MyLENGTH% = LEN(Str$)

iLEN = strlen(str);

Get Substring

SubStr$ = MID$(Str$,i,n)

strncpy(subStr,&str(i],n);
subStr[n] = \0’;

Move String

STR$ = “Hello”

strcpy(strDest,“Hello”);

Test Equal Strings

Equal% = (STR$ = “Hello”)

i = strcmp(str1,“Hello”);

String Equal?

if STR$ = “Hi” then...

if(!strcmp(str1,“Hi”))

String Equal to
String Table Element?

if STR$(n%) = “Hi” then...

if(!strcmp(str1[n],“Hi"))
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Convert-to-String Commands

The five convert-to-string commands are typically used when printing a number to a port. The ASCII
table on the following page shows how various parameters affect the string as it is converted. Note
the following:

Some commands add leading spaces to achieve the specified length. These spaces are
indicated with underscores ( _).

Floats (if used) are automatically rounded to integers before conversion except when using the
command Convert Number to Formatted Hex String.

Command Convert-to-String Commands
Parameters
E ] c:”'c
22 |25 8035 S o £2 E2 Eo
> 2 oE| £ EZ S & £ 55 S 5 ¢
= S o ST > o v E 20 Z2 o 2 E
= 9 = 0 < Z50s s n £ X v £ t®
o © Q5 @ £ oL o > o 2 o5 o
E o 2 o - ot 5o c 8 >T >h >8
52 E o >® 2% o T o c c
P4 3 3 E g € o (8} O = o 3 o
z35 852 o o o
= [I'S
16.0 1 4 41800000 16.0 10 1.6e+01 1.6e+01
16.0 2 4 41800000 b 10 1.6e+01 1.6e+01
8 -16.0 1 4 C1800000 e FFFFFFFO -1.6e+01 -1.6e+01
©
o
o 1.23 1 4 3F9D70A4 _1.2 1 1.23e+00 1.23e+00
12.3 1 4 4144CCCD 12.3 C 1.23e+01 1.23e+01
0.0 1 4 00000000 _0.0 0 0.0e+00 0.0e+00
16 1 4 0010 16.0 10 __16 16
” 16 2 4 0010 o 10 __16 16
:,',’ -16 1 4 FFFO b FFFFFFFO _-16 -16
k=
= 0 1 4 0000 0.0 0 0 0
1000 1 2 ** ** 3E8 1000 1000
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The following table shows ASCII characters with their decimal and hex values. For characters 0-31,
equivalent control codes are also listed; for example, a carriage return (character 13) is equivalent to

CTRL+M (shown in the table as AM).

Dec | Hex | CC Char Dec | Hex Char Dec | Hex | Char Dec | Hex | Char
0 00 | "@ NUL 32 | 20 Space 64 | 40 @ 96 | 60
1 01 A SOH 33 | 21 ! 65 | 41 A 97 | 61 a
2 02 B STX 34 | 22 “ 66 | 42 B 98 | 62 b
3 03 ArC ETX 35 | 23 # 67 | 43 C 99 | 63 c
4 04 D EOT 36 | 24 $ 68 | 44 D 100 | 64 d
5 05 E ENQ 37 | 25 % 69 | 45 E 101 | 65 e
6 06 AF ACK 38 | 26 & 70 | 46 F 102 | 66 f
7 07 G BEL 39 | 27 71 47 G 103 | 67 g
8 08 H BS 40 | 28 ( 72 | 48 H 104 | 68 h
9 09 Al HT 41 | 29 ) 73 | 49 I 105 | 69 i
10 | OA N LF 42 | 2A * 74 | 4A J 106 | 6A j
11 0B K VT 43 | 2B + 75 | 4B K 107 | 6B k
12 | 0C AL FF 44 | 2C , 76 | 4C L 108 | 6C I
13 | OD | "M CR 45 | 2D - 77 | 4D M 109 | 6D m
14 | OE N SO 46 | 2E 78 | 4E N 110 | 6E n
15 | OF o) SI 47 | 2F / 79 | 4F o} 111 | 6F o
16 10 P DLE 48 | 30 0 80 | 50 P 112 | 70 p
17 1 AQ DC1 49 | 31 1 81 51 Q 13| 71 q
18 | 12 R DC2 50 | 32 2 82 | 52 R 114 | 72 r
19 | 13 AS DC3 51 | 33 3 83 | 53 S 115 | 73 s
20 14 AT DC4 52 | 34 4 84 | 54 T 116 | 74 t
21 15 AU NAK 53 | 35 5 85 | 55 u 17 | 75 u
22 16 AV SYN 54 | 36 6 86 | 56 \Y 118 | 76 v
23 | 17 W ETB 55 | 37 7 87 | 57 W 19 | 77 w
24 18 AX CAN 56 | 38 8 88 | 58 X 120 | 78 X
25 | 19 AY EM 57 | 39 9 89 | 59 Y 121 | 79 y
26 | 1A rZ SuB 58 | 3A 90 | 5A z 122 | 7A z
27 | 1B ui ESC 59 | 3B ; 91 5B [ 123 | 7B {
28 | 1C A\ FS 60 | 3C < 92 | 5C \ 124 | 7C |
29 | 1D A GS 61 | 3D = 93 | 5D ] 125 | 7D }
30 | 1E AN RS 62 | 3E > 94 | 5E A 126 | 7E ~
31 1F A us 63 | 3F ? 95 | 5F _ 127 | 7F | DEL
Time/Date Commands
The following commands refer to time, dates, and days:
Copy Date to String (DD/MM/YYYY) Get System Time
Copy Date to String (MM/DD/YYYY) Get Time Zone Description
339
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Copy Time to String

Convert Date & Time to NTP Timestamp
Convert NTP Timestamp to Date & Time
Get Date & Time

Get Day

Get Day of Week

Get Hours

Get Julian Day

Get Minutes

Get Month

Get Seconds

Get Seconds Since Midnight

Get Time Zone Offset
Get Year

Set Date

Set Day

Set Hours

Set Minutes

Set Month

Set Seconds

Set Time

Set Time Zone Configuration
Set Year

Synchronize Clock SNTP

These commands can be used for timing a process or for making sure things happen according to a
set schedule. For example, you could use the command Get Seconds Since Midnight at the
beginning of a process and again at the end of the process, and then subtract the two numbers to
find out how long the process took.

You can set the time and date on the control engine by synchronizing it with the PC; in PAC Control
Debug mode, choose this option while viewing the control engine (Control Engine > Inspect). You
can also use these commands to set the time and date on the control engine. Commands with NTP
in the name refer to the Network Time Protocol.

Timing Commands

340

The following commands are used for timers and delays in a strategy.

Timers Stop Timer

Continue Timer Timer Expired?
Down Timer Expired?

Get & Restart Timer

Up Timer Target Time Reached?
Pause Timer Delays
Set Down Timer Preset Value Delay (mSec)
Set Up Timer Target Value Delay (Sec)

Start Timer

Delay Commands

Delay commands are used frequently in strategies to pause the logic. Here are two reasons to use
Delay (mSec) or Delay (Sec):

«  Toallow time for the state of an input to change before it is checked again. For example, a delay
could give an operator time to release a button before the state of the button is rechecked, or
allow time for an alarm state to change before rechecking.

«  Toletachart give up the remainder of its time slice, when its logic does not need to run
constantly. For more information on using delays in this way, see form 1776, Optimizing PAC
Project System Performance.
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Using Timers

Timers are a special type of numeric variable. A PAC Control timer stores elapsed time in units of
seconds with resolution of milliseconds. Down timers continuously count down to zero, and up
timers continuously count up from zero. Timers can be paused and continued.

To create a timer in PAC Control, configure a numeric variable and select the type Up Timer or Down
Timer. You can use any PAC Control command (for example, Move) that references a numeric variable
to access a timer. You can view the current value of a timer at any time in PAC Control Debug mode.

Since the timer is independent from the control engine’s clock, over thousands of seconds, the timer
and the control engine’s clock will not match. Timers do not place any additional load on the CPU.

Down Timer Operation

The Set Down Timer Preset Value command sets the time the down timer will start from, but does
not start the timer. Use the Start Timer command to start the timer counting down to zero. (Since
the default preset value for a down timer is zero, nothing will happen if you use the Start Timer
command before setting a value.)

Alternatively, you can use the Move command to set the time the down timer will start from. If you
use Move, the down timer begins counting down immediately. If program execution speed is a
priority, use the Move command and put an integer value rather than a float into the timer. This
action eliminates the float-to-integer conversion time.

Note that if you use the Move command, any value you set using Set Down Timer Preset Value is
overwritten, and subsequent Start Timer commands start the timer from the value last sent by the
Move command.

To determine if the timer is finished, use the condition Down Timer Expired? This condition is true
any time the down timer has a value of zero. Down Timer Expired? is much faster than using the
condition Equal? to compare the timer to a value of zero.

The Stop Timer command forces the timer to stop and puts its value at zero. If you want to halt the
timer and have it maintain its value at the time it was stopped, use the Pause Timer command
instead. When you use Pause Timer, you can move the timer’s value at the time it was stopped to a
variable. You can also use the Continue Timer command to resume the timer where it left off.

Up Timer Operation

The Set Up Timer Target Value command sets the time for the Up Timer Target Time Reached?
condition. It does not start the timer, however, and the timer does not stop when it reaches the
target value. You must start the up timer from zero by using the Start Timer command.

If you use the Move command to move a value to an up timer, the value you moved becomes the
target value and the up timer starts timing immediately. (Note that the timer does not start from the
value you moved; it always starts at zero.)

The up timer does not stop when it reaches the target value. To determine if the timer has reached
its target value, use the condition Up Timer Target Time Reached? This condition tests the timer to
see if it is greater than or equal to the target time.

The Stop Timer command forces the timer to stop and resets it to zero. If you want to halt the timer
and have it maintain its value at the time it was stopped, use the Pause Timer command instead.
After you use Pause Timer, you can then move the timer’s value at the time it was stopped to a
variable. You can also use the Continue Timer command to resume the timer where it left off.
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11: Using OptoScript

Introduction

This chapter shows you how to create and use OptoScript, an optional programming language that
can simplify certain types of operations in PAC Control. Modeled after computer languages such as C
and Pascal, OptoScript code gives you an alternative to using standard PAC Control commands.

In addition to the examples provided here, see the Control Basic Examples directory on your hard
drive for a fully annotated example strategy. OptoScript information is also provided in Opto 22 form
1638, the SNAP PAC Learning Center User’s Guide.

You will find OptoScript easy to use if you already have computer programming experience.
Beginning programmers may also want to try it for control operations involving extensive math
calculations, string handling, or complex loops and conditions.

This chapter assumes that you have some programming experience. Experienced programmers
may want to see “Notes to Experienced Programmers”on page 418.

In this Chapter

About OptoScript . . .
When t0 Use OPLOSCHPT covvvvvveeescvvveesssnsseessssseesssssssesssnsseeessne
OptoScript Functions and Commands
OPTOSCIIPT SYNTAX ortrtrerrrrrneerrssssseessssssisesssssssessess s ssssssssssesssesssesssess
OptoScript Data Types and Variables.......... . .
OptoScript Expressions and Operators...... . . v 359
OptoScript Control Structures
ST TaTe RAa TR O] o] to X Yol o]t = 1o

Troubleshooting “Unable To FINA” EITOrS..........vcooeveeeecseeeesssssveesssssseessssseess 370
TroubleshoOtING SYNTAX EITOS ... 370
Debugging Strategies with OptoScript..... . . e 372

About OptoScript

OptoScript is a procedural type of computer language similar to Pascal, C, or BASIC. It can be used
within any PAC Control strategy or subroutine to replace or supplement standard PAC Control
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commands. It does not add new functions, but offers an alternative method within PAC Control’s
flowcharting environment to simplify some common programming tasks.

OptoScript code cannot be mixed with commands in action or condition blocks; it is used in its own
hexagonal flowchart block.

The following figure shows an example of an OptoScript flowchart block and its contents:

OptoScript editor

OptoScript - Oven_Control - Block 1

*O Actions  +9r Conditions  +7 Variables @ Test Compile

— Dwven_Control*

OptoScript Code:

if (Owen_Temperature »= 450) then

Oyen bdlarm = 1; -~ Set the oven alarm
sl=z=

Oven_klarm = 0; ~» Clear the oven alarm
endif

Block 0

£ | >

i1 Shortcuts _I 00z w !
= OptoScript code

[ ][>\ Chart /
OptoScript block

When to Use OptoScript

You'll want to use OptoScript for some common programming tasks that can be more difficult to do
using standard PAC Control commands than using a procedural language. Extensive math
calculations or complex loops, for example, can be done with standard commands but take up a lot
of space on a flowchart.

When you use OptoScript, however, be aware that it is not self-documenting. Make sure you
frequently use comments to explain what the code does, so that when you come back to it a year
later—or when someone who is not as familiar with the code or the strategy must change it—it
can be easily interpreted.

This section shows examples of using OptoScript:
«  for math expressions

«  forstring handling

«  forcomplex loops

+  forcase statements

«  forconditions
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«  forcombining math expressions, loops, and conditions.

For Math Expressions

OptoScript is especially useful for mathematical computations. Math expressions are simpler and
easier, and many of them are built right into the language, instead of requiring commands such as
Add or Multiply. OptoScript has no limitations on the number of parentheses you can use in math
expressions.

Here's an example of a mathematical expression in OptoScript:
integerl = (integer2 + 2) * (floatl / (float2 - 2) - 3);

To accomplish the same computation using standard PAC Control commands, you would need to
Create at least two intermediate variables and use five instructions, as shown below.

1 Instructions - Math_Expressions - Block 16

Add ~ Add...
integer2 T
Plus 2
Put Result in tempintegerf
Subtract
float2 Mext Block
Minus 2
Put Result in tempfloath
Divide
float1
By tempfloath
Put Result in tempfloath
Subtract
tempfloath
Minus 3.0
Put Result in tempfloath
Multiphy -
tempfloath
Times tempintegerf
Put Result in integer1
e T
l Cloze ] l Help ]

As you can see, the OptoScript version of this math expression is not only simpler to create, but also
easier to understand once created.
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For String Handling

If your strategy transmits and receives serial data, you will want to try using OptoScript code. In
standard PAC Control, forming and parsing (decoding) serial data can take several blocks. In
OptoScript, string handling can be easier.

The following figure shows a flowchart designed to send the string request, “What type of plane?”
and parse the response, “F14,"into a classification (F) and a model number (14). Compare these
blocks and instructions with the ones on the following page, done in OptoScript.

M Instructions - String.Handler - Build new request E|
Move String I Add...
v From “plane™ 3
— 5tring_Handler* To sVehicle
Building a string using
- - - - - - ||| Move String standard PAC Control can
0 . From "What type of . | d
Block 0 . Te Request T require several commands.
S | T S &pend String to String w
: Append sWehicle
b . AT
Build new | - To Request If substrings or individual
regquest : s .
1! | Append string to String characters within a string
Lo { o Append "ig in stall " must be handled, a
29 : To Request standard PAC Control block
Send request | - ;
. Convert Humber to String can become QUIte Iarge.
. * R Convert nStall
Put Result in s5tall
Receive : . - ]
response ) Append String to String 1 Instructions - String Handler - Parse response E|
. Append
. * T To Get Substring - Add...
From String Response 3
Parse . Append String to String Start at Index 1
response ) Append Hum. Characters 1
S | R o Put Result in Classification
25 : .
. . < Get Substring Hext Block
Exit . From String Response
Start at Index 2 Previous Block
’ Close ] l Help Hum. Characters 2
< Put Result in Model
(1) Shartouts Convert String to Integer 32 =
|| | | | P\Ehart/ Convert Model
Put Result in Model_Humber
S e e s
< ! ?
[ Close ] [ Help ]

The OptoScript version of the String_Handler flowchart is more compact. The string request can be
built more easily, and parsing the response takes up much less space. If you handle more complex
serial data than in the String_Handler example, you will find OptoScript code even more useful.
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= String_Handler™

Block D

13
Build new
request

29-*.

Send request

CHAPTER 11: USING OPTOSCRIPT

ptoScript - 5tring. Handler, - Build & send request

O3 Actions  +<> Conditions  +(7) Variables o Test Compile

OptaScript Code:

az
L

Request = &
Remquest = "What" + " type" + " of plane?";
(TranSStringViaSerialPDrt(Request, 13 )

)

In OptoScript code, several strings and
variables can be combined to build the
request in one line.

Build & send
regquest

3Receive &
parse
response

'pt - String_Handler, - Receive & parse response

475 Test Compile

|

&0
&8

ReceiveStringViaSerialPort (Response. 1):

(GetSubstring(RespDnse, 1. 1, Clas=ification) ;>

Hodel):
Hodel Temnp):

Hodel Humber = StringTolnt32{Model):

|

Receive *O Actions @ Conditions  *[7) Variables
response
# OptoScript Code
Parse
response
. *‘ . GetSubstring(Response. 2. 2.
GetSubstring(Respon=se. 2. 3.
25 Hodel += Model Temp:
Exit
£
' b
>
(1) Shorteuts
[T chart /
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In OptoScript code, the commands
used to parse the response take up less
space, so they all can be seen at once.
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For Complex Loops

Strategies that use complex loops—for example, to repeat an operation while a condition remains
true—are easier to create and take up less space in a flowchart when done in OptoScript. While
loops, repeat loops, and for loops are all available.

+  While loops repeat a process while a test is true (the test comes at the beginning of the
process).

+  Repeat loops repeat a process until a test is false (the test comes at the end of the process).
This kind of loop is guaranteed to execute at least once.

«  Forloops repeat a process for a specified number of times.

Below is an example of a while loop as it would appear in standard flowchart commands, contrasted
with the way it could be handled in an OptoScript block.

. - WHILE-LOOP - - - - - - - - . . .
P (tes‘t for the'hﬂur) ..........

__________ In standard PAC Control commands, the
.......... loop takes several blocks, each
""""" containing one or more instructions.

Get Hour

o o : In OptoScript, the loop is in a single block that
o Somethin : : < > . . .
9 . 4 TestHour ; contains one condensed instruction.
] l - m cript - Powerup - Test Hour Pz|
: — Get Hour +O Ackions & Conditions  +71 Variables & Test Compile #h '?.s

OptoScript Code:

) while {(GetHours({) »>= 8) and (GetHours() ¢ 17))}
Continue on...| - - -~ - - - - 47 do something!

................. wend
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For Case Statements

Case or switch statements create multiple decision points. They can also be easier to do using
OptoScript. Here is an example of a case statement:

In standard PAC Control commands, the case

statement requires several sets of condition and

action blocks, each containing commands. In OptoScript, the code
is allin one block.

e WE : switch (GetDayOfWeek())
d C Fan Control case 1: »~ Monday
Run fans 1 &2| - - ’ : Fan_1 H

5 c case 2: -7 Tuesday

1}

Check Day

|
[T}
[=F=T2

Run fans 3 8 4 Fan 2

= Co Fan_1l = 1
Run fans 1 &2| - - Fan_2 : %
o 20

45 : : Fan_2
Run fans3 &4 Fan_3

40 T Fan_3
Run fans 1 &2| - - Fan_4

[T
[=F=N

default: v Saturday or Sunday

ocooo

Turn off all o Fan 4

fans o break
endswitch

Using OptoScript for case statements saves space in the flowchart and lets you see all the possible
cases in one dialog box.
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For Conditions

Like loops and case statements, conditions can be simpler when done in OptoScript code. /f/then,
if/then/else, and if/then/elseif statements can all be mixed and nested as needed. Here's an example
of a simple if/then/else statement as it could be done in standard PAC Control commands and in

OptoScript:

Block 2

- Y

I

In standard PAC Control commands, even a simple
it/then/else statement requires three blocks.

Set Alarm

Clear Alarm

In OptoScript, a single block
contains the statement.

_|Continue on...|

: i OptoScript - Power.

{ Check Oven
! Temp '

- Check Oven Temp

»3 Actions  +€> Conditions | ) Wariables 4% Test Compile dh 4
OptoScript Code:
if (Oven_Temperature »= 450) then
Oyen_Alarm = 1: ~ Set the oven alarm
else
Oyen_Alarm = 0; - Clear the oven alarm
endif]
< ¥

OptoScript is even more useful for more complex conditions, such as the following:

[
Delay 60 sec

Check -
Temperature |-

Turn on
Fan 1

7
Turn off
all fans

7] T 30
urn on
Send alarm —]

Fan 2

BT
. fe mperature
Control

i OptoScript - Temperature_Control - Temperature Control

+O Ackions  + Conditions  +7) Wariables & Test Compile

OptoScript Code:

if (Temp Probe > 80) then
Fan_1 = 1. »v Turn on fan 1

if (Temp Probe > 95) then
Fan_2 = 1. »v Turn on fan 2 too

In OptoScript, all the condition
and action blocks and their
commands are consolidated
into one block.
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if (Temp Probe > 105) then
Alarm = 1: v Send alarm — temperature too high
endif

endif
else ~+Turn off all fans

Fan_ 1 0:;
Fan_2 0

endif

DelaySec (60); ~~ Wait 1 min before checking temp again
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For Combining Expressions, Operators,

and Conditions

The real power of OptoScript can be seen in complex operations.

Start ‘-

or +10?

for 10 mins

. A
uesday or L
Friday? Delay 1 hour ; Erass-"'l’rees
' ’ r % Control
T
.. This portion of a sprinkler
Tcompae | 0 contolsystemuses
Temps ... . ... .. ... ... standard PAC Control blocks
o and commands to control
watering of grass and trees.
5 1
ax_Temp =80 watergraﬁ A

The OptoScript version of

- |43 - |44

g
Water grass Water Trees 3 Delay 1 min

for 20 mins

Grass/Trees Control handles the
loops, conditions, and operator:

Turn off Trees

i OptoScript - Sprinkler_Control - GrassfTrees Control

easily in a single block.

+O Ackions  + Conditions  +7) Wariables & Test Compile

OptoScript Code:

e et

as= long as it's not raining %7

Gr.

ass = 1;
DelaySec (1200); - Water grass for 20 mins
Grass = 0

else
Grass = 1;
DelaySec (600): ~ Water grass for 10 mins
Grass = 0;

endif

while (Soil Moisture < 30}
Trees = 1. ~~ Water trees
wend
else

endif

<% Setz Grass and Trees sprinklers to run on Tuesdays and Fridays

if ({{GetDay0iWesk() == 2) or (GetDayQiWesk() == 5)) and {(Humidity < 983) then

if {({Max Temp > 80) or (Hax Temp == Yesterday_Temp + 10)) then

DglaySec (3600); »» Wait one hour before checking the day again

Generally speaking, the more complex the combination of math expressions, logical and
comparison operators, loops, and conditions, the more convenient it is to use OptoScript code

rather than standard blocks and commands.
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OptoScript Functions and Commands
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Since functions in OptoScript are provided by commands almost identical to the standard
commands in PAC Control, you have the same complete range of functions. There are no additional
functions for OptoScript code, and you cannot make your own functions.

Standard and OptoScript Commands

In many cases you can easily recognize OptoScript commands, because they are almost the same as
standard PAC Control commands. All spaces are removed from the OptoScript commands, however,
and in some cases words in the command are abbreviated or left out. Commands are case sensitive.
Here are some examples of the same commands in PAC Control and in OptoScript:

PAC Control Command

OptoScript Command

Get Counter

GetCounter

Set Down Timer Preset Value

SetDownTimerPreset

Delay (mSec) DelayMsec
Convert Float to String FloatToString
Get Number of Characters Waiting GetNumCharsWaiting

Some commands are built into OptoScript functionality. Some of these have OptoScript commands
and some do not; you can use either the built-in functionality or the OptoScript command, if it
exists. Here are some examples:

PAC Control Command OptoScript Command Built-In Equivalent Example

Move = item1 = value
Add + 1+2

Less? < value1 < value2
Turn On TurnOn = [non-zero] digital3 = 1
Turn Off TurnOff =0 digital3 = 0
Comment (Single Line) I /I comment

Set Nth Character SetNthCharacter s1[5] ="c'

See Appendix E for a table of all PAC Control commands and their OptoScript equivalents. In
addition, OptoScript equivalents for each command are shown in the PAC Control Command
Reference and in the online command help.

Using I/0 in OptoScript

One advantage of OptoScript is that any named 1/0 point can be used directly, wherever a numeric
variable can be used, rather than requiring a variable. Digital points behave like integer variables that
have only two possible states: zero (off) or non-zero (on). Analog points behave like float variables.

For example, you can turn a digital point off by simply assigning it a value of zero:
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Light_Switch = 0;
You can turn a digital point on by assigning it any value other than zero:

Light_Switch = 1;
Light_Switch = -1;
Light_Switch = 486;

You can use I/0 points directly in mathematical expressions:
fLimit = Pressure_Input + 50;

Or use them directly in control structures, for example to turn off the light if the door is closed:
if (not Door) then

Light_Switch = O;
endif

You can set an output based on the value of an input or a variable:

LEDO1 = Switch_A;

Proportional_Valve = fPressure_Control

You can use a point directly with a command:

fRange = GetAnalogMaxValue(Temp_Input) - GetAnalogMinValue(Temp_Input);
TurnOn(Fan_A);

IsOn(Fan_A);

OptoScript Syntax

Here is a sample section of OptoScript code to illustrate syntax. Indentation is not required, but is
used for clarity.

Each statement is followed by a
semicolon.

fPressure = 300.0; <«

nTotal = ntTable[0] + ntTable[1] + ntTable[2];¢—_| Table elements are put in square

brackets next to the table name.

while ((GetHours() >= 8) and (GetHours() < 17
Fan /E(: 1- 0 ) ( 0 ))'\\Parenthesesare used as separators for

wend expressions and operators. You can use
an unlimited number of parentheses.

// Send alarm if oven temperature too hot.

if (Oven_Temperature >= 450) then \ Line comments appear on a separate
Oven Alarm = 1; // Set the oven alarm s line or after a statement. They are

else — | preceded by two slashes and a space
Oven_Alarm = 0; // Clear the oven alarm Block comments (not illustrated) are

endif preceded by /* and followed by */.

| Parameters (arguments) for a
command are listed in order within
parentheses following the command.
Commands that have no arguments
must still include the parentheses.

nCheck = GenerateChecksumOnString (0, sMessage) ;4]
nError_Block = GetldOfBlockCausingCurrentError();
RemoveCurrentError();

sGreeting = “Hello, world!”’;
nPos = FindCharacterInString(“!", 0, sGreetlng);‘\ An individual character can be in single

| quotes or in double quotes, depending
on its type. A string must be in double
quotes.
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NOTE: Each block has only one exit point. It is not possible to use return to jump out of the current
block.

More About Syntax with Commands

As noted in the previous sample, arguments for a command are listed in the parentheses following
the command. Arguments are listed in order beginning with argument 1. To find out the arguments
for any command, see the PAC Control Command Reference or online command help.

SetDownTimerPresetValue (60.0, Minute_Timer)

command (argument 1, argument 2)

EnablelOUnitCausingCurrentError ()

command (no arguments)

There are two types of OptoScript commands: procedure commands and function commands.

Procedure commands accomplish an action and return no value. Here are some examples:
RemoveCurrentError();

ClampInt32TableElement(10, 0, 5, x1);

Function commands return a value from their action, so the value can be placed somewhere. In
the following examples, the value is placed in the variable at the beginning of the statement:
nMonth = GetMonth();

fSquare_Root = SquareRoot(99);

nPosition = FindCharacteriInString("S", 0, sName);

When you compare these examples to the identical commands in standard PAC Control, you'll
notice that the returned value for the standard PAC Control command is an argument. In OptoScript
the returned value is not an argument, thus reducing the number of arguments by one. In the first
example, the standard command Get Month has one argument, which is where the result is placed.
The OptoScript command equivalent, GetMonth, has no arguments and places the result in the
variable.

In most cases you will use the value a function command returns by placing it in a variable, a control
structure, or a mathematical expression. Occasionally, however, you may not need to use the result.
For example, the command StartChart returns a status. If you do not need to track the status, you

can ignore it by not placing the result anywhere, for example:
StartChart(Fan_Control);

OptoScript Data Types and Variables

Unlike most procedural languages, PAC Control maintains a database of all declared variables, which
is shared with PAC Display. Variables are not declared in OptoScript code, but are created (declared)
within PAC Control. (See “9: Using Variables and Commands.”) Variables are not declared in
OptoScript because local variables are not allowed. All variables are global for the strategy (or global
within a subroutine).
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If you use a variable in OptoScript code that does not currently exist in the strategy, you'll receive an
error message when you test compile the code and can add the variable then.

Variable Name Conventions

With OptoScript and in PAC Control generally, it's a good idea to get into the habit of indicating the
variable type in each variable’s name. Some variable types may be obvious in the name itself, but
others are not. For more information, see “Naming Conventions”on page 85.

Using Numeric Literals

Here are examples of how to use numeric literals in OptoScript. Formats are automatically converted
if they don't match the variable type. For example, if a value of 300.2 were assigned to an integer 32,
the value would be converted to 300.

Decimal Integer 64 Literals assigned to variables. Inte-

Decimal Integer 32 Literals assigned to variables: ger 64s have an i64 at the end:

nvariabtel Z 9 dvariablel = 0i64;
nvar!ames ~ 133 dvariable2 = 10i64;
nvarrables = -1e3, dvariable3 = -123i64;
Hexadecimal Integer 32 Literals assigned to variables.

Hex notation starts with Ox. Digits A—F Hexadecimal Integer 64 Literals assigned
may be upper or lower case: to variables:

nVariablel = 0x0; dvariablel = Ox0i164;
nVariable2 = 0x10; dvariable2 = 0x10i64;
nVariable3 = O0x12AB34CD; dvariable3 = 0x1234567890ABCDEFi64;
nVariable3 = Ox12ab34cd;

Float Literals assigned to variables (Float literals may use scientific notation):
fVariablel = 0.0;

fVariable2 = 12.3;

fVariable3 = -123.456;

fVariable3 = -1.23456e2;

fVariable3 = -12345.6e-2;

Making Assignments to Numeric Variables

Values are easily assigned to variables.

Simple Integer 32 assignments: Simple Integer 64 assignments:
nl = 1; nnl = 2i64;

n2 = nl; nn2 = nnl;

Simple assignments between different data types

Simple Float assignments: (Types will be automatically converted to match):

-3 Heg
- nnl = nl;
f1l = nl;
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Using Strings

As noted in the section on syntax, a string in OptoScript must be in double quotes. An individual
character can be used either as a string (in double quotes) or as an integer value representing that
character in ASCII (in single quotes). When you assign a single character to a string, use double
quotes to avoid a syntax error:

sString = "a";

To change a single-character integer into a string, use the Chr () keyword as shown below:

sString
sString

Chr("a®); n = 97;
Chr(97); sString = Chr(97)

NOTE: If you intend to retrieve the string data in either PAC Display or OptoOPCServer, to avoid an error do
not use the Chr() keyword character to insert an embedded null, e.g. Chr(0).

Strings can be used in the following ways.

String literals (must be all on one line):

sGreeting = "Hello, world!™ String variables:

sOutgoing = slncoming;

A string can be thought of as a table of
characters. The number In square
brackets is the character’s index.

When you use the Chr() keyword to assign a
character value to a string variable, you can

either quote a character or give its ASCII value.

(Note that the index starts with the
number zero.) The following code would
result in sGreeting equaling “Hello!!!”

For example, the following two statements are sGreeting = "Hello...";
equivalent sGreeting[5] = "!";

_ _ e sGreeting[6] = "1~;
sStringl B Chr(*A"): sGreeting[7] = sGreeting[6];

sStringl Chr(65);

A character element of a string variable may be treated like

an Integer 32 value:
nNumber = sString2[1] * sString2[2];

Clear a string using empty quotation marks:
sStringl = "";

The + operator is used to paste strings together. There is no limit to the number of + operators you can use on a
line. The + operator must be used in an assignment statement:

sStringl = "Hello *;

sString2 = "world";

sString3 B s
After the three lines above, the following two lines would produce the
same result:

sString4 = sStringl + sString2 + sString3;

sString4 = sStringl + "world" + sString3;
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Use the += operator to append one string to another and change the value of one of them into the result. In the
following example, the value of sName would change to “Smith, John”:

sName = "Smith, "';

sFirstName = "John";

sName += sFirstName;

The Chr() keyword can be used to convert a numeric value into a one-element string:

sString5 = sStringl + sString2 + Chr("!17);
sString5 = sStringl + sString2 + Chr(33);

Working with Pointers

The use of pointers is an advanced programming technique that is very powerful. For more
information on using pointers, see “Pointer Commands” on page 330.

NOTE: Except for the equal operator (==), the comparison operators (see page 360) can be used only with
a numeric expression. They cannot be used with a null which is not considered to be a number.

For the following examples, assume that:

nl = 5;
1l = 9.2;
sl = ""test 123";

Using the “&” Character to Point to a Tag’s Address

A pointer variable or pointer table element contains the address of the object (tag) it is pointing to;
this is different than the tag itself. In OptoScript, the “&”means address of. It is used as a prefix to a
tag in OptoScript when moving the address of a tag into a pointer. PAC Control commands were
designed to act on tags and not just the address of the tags. The “&” prefix tells the controller to use
the address of the tag and not the tag itself.

Set the pointer. The types must match or the control engine will generate an error.

pnl = null;
pnl = &nl;
pfl = &F1;
psl = &sl;
pchtl = &Powerup;

Using the “&” Character to Move a Pointer
When moving a pointer to pointer, use the “&*" prefix.
To move a value from a pointer to another pointer:
pVariable0 = &*pVariableT;

To move a value from a pointer to a pointer table:
ptTable[0] = &*pVariable4;

Using the “*” Character to De-reference a Pointer

Use “*"to de-reference a pointer. It will then behave just like the variable to which it is pointing. The
following two statements are equivalent:

n2 =*pn1 + *pf]
n2=nl+fl;
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The “*"character has to be used as a prefix to a pointer in OptoScript so that the tag that is pointed
to will be used instead of the address of the tag. When using a pointer with normal PAC Control
commands you need to de-reference the pointer because PAC Control commands are designed to
use tags instead of the address of the tags.

Using the Comparison Operator “=="

To see if a pointer is pointing to something, use the comparison operator == (see page 360) to
compare it to null. This use is similar to standard PAC Control condition commands such as Pointer
Equal to NULL? For example:

n2 = pnl == null;

n2 = null == pnl;

it (ptl[0] == null) then

Determining Which Variable to Use

Pointers are very useful when you don't know what variables need to be used until runtime. For
instance, the next example uses a switch statement (see page 363) to determine which variable to
use based on the day of the week. It then uses a pointer to perform a calculation using the correct
variable.

switch (GetDayOfWeek())
case 0: // Sunday

pnl = n2;
break

case 6: // Saturday
pnl = n3;
break

default: // Monday-Friday
pnl =5 n4;
break

endswitch

Use the pointer to set the chosen variable.

*pnl = n5 * f1 - 5;

For More Information

For more information and examples of using pointers in OptoScript, see the following:
«  Pages "Pointer Commands”on page 330 and “Pointers and Indexing”on page 95.
«  See Appendix E: OptoScript Language Reference,

«  Download the OptoScript Examples. Either click here, or go to the Opto 22 website and search
for “OptoScript Examples.”
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Working with Tables

Following are some examples for using numeric, string, and pointer tables.

Numeric tables:

ntTablel[0] = 1;

ntTablel[1l] = 2.0;

ntTablel[2] = nVarl;

ntTablel[3] = ntTablel[2];

ntTablel[4] = ntTablel[ntTablel[0]];
ntTablel[5] = nvVarl + ntTablel[2] * 3.1;

nvVarl = ntTablel[0];
nvVarl = (ntTablel[0] + ntTablel[1]) * ntTablel[2];

String tables:

stStrT1[0] = *Hello, *;
stStrT1[1] = “world";
stStrT71[2] = stStrTl[0] + ™ " + stStrTl[1] + Chr("!'");

sStringl = stStrT1[2];

Pointer tables:

ptTable6[0] = &*pVariable2;
ptTable6[1] = &nvaril;
ptTable6[2] = &stStrT1[0];

stStrT1[0] = *ptTable6[2];

Pointer tables. Note that types are not checked when putting pointers into a pointer table. However, when a
pointer is moved from a pointer table element into a pointer variable, the types are checked at runtime by the
control engine and must match. For example, assume that the following elements have been placed in table
ptPointT:

ptPointT[0] = null;
ptPointT[1] = &nLED_A;
ptPointT[2] = &fTemp;
ptPointT[3] = &sStringl;

ptPointT[4] = &Powerup;

Based on this information, the first two of the following statements are good. The third one is bad and will cause
a control engine error, because the element at ptPointT[3] is a string and therefore does not match the variable
pntl, which is defined as an integer 32:

pnl = ptPointT[1];

pfl ptPointT[2];

pnl = ptPointT[3];

Expressions and Operators

OptoScript includes mathematical expressions as well as comparison, logical, and bitwise operators.
Because expressions and operators are built into the OptoScript language, several standard PAC
Control commands such as Multiply, Bit Shift, and Greater Than or Equal? are not used.
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Using Mathematical Expressions

Addition

nCount = nLast_Count + 2;
fPressure = 1.5 + fReading;
nTotal = nMonday + nTuesday + 10;

Subtraction
nNumber_A = nNumber_B - 250;
fRange = fMax_Temp - fMin_Temp;

Multiplication

N Division
nQuantlfy = nBoxes * 12; . nBoxes = nCount / 6;
nHours = nSeconds * 60 * 60; fConversion = fLimit / 2.0;
fMax_Speed = fSpeed * 16.52; B
Modulo division. If any argument is a float, it is
rounded to an integer before the division occurs. Mixture of operators.
nvarl = nVar2 % 2; nAvg = (nHrs_A + nHrs_B) / 2;
nvarl = 2 % nVar2 % nVar3; nVarl = fFloat2 + nvar3 * 4;

fFloatl = fFloat2 % 2.5;

Use parentheses to clarify groupings and meaning. You can use an unlimited number of parentheses.
nvVarl nvar2 * (fFloat2 - 2.0);
nvVarl (nvar2 + 2) * (nvar3 + (fFloatl / (fFloat2 - 2)) - 3);

The *, /, and % operators have greater precedence than + and -. (See Opto 22 page 421for the order of prece-
dence.) In the following lines, line #1 is equivalent to line #3, not to #2.

nl = n2 + n3 * n4;

nl (n2 + n3) * n4;

nl n2 + (n3 * n4);

Using Comparison Operators

All OptoScript comparison operators return an Integer 32 value of zero (false) or of non-zero (true).
OptoScript supports the following comparison operators for comparing two numeric values:

NOTE: Except for the equal operator (==), the comparison operators can be used only with a numeric
expression. They cannot be used with a null which is not considered to be a number.

Operator and Meaning Example
== equal nvVarl = nVar2 == fFloat3;
<> not equal nVarl = nVar2 <> fFloat3;

< less than nVarl = nVar2 < fFloat3;
<= less than or equal nVarl = nVar2 <= fFloat3;
> greater than nvVarl = nvar2 > fFloat3;
>= greater than or equal nvarl = nvar2 >= fFloat3;

More complex examples:
nvVarl (nvar2 * 2) == (fFloat3 / 9.5);
nvVarl (nvar2 * 2) < (fFloat3 / 9.5);
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You can also use a comparison operator to test whether two strings are equal. For example:
nVarl = sStringl == sString2;

nVarl = sStringl == "abc";

nvVarl = sStringl == stStrT1[0];

nvVarl = stStrT1l[0] == stStrT1[1];

When you use a comparison operator in an if statement, it isn’t necessary to put the result in a variable
because the result is used (consumed) by the if:
if (FICTD Input <= Avg_Temp) then
Fan_A = O;
endif

Using Logical Operators

All OptoScript logical operators return an Integer 32 value of zero (false) or of non-zero (true). OptoScript sup-
ports the following logical operators for numeric values:

Operator and Meaning Example

and Result is true if both values are true nvarl = nvar2 and nvar3;
or Result is true if at least one value is true  nVarl = nVar2 or nVar3;
Xor Result is true if only one value is true nVarl = nVar2 xor nVar3;
not invert the logical value nvVarl = not nVar2;

Logical operators are left-associative. For exam-

Any number of logical operators can be ple, these two lines are equivalent:

chained together: nVarl = nVar2 and nVar3 or

nVarl = nVar2 and nVar3 and nVar4; nVar4;

nvVarl = nVar2 and nVar3 or nVar4; nvarl = (nVar2 and nVar3) or
nvar4;

The following two lines are equivalent:

nVarl = not nVarl and not nVar2;
nvarl = (not nvVarl) and (not
nvar2);

The not operator precedes a value (it takes a value only on
its right-hand side):
nVarl = not nvVar2;

Logical operators can be combined with comparison operators to create complex logical expressions:

nvarl = (nVar2 < 1) and (nvar3 == 6.5);

nvVarl = (nVar2 < 1) and (sStringl == "abc");

nvVarl = ((nvar2 < 1) and (nvar4 xor nVar5) or (not (fFloatl == fFloat2));
nvarl = not (nvVar2 < 5); // same as 'nVarl = nVar2 >= 5;"

When you use a logical operator in an if statement, it isn’t necessary to put the result in a variable because the
result is used (consumed) by the if:
if (Motor_1 or Motor_2) then
Motor_3 = O;
endif
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Using Bitwise Operators

All OptoScript bitwise operators operate on integer values. OptoScript supports the following

bitwise operators:

bitand (pitwise and)
bitor (bitwise or)
bitxor (bitwise xor)
bitnot (bitwise not)
<< (left shift)
>> (right shift)

Use the bitwise and operator to and together the
two values bit by bit:

nl = n2 bitand 2;

nl = n2 bitand n3;

Use the bitwise or operator to or together the two values
bit by bit:

nl = n2 bitor 2;

nl = n2 bitor 0x0002;

nl n2 bitor n3;

Hex literals can be convenient:
nl = n2 bitand 0x0002;

Use the bitwise xor operator to xor together the two val-
ues bit by bit:

nl = n2 bitxor 2;

nl = n2 bitxor 0x0002;

nl n2 bitxor n3;

The left-shift operator shifts the left value's bits to the left by the right value:

nl = n2 << 2; /1 left shift n2's value by 2
nl = n2 << n3; /I left shift n2's value by n3

The right-shift operator shifts the left value's bits to the right by the right value:

nl = n2 >> 2; // right shift n2's value by 2
nl = n2 >> n3; //right shift n2's value by n3

Precedence

For a list of operators from highest to lowest precedence, see “Operators”on page 421.

OptoScript Control Structures

OptoScript provides the following structures to control the flow of logic in the code:

362

«  "If Statements” (below)

«  "Switch or Case Statements”on page 363
«  "While Loops”on page 364

«  "Repeat Loops”on page 365

«  "For Loops”on page 365
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If Statements

If statements offer branching in logic: if statement A is true, then one action is taken; if statement A is
false (or statement B is true), a different action is taken. /f statements are very flexible; here are
several examples of ways you can use them.

Since a comparison operator returns an
Any numeric value can be tested by the if statement (NOTE: The Integer 32 value, it can be used as the

value is first converted to an Int32): test value:
if (n1) then if (n1 > 3) then
fl = 2.0; fl = 2.0;
endif f2 = 6.5;
endif
An optional e I se statement can be
Complex logical operations can also be used: add_e:: 1> 3) th
if ((n1 > 3) and (not nl == 6)) then ! fgn_ 5 o? en
1= 2.0 2 = 6.5;
f2 = 6.5; T
endif else
3 = 8.8;
endif

Multiple e I se i T statements can be used to chain together sev-
eral tests. The el se statement is still allowed at the end.
if (n1 > 3) then

If statements can be nested. Each i f
requires an endi f:
if (n1 > 3) then

fl = 2.0; fl = 2.0:
T2 =6.5; f2 = 6.5;

elseif (n1 < -3) then T
3 = 8.8;

i 0
elseif (nl1 == 0) then T (n1 % 10) then

et = v fl = f1 * 2;
ctse 2= f2 % 3;
f1 = 0- else
2 = 0; 3 =0;
£3 = 0- endif
endif ? endif

Switch or Case Statements

A switch or case statement also offers branching logic and can be used in place of if statements
when the expression can match one of a number of numeric values. The value for each case can be
a numeric constant or a mathematical expression only. Comparisons and logical operators cannot
be used in cases, nor can strings. If a case involves a float, the float is converted to an integer before
use. Notice that only one case can be tested at a time.
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Here's an example of a switch statement.

The value of the expression in parentheses, NNumber, is compared
switch (nNumber) «—— toeach of the cases. If the case matches the value of nNumber, the

case 1: action is taken.
1 = 10;

break
case 2- '\ Make sure you use a colon (;) after each case.

Eljle;le; ™~ If a case matches the value of nNumber, the break statement after
case (N2 * 2): citation immediately exits the switch. Notice that a semicolon is not

f1 = 20; v\ used after break.

de'?‘gﬁ?lt(' ™~ You can use a mathematical expression as a case.
:% f (_)1 } ~—— If no case matches, the default action is taken. Using a default is
break ? optional; if you use it, it must be at the end of the list.

endswitch «——————— A switch statement must be followed by endswitch.

While Loops

The while loop is used to execute a list of statements while a given condition is true. The condition is
tested at the beginning of each loop.

For example, this loop sets the first five elements (elements O through 4) of a table (ntTable) to a

value of 10:
nlr_ldex = 0;« Initialize the counter.
while (nlndex < 5)¢ Execute loop if condition is true.

ntTable[nlndex] = 10; <«—
nindex = nindex + 1; <4—
wend

Set the table element.
Increment the counter.

While loops can be nested and can contain other kinds of program statements. Each whi le needs a
matching wend at the end. For example:

nl = 0;
while (n1 < 100)
while ((n1 > 50) and (n1 < 60))
ntl[nl] = nl1 * 100;
nl =nl+ 1;
wend
ntl[nl] = nl;
nl =nl+ 1;
wend
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Repeat Loops

Repeat loops, in contrast to while loops, are used to execute a list of statements until a given
condition is true. Because the condition is tested at the end of each loop, the content of the loop will
always be executed at least once.

This example sets the first five elements of ntTable to 10. Compare this example to the example for
while loops to see the difference.

nindex = 0; « Initialize the counter.
repeat
ntTable[nlndex] = 10; €—
nindex = nindex + 1; €4—
until (nIndex >= 5);¢—

Set the table element.
Increment the counter.
Exit loop if condition is true.

Repeat loops can be nested and can contain other kinds of program statements. Each repeat
statement needs a matching unti I statement at the end.

For Loops

Forloops can be used to execute a list of statements a certain number of times.

The for line sets up a predefined initial value and a predefined final value for the counter that
counts the repetitions. The line also includes the steps by which the counter gets from its initial
value to its final value (step 1 counts by ones; step 2 counts by twos, and so on). The step is
required. The counter can be any numeric variable or I/0 point, but its value will always be a whole
number. The initial value, final value, and step can be any numeric expression; they are converted to
integer 32s.

CAUTION: A step value of zero creates an infinite loop. A float step value between —0.5 and 0.5 also
creates an infinite loop, since it is rounded to zero when converted to an integer 32.

This example results in nVariable equaling 6:

nVariable = 1; The counter starts at zero, and its final value is 4.

for nCounter = 0 to 4 step 1 < It will count up one step at a time
nVariable = nvariable + 1; P P ’

next < The For loop must end with next.
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The for loop counter can be used in the loop. Other step amounts can be used, including negative

This example sets the first five elements of table fste:‘p.& Do not u§e a zero step, which creates an
ntTable to 10: infinite loop. This example sets elements 0, 2, and 4 of

= ntTable to 20:
fort$lgcljex ; g s ‘_1 i;(.ap ! for nindex = 0 to 4 step 2
nth aofelnindex] = ’ ntTable[nIndex] = 20;

next

Predefined values can be a numeric expression, but they are evaluated only at the beginning of the loop. For
instance, the following example will loop 0 to 15 because the upper limit of nSide*3 is evaluated only at the
beginning of the loop, not each time through the loop:
nSide = 5;
for nLength = 0 to (nSide * 3) step 1
nSide = 1;
next

For loops can be nested and can contain other types of statements. Each For requires a next at the
end.

Using the OptoScript Editor

1. To use the editor, create an OptoScript block in the flowchart where you want the code to
appear. (For more information on creating charts and blocks, see “8: Working with Flowcharts.”)
Double-click the OptoScript block to open the editor.

The editor is similar to the editor for Microsoft Visual Basic . You can resize the editor window as
needed to see the code.

ﬂ OptoScript - Dough_Chip_Control - Start Conveyor - Block 17 x|
Toolbar @ e ) | & | | | #h 8L| A ab
OptoScript Code:
Type OptoScript &
code in this area.
W
£ >
Output:
See results of
test compilein
this area. = Column
and line
Cancel Help Command Help Ln 16, Col 7 numbers
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The following tools are provided in the Optoscript toolbar:

Button Description Button Description

+O Actions Insert Action Command 4 Find

v Canditions Insert Conditions Command 2% Replace

H7) Variables Insert Conditions Command A Toggle Bookmark
27 Test Compile | Test Compile % Clear All Bookmarks
& Cut % Next Bookmark
Copy % Previous Bookmark

Paste &b Toggle Whitespace

i) Undo i= Increase Indent

o Redo i= Decrease Indent

Begin typing OptoScript code in the top area.

You'll notice that what you type is automatically color-coded to help you:

—  Blue—operators and control structures

- Purple—values

- Green—comments

- Black—commands and names of variables, I/0 points, charts, and other items
- Red—string literals.

If you want to see white-space marks to help line up code, click the Toggle Whitespace button
in the toolbar. To hide the marks, click the button again.

To use a command, place your cursor in the OptoScript code where you want the command to
appear. Click the Insert Actions or Conditions button in the toolbar.
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i Select Instruction

>
Groups: Instructions:
A A
Chart CalcSetAnalogOffset
Communication GetanalogMaxvalue
Control Engine GetAnalogMinValue
Deprecated GetanalogTotalizerValue
Digital Point GetClear AnalogMaxValue
Error Handling GetClear AnalogMinValue
1O Unit GetClearAnalogTotalizervalue
10 Unit - Event Message GetHartUnigueAddress
1/O Unit - Memory Map RampAnalogOutput
1/O Unit - Scratch Pad ReceiveHartBurstResponse
Logical ReceiveHartResponse
Mathematical sendReceiveHartCommand
Miscellaneous SetAnalogFilterWeight
PID - Ethernet SetAnalogGain
Pointers o SetAnalogloadCellFastSettel evel o
Sirnnil=tinn Getinalnnl nadCelFilteritizinht

[Jindude parameter helps

Cancel

Help Command Help

4, Inthe Select Instruction dialog box, select the command group from the left-hand column,

and then select the command name from the right-hand column.

For information on any command, highlight it and click Command Help, or just double-click

the command name.

NOTE: If you know the command name, you can just type it into the OptoScript code. Remember that
OptoScript command names may be different from standard PAC Control commands. See “E:

OptoScript Language Reference,” Opto 22 form 1700, for more information.

5. Toinclude information about the instruction in the OptoScript code, select “Include parameter

helps.”
6. Click OK.

The command appears in the OptoScript code.

7. Touseavariable, table, I/0 unit or point, chart, counter, timer, or similar item, place your cursor
where you want the item to appear in the code. If you know the item’s exact name, enter it and
skip to step 9. If you're not sure of the item’s name, locate it in the Strategy Tree, enter it, and

skip to step 9. Or for a variable, click the Add Variable icon g in the toolbar.
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Select Variable x
Type: Mame:
Al Valid Types aiDoughVesselPressure
- -
Analog Input aiOvenTemperature
Analog Qutput Alarms
Chart aoConveyorspeedControl
Communication Handle aoDvenTemperatureControl
Counter bStartFlag
Digital Input diChipLevelSwitch
Digital Qutput diDoughLevelSwitch
Down Timer Variable diEStop
E1l dilnspectionPassFailSwitch
E2 doChipDispenseValve
Float Table doDoughDispenzeValve
Float Variable doDoughPressureContralValve
Frequency doRejectvalve
G4EB2 Dough_Chip_Control
Generic OptoMMP Device Dough_Vessel_Pressure_Control
Integer 32 Table ditCookieMotionTimer
Integer 32 VYariable fDoughPressureSetpaint
Integer 64 Table fRampvalue
Integer 64 Variable fSetpointMinusDeadband
Off Pulse Mixed_IO_Unit
Off Totalizer e nChartStatus b
Cancel Help

In the Select Variable dialog box, select the variable type from the left-hand column, and then
select the variable name from the right-hand column.

The item appears in the code.
Use the Tab key on the keyboard as you type to indent lines as needed. To increase or decrease

indentation for a line of code you've already typed, highlight the line and click the Increase
Indent or Decrease Indent button in the toolbar.

Enter comments to document what the code does, so anyone who must debug or maintain
the code can clearly see your intentions.

Comments appear in green. Line comments must be preceded by two slashes, for example:
// This is a line comment.

Block comments must be preceded by one slash and an asterisk, and be followed by the same
two elements in reverse. For example:

/* This is a block comment that goes
beyond one line. */

Use the Bookmark buttons in the toolbar as needed to set or clear temporary bookmarks
within the code and to move between them.

Bookmarks mark lines of code so you can easily find them and jump from one bookmark to the
next. Bookmarks remain only while the editor is open; they are not saved when the dialog box
is closed.

When you have finished entering all the code for an OptoScript block, click the Test Compile
button in the toolbar to compile the code for this block.

The code is compiled, and the results appear in the bottom part of the OptoScript window:
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i OptoScript - Dough_Chip_Control - Start Conveyor - Block 17 4

me it |G| 4 BB A K %% | iE =

_ .
oo | ok AL

OptoScript Code:

-
S Caloulate the small increments of change to acConveyorSpee

fRampValue = (55.0 - aoConwveyorSpeedControl) » 20 .0;

s Loop twenty times
for nLloopCounter = 1 to 20 step 1
S Adjust aoConwveyorSpesedControl
aoConveyorSpesedControl = aoConveyorSpesdControl + fRampVali

s Delay for one second
DelaySec(l .03

ne=xt
w
£ >
Resultsaftercode Output:
is compiled T R e e
U errori(=), 0 warning(s=s)

Cancel Help Command Help Ln 3, Col 13

NOTE: The next time the chart is compiled, all OptoScript code within the chart will be compiled
again.

If errors are found, you can fix them now or later. Begin with the first one (the one on the
lowest-numbered line), since later errors are often a result of earlier errors. To check a
command, place the cursor anywhere in the command name and click the Command Help

button. If you need to add variables or other items that don't exist in the strategy, do so after
step 12.

13. When you have finished with the code in this OptoScript block, click OK to save your work and
close the editor.

You return to the flowchart.

Troubleshooting “Unable To Find” Errors

Also see “Troubleshooting Syntax Errors” below.

If you test compile an OptoScript block and receive “unable to find”errors, try the following
suggestions.

For Commands

Check the exact spelling of the command, including upper and lower case. OptoScript commands
are similar to standard PAC Control commands, but contain no spaces and some abbreviations.

Also check that the command is necessary in OptoScript. Some common commands, including
comparison commands such as Less? and mathematical commands such as Add, are replaced with

operators built into the OptoScript language. Check Appendix E: OptoScript Language Reference,
for equivalent OptoScript commands.
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The easiest way to make sure the command you enter is valid is to enter it by clicking one of the
Insert Command buttons in the OptoScript Editor and choosing the command from the Select
Instruction dialog box.

For Variables or Other Configured Items

Variables, I/0 units and points, counters, and other configured items in your strategy—as well as
charts—have usually been created before you use them in OptoScript code. Check their exact
spelling, including underscores and upper and lower case, to make sure they are correct in the code.
The easiest way to make sure spelling is correct is to enter the variable or other item by clicking the
Insert Variable button in the OptoScript Editor and choosing the item from the drop-down lists.

If the item has not yet been configured or created, use the normal PAC Control methods to do so. For
help, see the chapters in this guide on configuring I/0 and using variables.

IMPORTANT: In nearly all applications, you want points and variables to be identical in the Strategy
Tree and in OptoScript blocks. For example, if you change the name of a variable or point in the
Strategy Tree, you want the name changed in OptoScript blocks as well.

However, it is possible to turn off some of these automatic updates and cross-checks. To check
whether they've been turned off:

1.  With the strategy open in Configure mode, choose Configure > Options.
2. (lickthe Advanced tab.

PAC Control Options *
Workspace Debugger Advanced

[]When adding Pairts and Variables, do not check OptoScript blocks
[]When renaming Points and Variables, do not update OptoScript blocks
] Allow Points and Variables with references to be deleted

Cancel Help

3. lookto see if any boxes are checked. If they are, you may need to make manual adjustments.
(See more information in “Advanced Options”on page 214.)

Troubleshooting Syntax Errors

Check for the following common syntax errors:
Missing Code

Check for obvious errors first. For example, make sure nothing essential has been left out of (or
unnecessarily added to) a statement:

Sample Statement Should Be Missing Code
iTotal = x +y + ; iTotal = x +y + z; Last operator missing a variable
iTotal = x +y + z iTotal = x +y + z; Semicolon missing
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Sample Statement Should Be Missing Code

sGreeting = Hello!" |sGreeting = "Hello!" | First quotation mark missing on the string

Extra space in command name; parenthe-

iTime = Get Hours; iTime = GetHours(); ses missing after the command

x=Q+ & -Y); x=0+ &-Y); Parentheses mismatched (last half missing)

Check to make sure operators are used correctly. You may want to review “OptoScript Expressions
and Operators”on page 359.

If you are using control structures such as loops or if statements, especially if they are nested, make
sure all required elements are present. For example, every i ¥ must have a then and an endif. See
“OptoScript Control Structures”on page 362 for more information.

Type Conflicts

Type conflicts are caused when different data types are incorrectly mixed. For example, you cannot
assign an integer to a string. Make sure data types are correct. It is easier to keep track of data types
if you use Hungarian notation when naming variables. See “Variable Name Conventions”on

page 355 for help.

Debugging Strategies with OptoScript

372

Before trying to debug strategies containing OptoScript code, make sure the code has been
compiled within each block, or choose Compile All to do all blocks at once.

When you begin debugging the strategy, start by stepping through whole blocks. If you run across a
problem, then step within that block. Stepping within the block is discussed in “Choosing Debug
Level”on page 190.
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Introduction

This chapter shows you how to create and use subroutines.

In this Chapter

ADOUL SUDTOUTINES ..ovseveeeeeseeesseesss s ssssss s ssssss s 373
CreatiNg SUDIOULINGS ....vooooeevveeesceseeesesseeesesssseessssssses e sssssssessssssssessssosseesssnssoen 375
Using Subroutines.......... . . . . . e 381
Viewing Subroutines..... . . . . . . S 385
Printing Subroutines...... . . . . e 386

About Subroutines

A subroutine is a custom command that represents a series of commands. Subroutines are useful
anytime you have a group of commands that is repeated in a strategy or used in more than one
strategy. Subroutines are built using the same tools and logic used to create charts. Once built, you
can call them at any time from any chart in any strategy or from another subroutine. (You cannot call
subroutines recursively, though; that is, a subroutine cannot call itself, nor can a subroutine called by
a subroutine call the original subroutine.)

NOTE: To call a subroutine from another subroutine, you need SNAP PAC firmware R9.5a or higher.

Like charts, subroutines start at block 0 and move sequentially through command blocks to the end.
They use variables, inputs, and outputs. They can use OptoScript code. Each subroutine is displayed
in its own window, and you can open and view several subroutine windows at once.

Unlike charts, however, subroutines are independent from a strategy. You don't need to have a
strategy open to create or change a subroutine. And if you do have a strategy open, creating a
subroutine has no effect on the open strategy unless you specifically link them together.
(Debugging a subroutine, however, requires that it be called from a strategy.)

A second important difference between subroutines and charts is that subroutines offer two ways
to work with variables and other logical elements: they can be passed in or they can be local to the
subroutine.
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«  Passed-in items are passed into the subroutine by the strategy. They are referenced when the
subroutine is executed. If a parameter is passed by reference, the subroutine will pass the value
back to the strategy. For example, you could create a subroutine to add 3.0 to a passed-in float
variable. If they are passed by value, the updated value is not passed back to the strategy by the
subroutine. For more information, see the next section, “Data Types for Subroutines.”

When the subroutine ends, the float variable will contain a new value. Passed-in items are
called subroutine parameters, and you can use up to 12 of them in a subroutine.

«  Local items are created when a subroutine begins, and they are destroyed when it ends. For
example, a subroutine could take a passed-in item, copy it to a local variable, and add 3.0 to
that local variable for use within the subroutine. The local variable is created when the
subroutine is called, and it disappears when the subroutine ends.

Data Types for Subroutines

The following data types may be used in subroutines for both passed-in items and local items:
«  Numeric variables (integers, floats, and timers)

»  Numeric literals (integers and floats). If you are familiar with other programming languages,
literals are similar to “passed by value”parameters, while variables are like “passed by reference’
parameters. Other types besides numeric can be passed into the subroutine through literals,
however; see below for more information.

4

«  Numeric tables

«  String variables

«  String literals

«  String tables

+  Communication handles

The following data types are also supported:

«  For passed-in items: 1/0 points, I/0 units, and pointer tables

«  Forlocal items: pointer variables

The following data types are not supported in subroutines: PID loops and charts.

Although most variables passed in and out of a subroutine must be of a specific type, literals that are
passed into subroutines can take several types. Using a string literal, you can pass in either a string
literal or a string variable. Using a numeric literal, you can pass in an analog point, a digital point, an
integer variable, a float variable, or a timer variable.

This flexibility in using literals makes it easier to use a subroutine in multiple strategies. For example,
a literal passed into a subroutine from two strategies might be a float value in one strategy and an
analog point in the other.
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Creating Subroutines

Tips for Subroutines

As a general rule, keep subroutines as small as possible to do the job they're intended for. Extra
variables and unnecessarily large table sizes can affect the memory available for running
subroutines.

A Put Status In parameter appears automatically in every subroutine. This parameter is used to let
you know whether the subroutine was called successfully, in the same way that function commands
return a status. Make sure that you always check the status code after calling a subroutine.
Subroutine status codes are:

Success

-67 | Out of memory

-69 Null object error. Make sure you are not passing a pointer that points to null.

-72 Nesting too deep

-73 | select Global and Operand, and then click Find to search for objects with the

Invalid subroutine or parameters. In configure mode, choose Edit > Find,

same name as the subroutine. Rename any objects that you find.

Drawing the Flowchart

1.

2.

3.

In the PAC Control main window (with or without a strategy open), choose Subroutine > New.
The Create New Subroutine dialog box appears.

ﬂ Create Mew Subroutine b |
Look in: | inCookies v| e ¥ * [
MName - Date modified Ty

Mo items match your search.

£ >
File name: || | I Open
Files of type: | PAC Control Subroutine Files (*ish) ~ Cancel

Enter a subroutine name.

The name must start with a letter, but may also include numbers and underscores. It cannot
include spaces or other characters.

The subroutine name will become a command (instruction) in PAC Control. It's a good idea to
make it a descriptive name indicating the purpose of the subroutine, for example,
“Variable_Increase_Notification.” You cannot use the name of any existing command (for
example, “Add").

Navigate to the directory where you want to store the subroutine and click Open.
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Unlike strategies, multiple subroutines can be saved to the same directory.

A new subroutine window is created.

=i Variable_Increase_Motification EIIEI
....................... A
........ g T T
| Becko |
....................... v
< >

(i)shortcuts | 100% v
4[4[ > > Subroutine /

4. Add blocks and connections and name the blocks as you would in a chart, as shown in the
example below.

=S Variable_lncrease_Motification™ EI\EI

< >

{iiShortcuts | 100% w

[ Subroutine /

You can also copy existing flowchart blocks from another subroutine or chart and paste them
into the new subroutine. See "Cutting, Copying, and Pasting Elements”on page 227.

5. Save the subroutine by selecting Subroutine > Save.
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Configuring Subroutine Parameters

Before you can call a subroutine from a strategy, you must configure the variables and other logical
items that are passed into it. These passed-in items, called subroutine parameters, are the only
information that is shared between a subroutine and the calling strategy. Twelve parameters can be
passed into a subroutine, and since a table can be a parameter, those 12 parameters can include a
large amount of data.

An item passed into a subroutine may be called by one name in the strategy and by another name
in the subroutine. In fact, if a subroutine is used for more than one strategy, it is good practice to
select generic names in the subroutine. For example, if you create a subroutine to average values in
any float table, the table might be named Float_Table in the subroutine. You could use this
subroutine to average pressures in a table named Pressure_Values from a strategy, and
Pressure_Values would be referred to as Float_Table in the subroutine.

1. With the subroutine open, select Subroutine > Configure Parameters.

The Configure Subroutine Parameters dialog box appears.

4 Configure Subroutine Parameters - [m} *
Subroutine Name: Group:
| Variable_Increase_Motification | Subroutines ~

Subroutine's OptoScript Name:
| Variable_Increase_Motification |

Comment:

# Prompt Type Name RefCo. ™ Add...
1 PutStatusIn Integer 32 Vari... Mot Available S
Modify...

Delete

Cancel Help

In this dialog box you determine the way the subroutine is called from the strategy.

2. From the Group drop-down list, choose the command group you want the subroutine to
appearin.

For example, if you create a subroutine to find the average value of several variables, you could
choose Mathematical as the command group. The default group is Subroutines.

3. (Optional) Enter a comment to explain the purpose of the subroutine.
4. Notice that one parameter, Put Status In, has been automatically entered for you.

This parameter is used to return status information on the subroutine, and it always appears at
the bottom of the parameter list. A subroutine essentially becomes a command within a chart
or another subroutine, and subroutines are similar to function commands that return a status.
Since the system itself returns this status parameter, the name of the status parameter is not
available in the subroutine. When you add the subroutine to a strategy, you choose the variable
the status will be placed in.
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IMPORTANT: Make sure you always check returned status codes for all subroutines. Subroutine
status codes and their meanings are:

0 Success

-67 | Out of memory

-69 Null object error. Make sure you are not passing a pointer that points to null.

-72 | Nesting too deep

Invalid subroutine or parameters. In configure mode, choose Edit > Find,
-73 | select Global and Operand, and then click Find to search for objects with the
same name as the subroutine. Rename any objects that you find.

5. Foreach parameter you add, do the following steps.

NOTE: What you enter here appears in the Add Instruction dialog box when the subroutine is called
from within the strategy. See page 379 for an example.

a. Highlight the first empty line (below the Put Status In parameter) and click Add to open the
Add Subroutine Parameter dialog box.

lﬂ"’ Add Subroutine Parameter % T
Prompt: | | |
Marme: | |
Type: =

Cancel Help

b. Inthe Prompt field, enter the prompt text you want to show in the Add Instruction dialog
box in the strategy. This field is limited to 16 characters.

c. Inthe Name field, enter the name of the parameter (the argument) as it will be referred to
in the subroutine. This name is used within the subroutine only.

d. From the Type drop-down list, choose the type of item to be passed into the subroutine.
Use variables for values the subroutine changes (passed by reference); use literals for values
the subroutine uses but does not change (read-only or passed by value).

e. (lick OK. The parameter appears in the Configure Subroutine Parameters dialog box, above
the Put Status In parameter. (Scroll up to see it if necessary.)
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ﬁ Configure Subroutine Parameters

Subroutine Mame:
| Variable_Increase_Motification

Subroutine's OptoScript Name:
| Variable_Increase_Motification |

Comment:

Group:

| | Subroutines

# Prompt Type MName RefCo, ™

1 IF Integer 32 Vari... Counter 1]

2 PutStatusIn Integer 32 Vari... Mot Available

3

4

5 v

£ >
oK | Cancel | | Help

Add...
[ Madify...

lete

A

Reference
count

> Up-and
down-arrow
buttons

Repeat step 5 for each parameter. To change a parameter, highlight it and click Modify. To

change the order of a parameter in the list, highlight it and click the up- or down-arrow button
in the dialog box. To delete a parameter, highlight it and click Delete.

NOTE: You cannot delete the Put Status In parameter or change its order in the list, and you cannot
delete a parameter that has a reference count greater than zero (indicating that it is used in the
subroutine). Also, if you add or delete parameters after including a subroutine in a strategy, you may
receive an error and will need to add the subroutine to the strategy again.

7. When the parameters appear the way you want them in the list, click OK.

The parameters you have named can now be used in the subroutine’s commands.

Configured Parameters Example

Here's an example of a completed Configure Subroutine Parameters dialog box, showing three
parameters to be passed into the subroutine. When the subroutine is called from the strategy, these

parameters appear in the Add Instruction dialog box:
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ﬁ Configure Subroutine Parameters - O X
Subroutine Name: Group:
| Variable_Increase_Motification | Subroutines v
Subroutine's OptoScript Name:
| Variable_Increase_Notification | Names used in the
e subroutine may differ from
[ those used in the strategy.
# (Prompt Type Name RefCo, ™
L SiPg e | Do g Modify... Add/Edit Instruction
2 | Is Greater Than Integer 32 Vari.. Previous_Counter a - dialoa box in the strate
3 | Then Enter Text String Variable Warning_Motice i} Delete 9 9y
4 ut Status In e
2 & Edit Instruction >
_ Subroutine
- file name
| Variable_Ina'ease_Noﬁﬁl\aﬁon ~ Select...
Comment:
I |
(Fype ™ (Fame e
Prompt and Type If | Integer 32 Variable vl | Cookie_count e |
parameters from the
subroutine define Is Greater Than | Integer 32 Variable vl | Previous_cookie_count ~ |
theinstructionin the
Then Enter Text | String Variable ~ | | Production_status e |
strategy.
Put Status In | Integer 32 Variable vl | Sub_status e |
& A
Cancel Help Command Help

Adding Commands and Local Variables

Adding commands (instructions) to subroutines is exactly like adding instructions to charts. For
help, see “Adding Commands”on page 253. If you are using OptoScript code within a subroutine,
see Chapter 11 for help on creating code. You can copy and paste instructions from one block to
another within the same subroutine; if you have trouble copying and pasting instructions from one
chart or subroutine into another, simply paste the entire block and then modify it.

You may also need to add local items to be used in the subroutine only and discarded when the
subroutine is finished running. Adding variables to subroutines is also like adding variables to charts.
For help, see “Adding Variables”on page 239.

Remember that the subroutine is separate from any strategy and can be called by any strategy. I/0
units and points are specific to a strategy, so they cannot be added to a subroutine. Also, note that
commands and OptoScript code within a subroutine can use only the passed-in and local items in
the subroutine, not items in the strategy that calls the subroutine.
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Compiling and Saving the Subroutine

1. With the subroutine open, select Compile > Compile Subroutine.
When the subroutine has finished compiling, the cursor returns to its normal form.

2. Select Subroutine > Save.

Using Subroutines

To use a subroutine in a strategy, first add the subroutine to the strategy. Then, you can use it just like
a command in the logic within the strategy’s flowcharts, or within another subroutine that has also
been added to the strategy.

Adding a Subroutine to a Strategy

Since subroutines are independent of strategies, you must add the subroutine to the strategy before

you can use it.

1. With the strategy open in Configure mode, double-click the Subroutines Included folder on the
Strategy Tree (or in the menu bar, click Configure > Subroutine Included).

The Subroutine Files dialog box appears, listing all subroutines currently included in the
strategy. The example below shows no subroutines currently included.

4 subroutine Files: Cookies .
Subrautine Filename Ref Count Add...
Remove
Change Folder...

Cancel Help

2, (lick Add.
3. Inthe Select Subroutine File dialog box, navigate to the folder containing the subroutine you
want to add.
|;F' Select Subroutine File X |
Look in: | | | Subroutines v @ & = E
Name . Date modified Type
i Variable_Increase_Motification.isb 4/19/20716 11:41 AN I5B File
£ >
File name: | | Open |
Files of type: | PAC Control Subroutine Files (*isb) ~ Cancel
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4. C(lickasubroutine to select it, and then click Open.

5. The new subroutine’s name appears in the Subroutine Files dialog box. Click OK to save the
change and close the dialog box.

The new subroutine appears in the Strategy Tree in the Subroutines Included folder.

Removing a Subroutine

If the Remove button is grayed out when you select a subroutine in the Subroutine File dialog box, it
means the subroutine is used in the strategy. Before you can remove the subroutine, you must first
delete any references to it in the strategy.

1. Open the Subroutine Files dialog box, and then click the subroutine to remove.

ﬂ Subroutine Files: Cookies &
Subroutine Filename | Add
C: \MyStrategies\subroutines\Variable_Increase_Motification.isb Femaue
_. Change Folder...
{ }
oK [ Cancel | Help

2. (lick Remove, and then click OK to save your changes and close the dialog box.

Changing a Subroutine’s Folder

The Change Folder button helps when:

«  Asubroutine is saved in a read-only folder (which can cause errors when you attempt to
compile the strategy)

«  Yousimply want to change the location of a subroutine that is being used by a strategy.

To change a subroutine’s folder:
1. Open the Subroutine Files dialog box. The subroutine’s original folder and filename appear.

ﬂ Subroutine Files: Cookies &
Subroutine Filename | Add
C: \MyStrategies\Subroutines\Variable_Increase Motification.isb Pemaue
_. Change Folder...
{ }
oK . Cancel | Help

2. (lick the subroutine to select it, and then click Change Folder.
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In the “Choose a new location for” dialog box, navigate to the folder containing the subroutine.

I & Choose a new location for Variable_Increase_Motification > |
\oolcin: | MewSubroutinesFolder “ | (e Tt ol
MName - Date modified Type
SN Wariable_|ncrease_Notification.ish 1/19/2017 432 PM  15B File
£ >
File name: | I Open
Files of type: | PAC Control Subroutine Files {* isb) w Cancel

4. C(lick the subroutine to select it, and then click Open.
5. The subroutine’s name appears in the Subroutine Files dialog box. Click OK to save the change

and close the dialog box.

Using a Subroutine in Strategy Logic

You use a subroutine just like a PAC Control command: by adding the subroutine asa command to a
block in a chart or subroutine.

NOTE: Subroutines are located in the Subroutine group by default. If you want subroutines in a different
group, you must change the group when you configure the subroutine's parameters. See “Configuring
Subroutine Parameters” on page 377.

1.

With the strategy open in Configure mode, open the chart or subroutine that will call the
subroutine.

Double-click the block that will call the subroutine.

If it is an OptoScript block, list parameters (arguments) in order within parentheses, the same
way you enter parameters for PAC Control commands (see “OptoScript Syntax”on page 353).
Be sure to use the subroutine's OptoScript name, using underscores instead of spaces. The Put
Status In return value can be consumed by a variable (as shown below), a mathematical
expression, or a control structure.

nStatus = Variable_Increase_ Notification( bCondition, nValue, Outputl );

For more information on entering a command (instruction) in OptoScript, see “Using the
OptoScript Editor” on page 366.

In the Instructions dialog box, click where you want the instruction to be placed and then click
Add.

The Add Instruction dialog box appears.
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4,

Prompts—

i Add Instruction X
Instruction:
| Variable_Increase_Motification o Select...
Comment:
~
| Type Mame
If | All valid Types o | | ~ |
Is Greater Than | All Valid Types s | | w |
Then Enter Text [ All valid Types ~| | v
Put Status In | Al valid Types w | | | w |
o v
Cancel Help Command Help

& Add Instruction >
Instruction:
Absolute Value w Select...
Comment:
Type Name
of | All valid Types ~ | | aiDoughVesselPressure ~ |
Put Resultin | all valid Types w | | anConveyorSpeedControl w |
Cancel | | Help | | Command Help |

In the highlighted Instruction field, enter the subroutine name (or choose it using the
drop-down list, or click the Select button and locate it in the command group you chose).

NOTE: If you click Select, you will find subroutines located in the Subroutine group by default. If you
want subroutines in a different group, you can change the group when you configure the Subroutine's
parameters. See “Configuring Subroutine Parameters” on page 377.

The subroutine command appears in the dialog box, just as any command would, and the
prompts you entered when you configured the parameters appear also.

Choose the Type and Name for each prompt from the drop-down lists.

You can configure variables on the fly as you would with any command. Remember that the
Type was chosen when the parameters for the command were configured, so your Type
choices may be limited.

When the Add Instruction dialog box is completed, click OK.

Click Close to close the Instructions dialog box and return to the chart.
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The chart or subroutine is now set up to call the subroutine.

Debugging Subroutines

Debugging a subroutine is just like debugging a flowchart. When you are debugging a strategy that
calls the subroutine, make sure the debug level is Full Debug (see page 190). Then use the Step Into
button to step inside the block that calls the subroutine. The subroutine window automatically
opens, and you can continue to step through blocks or lines inside the subroutine. As you step
through blocks, subroutines, and charts, the tabs at the bottom of the window let you know where
you are (see “Using Tabs to View Open Windows” on page 59).

You can also set breakpoints on any subroutine block as needed. See “Setting and Removing
Breakpoints”on page 194 for more information.

Viewing Subroutines

Since subroutines appear on the Strategy Tree, it is easy to view information about them. A
subroutine appears in two places on the Strategy Tree: in the Subroutines Included folder and in the
folder for the chart or subroutine that calls it.

Cookies Lol x |

= [[T) Cookies

| Contral Engines . . . .
O 5 Subroutines Induded This subroutine appears in the Subroutines Included

e folder and also under the subroutine that calls it.

o =& Variable_Increase_Motification —_

(B Passed Parameters 71 This subroutine appears in the Subroutines Included
=) Variables folder and also in the folder for the calling chart
= Iy Subroutines Used (Dough_Chip_Control).
=& Chedc_Day_Time
B I3 Charts
EIO Alarms

= EIO Dough_Chip_Contral
= |55y Subroutines Used
=& Variable_Increase_Notification
EIO Dough_Vessel_Pressure_Control
EIO Owen_Inspection_Control
EIO Powerup
| Variables
I 1/0 Units

| V| dL Mext 47 Prev

You can view, add, and change variables in a subroutine from the Strategy Tree, just as you would for
a chart.

Viewing All Subroutines in a Strategy

To see all the subroutines in a strategy, double-click the Subroutines Included folder on the Strategy
Tree. All subroutines associated with the strategy are listed in the Subroutine Files dialog box. Click
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and drag the right side of the box to see all the information. The path, file name, and reference count
(how many times the strategy refers to the subroutine) are shown for each subroutine.

Printing Subroutines

For steps to print a subroutine’s graphics, see “Printing Chart or Subroutine Graphics”on page 199.
To view and print instructions in the subroutine’s blocks, see “Viewing and Printing Strategy or
Subroutine Elements”on page 203.
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This appendix provides general tips for resolving problems you may encounter while running PAC
Control or communicating with your hardware. If you encounter problems with permissions in
Windows, see page 395.

For information about types of errors and lists of error codes, see “B: Errors and Messages.”

Also check troubleshooting information in your controller’s user guide. See also form 1690, the SNAP
PAC Brain User's Guideform 1.

How to Begin Troubleshooting

You've built your strategy, but now you get errors when you try to download it, or it won't run
properly. How do you begin to figure out what's wrong? The problem may be in communication
with the control engine, in communication between the control engine and I/0, in a command, or
in the strategy logic. Following are some steps to help you discover the cause.

1. Read Any Error Message Box

If an error message box appears on the computer running PAC Control, it's probably a PAC Control
error. Here's an example of a PAC Control error message:

Opto Error

'E Timeaout while connecting to device, Check hardware connection, address, power, and jurpers,

Code: -10033

2. Check Communication with the Control Engine

If there is no error message box, or the error indicates that there may be a communication problem,
check whether the PC running PAC Control is communicating with the control engine. See
“Checking Communication with the Control Engine” on page 390.
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3. Check the Message Queue

If communication with the control engine is OK, check the message queue. To open the queue, see
“Inspecting Control Engines and the Queue”on page 111. In the “List of Common Messages” on
page 399, look up any errors you find in the queue. Errors are listed in numerical order. Queue errors
may indicate problems with a command or with communication to I/O. Check the possible causes
for help in fixing problems.

«  Forhelp with a command, look up details about the command in the PAC Control Command
Reference or online help.

«  For help with communication to I/0, see “Resolving Communication Problems” on page 391.
Many of these suggestions apply to 1/0 as well as to control engines.

4. Check Status Codes in Your Strategy

If all is well up to this point, double-check Status Codes in your strategy. Status Codes are responses
to a command that appear in a variable within your PAC Control strategy or as returned values in
OptoScript. Your strategy should routinely check status codes and adjust logic as necessary to
respond. It's especially important to check status codes when you use a command that starts a chart
or subroutine, to make sure it started successfully.

Status codes may indicate problems with a command or communication to /O, or they may
indicate a problem in the strategy logic. See “List of Common Messages” on page 399 for more
information. Again, look at the possible causes for help in fixing problems.

5. Call Product Support

If you cannot find the help you need in this book, the PAC Control Command Reference, or the SNAP
PAC Brains User’s Guide, call Opto 22 Product Support. See “Product Support”on page 4 for contact
information.

Strategy Problems

388

If You Cannot Delete an Item

Sometimes when you try to delete an item in a strategy—a variable, a chart, an I/O unit or point—
you receive a message saying “You cannot delete an item with a reference count greater than zero.’
This message means you cannot delete the item because other elements in the strategy use it.

4

You can use Find to locate all references to the item you want to delete. For help in using Find, see
“Searching”on page 208.

Sometimes the reference counts can become incorrect due to cutting and pasting variables or
importing charts into a strategy. If a reference count appears to be incorrect, you can rebuild the
strategy database by following these steps:

1. With the strategy open in Config mode, choose Tools > Regenerate Reference Counts.
2, Choose Compile > Compile All.
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3. Choose File > Save All.

The strategy database is rebuilt and the reference counts should be correct. If they are not, you
may need to choose Tools > Regenerate Reference Counts more than once.

If You Have Memory Problems

Control engine memory is allocated as shown in detail in form 1646, the SNAP PAC Memory Usage
Technical Note.

On your controller, you can see the amount of RAM and the amount of battery-backed RAM
available for use by inspecting the control engine in Debug mode (see page 111). Battery-backed
RAM stores persistent variables, variables initialized on download, autorun flag, and optionally, an
archive of the strategy. Note that strategies are not saved in battery-backed RAM. Save your strategy
to flash memory so it will be available if the control engine is rebooted. See “Saving a Strategy to
Flash”on page 178.

Check Strings and Tables

In general, if you experience memory problems, you can reduce the amount of memory needed by
checking strings and tables for lengths and widths that are longer than necessary.

Since the battery-backed RAM contains persistent variables and variables initialized on download
and optionally stores a strategy archive, you may need to adjust the length of tables or the width of
strings and string tables.

The currently running strategy is not stored in battery-backed RAM. To make sure the strategy will
run after a control engine reboot, save the strategy to flash memory after downloading it. See
page 178 for information on saving to flash.

Subroutines and Memory

When you use subroutines, use the minimum number of variables and the minimum size of tables
that the process requires. Here are some additional things to keep in mind:

«  Less memory is used if only one chart in the strategy calls subroutines than if multiple charts
call subroutines.

«  Using nested subroutines (that is, subroutines that call other subroutines) uses more memory.
(To use nested subroutines, you need SNAP PAC firmware R9.5a or higher.)

Make sure your strategy logic checks the value of the “Put status in"variable when starting a chart or
calling a subroutine to make sure they start correctly. When a chart or subroutine starts, if there is
not enough memory available to process it and all the subroutines called within its logic, you will
receive an error in the “Put status in"variable for that command.

Archiving Strategies to Battery-Backed RAM

Strategies can optionally be stored in battery-backed RAM on the control engine. In addition to an
archived strategy, battery-backed RAM holds persistent variables and variables that are initiated on
download. If you have a large strategy, large tables, or wide strings or string tables, you may not
have sufficient space for an archived strategy. Strategies can optionally be stored in battery-backed
RAM on the control engine. See page 179 for more information on archiving.
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Do You Use Online Mode?

If you use Online mode to change your strategy, you may run out of memory. When you change a
chart in Online mode, a new copy of that chart is downloaded to the control engine, causing
additional memory to be used.

To avoid memory issues, it may be necessary to periodically do a full download of the strategy.

Checking Communication with the Control Engine

You can test communication with the control engine by using PAC Terminal.
1. Start PACTerminal as follows:

- InWindows 7 and Windows Vista, press the Windows Start key _ and then click
Programs > Opto 22 > PAC Project 9.6 > Tools > PAC Terminal.

- InWindows 10 and Windows 8.1, press the Windows Start key
9.6 and then press the Enter key.

:--._.; PAC Terminal

The PAC Terminal window appears, showing all control engines configured on your system:

= PAC Terminal - olEd
Eile Tools Configure View Help
Control Engines:
Controller iQame System Type Address 1 Address 2 Status
$¥ Cookie Controller  Standard v¥127.0.0.1 =
$¥R1 Controller Standard v10.195.55.111 %
Status Scan
=, Scan All
“% Scan Selected
< >

2. Ifno control engine is listed, configure one by choosing Configure > Control Engine and
following directions on the screen. See “Configuring Control Engines”on page 99 for help.

3. To verify that a control engine in the list is communicating, double-click the control engine’s
name.
The Comm. Loop Time (communication time) in the Inspect Control Engine dialog box
indicates how long it takes to gather the information in the dialog box and is a good relative
indicator of communication time.
This dialog box also shows the status of the current strategy and any errors in communication
with the control engine. For further explanation, see “Inspecting Control Engines and the
Queue”on page 111.

4. |Ifyoureceive an error indicating a communication problem, go on to the next section.
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Resolving Communication Problems

Matching PAC Control Configuration to the Real World

/0 unit and point configuration in PAC Control must match actual I/0 units and points with which
the control engine is communicating. See brain and 1/0 module data sheets for specifications and
information.

Resolving TCP/IP Cannot Connect Errors (-412)

Many problems with Ethernet connections return a TCP/IP Cannot Connect error. Cannot connect
errors are probably the most common communication problem with control engines. They indicate
that a TCP/IP connection could not be made to the control engine within the specified time interval.

If you receive this error, first check the following:
«  Make sure the control engine has been turned on.
«  Verify that the correct IP address appears for the control engine.

«  Make sure your control engine has been assigned a valid IP address. These controllers and
brains come from the factory with a default IP address of 0.0.0.0, which is invalid. For help in
assigning an IP address, see Opto 22 form 1704, the PAC Manager User’s Guide.

«  Make sure you have up-to-date drivers installed on your computer's Network Interface Card
(NIC). Contact your system administrator or the manufacturer of the card for help.

«  If problems persist, you can increase the length of time before a timeout occurs. Choose
Configure > Control Engines and change the Timeout (mSec) field to a larger number.

Pinging the Control Engine
If you still cannot communicate with the control engine after you have checked these items, try to
reach it using the Windows PING command.
1. To ping a control engine, open a Windows Command Prompt:
—  ForWindows 7, Windows Vista, and Windows XP, click the Windows Start menu, and then
and then click Programs > Command Prompt.

- ForWindows 10 or Windows 8.1, press the Windows Start key, type cmd and then press
the Enter key.

2. Atthe prompt, type ping and the control engine’s IP address, and then press Enter.
Example: ping 10.192.54.40
If data is returned from the control engine, the control engine can be found on the network.

If the PING command cannot be found—\erify that the PC has TCP/IP bound to and configured
on the network adapter in Windows'Network and Sharing Center. To open Windows Network and
Sharing Center:

1. Open Windows Control Panel.

- If Control Panel is set to View by: Category, click the View by drop-down list, and then
click Large icons.

— Inthe Large icons view, click the Network and Sharing Center icon.
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2. Onthe left side of the Network and Sharing Center window, click Change adapter settings.

3. Inthe Network Connections window, right-click your network connection, and then click
Properties on the pop-up menu.

4. On the network properties’ Networking tab, make sure Internet Protocol Version 4 (TCP/IPv4) is
present and checked.

5. Cick Internet Protocol Version 4 (TCP/IPv4) to highlight it, and then click the Properties button.
If the IP address is not automatically obtained, verify that the IP address, subnet mask, and
default gateway are appropriate for your network.

If you see the message “Destination host route not defined,” the control engine probably has
an IP address and subnet mask that are incompatible with those on the computer. Subnetwork
numbers and netmasks must be identical on the control engine and the computer.

If you see the message “No response from host,” check the following:
- Are the computer and control engine correctly connected? Is the control engine turned on?

— Are the IP address and subnet mask on the control engine compatible with those on the
computer?

If your host computer has more than one Ethernet card, check your route table to make sure packets
are routed to the correct adapter card.

If all else fails, connect the PC and the control engine using an Ethernet crossover cable, and retest
the connection.

If you still cannot ping the control engine, contact Product Support. (See page 4.)

Other Troubleshooting Tools

392

Checking Detailed Communication Information Using PAC
Message Viewer

For detailed information about each communication transaction, use the PAC Message Viewer tool.
To open PAC Message Viewer:

—
— InWindows 7 and Windows Vista, press the Windows Start key , and then click
Programs > Opto 22 > PAC Project 9.6 > Tools > PAC Message Viewer.

s
— InWindows 10 and Windows 8.1, press the Windows Start key , type PAC Message
Viewer 9.6 and then press the Enter key.

You can also start PAC Message Viewer from:
«  PACTerminal’s menu bar, by clicking Tools > Start PAC Message Viewer
«  PAC Control in Debug mode by clicking Debug > Sniff Communication.
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The PAC Message Viewer window appears.

5 PAC Message Viewer,

File Wiew Help
PaLise Clear lessages sniffed: 0

In most cases the main window is blank, indicating that no messages are being monitored
between the PC and the active control engine. In some cases, for example when PAC Control
launches PAC Message Viewer, messages should appear immediately.

To start monitoring or change the level of monitoring, choose View > Monitor Levels.

The Monitor Levels dialog box lists all the possible levels to monitor. You can click Refresh to
make sure the list is up to date.

'S Monitor Levels E

Al

iobdvad:low-level, 1 wzer, handle 00000002
ioMwd:midHlevel, 1 uzer, handle 00000001

Hone

Refresh

Cloze

Highlight one or more of the monitor levels in the list, and click Close.

You return to the PAC Message Viewer window, where the changes you made are reflected at
once. To stop monitoring, click Pause. To start monitoring again, click Resume. To erase all
messages from the window, click Clear.

By default, communication messages in PAC Message Viewer are automatically saved to a log
file named IOSNIF.LOG. You can toggle saving on and off by choosing File > Log to File.

Also by default, messages are temporarily stored in system cache memory before being saved
to the log file. If you are having trouble with system crashes and need to capture messages just
before a crash, however, you can choose File > Flush File Always to send messages directly to

the log file.

To view or edit the log file, choose File > Edit Log File.
The file opens in a text editor. Logging is turned off when you open the file.
View or edit the file as needed, and then close it.

You return to the PAC Message Viewer window.
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5. Toresume logging, choose File > Log to File.

6. Torename the log file or change its location, choose File > Select Log File. Navigate to the
location where you want to save the file and enter a name. Click OK.

7. When you have finished monitoring communication, close the PAC Message Viewer window.

If you leave it open, it will normally appear on top of other running programs. If you don’t want
it to appear on top of other programs, choose View > Always on Top to toggle that option.

Checking File Versions for Opto 22 Software

Sometimes problems may be caused by older or misplaced files. Product Support may ask you to
run OptoVersion to check the versions and paths of your Opto 22 .dll and .exe files. Here's how:

1. Start OptoVersion as follows:

- InWindows 7 and Windows Vista, press the Windows Start key &4, and then click
Programs > Opto 22 > PAC Project 9.6 > Tools > OptoVersion.
)

- InWindows 10 and Windows 8.1, press the Windows Start key i, type OptoVersion

9.6 and then press the Enter key.

= OptoVersion Utility |Z”'~_:'Ir>__<|

File Wersion Optoersion | Date | Location |

=

Click Find to zearch for Opto 22 files on your hard drives.

Heb | | [ Fnd | close

2. Inthe OptoVersion window, click Find.
The utility searches your hard drive and prints a list of Opto-related files found.

3. Tosee more information on any file, double-click its name. To sort the list in a different order,
click any column heading.

4. Toemail the information to Opto 22 Product Support, click E-mail.
The utility saves the list to a file named Version.bd in the same directory that contains
OptoVersion.exe. If you use Microsoft Outlook as your email program, a new message
automatically appears addressed to Product Support, with the version file attached.

5. If you use Microsoft Outlook, add comments to the new message and click Send.

6. Ifyou use another email program, attach the Version.bd file to an email message and address
the message to support@opto22.com, along with an explanation of the problem you're
experiencing.
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7. To save the file, click Save As. Give the file a name and save it in the location you want.

OptoVersion also creates a tab-delimited file with the same file extension and in the same
directory. This file has the same name you gave it but with _Delimited added. Forexample,
if you name the saved file Opto_software . txt, the tab-delimited file is named
Opto_software_Delimited. txt. This file can be opened in Microsoft Excel or other
programs to easily sort and view its contents.

Problems with Permissions in Windows

When you set up controllers on a computer running the Microsoft Windows operating system,
typically you are using the computer with top-level “administrator” privileges. If someone later uses
this same computer to run PAC Control or PAC Display, but logs in to the computer with lower-level,
non-administrator privileges, the application may not recognize control engines that have been
previously configured.

If this problem occurs, you can modify the permissions to let specific users access previously
configured control engines without having administrator access. This is done using the Registry
Editor utility. Follow the steps below.

CAUTION: Use the Windows Registry Editor carefully. It is strongly recommended that you make a
backup copy of your Windows Registry before continuing with this procedure. Without a backup copy, if you
delete the wrong properties and cannot return the Registry to its original state, application and system files
can become unusable and will have to be reinstalled.

1. Logon asan administrator on the computer where PAC Control or PAC Display is installed.

2. Onyour keyboard, press the Windows Start key, type run and then press Enter. The Run
dialog box appears.

3. Inthe Openfield, type regedt32 and then press Enter:
NOTE: This is NOT regedit.exe, which is a similar tool.
If a User Account Control window appears, click Yes to continue.
The Registry Editor window appears.
4, Inthe left pane, double-click the HKEY_LOCAL_MACHINE folder to expand it.
In the HKEY_LOCAL_MACHINE folder, double-click the SOFTWARE folder to expand it.
6. Navigate to the Opto 22 folder by following the instructions for your system type.

- For 32-bit operating systems, in the SOFTWARE folder, click the Opto22 folder to highlight
it.

b

- For 64-bit operating systems:
-~ Inthe SOFTWARE folder, double-click the WOW6432Node folder to expand it.
- Inthe WOW6432Node folder, click the Opto22 folder to highlight it.
7. With the Opto22 folder highlighted, click Edit > Permissions on the Registry Editor menu bar.
The Permissions for Opto22 dialog box opens.
8. (lick Add.

9. Inthe Select Users, Computers, or Groups dialog box, type the name of the user or group that
should have control engine access, and then click OK.

The Permissions for Opto22 dialog box reappears.
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10. Ifitis not already selected, check the “Full Control—Allow”box in the Permissions area.
11. Click OK to save your changes and close the dialog box.
12. Click File > Exit to close the Registry Editor.

The added users will need to restart their computers for the new permissions to take effect. Then
they will be able to use control engines without having administrator access.
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Introduction

This appendix discusses errors and messages you may see in PAC Control and their possible causes.
Errors and messages may appear with text only or with a negative number and text. The more
common errors and messages are listed in this chapter in numeric order, starting on page 399.

To look up an error in PAC Control, select Help > Error Lookup. In the Error Lookup dialog box, enter
the error code, and then click Get Error.

Error Lookup FZ|

Error code: |01 [ GetEror

Error Description:

QOperation performed successhully,

Claze

See also, “A: Troubleshooting” on page 387 for additional help in resolving errors.

Types of Errors

As you work in PAC Control, you may see three types of errors:
«  PAC Control Errors appear in dialog boxes on the computer screen.

«  Queue Messages (both errors and other messages) appear in the control engine’s message
queue.

«  Status Codes appear in variables or as returned values in OptoScript.

PAC Control Errors

PAC Control errors indicate a problem within PAC Control that may have been reported by the
control engine or may have occurred before control engine communication.
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PAC Control errors appear in dialog boxes on the computer running PAC Control. Some of these
errors appear as numbers, some as text, and some show both numbers and text. An example of a
PAC Control error is “Timeout. No response from device.” Another example is “TCP/IP: Cannot error”
with an error code of -412.

Queue Messages

Queue messages indicate an error or other message during strategy operation, and they appear in
the PAC Control message queue. (For information on viewing the queue, see “Viewing the Message
Queue”on page 113.) Here’s an example of a message queue:

 Yiew Message Queue for, “Cookie Controller™

=sRefresh =3 Copy Al Eanp Top Message | ¢ Clear All Messages
# | Code | Severty | Description Chart Block Line | Object | Time Date ~
o4 Info Device has powered up, [Powerup clear e, <aystem; _INIT_... NA& Még Miged |, 190203 09/06/07
1 -3 Wharming A0 point mizmatch; a configured point doe... <spster: _IMIT_... Mag Miga ao0ven.. 1%0203  09/06/07
2 38 Wharming A0 point mizmatch; a configured point doe... <spster: _IMIT_... Mag Miga aoCore.. 190203 09/06/07
3 38 Wharming A0 point mizmatch; a configured point doe... <spstern: _IMIT_... Mag Mig ailwen.. 1m0203  09/06/07
4 700 waming  PID Loop O has been configured outside of... <spstem: _IMIT_... Mag Még Miged |, 190203 09/06/07
5 13 Error Dwerflow eror, Dough_Chip_Co.. 17 Méa [rull) 180221 09/06/07
g 13 Error Dwerflow ermor, Dough_Chip_Co.. 17 Méa [rull) 1m:0221  09/08/07 A
MHumber of meszages: 12

This queue shows several types of messages that you might see. To see all the information in a
column, drag the edge of the column heading to the right.

Code. Queue errors generated by the system are shown as negative numbers in the Code column.
For example, if you specify a table index that is greater than the number of elements in the table, an
error-12, “Invalid table index,” appears, as in message #3 above. Common queue errors for each
command are listed in the PAC Control Command Reference and in online help.

If the Code column indicates User, the error is one you have placed in the queue using the command
Add Message to Queue. User messages can help with troubleshooting. Message #2 above is an
example of a message the user placed in the Temperature_Control chart.

Severity. The Severity column indicates the type of message: information, warning, or error.

Chart, Block, Line, Object. If a PAC Control command in the strategy caused an error, the chart
name, block number, and line number (if you are in Full Debug mode) where the command appears
are listed. Message #3 above is an example: an invalid table index was used in block 19 of the
Temperature_Control chart. The Object column shows the table name.

If an error did not occur in a strategy chart, the Chart column shows <system>. Messages 1 and 2
occurred when the strategy was unable to initialize an 1/O unit, so the Chart column shows <system:
_INIT_IO>. Block and Line do not apply, but the Object column shows the name and IP address of
the 1/0 unit.

If an error was caused by a subroutine, the Chart column shows the name of the chart that calls the
subroutine, and the Block column shows the name of the subroutine and the block number where
the error occurred, in the format <subroutine name>.<block number>. Messages4,5,and 6
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are examples; these errors occurred in block 1 of the subroutine Variable_Increase_Notification,
which was called by the Temperature_Control chart.

Using Queue Messages

If a block number is listed for the error, look in that block in the strategy to find the PAC Control
command that caused the error. The easiest way to find a block is to open the chart or subroutine,
then choose Center on Block from the View menu. You can click the Block column to sort the blocks
by number and locate the one with the problem.

To see which line within a block is causing the error, in PAC Control Configure mode, choose
Configure > Full Debug. When the error appears in the queue, it will include the line number of the
command as well as the block ID.

Status Codes

Status Codes indicate the success or failure of a PAC Control command (instruction), and they are
reported by the control engine to a variable in your PAC Control strategy or as a returned value in
OptoScript. The status code is either zero (indicating a successful command) or a negative number
(indicating an error).

For example, suppose you use the command Transmit Numeric Table. You create a variable named
Transmit_Status to put the status of the command in. In Transmit_Status you receive either a zero,
indicating that the table was successfully transmitted, or you receive a negative number such as -37
or -42.

Status codes that may be returned are listed for each command in the PAC Control Command
Reference and in online help.

Naming Conflicts

During various procedures, PAC Control checks for duplicate names of objects such as variables,
charts, subroutines, strategy variables, OptoScript instruction names, and reserved keywords. If a
naming conflict is found, you may need to rename an object or perform some other housekeeping
procedures. When converting to a newer PAC Project, make sure to update PAC Control strategies
first and then PAC Display projects so that PAC Display projects are updated based on changes to the
strategy database.

List of Common Messages

The following messages may appear in PAC Control. They are listed in numeric order.

If an X appears in the Q7 column, the code number appears in the message queue. If an X
appears in the I/0? column, the message is an I/0 unit error and may appear either in the
message queue, as a status code in a variable, or both. For more information on handling 1/0
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unit errors, see “Error Handling Commands”on page 314 and form 1776, Optimizing PAC Project

System Performance.

table.

# Description Possible Cause Q? | 1/0?
0 Operation performed successfully. NOT AN ERROR. Indicates the command was successful.
-1 Undefined command. An unknown command was sent to the PAC Control engine.
When comparing DVFs (Data Verification Fields), a
-2 Checksum or CRC mismatch. mismatch occurred. Examples of DVFs include checksum
and CRC.
In string manipulations, a string was requested that is longer
-3 Buffer overrun or invalid length error. than the string it will be put into, or the destination string X X
length <= 0.
4 Device has powered up. ('Powerup clear NOT AN ERROR. The device has been turned off and then X
expected' message received.) on again since the last communication, and is now ready.
An attempt to store the strategy to flash failed, or an attempt
-5 Operation failed. to do something with a chart failed (like call, continue,
suspend, start, initialize threads).
Invalid year entered (must be between 2000 and 2099), or
-6 Data field error. invalid data read from memory when attempting to read the X
strategy from flash memory.
-7 Watchdog timeout has occurred. See “Add I/0O Unit Dialog Box” on page 127.
Invalid data read when attempting to read a strategy from
-8 Invalid data. flash, or an invalid character number was passed to a string
function.
. Valid range for Ethernet is 0-65535. For a communication
-10 Invalid port number. . . X
handle, serial port format may be incorrect.
A Transmit or Transfer command fails when using a comm
-1 Could not send data. handle. For example, an attempt is made to send a file to a
remote ftp server that has gone off-line.
12 Invalid table index. Used an index greater than the number of elements in the X X
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Description

Possible Cause Q?

1/10?

-13

Overflow error.

Typically, a math result too big to fit in the value passed,
while doing number conversion functions such as
converting a float value to engineering units, a float to an
unsigned integer, a float to an integer, a 64-bit integer to a
32-bit integer, a floating point value to a 64-bit integer, a
floating point value to an unsigned 64-bit integer, an ASCII
value to a float.

NOTE: In OptoScript, an If Statement expects an 32-bit
number and will automatically convert any other type (such
as 64-bit integer or float value) to a 32-bit number. To avoid
this overflow error, a slight change to the code can avoid this
problem. For example:

if (your_int_64_here) then...
becomes:
if (your_int_64_here <> 0) then...

Also math functions such as multiply, exponentiation,
hyperbolic sine, hyperbolic cosine, function x to the y, add,
subtract, modulo, negate, move/assign.

Time/date functions: setting a month not in the range 1-
12, a day not in the range 1-31, hours not in 0-23,
minutes 0-59, seconds 0-59.

Number entered on host port (for example, through PAC
Terminal) was too big for data types.

14

Invalid number.

Math resulted in an invalid number (like infinity or an
imaginary number): natural log of the floating point number,
square root, arc sine, arc cosine of float, function x to the y
(with negative x).

-15

Cannot divide by zero.

Attempted to divide a number by zero.

-16

Bus error.

Contact Product Support. See Opto 22 page 4.

-17

Port already locked on PAC Control engine.

Attempted to lock a connection that's already locked.

Device busy. May be in use by another user
or another application.

A resource is already acquired by another task or process.

Had to relock host port in 'QUIT".

Host port needed relocking.

Destination string too short.

In string manipulations, a string was requested that is longer
than the string it will be put into, or destination string length
<=(.

Port not locked.

Attempted to transmit or receive on a connection that wasn’t
locked, or to unlock a connection that wasn'’t locked.

Unknown response from device.

OptoMMP-based protocol packet returned by the device
was invalid.

Wrong object type. Most likely caused by
moving a pointer table element to a pointer
of the wrong type.

An object was passed to a command that doesn’t handle
that object type.

Invalid /O command or invalid memory
location.

Contact Product Support. See page 4.
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# Description Possible Cause Q? | 1/0?
I/0 Point mismatch. The Object field
specifies the point name, board name, mod-
ule number, and point number. A point is incorrectly configured (for example, an output
For example: point is configured as an input point), or the point type is not
35 supported by the I/O Unit's firmware. Check X X
BadPoint AIARMS Point Analog (R1: 2, 1) pp y . '
www.opto22.com for firmware updates.
Point hame Board  Module Point
. Feature not yet implemented for this hardware/command
Invalid command or feature not L
-36 . combination, or command may not apply to the type of X
implemented. S )
communication handle you are using.
37 Timeout on lock. Un.a.ble tg I(?ck a resource (sgch as a variable) for exclusive X
writing within the timeout period.
-38 Timeout on send. Unable to send communication in the timeout period.
-39 Timeout on receive. Unable to receive communication in the timeout period.
Invalid limit (on string index, task state, prior- A character nurleer greater than the length qf the.strlng was
-42 ity, etc.) used (or the string had a zero length), or an invalid value
Y, ele.). was passed when setting the state of a chart (running, etc.)
String less than 8 characters used to read time
-44 String too short. (*hh:mm:ss”), or not 8 or 10 characters for a date, or zero X
length on a string function.
-45 Null string. Attempted to use an uninitialized string.
String not 8 characters long when setting time, or invalid
-46 Invalid string. format when setting date, or invalid communication handle X
string or comm handle command (such as a missing colon).
-47 In.val.ld connection. Device .drlvers might be Attempted to open an already open connection. X
missing or not loaded/running.
-49 No more connections arg available. MaXI_ No more sessions available for Ethernet. X
mum number of connections already in use.
-50 Qpen conne.ct|on.t|rT1eout. .COUId not ?Stab- Unable to open a connection in time. X
lish connection within the timeout period.
Attempted to close a connection that wasn’t opened.
-52 Invalid connection—not opened. Communication handle may have been closed by a previous X
command that failed.
-57 String not found. Substring not found in the string being searched.
. Attempted to read an empty buffer (or a connection with no
No data received. e .
58 or characters waiting); or the 1/0 unit may be turned off or X
unreachable; or when searching a string for a particular
Character not found. ,
character, the character wasn’t found.
Command may not apply to the type of communication
. handle you are using; for example, Receive commands
-9 Could not receive data. cannot be used with ftp comm handles. (Use the get option
with Send Communication Handle Command instead.)
Empty stack error. PAC Control engine
-60 attempted to perform an operation that Contact Product Support. See Opto 22 page 4.

expected data on the PAC Control engine
stack.
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# Description Possible Cause Q? | 1/0?
A number of things can reduce the amount of dictionary
o . space, such as:
Dictionary full error. PAC Control engine . .
L . . ; » Too many blocks or variables in a strategy
-61 dictionary is full and no more 'words' can be
defined. * Too many large tables
* Using background downloads, which cuts available
memory in half
62 Stack full error. PAC Control engine stack | . pa ¢ control engine stack is full
has grown too big.
Execute-only error. A command or 'word'
-64 was encountered that cannot be used when | Contact Product Support. See Opto 22 page 4.
compiling.
66 Requested item in protected dictionary Attempted to remove a strategy when there was no strategy
in the control engine.
Out of memory. To minimize the size of your
strategy, reduce the number and size of No room left to create any variables or save any data on the
-67 variables (especially tables). You can also stack. Or an attempt was made to save the strategy to flash, | X
shrink your strategy by using subroutines to | without enough room in flash to save it.
perform common tasks
69 Invalid parameter (null pointer) passed to Attempted to use an uninitialized pointer, or a null pointer X
command. was received by a command.
-70 Not enough data supplied. Table index given is larger than the size of the table. X
. . Too many persistent variables, variables initialized on
Out of persistent memory. If applicable, . L
-71 check lenath of tables download, or too large a strategy archive to fit in
9 : battery-backed RAM.
-72 Subroutine nesting too deep Reduce the number of layers of subroutines called.
In configure mode, choose Edit > Find, select Global and
. . Operand, and then click Find to search for objects with the
-73 Invalid subroutine or parameters. h .
same name as the subroutine. Rename any objects that you
find.
Communication to I/O unit not enabled. Pre-
vious communication failure may have dis- Communication to the 1/0O unit may have been disabled by a
-93 - - - ; ; X
abled communication to the unit communication failure that happened earlier.
automatically. Re-enable it and try again.
-95 Stack not empty. Contact Product Support. See Opto 22 page 4.
Port could not be unlocked. Task attempting Attempted to unlock a connection that was locked by a
-103 to unlock the port does not match the task ) X
) different task.
with the current lock on that port.
Communication command didn’t find the driver described in
-203 Driver could not be found or loaded. the communication handle. Make sure driver name is not X
misspelled (for example, tcp must be lower case).
407 File not found. Attempted to save a strategy to flash, but there was no strat-
egy in RAM to save.
-412 TCP/IP: Cannot connect error Ethernet “connect” failed. See page 391. X
-417 Cannot open file File does not exist or file name may be incorrect.
Invalid data range. Verify high value is Invalid data passed to driver (for example, a point number
-430 . - X
greater than low value. larger than the maximum number of points on the rack).
403
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Description

Possible Cause

Q?

1/10?

-433

Object/device already locked.

Couldn’t set the state of a chart (running, suspended, etc.)
because it's already locked by something else.

-437

No acceptable socket interface found.

Ethernet “accept” attempted, but no more sessions are
available (32 total).

-438

Could not create socket.

This error is generated when the controller has run out of
available TCP sockets (a limited resource). This is most
likely caused when the strategy is overaggressive when
trying to establish TCP communications to other devices.
When sockets are opened and fail or are closed, there is a
time period that must expire before the socket resource may
be reused. Sockets that are rapidly opened and closed will
cause all available socket resources to enter this time
period. When this occurs, any attempt to open an outgoing
communication will fail with this error code because there
are no available sockets to use for this attempt.

When an error occurs when trying to open a TCP communi-
cation handle, the strategy should back off for a significant
amount of time before reattempting. Subsequent failures
should have additional delays applied. These delays slow
the consumption of TCP resources.

-440

Could not bind socket.

Another device, such as the I/O on the brain, is already
using the port. If you are using the Modbus toolkit, make
sure to use PAC Manager to set the brain’s Modbus port to a
number other than 502. Try 0.

442

Could not accept on socket.

Ethernet “accept” failed.

-443

Could not receive on socket.

Ethernet “receive” failed.

444

Could not send on socket.

Ethernet “send” failed.

-446

FTP: Login failed.

Incorrect user name or password. The maximum number of
login attempts on the server has been exceeded.

-531

Buffer full.

Attempted to write to a full buffer. For a serial communica-
tion handle, data is being sent faster than the serial port can
send and buffer it. Use a faster baud rate or a delay
between Transfer/Transmit commands.

-534

Attempts to communicate with 1/O unit failed.

1/0O unit may have lost power or network connection.

-5639

1/0 error; performing retry

1/0O unit may have lost power or network connection. When
communicating with 1/0O Units, retries are logged in the
message queue.
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# Description Possible Cause Q? | 1/0?

(Applicable only when redundant controller support is enabled.)
The synchronization queue contains more than one write
command for the same object.

In a redundant strategy, write commands (for example, Turn
On and Turn Off) are queued until the controller encounters
a sync block. When the sync block is executed, the queued
commands are processed. New write commands are then
queued until the next sync block is executed.

A -612 message indicates that an object has been sent
-612 Unable to enqueue sync command more than one write command without a sync block between | X X
them. The command that triggered the -612 message can
be in any chart in the strategy.

To resolve the issue:

* Add a sync block between any blocks that send write
commands to the same object.

* When writing to the same object, put the write commands
in the same transactional chart. (This will make it easier to
debug -612 errors that are caused when a chart sends a
write command to an object in a different chart.)

You are trying to download a new strategy, but a PID loop is
currently running on the brain. Open PAC Manager and turn
off the loop in Inspect mode by changing its algorithm to
None.

PID Loop has been configured outside of this
-700 strategy and could conflict with this
strategy’s logic.

-8607 Invalid protocol. Attempted to set a port to an unknown mode. X

While starting up a chart or task, the default host port could

-8608 Port initialization failed.
not be created.
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Description

Possible Cause

1/10?

-8612

Old response to new command

Each command sent by the PAC controller has a sequence
ID. Each response from an I/O unit includes the sequence
ID of the command it is responding to. This allows the
controller to verify that a response from an I/0 unit matches
the most recent command sent to that 1/O unit.

An out-of-sync error would occur (and be posted in the PAC
controller's message queue) if the response received by the
controller is for a previous command rather than the current
command.

It usually occurs like this:

Controller sends a command and waits the timeout period
for the response. If no response is received, it sends a
re-transmit of the same command, but with a new sequence
ID. The controller receives a response to the original
command, so the sequence ID does not match the current
sequence ID.

Possible problems:

* Network problems. Out-of-sync errors typically occur
when communication to the 1/O unit is via a network with
high latency or inconsistent latency, such as wireless Ether-
net, radio modem, cell modem, etc. This usually does not
occur on a wired network because normal response times
are much shorter than the default timeout period for 1/0
Units (typically 1 Sec).

Note: If an Ethernet packet from a controller to an I/O unit
gets dropped, you would get a -539 error instead of an
out-of-sync error.

* The timeout interval is too short. Increase the timeout
value to reduce out-of-sync errors.

All -10,000
and -11,000
errors

[Various descriptions]

Socket or network problems. Check cables and connections
to control engine; cycle power to control engine.
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Introduction

This appendix lists all of the PAC Control file types and special files. You can use this information to
determine what types of files are present in your PAC Control project directory.

Files Related to a Strategy

<strategy>.idb
<strategy>.crf
<strategy>.crn
<strategy>.crn1
<strategy>.crn2

<strategy>.crn3
<strategy>.inc

<strategy>.inf
<strategy>.$idb
<strategy>.lidb

<strategy>.per
<strategy>.<control engine>.cdf

<chart name>.cht
<chart name>.ccd
<chart name>.con
<chart name>.cxf
<filename>.wth

<filename>.otg

<strategy.date.time>.zip

PAC Control strategy database

Controller Run File (compiled file that is sent to the control engine)
Intermediate run file (compiled file that is sent to the control engine)
Intermediate run file (component of the run file)

Intermediate run file (component of the run file)

Intermediate run file (component of the run file)

Initialization data for variables with “Init on Download” option
(component of the run file)

Strategy configuration information

Temporary PAC Control strategy database file
PAC Control strategy database lock file
Persistent variable definitions

Control engine download file for special circumstances
(see page 186)

Chart

Compiled chart code (component of the run file)
Online compiled chart code

Exported chart file

Watch window file (you name the file)

Exported 1/O configuration file (you name the file)

Strategy archive file (automatically named; see “Archiving Strategies
on the Computer” on page 179 for file name formats)
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Files Associated with a Subroutine

<subroutine name>.isb Subroutine
<subroutine name>.ini
<subroutine name>.isc

<subroutine name>.lisb Subroutine lock file

Files in the PAC Control Directory

Subroutine configuration information

Compiled subroutine (component of the run file)

<xxx>.io.def

ioCtrl.exe

PAC Control.cnt

PAC Control.GID

PAC Control.hlp

PAC ControlCommands.cnt
PAC ControlCommands.GID
PAC ControlCommands.hlp

ioCtrlTools.dat

ioSnif.log
OptoScriptTemp.txt

Readme.txt
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Object definition files (commands, 1/O points, and I/O units). You must not
modify these files.

PAC Control executable file

PAC Control help contents file

PAC Control help support file (created when you launch the help file)
PAC Control help file

Commands help contents file

Commands help support file (created when you launch the help file)
Commands help file

File that lists software applications you've configured in the Tools menu to
launch from PAC Control

PAC Message Viewer log file
A temporary file
README text file containing information about PAC Control



D: Sample Strategy

Introduction

Chapter 2 introduced the Cookies strategy, a sample project used to illustrate how PAC Control
works. Although this strategy is based on a mythical factory, you may want to know more about the
factory, its process, and its hardware. This appendix gives you that information.

Factory Schematic

The following schematic drawing summarizes the cookie factory:
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Description of the Process

Dough Vessel

The first station in our process is the dough vessel. This tank contains a pre-made cookie dough mix.

Dough is dispensed onto the conveyor belt through a valve (SV-100B) at the bottom of the vessel.
The dough, being somewhat viscous, must be kept under low pressure to dispense properly. To
monitor the pressure, we have included a pressure transmitter (PT-100) in the vessel. Our control
engine (a SNAP PAC R-series I/0 system) maintains the vessel pressure through a plant air valve
(SV-100A).

The vessel also includes a level switch (LAL-100) to tell us when the dough level is low. When it is,
the process is halted so that an operator can refill the vessel.

Chip Hopper

The chip hopper supplies chocolate chips. A chip dispenser valve (SV-101) controls the number of
chips dropped on each cookie. Like the dough vessel, this tank also includes a level switch (LAL-101)
to stop the system when the chip hopper needs refilling.

Oven

After the dough and chips have been dropped onto the conveyor, the conveyor sends the cookie
into the oven, and the oven bakes it.

Inspection Station

Our freshly baked cookies then move to the inspection station, where someone inspects them. If the
cookie does not fall within normal tolerances— for example, it doesn't have enough chips or is
shaped oddly—the inspector closes a switch (X5-103), signaling the bad cookie. A valve (SV-103)
then opens to allow plant air to blow the reject cookie into a waste bin.

If the cookie passes the inspection, it moves on to packaging and shipping.

Conveyor

The conveyor and its motor continuously move the cookies from the dough vessel to the inspection
station. The conveyor speed is controlled through an analog output (SY-104) from a speed controller
(SC-104).

Emergency Stops

Wired at key locations around our bakery are emergency-stop buttons. If something goes wrong
with the process, an operator can press any of these E-STOP buttons.
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The buttons are wired in series and are normally closed, so pressing any E-STOP button breaks the
circuit. One digital input can monitor all the buttons. The system can be restarted by resetting the
button.

Required I/O

Here's the list of analog and digital I/0 modules required for the cookie factory:

Analog I/0
Name Description Type Module Range
PT-100 Dough Vessel Pressure Input SNAP-AIV (=10 to +10 VDC) 0-15 psig
TT-102 Oven Temperature Input SNAP-AICTD (ICTD) -50-350°C

TY-102 Oven Temperature Control Output SNAP-AOV-27 (-10 to +10 VDC) 0-100%

SY-104 Conveyor Speed Control Output SNAP-AQOV-27 (-10 to +10 VDC) | 0-100%

Digital I/0

Name Description Type Module States
0=Closed
SV-100A Pressure Control Valve Output SNAP-ODC5SRC (5-60 VDC) 1=Open
. 0=Closed
SV-100B Dough Dispense Valve Output SNAP-ODC5SRC (5-60 VDC) 1=Open
0=0K
LAL-100 Dough Level Alarm Input SNAP-IDC5D (2.5-28 VDC) 1=Low
. 0=Closed
SV-101 Chip Dispense Valve Qutput SNAP-ODC5SRC (5-60 VDC) 1=Open
. 0=0K
LAL-101 Chip Level Alarm Input SNAP-IDC5D (2.5-28 VDC) 1=Low
" . 0=0K
XS-103 Inspection Signal Input SNAP-IDC5D (2.5-28 VDC) 1=Reject
. 0=Closed
SV-103 Reject Valve Output SNAP-ODC5SRC (5-60 VDC) 1=Open
0=Stop
XS-105 Emergency Stop Input SNAP-IDC5D (2.5-28 VDC) 1=0K
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E: OptoScript Language
Reference

Introduction

This appendix includes the following reference information about the OptoScript language:

OptoScript Comparison with Standard Programming Languages............. 413
Notes to Experienced Programmers. .............oo oo 418
OptoScript Lexical Reference ....... ... ... 420
OptoScript Grammar Syntax Reference............. ... . v, 423

OptoScript Comparison with Standard Programming
Languages

The tables on the following pages compare OptoScript functions and variables to those available in
Pascal, BASIC, and C. For more information on using OptoScript, see “11: Using OptoScript,” on
page 343.

General Notes:
1. The BASIC column is based on Microsoft's Visual Basic language.
2. The Pascal column is based on Borland's ObjectPascal language.

3. The use of logical statements in BASIC and Pascal is significantly different than in OptoScript
and C. BASIC and Pascal have a Boolean data type; OptoScript and C use integers. OptoScript
and C treat a zero value as false and a non-zero value as true.

4. InOptoScript, you cannot use a break type of command in a loop.

OptoScript can test only one case in a switch at a time; other languages can test more than one.
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NOTES TO EXPERIENCED PROGRAMMERS

Variable Comparison

Variable PAC Control BASIC Example C Example Pascal Example
Name Type

n integer 32 Dim n as Long long n; n: Integer;
nn integer 64 Not available LONGLONG d; d: Int64;
f float Dim f as Single float f; f: Single;
s string Dim as String char s[128]; s: ShortString;
p pointer not available long * pn; pn: Mnteger;
nt integer 32 table Dim nt(10) as Long long i[10]; nt: array[0..9] of Integer;
ft float 32 table Dim ft(10) as Single float f[10]; ft: array[0..9] of Single
st string table Dim st(10) as String char s[10][128]; st: array[0..9] of ShortString;
pt pointer table not available void * pt[10]; pt: array[0..9] of AInteger;

Notes to Experienced Programmers

Experienced programmers, especially those who are new to PAC Control, may be interested in the
following notes.

Variable Database and Other Surprises

PAC Control maintains a database of all declared variables—a notable difference from common
procedural languages. Variables are not declared in the programming code, but in the PAC Control
tag database. This is a basic concept of PAC Control and how it ties in with PAC Display, but may
seem odd to experienced programmers using PAC Control for the first time. Also, all variables and
objects are global. Local variables do not exist in PAC Control in the way they do in most procedural
languages. Subroutines in PAC Control contain “local”variables, but those local variables apply
throughout that subroutine.

Most languages allow you to return from a function before it ends, but OptoScript does not. The
same effect can be achieved in other ways, however, such as introducing tests into the code. (Some
people argue that this limitation produces better programming, because each function has only
one exit point.)

PAC Control's Target Audience

Because PAC Control is based on OptoControl, which was conceived as a simple programming tool
for non-programmers, it is designed to be relatively foolproof. Even though OptoScript provides
advanced functionality, this philosophy also influenced the design of OptoScript. OptoScript exists
only inside OptoScript blocks, which can exist only inside a flowchart. Flowcharts are the basis of
PAC Control.

Even an experienced programmer may want to think twice before using OptoScript blocks
extensively. Many programmers like PAC Control's simplicity not for themselves but for the field
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technicians and maintenance personnel who will use it in the field. While you could write an entire
chart (or conceivably an entire strategy) in one block, doing so would eliminate most of the
advantages of using PAC Control. Consider limiting your use of OptoScript to math operations,
complex string manipulation, and other logic most suited to scripting, so you retain PAC Control’s
advantages for non-programmers.

Language Syntax

In the same way, OptoScript syntax is meant to be simple enough for a beginner to understand but
also easy for an experienced programmer to learn quickly.

Some programmers may wonder why OptoScript is not modeled after just one existing language,
such as BASIC or C. Instead, one can clearly see influences from Pascal, BASIC, and C. PAC Control's
target audience is one reason; internal consistency with PAC Control commands and the capabilities
and limitations of Opto 22 control engines are another.

Some aspects of OptoScript were designed to be consistent with PAC Control commands. For
instance, the bitwise and operator was named bitand in OptoScript because there is a command in
PAC Control named Bit AND.

OptoScript provides all the functionality of Opto 22 control engines but is subject to their
limitations. For instance, OptoScript provides some convenient ways of working with strings, but
only to a certain point.

For example, in an assignment statement, strings can be added together like this:
strDate = strMonth + /" + strDay + "/" + strYear;

It would certainly be nice to use the same kind of string addition in a procedure call:
TransmitString(strMonth + "/ + strDay + /" + strYear, nPort);

However, due to the current abilities of control engines, this type of string addition inside a function
callis not possible.
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OptoScript Lexical Reference

Token Syntax Legend

Tokens are the smallest units that the OptoScript compiler processes.

bold character:
(parenthesis):

[brackets]:

opt subscript:

no subscript:
0+ subscript:
1 subscript:

1+ subscript:

specific character

content is treated as a unit

set of possible items

item is optional

item is not allowed

0 or more items may be chosen
one item must be chosen

one or more items must be chosen

Literals and Names

letter:

any character
any character a through z,

upper or lower case
digit: oneof[0123456789]
non-zero-digit oneof[123456789]
oneof[0123456789ABC
hex-digit:

DEFabcdef]

Token Name

Token Syntax

Comments

Int32Literal

O[xX] hex-digity,

Hexadecimal Integer 32-bit

Good examples: Ox12AB, 0X12aB,
0x0

Bad examples: X123ABC, 0123ABC

0
non-zero-digit,; dig-
ity

Decimal Integer 32-bit
Good examples: 0, 123, 7890
Bad examples: 123ABC

) [*'no]l.

Single Character
Good examples: "A®", *1%, * *
Bad examples: """

Int64Literal

0[xX],hex-digit,;+i64

Hexadecimal Integer 64

Good examples: 0X12ABi64,
0X12aBi64, 0x0i64

Bad examples: X123ABCi64,
0123ABCi64

0i64
digit,i64
non-zero-digity,i64

Decimal Integer 64

Good examples: 0164, 123164,
7890164

Bad examples: 123ABCi64

FloatLiteral

digity, . digity,
([Eely [+-1ope dig-
it1+)opt

Float Literal

Good examples: 1.0, 2.3, 1.2€6,
1.2e-6, .1, .2e6

Bad examples: 1., 1l.e7, le7

StringLiteral

"[*"nodo+"

String Literal. Confined to single line.
Good examples: "‘abc def"
Bad examples: '"abc''def"’
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Token Name

Token Syntax

Comments

NumericVariable
StringVariable
ChartVariable

DigloUnitVariable
MixedloUnitVariable

PointerVariable
NumericTable
StringTable
PointerTable

CommunicationHandle

[letter],; [letter
digit _ Jo.

A letter followed by mix of letters, digits,
and underscores. The nhame must be
found in the PAC Control database.

Good examples: MyInt, Mylnt2,
My_Int_3
Bad examples: _MylInt, OMylnt

A letter followed by mix of letters, digits,
and underscores. The name must be a

CommandProcedure e !
CommandProcedureNoArgs [letter], [letter built-in command or subroutine.
ggzmzzgg:zﬂg:NoAr s digit _ Jo. Good examples: Sine, Sine2,
9 Sine_3
Bad examples: _Sine, 0Sine
Keywords (Reserved Words)
if for switch ::”e
then to endswitch wend Chr
else ste case
elseif nexri break repeat null
endif default P
until
Operators

The following table lists operators in order of highest to lowest precedence:

Operator Name/Meaning Comments
- negation
not logical not
bitnot bitwise not
* multiplication
/ division
% modulo division
- subtraction
+ addition
+= string append assignment
<< bitwise left shift
>> bitwise right shift
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Operator Name/Meaning Comments
== equality
<> non-equality
< less than
<= less than or equal to
> greater than
>= greater than or equal to
bitand bitwise and
bitor bitwise or
bitxor bitwise exclusive or
and logical and
or logical or
Xor logical exclusive or
not logical not
« ) parentheses no precedence
L 1 brackets no precedence
: colon no precedence
; semi-colon no precedence
, comma separator no precedence
= assignment no precedence
& address of no precedence
Comments

OptoScript has two kinds of comments: single line and block.

Single line comments are indicated by two slashes, followed by any sequence of characters, until
the end of the line.

Examples:
i =a+ b; // this is a comment
i =a+ b; //determine i by adding a and b together

// 1 = a+ b; // This whole line is commented out

Block comments are indicated by a slash and an asterisk (#*), followed by any sequence of
characters, and ending with an asterisk and a slash (*/). This type of comment may span multiple
lines. Block comments may not be nested.

Examples:
i =a+ b; /*determine i by adding a and b together*/
i =a+ b; /7% determine i by adding
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a and b together */
/* 1 = a+ b; // determine i by adding a and b together */

OptoScript Grammar Syntax Reference

Tokens are in regular type.
Keywords and operators are in bold type.
Syntax Rules are in italic type.

Program
> StatementList

StatementList
> Statement
> StatementList Statement

Statement

> AssignmentStatement

> StrAssignmentStatement
> PtrAssignmentStatement
> ProcedureCommand

> FunctionCommand ;

> ConditionStatement

> forStatement

> WhileStatement

> RepeatStatement

> SwitchStatement

ProcedureCommand
> CommandProcedureNoArgs () ;
> CommandProcedure (ArgumentlList) ;

FunctionCommand
> CommandFunctionNoArgs ()
> CommandFunction (ArgumentList)

ArgumentList

> NumericExp

> ArgumentList, NumericExp

> Stridentifier

> ArgumentlList, Stridentifier

> ObjVarldentifier

> ArgumentlList, ObjVarldentifier

NumericExp

> ( NumericExp)
> NumericExp

> LogicalExp

> LogicalUnaryExp
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> AdditiveExp

> MultiplicativeExp

> BitwiseExp

> Numldentifier

> NumericLiteral

> FunctionCommand

LogicalExp

> NumericExp and NumericExp
> NumericExp or NumericExp
> NumericExp xor NumericExp
> NumericExp == NumericExp
> NumericExp <> NumericExp
> NumericExp < NumericExp
> NumericExp <= NumericExp
> NumericExp > NumericExp
> NumericExp >= NumericExp
> Stridentifier == Stridentifier
> PointerVariable == null

> null == PointerVariable

> null == PointerTable [ NumericExp 1
> PointerTable [ NumericExp ] == null
AdditiveExp

> NumericExp + NumericExp
> NumericExp - NumericExp

MultiplicativeExp

> NumericExp * NumericExp
> NumericExp [ NumericExp
> NumericExp % NumericExp

NotNumExp
> ObjVarldentifier
> Stridentifier

BitwiseExp

> bitnot NumericExp

> NumericExp bitand NumericExp
> NumericExp bitor NumericExp
> NumericExp bitxor NumericExp
> NumericExp << NumericExp
> NumericExp >>  NumericExp

AssignmentStatement

> NumericVariable = NumericExp ;

> NumericTable [ NumericExp 1= NumericExp ;
> StringVariable [ NumericExp 1= NumericExp ;

PtrAssignmentStatement
> PointerVariable = Pointableldentifier ;
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> PointerVariable = PointerTable [ NumericExp 1;
> PointerTable [ NumericExp 1= Pointableldentifier ;

Pointableldentifier

> null

> &StringVariable

> &NumVarldentifier
> &ObjVarldentifier

StrAssignmentStatement

> StringVariable = StrExp ;

> StringTable [ NumericExp 1= StrExp ;

> StringVariable += Strldentifier ;

> StringVariable += Chr ( Numerickxp ) ;

StrExp

> StrAdditiveExp

> Stridentifier

> Chr ( NumericExp)

StrAdditiveExp
> StrExp + StrExp

Strldentifier

> StringVariable

> StringLiteral

> StringTable [ NumericExp ]

Numldentifier

> NumVarldentifier

> NumTableldentifier
> StringCharldentifier

NumVarldentifier
> NumericVariable

ObjVarldentifier

> ChartVariable

> DigloUnitVariable

> MixedloUnitVariable

> Tableldentifier

> CommunicationHandle

NumTableldentifier
> NumericTable [ NumericExp ]

Tableldentifier
> NumericTable
> StringTable

StringCharldentifier
> StringVariable [ NumericExp ]

NumericLiteral
> Integer32Literal
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> Integer64Literal
> FloatLiteral

LogicalUnaryExp
> not NumericExp

ConditionStatement
> [fStatement
StatementListOrEmpty
EndifStatement
> [fStatement
StatementListOrEmpty
ElseStatement
StatementListOrEmpty
EndifStatement
> [fStatement
StatementListOrEmpty
ElselfList
EndifStatement
> [fStatement
StatementListOrEmpty
ElselfList
ElseStatement
StatementListOrEmpty
EndifStatement

IfStatement
> if ( NumericExp ) then

ElseStatement
> else

ElselfStatement
> elseif ( NumericExp ) then
StatementListOrEmpty

ElselfList
> ElselfStatement
> ElselfList ElselfStatement

EndifStatement
> endif

Caselist

> CaseStatement

> CaseStatement DefaultStatement

> Caselist CaseStatement

> Caselist CaseStatement DefaultStatement

DefaultStatement
> default :
StatementListOrEmpty
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break

CaseStatement
> case NumericExp :
StatementListOrEmpty
break

SwitchStatement
> switch ( NumericExp )
Caselist
endswitch

ForStatement
> for NumericVariable = NumericExp to NumericExp step NumericExp
StatementListOrEmpty
next

WhileStatement
> while ( NumericExp )
StatementListOrEmpty
wend

RepeatStatement
> repeat
StatementListOrEmpty
until NumericExp ;
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Index

A

action block
definition 218
action command
definition 51
active address 316
adding
analog point 135
command 253
in OptoScript 367
communication handle 239
digital point 132
numeric variable 239
PID loop 147
pointer 239
pointer variable to watch window 250
string variable 239
table variable 242
table variable to watch window 251, 253
text to chart 225
variable 239
variable to watch window 248
algorithms for PID loops 328
analog
adding I/0 point 135
changing I/0 while strategy is running 156
copying /0 point 143
I/0 unit commands 315
minimum/maximum value 262
offset and gain commands (instructions)
262
point commands 262, 352
point, definition 48
TPO 262
applications

launching from PAC Control 67
archiving strategies

restoring archives 118

to computer 179

to control engine 116
argument 83, 255

in OptoScript 354

ASCII, decimal and hex values of characters 339

auto stepping through a chart 192, 193

automation 47
autorun 189

B
background downloading 183, 184

baud rate and mode for serial I/O units (Pro) 129

baud rate for serial /0 units 129
bill of materials 205, 206
bit commands 321
bitwise operator, in OptoScript 362
block
block 0218
changing color or size 219, 228
connecting blocks 223
definition 218
deleting 228
drawing 221
finding in a chart 63
moving 226
naming 86, 222
OptoScript 344
selecting 226
stepping through 192
BOM 205, 206
bookmark 369
breakpoints in a chart 194
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C

CA root certificate 298
calling a subroutine 383
case statement 349, 363

programming example 90

certificate 299
changing

active control engine 110
analog I/0 while strategy is running 156

baud rate and mode for serial I/O units (Pro)

129
baud rate for serial I/0 units 129
block color or size 219, 228
chart background 219
chart name or description 230
column width in a dialog box 64
command (instruction) 257
connection line color or size 228
control engine definition 109
debug level 190
debugger speed 190
digital I/0 while strategy is running 154
I/0 points 145
/0 unit configuration 131
I/0 while strategy is running 152
numeric variable 248
PID loop 151
pointer table 253
pointer variable 250
scale of a chart 61
strategy download compression 188
string table 257
string variable 248
text color or size 219, 228
text in chart 225
variable 247

chart

adding text to 225

auto stepping 192, 193
breakpoints 194

calling a subroutine 383
changing background 219
changing name or description 230
changing scale 61

closing 229

commands 263

contents 218

copying 229
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creating 217
definition 50
deleting 231
designing 81
exporting 231
finding a block 63
flow-through logic 84
guidelines for design 85
importing 232
loop logic 84
looping 348
monitoring in watch window 169
naming 86, 230
opening 229
pausing 191
printing commands (instructions) 202
printing graphics 199
replacing elements 209
saving 177, 229
searching 208
status 50, 198
stepping through 192
viewing 59, 198
zooming in or out 61
chart element
changing color or size 228
cutting, copying, and pasting 227/
moving 226
selecting 226
client 267
client/server architecture 274
closing
chart 229
strategy 177,178
command
adding 253
adding in OptoScript 367
arguments 83
changing 257
commenting out 258
cutting, copying, and pasting 258, 259
definition 51
deleting 257
deleting temporarily 258
for continue block 259
groups
analog point commands 262
chart commands 263
communication commands 264



control engine commands 310
error handling commands 314
I/O unit—event message commands
317
/0 unit—memory map commands 318
/0 unit—scratch pad commands 319
logical commands 321
mathematical commands 322
miscellaneous commands 326
PID—Ethernet commands 326
pointer commands 330
simulation commands 331
string commands 332
time/date commands 339
timing commands 340
in OptoScript 352
function 354
procedure 354
printing 202

comment 258, 326

in OptoScript 369, 422

communication

Ethernet link redundancy 104, 315

I/0 memory map commands (instructions)
318

I/0 unit—event message commands (in-
structions) 317

/0 unit—scratch pad commands 319

incoming 270

outgoing 267

PC and control engine 99

peer-to-peer 267,319

TCP/IP 265

with serial communication module 267,
271,273

communication commands 264
communication handle

adding 239
definition 54, 237, 264
examples
File 286
FTP 291
serial 295
TCP 271,272
File 284
FTP 291
port numbers 269
serial 295
serial communication modules 271

TCP 265
types 265
viewing 248

comparison operators 360
compiling

copy errors and warnings 181
strategy 26, 180

strategy without downloading 183
subroutine 381

condition block

definition 218

condition command, definition 51
condition in OptoScript 350
configuration mode toolbar 56
Configure mode, definition 55
configuring

continue block 259
control engine 99

I/0 points 132

I/0 unit 123

PID loop 146, 327

serial module 140
subroutine parameters 377
table variables 242
variables 239

connection line

changing color or size 219, 228
definition 219

deleting 228

drawing 223

moving 226

selecting 226

constant, See literal
continue block

command (instruction) 259
configuring 259
definition 219

control characters, adding to string 334
control engine

active control engine 110

archiving strategies 116

changing definition 109

changing the active control engine 110
commands (instructions) 310
configuring 99

definition 47

deleting from strategy 110

download file, creating 186

hostname 102
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inspecting 111
IP address 102
moving to another PC 119
removing association with strategy 110
restoring archived strategies 118
testing communication 390
viewing message queue 113
control network

segmenting from company network 104

control structures, in OptoScript 362
controller, See control engine
converting a strategy 399
converting IEEE float 323
copying
block 227
chart 229
command (instruction) 258, 259
configured /0 point 143
connection line 227
/0 configuration 125
text block 227
count variable programming example 90
counter
commands (instructions) 312
CRC commands 310
creating
flowchart 217
PID loop 146
strategy 175
subroutine 375
watch window 169
See also changing
cross reference window 204
cutting
block 227
command (instruction) 258, 259
connection line 227
text block 227

D

data

|EEE float format 323
data format

IEEE float 323
data types in subroutines 374
data, sorting, in a dialog box 65
date commands 339
Debug mode
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definition 55
inspecting control engine 111
inspecting 1/0 152
debug mode toolbar 56
debugging
changing speed 190
choosing level 190
follow stepping 191
strategy 190
subroutines 385
when using OptoScript 372
delay
commands 340
deleting
chart 231
chart elements 228
command (instruction) 257
command, temporarily 258
control engine association with strategy
110
control engine from strategy 110
I/0 point 146
I/0 unit 131
PID loop 152
variable 248
designing
basic rules for strategies 84
steps for 77
dialog box
sizing columns 64
sorting columns 65
digital
adding digital point 132
changing I/0 while strategy is running 154
copying I/O point 143
counter 312
I/0 unit commands 315
latches 311
point commands 352
point, definition 47/
pulse commands (instructions) 312
quadrature counter 312
totalizer 312
directory listing 294
disabling 1/0 313
docking
Strategy Tree 61
watch window 171
down timers 341



downloading
files using FTP 291
files using PAC Terminal 120
initialization file for table variable 246
strategy 180, 184
changing compression 188
without using PAC Control 186
drawing toolbar 219
duplicate object names 399

E

editing, See changing
EEPROM, See flash
elapsed time 197
email 297, 306
error
cannot delete item 388
copy compile errors 181
queue 113, 398
status codes 399
TCP/IP cannot connect 391
types 397
See also troubleshooting
error handling
commands (instructions) 314
programming example 89
error lookup 397
Ethernet
connections 274
link redundancy 104
commands for 315
ports 274
Ethernet I/O units and commands 213
example
case statements 90, 349
complex operations 351
creating messages to display on screen 87
error handling chart 89
File communication handle 286
flag lock 92
FTP communication handle 291
if statements 350
loops 348
mathematical expressions 345
pointers (indexing) 95
repetitive actions 90
serial communication handle 295

string building 336, 346
string data extraction 335
string formats 334
string table 335
subroutine parameters 379
TCP communication handle 271
timer 91

exiting, See closing

exporting
chart 231
I/0 configuration 125

F

File communication handle 284
examples 286
file system on the brain
moving files via FTP 291
saving files to flash 310
finding a block in a chart 63
flag lock example 92
flash memory 153
saving files to 310
saving strategy to 178
float
IEEE 323
floating point
converting to integer 325
converting to string 338
definition 53
in logic 322
variable, definition 236
flowchart, See chart
flow-through logic 84
follow debugger stepping 191
for loop 348, 365
format
File communication handle 284
FTP communication handle 291
IEEE float 323
serial communication handle 295
TCP communication handle 267
FTP
directory listing 294
FTP communication handle 291
full debug, definition 190
functions in OptoScript 352
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G
gain

and offset 262

in PID loops 163
grammar in OptoScript 423

H

handshake 267
hardware requirements for PAC Control 5
help

See also troubleshooting
help, online 76
hex display mode 66
high-density digital

enabling commands 213
high-density points 316
host task

definition 52
hostname, control engine 102
Hungarian notation 86, 355

170
changing configured point 145
configuring 132
copying configured point 143
deleting configured point 146
disabling 313
exporting configuration 125
importing configuration 125
in strategy design 78, 80
monitoring in watch window 169
moving configured point 142
naming points 86
point numbers 126
point, definition 47/
saving configuration 153
segmenting I/O from host network 104
using in OptoScript 352
viewing all in a strategy 203, 204
170 unit
changing 131
commands 315,317,318, 319
configuring 123
definition 123
deleting 131
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exporting configuration 125
importing configuration 125
monitoring in watch window 169
point numbers 126
IEEE float 323
if statements
in OptoScript 363
if/then statements 350
importing
chart 232
I/0 configuration 125
info, viewing 113
initialization file 120, 243
creating 244
downloading 246
input point
definition 47
disabling 313
input/output, See l/O
inspecting
control engine 111
control engine using PAC Terminal 116
1/0 152,153
/0 using watch window 169
PID loop 158
See also viewing
installing PAC Control 4
instruction, See command
integer
converting to float 325
definition 53, 322
in logic 322
variable, definition 236
interacting algorithm for PID 328
IO Enabler 315
[P address
control engine 102
loopback 127, 268, 272
primary and secondary 127
ISA algorithm for PID 328
IVAL 313

K
keyboard shortcuts 76

L
lag time, for PID 159



latch
commands (instructions) 311
launching, See opening
legacy options, enabling 211
link redundancy 105, 315
SoftPAC controller 105
literal
constant 239
in OptoScript 420
load last mode at startup 176
load last strategy at startup 176
local subroutine parameter 374
local variable 374
log file 408
logic, in charts 84
logical commands (instructions) 321
logical operator in OptoScript 361
logical true and false 322
look up an error 397
loop logic 84
loopback address 127, 268, 272
looping 348, 364, 365

M

mathematical commands (instructions) 322
mathematical expressions 345

in OptoScript 360
memory 389
memory map commands 318
message on screen, programming example 87
message queue 113
microSD card 286, 291
minimal debug, definition 190
minimum/maximum value 262
mistic I/0 units and commands 213
mode

Configure, definition of 55

Debug, definition of 55

Online, definition of 55
modifying, See changing
monitoring, See inspecting and viewing
moving

block 226

connection line 226

control engine definitions 119

files via FTP 291

I/0 point 142

text block 226

to another window or chart 59
moving control engines 119
multitasking 52

and strings 334

N

naming

block 86, 222

chart 86, 230

conventions 85, 86, 355

/0 points 86

variables 86, 355
naming conflicts 399
network

segmenting control network 104
network redundancy 104
number, converting to string 338
numeric literals in OptoScript 355
numeric table

adding 242

as alternative to strings 333
numeric variable

adding 239

in OptoScript 355

o)

offset and gain commands (instructions) 262
online help 76
Online mode
avoiding memory problems 55
definition 55
online mode toolbar 56
opening
applications from PAC Control 67
chart 229
strategy 176
watch window 171
operator
bitwise, in OptoScript 362
comparison, in OptoScript 360
in standard commands (AND/OR) 256
logical, in OptoScript 361
order of precedence 421
OptoScript
bitwise operators 362
block example 344
block, definition 218
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bookmark 369 errors 397

case statements 349, 363 files, list of 407
command types 354 installing 4
commands 352 main window 54
comments 422 mode 55
communication handle 288 opening other applications 67
comparison operators 360 programming 77, 343
comparison with other languages 413 system requirements 5
complex loops 348 PAC Display 52
conditions 350 PAC Manager 123
control structures 362 PAC Message Viewer utility 392
debugging strategies 372 PAC Terminal utility
definition 343 downloading files 120
editor 366 inspecting control engines 116
for loop 365 testing communication with control engine
functions 352 390
if statements 363 PAC Utilities 116, 120, 390, 392, 394
language reference 413 page setup for printing graphics 199
literals 420 panning 63
logical operator 361 parallel algorithm for PID 328
math expressions 345, 360 parameters, subroutine 373, 377
notes for programmers 418 passed-in subroutine parameters 374
numeric literals 355 pasting
numeric variables 355 block 227
pointers 357 command (instruction) 258, 259
precedence for operators 421 connection line 227
repeat loop 365 text block 227
string handling 346 pausing
strings 356 chart 191
switch statements 363 peer-to-peer communication 237, 267, 274,
syntax 353, 419, 423 319
tables 359 permanent storage, See flash memory
toolbar 367 permissions in Windows 395
troubleshooting 370 persistent data 238
types of commands 354 persistent RAM 389
when to use 344 PID loop
while loop 364 algorithms 328
OptoVersion utility 394 changing 151
order of precedence for operators 421 configuring 146, 327
output point definition 327
definition 47 deleting 152
disabling 313 determining system lag 159
inspecting 158
tuning 163
P PID—Ethernet commands 326
PAC Control pointer
definition 45 adding 239
designing a strategy 77 commands 330, 357
directory, list of files in 408 definition 54, 237, 330
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in OptoScript 357
programming example (indexing) 95
pointer table 331
adding 242
port
Ethernet 274
peer-to-peer communication 269
Powerup chart 51
uses 85
precedence for operators 421
primary and secondary addresses
for 1/0 unit 128
printing
bill of materials 205, 206
chart commands (instructions) 202
chart graphics 199
chart instructions 259
page setup 199
subroutine commands 202
problems, see troubleshooting
Product Support 4
programming
comparing OptoScript with other languages
413
examples 87
in PAC Control 77
pulse
commands (instructions) 312

Q

quadrature counter commands (instructions)
312
queue
checking messages 113, 398
quotation marks in strings 356

R

RAM 389

redundant communication links 104, 315
redundant controllers 109

repeat loop 348, 365

repetitive actions programming example 90
replacing elements 209

resolution, timer 341

retrieving a directory listing 294

root certificate 298

RTS/CTS 296

running a strategy 28
automatically 189
manually 189

S

saving
chart 177,229
configurations to flash memory 153
files to flash memory 310
strategy 177
strategy to flash 178
subroutine 381
saving I/0 unit configuration 153
scratch pad commands 319
searching 208
secondary address 128
security certificate 299
Security type 298
segmenting control network 104
selecting
block or text block 226
connection line 226
Send Email
timeouts 306, 309
send email 297, 306
serial communication handle 295
serial communication module
communicating with 267, 271, 273
configuring 140
serial devices, communicating with 295
serial I/0 unit
changing baud rate 129
changing baud rate and mode (Pro) 129
server 267/
setpoint, for PID 146
setting hex display mode 66
shortcuts, keyboard 76
Simple I/0 units and commands 213
simulation commands 331
sizing columns in a dialog box 64
SNAP PAC redundancy option 109
SNAP-PAC-S2
RTS/CTS 296
SoftPAC
adding a control engine 25
archiving strategies 116
compatible I/0 units 6
file storage 284
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link redundancy 105
saving files to flash 310
software, launching from PAC Control 67
sorting columns in a dialog box 65
SSL (Secure Sockets Layer) 298
starting a strategy 189
status codes 399
stepinto 192
step out 192
step over 192
stepping
inside blocks 193
one block at a time 192
through a chart 192
within a block 190
stopping
strategy 189
strategy
archiving
to computer 179
to control engine 116
closing 177,178
compiling 26, 180
compiling without downloading 183
creating 175
debugging 190
debugging when using OptoScript 372
definition 53, 175
deleting control engine 110
designing 77, 84
disassociating control engine 110
downloading 180, 184
downloading, changing compression 188
downloading, without using PAC Control
186
files 407
including subroutine 381
opening 176
replacing elements 209
restoring archive from control engine 118
running 28
automatically 189
manually 189
saving 177
saving to flash EEPROM 178
searching 208
starting automatically 247
stopping 189
transfer to another PC 119
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viewing all operands 204
viewing variables and 1/0 203
Strategy Tree
definition 57
docking 61
icons 57
string
adding control characters 334
building, example of 336
commands 332, 356
equivalents in Visual Basic and C 337
convert-to-string commands 338
data extraction, example of 335
definition 54
examples 334, 356
in OptoScript 356
length and width 333
quotation marks 356
variable, adding 239
variable, definition of 237
string handling 346
string table
adding 242
example 335
subroutine
adding commands (instructions) 380
adding local variables 380
auto stepping 193
breakpoints 194
calling from a chart 383
compiling 381
configuring parameters 377
configuring parameters, example 379
creating 375
data types 374
debugging 385
definition 373
including in strategy 381
list of files in 408
parameters 373
pausing 191
printing commands 202
printing graphics 199
saving 381
searching 208
stepping through 192
tips 375
viewing 385
viewing all operands 204



viewing variables 203
Switch & Run 183
switch statement 349, 363
switching strategies 183, 184
sync block
definition 219
syntax
common errors, in OptoScript 371
in OptoScript 353,419,423
system requirements for PAC Control 5

T

table
commands 316, 326
in OptoScript 359
numeric table as alternative to strings 333
table variable 237
adding 242
changing 251, 253
configuring 242
initializing during strategy download 244
monitoring in a watch window 251, 253
tabs, using to view windows 59
target address 315
task queue 263
TCP communication handle 265
TCP/IP cannot connect error, resolving 391
text block
deleting 228
moving 226
selecting 226
text, changing color or size 219, 228
time/date commands (instructions) 339
timeouts
Send Email 306, 309
timer
commands (instructions) 340, 341
definition 53
down timer 341
programming example 91
resolution 341
up timer 341
variable, definition 237
timing a process, commands used for 339
TLS (Transport Layer Security) 298
toolbar 55
drawing 219
OptoScript 367

toolbars
configuration mode and online mode 56
debug mode 56
totalizer commands (instructions) 312
TPO 262
transfer control engine 119
trigonometry commands (instructions) 322
troubleshooting
how to begin 387
in OptoScript 370
memory problems 389
memory problems from Online mode
changes 55
PAC Message Viewer utility 392
Product Support 4
Windows permissions 395
tuning
PID loop 163
types of OptoScript commands 354

U

UDP communication handle 275
Ultimate I/0 units and commands 213
up timers 341

\'

variable
adding 239
changing 247, 248, 250
configuring 239
definition 53, 235
deleting 248
in strategy design 81
literal (constant) 239
monitoring in a watch window 169, 248,
250
naming 86, 355
OptoScript compared to other languages
418
persisent data in 238
pointer, definition 330
table 237
types of data 236
types, in PAC Control 237
viewing all in a strategy 203, 204
velocity algorithm for PID 328
version, checking with OptoVersion 394
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subroutine

viewingviewing, See also inspecting

viewing

all operands 204

all variables and /0 203

another window or chart 59

bill of materials 205, 206

chart 198

chart instructions 259

communication handle variable 248

message queue 113

numeric table variable 251

numeric variable 248

PID loop 158

pointer table variable 253

pointer variable 250

string table changing
numeric table 251

string variable 248

subroutine 385
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W

warning
copy compile warnings 181
viewing 113

watch window
creating 169
docking 61, 171
monitoring pointer variable 250
monitoring table variable 251, 253
monitoring variable 248
opening 171

while loop 348, 364

Windows
permissions 395

XVAL 313

y4

zooming in or out 61
z-order, changing 227
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